
 

ΕΘΝΙΚΟ ΜΕΤΣΟΒΙΟ ΠΟΛΥΤΕΧΝΕΙΟ 

ΣΧΟΛΗ ΝΑΥΠΗΓΩΝ ΜΗΧΑΝΟΛΟΓΩΝ 

ΜΗΧΑΝΙΚΩΝ 

ΤΟΜΕΑΣ ΝΑΥΤΙΚΗΣ ΜΗΧΑΝΟΛΟΓΙΑΣ 
 

 
 

 

Μελέτη Βραχυκυκλωμάτων σε Συστήματα 

Ηλεκτρικής Ενέργειας Πλοίων με Χρήση του 

PowerFactory 
 

 

 

ΔΙΠΛΩΜΑΤΙΚΗ ΕΡΓΑΣΙΑ 
 

του 

 

 ΠΑΝΤΑΖΟΠΟΥΛΟΥ ΓΕΩΡΓΙΟΥ 

 

 

 

 

 

 

 

Επιβλέπων : Ιωάννης Μ. Προυσαλίδης 

Αναπληρωτής Καθηγητής Ε.Μ.Π. 

 

 

 

  

Αθήνα, Φεβρουάριος 2016 

  



 

 

 

 



ΕΘΝΙΚΟ ΜΕΤΣΟΒΙΟ ΠΟΛΥΤΕΧΝΕΙΟ 
ΣΧΟΛΗ ΝΑΥΠΗΓΩΝ ΜΗΧΑΝΟΛΟΓΩΝ ΜΗΧΑΝΙΚΩΝ 

ΤΟΜΕΑΣ ΝΑΥΤΙΚΗΣ ΜΗΧΑΝΟΛΟΓΙΑΣ 

 

 

 

Μελέτη Βραχυκυκλωμάτων σε Συστήματα 

Ηλεκτρικής Ενέργειας Πλοίων με Χρήση του 

PowerFactory 
 

 

 

ΔΙΠΛΩΜΑΤΙΚΗ ΕΡΓΑΣΙΑ 
 

του 

 

 ΠΑΝΤΑΖΟΠΟΥΛΟΥ ΓΕΩΡΓΙΟΥ 

Α.Μ.: 08109032 

 

 

 

 

 

 

Επιβλέπων : Ιωάννης Μ. Προυσαλίδης 

Αναπληρωτής Καθηγητής Ε.Μ.Π. 

 

 

 

 

Εγκρίθηκε από την τριμελή εξεταστική επιτροπή την 24
η
 Φεβρουαρίου 2016. 

 

 

 
(Υπογραφή)            (Υπογραφή)           (Υπογραφή) 

         ...................................          ...................................         ................................... 
Γεώργιος Κορρές Ιωάννης Προυσαλίδης Χρήστος Παπαδόπουλος  

Καθηγητής Ε.Μ.Π. Αν. Καθηγητής Ε.Μ.Π. Επ. Καθηγητής Ε.Μ.Π. 

 

 

 

Αθήνα, Φεβρουάριος 2016 

 

 



4 
 

 

 

 

 

 

 (Υπογραφή) 

................................... 

ΠΑΝΤΑΖΟΠΟΥΛΟΣ ΓΕΩΡΓΙΟΣ 

Διπλωματούχος Ναυπηγός Μηχανολόγος Μηχανικός Ε.Μ.Π. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Copyright © Πανταζόπουλος Γεώργιος, 2016 

Με επιφύλαξη παντός δικαιώματος. All rights reserved. 

 

Απαγορεύεται η αντιγραφή, αποθήκευση και διανομή της παρούσας εργασίας, εξ ολοκλήρου ή 

τμήματος αυτής, για εμπορικό σκοπό. Επιτρέπεται η ανατύπωση, αποθήκευση και διανομή για σκοπό 

μη κερδοσκοπικό, εκπαιδευτικής ή ερευνητικής φύσης, υπό την προϋπόθεση να αναφέρεται η πηγή 

προέλευσης και να διατηρείται το παρόν μήνυμα. Ερωτήματα που αφορούν τη χρήση της εργασίας 

για κερδοσκοπικό σκοπό πρέπει να απευθύνονται προς τον συγγραφέα, σύμφωνα με τις κείμενες 

διατάξεις περί πνευματικής ιδιοκτησίας. 

 

Οι απόψεις και τα συμπεράσματα που περιέχονται σε αυτό το έγγραφο εκφράζουν τον συγγραφέα και 

δεν πρέπει να ερμηνευθεί ότι αντιπροσωπεύουν τις επίσημες θέσεις του Εθνικού Μετσόβιου 

Πολυτεχνείου. 

 

  



5 
 

 

 

Περίληψη 

 
Σκοπός της συγκεκριμένης διπλωματικής εργασίας είναι η παρουσίαση του λογισμικού 

DIgSILENT PowerFactory και η διερεύνηση των δυνατοτήτων που προσφέρει αναφορικά με 

τη μελέτη βραχυκυκλωμάτων σε ηλεκτρικά δίκτυα πλοίων. Στην κατεύθυνση αυτή, επιχειρεί 

αφενός να καταστήσει το PowerFactory πιο εύχρηστο και κατανοητό ακαδημαϊκά, καθότι 

είναι ένα σύνθετο υπολογιστικό πακέτο υψηλού επιπέδου, και αφετέρου να επιλύσει 

προβλήματα που σχετίζονται με τη μοντελοποίηση ηλεκτρικών δικτύων πλοίων και την 

εφαρμογή του διεθνούς προτύπου IEC 61363-1 για την ανάλυση βραχυκυκλωμάτων στην 

πλατφόρμα του εν λόγω προγράμματος. Αρχικά, πραγματοποιείται μία εισαγωγή στα βασικά 

χαρακτηριστικά και τις λειτουργίες του προγράμματος. Στη συνέχεια, εκτίθενται οι 

απαραίτητες αναφορές στη θεωρία βραχυκυκλωμάτων και το διεθνές πρότυπο IEC 61363-1, 

με στόχο την κατανόηση της μεθοδολογίας για την ανάλυση βραχυκυκλωμάτων. Στο 

επόμενο στάδιο, παρουσιάζεται μία μελέτη βραχυκυκλώματος στο ηλεκτρικό δίκτυο μίας 

υποδειγματικής ηλεκτρολογικής μελέτης πλοίου, ώστε να εξεταστούν τα αποτελέσματα της 

προσομοίωσης υπό το πρίσμα των θεωρητικών σχέσεων. Ακολουθεί μία αντιπροσωπευτική 

περίπτωση μελέτης βραχυκυκλώματος στο ηλεκτρικό δίκτυο ενός υπαρκτού πλοίου 

μεταφοράς φορτίου χύδην, όπου συγκρίνονται τα αποτελέσματα της προσομοίωσης με τις 

θεωρητικές τιμές, κατά το πρότυπο IEC 61363-1, που περιλαμβάνονται σε σχετικό φυλλάδιο 

του πλοίου. Στη βάση της παραπάνω διαδικασίας, διερευνάται το υπολογιστικό περιβάλλον 

του PowerFactory με σημείο αναφοράς την ανάλυση βραχυκυκλωμάτων σε συστήματα 

ηλεκτρικής ενέργειας πλοίων και άξονα την ένταξη του προγράμματος σε ακαδημαϊκό 

πλαίσιο. 

 

 

Λέξεις κλειδιά: συστήματα ηλεκτρικής ενέργειας πλοίων, DIgSILENT PowerFactory, 

αναπαράσταση ηλεκτρικών δικτύων πλοίων, ανάλυση βραχυκυκλωμάτων, ρεύμα 

βραχυκύκλωσης, διεθνές πρότυπο IEC 61363-1 
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Abstract 

  
The aim of this diploma thesis is the presentation of the DIgSILENT PowerFactory software 

and the exploration of the opportunities it offers regarding the study of short circuits on ship 

electrical networks. In this direction, on the one hand, it attempts to make PowerFactory user 

friendlier and comprehensible academically, because it is a complex and superior computing 

package, and, on the other hand, to resolve problems related to the modeling of ship electrical 

networks and the application of the IEC 61363-1 international standard in the short circuit 

analysis at the platform of this program. Initially, an introduction to the basic characteristics 

and the functions of the program is made. Subsequently, the necessary references to the short 

circuit theory and the IEC 61363-1 international standard are exposed, aiming to the 

comprehension of the short circuit analysis methodology. In the next step, a short circuit 

study on the electrical network of an exemplary ship electrical study is presented, in order to 

examine the results of the simulation in the light of the theoretical relations. A representative 

short circuit case study on an existent bulk carrier electrical network follows, where the 

results of the simulation are compared to the IEC 61363-1 standard theoretical values, which 

are included in a relative ship brochure. On the basis of the above procedure, the 

PowerFactory computing environment is explored with reference to short circuit analysis on 

ship power systems and focusing on the integration of the program in an academic context. 

 

 

Keywords: ship power systems, DIgSILENT PowerFactory, ship electrical networks 

representation, short circuit analysis, short circuit current, IEC 61363-1 international standard 
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ΚΕΦΑΛΑΙΟ 1 
Εισαγωγή 

 
Η παρούσα διπλωματική εργασία εκπονήθηκε κατά το ακαδημαϊκό έτος 2015-2016 στον 

Τομέα Ναυτικής Μηχανολογίας της Σχολής Ναυπηγών Μηχανολόγων Μηχανικών του 

Εθνικού Μετσόβιου Πολυτεχνείου. Πεδίο εφαρμογής της είναι η σχεδίαση και η ανάλυση 

συστημάτων ηλεκτρικής ενέργειας πλοίων με τη βοήθεια ηλεκτρονικού υπολογιστή. 

Επιχειρεί να συμβάλει, κυρίως από ακαδημαϊκή άποψη, στις σύγχρονες ανάγκες 

αναπαράστασης ηλεκτρικών δικτύων και ηλεκτρολογικών αριθμητικών υπολογισμών με τη 

χρήση ισχυρών και ολοκληρωμένων υπολογιστικών εργαλείων. Χαρακτηριστική είναι η 

περίπτωση της μελέτης βραχυκυκλωμάτων σε πλοία, με στόχους την ορθή ανάλυση των 

σφαλμάτων αυτών, τον υπολογισμό των αναπτυσσόμενων ρευμάτων και την ελαχιστοποίηση 

των σχετικών κινδύνων. 

 

Αντικείμενο της παρούσας διπλωματικής εργασίας είναι η παρουσίαση του λογισμικού 

DIgSILENT PowerFactory και η διερεύνηση των δυνατοτήτων που προσφέρει αναφορικά με 

τη μελέτη βραχυκυκλωμάτων σε ηλεκτρικά δίκτυα πλοίων. Το θεωρητικό υπόβαθρο για τη 

μελέτη αυτή συνίσταται στη θεωρία βραχυκυκλωμάτων και στο διεθνές πρότυπο IEC 61363-

1 της Διεθνούς Ηλεκτροτεχνικής Επιτροπής (International Electrotechnical Commission – 

IEC). Σκοπός της εργασίας είναι αφενός να καταστήσει το PowerFactory πιο εύχρηστο και 

κατανοητό ακαδημαϊκά, καθότι είναι ένα σύνθετο υπολογιστικό πακέτο υψηλού επιπέδου, 

και αφετέρου να επιλύσει προβλήματα που σχετίζονται με τη μοντελοποίηση ηλεκτρικών 

δικτύων πλοίων και την εφαρμογή του προτύπου IEC 61363-1 για την ανάλυση 

βραχυκυκλωμάτων στην πλατφόρμα του εν λόγω προγράμματος. 

 

Το PowerFactory της εταιρείας DIgSILENT είναι ένα ιδιαίτερα χρήσιμο λογισμικό ανάλυσης 

συστημάτων ηλεκτρικής ενέργειας, το οποίο χρησιμοποιείται για εφαρμογές σχετικές με την 

παραγωγή, τη μετάδοση και τη διανομή ηλεκτρικής ενέργειας, καθώς και για μελέτες 

βιομηχανικών συστημάτων, με τη βοήθεια ηλεκτρονικού υπολογιστή. Σχεδιάστηκε ως ένα 

προηγμένο και ολοκληρωμένο λογισμικό πακέτο ειδικά για την ανάλυση ηλεκτρικών 

συστημάτων  ελέγχου, έτσι ώστε να επιτυγχάνονται οι κύριοι στόχοι της βελτιστοποίησης 

στο σχεδιασμό και τη λειτουργία των συστημάτων αυτών. Το DIgSILENT είναι ακρωνύμιο 

του «Digital SImuLation of Electrical NeTworks». Η έβδομη έκδοση του πακέτου αποτέλεσε 

το πρώτο παγκοσμίως λογισμικό ανάλυσης συστημάτων ενέργειας με ένα ολοκληρωμένο 

γραφικό μονογραμμικό περιβάλλον. Το μονογραμμικό αυτό διάγραμμα περιελάμβανε 

διάφορες λειτουργίες σχεδιασμού, επιλογές παραμετροποίησης καθώς και όλες τις επιλογές 

στατικών και δυναμικών υπολογισμών. 

 

Το PowerFactory σχεδιάστηκε και αναπτύχθηκε από καταρτισμένους μηχανικούς και 

προγραμματιστές με εμπειρία πολλών χρόνων τόσο στα ηλεκτρικά συστήματα ισχύος όσο 

και στο πεδίο του προγραμματισμού. Η ακρίβεια και η εγκυρότητα των αποτελεσμάτων που 

λαμβάνονται από το PowerFactory έχουν επιβεβαιωθεί σε ένα μεγάλο αριθμό εκτελέσεων 

από οργανισμούς σε όλο τον κόσμο, οι οποίοι ασχολούνται με το σχεδιασμό και τη 

λειτουργία συστημάτων ηλεκτρικής ενέργειας. Η χρήση μίας μόνο βάσης δεδομένων, που 
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περιλαμβάνει όλα τα στοιχεία που μπορούν να συμμετέχουν σε ένα σύστημα ισχύος 

(στοιχεία γεννητριών, στοιχεία γραμμών, στοιχεία προστασίας κ.λπ.), δίνει τη δυνατότητα να 

εκτελεστούν εύκολα όλες οι γνωστές λειτουργίες προσομοίωσης των συστημάτων. 

 

Η γενική ιδέα για το σχεδιασμό συστημάτων στην πλατφόρμα του PowerFactory 

συνοψίζεται στα εξής σημεία: 

 Το λογισμικό αυτό χρησιμοποιείται σαν ένα απλό εκτελέσιμο πρόγραμμα και είναι 

συμβατό με τις περισσότερες εκδόσεις των Windows. Η μέθοδος προγραμματισμού 

επιτρέπει τη γρήγορη και εύκολη επιλογή διάφορων υπολογισμών. Δεν είναι 

αναγκαίο να ενημερωθούν και να μεταφερθούν τα δεδομένα και τα αποτελέσματα 

μεταξύ των διάφορων εφαρμογών του προγράμματος. Για παράδειγμα, η ροή 

φορτίου, τα βραχυκυκλώματα και η ανάλυση αρμονικών, μπορούν να εκτελεστούν 

διαδοχικά χωρίς να γίνει επαναφορά του προγράμματος και χωρίς να χρειάζεται να 

ενεργοποιηθούν άλλες λειτουργίες και υποπρογράμματα του λογισμικού. 

 Τα μοντέλα, τα οποία σχεδιάζονται με το λογισμικό αυτό, μπορούν να μοιράζονται 

για να εκτελεστούν όλες οι αναλύσεις. Επιπρόσθετα, μελέτες που αφορούν την 

παραγωγή ρεύματος, τη διανομή και την ανάλυση βιομηχανικών συστημάτων 

μπορούν να ολοκληρωθούν μέσα στο PowerFactory. Δε χρειάζονται, δηλαδή, 

ξεχωριστά προγράμματα για να γίνει η ανάλυση των διάφορων τομέων 

ενδιαφέροντος ενός συστήματος (ροή φορτίου, βραχυκύκλωμα κ.λπ.), καθώς το 

PowerFactory μπορεί να διεκπεραιώσει τα πάντα μέσα σε ένα ολοκληρωμένο 

πρόγραμμα και μία ολοκληρωμένη βάση δεδομένων. 

 Το πρόγραμμα προσφέρει άριστη οργάνωση δεδομένων και ορισμών, που είναι 

απαραίτητα για να εκτελεστούν οι διάφοροι υπολογισμοί, καθώς και πλήρη 

απομνημόνευση των ρυθμίσεων του χρήστη. Το περιβάλλον της βάσης δεδομένων 

του PowerFactory ενοποιεί όλα τα δεδομένα που χρειάζονται για την υλοποίηση 

υποθέσεων εργασίας (study cases), σεναρίων λειτουργίας (operation scenarios), 

μονογραμμικών σχεδίων και αποτελεσμάτων τόσο σε κείμενο όσο και σε γραφικό 

περιβάλλον (διαγράμματα κ.λπ.).  

 Όλα τα δεδομένα, τα οποία καθορίζουν ένα μοντέλο συστήματος ενέργειας, 

αποθηκεύονται στο φάκελο project της βάση δεδομένων (database). Μέσα σε έναν 

τέτοιο φάκελο, οι study cases χρησιμοποιούνται για να καθορίζουν διαφορετικές 

μελέτες του ίδιου συστήματος, λαμβάνοντας υπόψη ολόκληρο το δίκτυο και 

κομμάτια αυτού ή διαφοροποιήσεις στην κατάσταση του.  

 Το πρόγραμμα προσφέρει, επίσης, λειτουργία για πολλαπλούς χρήστες, όπου ο 

καθένας έχει το δικό του project ή μπορεί να μοιράζεται και δεδομένα από άλλους 

χρήστες. Ο λεγόμενος database administrator του PowerFactory είναι υπεύθυνος για 

τα ανωτέρω. Επιπλέον, προσφέρει τη δυνατότητα στο χρήστη να προσαρμόσει 

κατάλληλα το «προφίλ» του με βάση τις προτιμήσεις του. Το προεπιλεγμένο προφίλ 

είναι το Base Package, το οποίο περιλαμβάνει τις βασικές εντολές στη βασική 

γραμμή εργαλείων που χρησιμοποιεί ένας νέος χρήστης, όπως το Load Flow και το 

Short-Circuit.  Από εκεί και πέρα, ο χρήστης μπορεί να προσαρμόσει και να 

διαμορφώσει πλήρως τη γραμμή εργαλείων, τη γραμμή εργαλείων σχεδίασης, το 

κύριο μενού, τον Data Manager, τα παράθυρα ρυθμίσεων κάθε στοιχείου (element 

dialogue) κ.ο.κ. 

 

Η εργασία αποτελείται από επτά (7) κεφάλαια, το πρώτο εκ των οποίων είναι η παρούσα 

εισαγωγή, με τη δομή της να εκκινεί από τη γενική παρουσίαση του προγράμματος, να 

περιλαμβάνει τις απαραίτητες θεωρητικές αναφορές και να επικεντρώνεται στην ανάλυση 

βραχυκυκλωμάτων. Το Κεφάλαιο 2 αποτελεί μία εισαγωγή στις βασικές πτυχές του 
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PowerFactory, μέσα από την έκθεση αναλυτικών οδηγιών για τη λειτουργία του, 

προκειμένου να καταστεί εφικτή η ακαδημαϊκή χρήση του για εφαρμογές στο πεδίο της 

ναυτικής μηχανολογίας. Το Κεφάλαιο 3 εκθέτει, σε γενικές γραμμές, τη θεωρία 

βραχυκυκλωμάτων και παρουσιάζει μεταφρασμένες τις περισσότερες διατάξεις του διεθνούς 

προτύπου IEC 61363-1 για τη μελέτη βραχυκυκλωμάτων. Το Κεφάλαιο 4 αναφέρεται στον 

τρόπο εφαρμογής του διεθνούς προτύπου IEC 61363-1 στην ανάλυση βραχυκυκλωμάτων 

μέσω του PowerFactory. Το Κεφάλαιο 5 συνιστά μία μελέτη βραχυκυκλώματος στο 

ηλεκτρικό δίκτυο μίας υποδειγματικής ηλεκτρολογικής μελέτης πλοίου, με στόχο την 

εξέταση των αποτελεσμάτων της προσομοίωσης υπό το πρίσμα των θεωρητικών σχέσεων. 

Το Κεφάλαιο 6 παρουσιάζει μία αντιπροσωπευτική περίπτωση μελέτης βραχυκυκλώματος 

στο ηλεκτρικό δίκτυο ενός πραγματικού πλοίου μεταφοράς φορτίου χύδην, όπου 

συγκρίνονται τα αποτελέσματα της προσομοίωσης με τις θεωρητικές τιμές, κατά το πρότυπο 

IEC 61363-1, που περιλαμβάνονται σε σχετικό φυλλάδιο του πλοίου. Τέλος, το Κεφάλαιο 7 

περιλαμβάνει τα αναγκαία συμπεράσματα, τόσο για τη συνεισφορά της εργασίας όσο και για 

τη χρησιμότητα του PowerFactory, καθώς και προτάσεις για την ένταξη του προγράμματος 

σε ακαδημαϊκό πλαίσιο. 

 

Η παρούσα διπλωματική εργασία εκπονήθηκε μαζί με τη διπλωματική εργασία Μελέτη 

ηλεκτρικών δικτύων πλωτών κατασκευών σε μόνιμη κατάσταση λειτουργίας με χρήση του 

PowerFactory, σε συνεργασία με τον συνάδελφο Δημήτριο Πίτσιο. Πρόκειται για δύο 

εργασίες που αποτελούν προϊόν μίας ενιαίας προσπάθειας. Στο σημείο αυτό, θα ήθελα να 

ευχαριστήσω για τη συμπαράσταση και την ανεκτίμητη βοήθειά τους τους δικούς μου 

ανθρώπους που με στήριξαν κατά τη διάρκεια εκπόνησης της εργασίας. Ιδιαίτερα: 

 

Τον κ. Ιωάννη Μ. Προυσαλίδη, Αναπληρωτή Καθηγητή της Σχολής Ναυπηγών 

Μηχανολόγων Μηχανικών του Εθνικού Μετσόβιου Πολυτεχνείου, για την αμέριστη βοήθεια 

και συμπαράστασή του και το άριστο κλίμα συνεργασίας που καλλιέργησε. 

 

Τους κ. Δημοσθένη Σπαθή και Θοδωρή Κουρμπέλη, υποψήφιους διδάκτορες στον Τομέα 

Ναυτικής Μηχανολογίας της Σχολής Ναυπηγών Μηχανολόγων Μηχανικών του Εθνικού 

Μετσόβιου Πολυτεχνείου, για τη διαρκή βοήθεια που πρόθυμα παρείχαν σε εμένα και τον 

συνάδελφο Δημήτριο Πίτσιο κατά την εκπόνηση των δύο εργασιών. 

 

Τέλος, θα ήθελα να αφιερώσω την παρούσα διπλωματική εργασία στο νέο και στη νέα 

μηχανικό που αγωνιούν για το μέλλον τους στις δύσκολες συνθήκες της σημερινής εποχής. 

 

Αθήνα, Φεβρουάριος 2016 

 

Γεώργιος Γ. Πανταζόπουλος 

 



ΚΕΦΑΛΑΙΟ 2 
 

Γενικές οδηγίες για το PowerFactory 
 

Το συγκεκριμένο κεφάλαιο πραγματεύεται τα βασικά χαρακτηριστικά, τη δομή, τα 

σχεδιαστικά και υπολογιστικά εργαλεία και τις παραμέτρους του λογισμικού DIgSILENT 

PowerFactory. Σκοπός είναι η γνωριμία του αναγνώστη με τις βασικές πτυχές του 

προγράμματος, προκειμένου να καταστεί εφικτή η ακαδημαϊκή χρήση του για εφαρμογές 

στον τομέα της ναυτικής μηχανολογίας. Στη βάση αυτή, το κείμενο είναι όσο το δυνατό πιο 

αναλυτικό και έχει τη μορφή φροντιστηριακών οδηγιών (tutorial instructions), μέσω των 

οποίων ο αναγνώστης έχει τη δυνατότητα να αποκτήσει μία πρώτη εξοικείωση με το 

πρόγραμμα. 

 

 

2.1 Δημιουργία ενός νέου σχεδίου και αποθήκευση 
 

Το πρώτο βήμα για το σχεδιασμό ενός συστήματος ηλεκτρικής ενέργειας είναι η δημιουργία 

ενός σχεδίου (project). Το project προσφέρει τη βασική δομή εντός της οποίας καθορίζονται 

και αποθηκεύονται οι προσδιορισμοί του συστήματος ηλεκτρικής ενέργειας, μαζί με τις 

επιμέρους παραμέτρους τους, τα μονογραμμικά διαγράμματα, τους διάφορους τύπους 

βιβλιοθηκών, τα βήματα και τις εντολές υπολογισμού. Στην ενότητα αυτή δίνονται οι 

βασικές οδηγίες για τη δημιουργία ενός νέου project με συγκεκριμένα χαρακτηριστικά, 

διαδικασία η οποία είναι απαραίτητη κατά την έναρξη οποιασδήποτε δραστηριότητας στο 

PowerFactory. 

 

 

2.1.1 Εκκίνηση του PowerFactory και δημιουργία νέου project 
 

Το πρόγραμμα διαθέτει μία βάση δεδομένων (Database), η οποία περιλαμβάνει το φάκελο 

του χρήστη (User folder) με αντίστοιχη ονομασία. Στην εικόνα 2.1 φαίνεται η συγκεκριμένη 

ιεραρχική διάρθρωση του προγράμματος. Ο διαχειριστής δεδομένων (Data Manager) θα 

αναλυθεί στην ενότητα 2.3 του κεφαλαίου. 
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Εικόνα 2.1 Παράδειγμα ενεργού φακέλου χρήστη 

 

Για τη δημιουργία ενός νέου project στο φάκελό σας, ακολουθήστε τα εξής βήματα: 

 Ανοίξτε το File menu στην μπάρα του κύριου μενού. 

 Επιλέξτε New. 

 Επιλέξτε Project…, όπως φαίνεται στην εικόνα 2.2. 

 

 
Εικόνα 2.2 Δημιουργία ενός νέου Project από το File menu 

 

 Θα ανοίξει το παράθυρο διαλόγου της Εικόνας 2.3, το οποίο δίνεται συμπληρωμένο 

για τους σκοπούς του κειμένου. 

 

 
Εικόνα 2.3 Το παράθυρο του νέου project 
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 Ονομάστε το project “Project 1”. 

 Κάντε κλικ στην επιλογή OK. 

 

Η δημιουργία ενός νέου project απενεργοποιεί οποιοδήποτε πιθανό ενεργό project και κλείνει 

όλα τα σχετικά παράθυρα. Ένα project χρειάζεται τουλάχιστον ένα πλέγμα (φάκελος grid), 

όπου εντάσσεται το σύστημα ηλεκτρικής ενέργειας. Για το λόγο αυτό, δημιουργείται 

αυτόματα ένας φάκελος grid και ανοίγει το παράθυρό του, όπως φαίνεται στην Εικόνα 2.4. 

 

 
Εικόνα 2.4 Το παράθυρο επεξεργασίας του grid 

 

 Ορίστε το όνομα του grid ως “Part 1”. 

 Επιλέξτε (ενδεικτικά) το μπλε χρώμα. 

 Ορίστε τη συχνότητα στα 50 Hz. 

 Δώστε όνομα Owner “NTUA”, κάτι που είναι προαιρετικό. 

 Πατήστε OK. 

 

Παρατηρήστε ότι δημιουργήθηκε το νέο grid “Part 1”, σε συνδυασμό με ένα φάκελο 

ονόματος “Study Case”, ο οποίος χρησιμοποιείται για την ενεργοποίηση του grid και την 

εκτέλεση των σχετικών υπολογισμών. Το όνομα της “Study Case” θα αλλαχθεί στη συνέχεια. 

Επίσης, δημιουργήθηκε ένα νέο κενό παράθυρο για τη δημιουργία του μονογραμμικού 

διαγράμματος. Ο χώρος εργασίας του PowerFactory θα πρέπει να έχει τη μορφή που δίνεται 

στην ακόλουθη εικόνα, στην οποία έχουμε τα εξής στοιχεία αριθμημένα: 

1. Την μπάρα του κύριου μενού (main menu bar). 

2. Την μπάρα των κύριων εικονιδίων (main icon bar) για την εκτέλεση συγκεκριμένων 

πράξεων (υπολογισμών κ.λπ.). 

3. Την μπάρα του παραθύρου των γραφικών (graphics window icon bar). 

4. Το κενό παράθυρο γραφικών (παράθυρο μονογραμμικού διαγράμματος – single line 

graphics window), το οποίο περιλαμβάνει κατάλληλο πλέγμα για το σχεδιασμό. Οι 

τελείες του πλέγματος δείχνουν τα σημεία όπου «κλειδώνουν» τα διάφορα στοιχεία, 

εφόσον είναι ενεργοποιημένη η σχετική επιλογή. 

5. Την εργαλειοθήκη για το σχεδιασμό των στοιχείων του συστήματος (drawing 

toolbox), στα δεξιά του παραθύρου μονογραμμικού διαγράμματος. 
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6. Το παράθυρο εξόδου (output window), κάτω από το παράθυρο μονογραμμικού 

διαγράμματος, στο οποίο δίνονται μηνύματα κειμένου, αναφορές για τους διάφορους 

υπολογισμούς και ενεργοί σύνδεσμοι για τη διόρθωση λαθών στο σύστημα. 

7. Την μπάρα κατάστασης (status bar), κάτω από το παράθυρο εξόδου, η οποία δίνει 

πληροφορίες για την κατάσταση του PowerFactory, όπως είναι η θέση του δείκτη του 

ποντικιού στο παράθυρο μονογραμμικού διαγράμματος ή στο παράθυρο εξόδου, 

καθώς και το όνομα του ενεργού project. 

 

 
Εικόνα 2.5 Ο χώρος εργασίας ύστερα από τη δημιουργία ενός νέου project 

 

 

2.1.2 Επεξεργασία της study case 
 

Παρότι το project, που δημιουργήσαμε προηγουμένως, μπορεί να χρησιμοποιηθεί ως έχει, θα 

αλλάξουμε το όνομα της study case σε κάτι πιο αντιπροσωπευτικό: 

 Επιλέξτε Edit → Project Data → Study Case… στο κύριο μενού. 

 

Ανοίγει, έτσι, το παράθυρο διαλόγου της study case, όπως αυτό απεικονίζεται παρακάτω. 
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Εικόνα 2.6 Το παράθυρο διαλόγου της study case 

 

 Μετονομάστε τη study case σε “Case 1”. 

 Προκειμένου να ρυθμίσετε την ώρα (Study Time), κάντε κλικ στο κουμπί με τις τρεις 

τελείες (…). Ένα παράθυρο με τίτλο “Set Study Time” εμφανίζεται, σύμφωνα με την 

Εικόνα 2.7. 

 

 
Εικόνα 2.7 Ρύθμιση ώρας και ημερομηνίας της study case 

 

 Πατήστε το κουμπί “-> Date" και το κουμπί “-> Time" για να χρησιμοποιήσετε την 

ημερομηνία και την ώρα του υπολογιστή σας για τη study case. 

 Επιβεβαιώστε τις αλλαγές με το κουμπί OK. Το παράθυρο διαλόγου της study case 

θα πρέπει να είναι όπως δείχνει η Εικόνα 2.8. 

 Παρατηρήστε ότι μπορείτε να ρυθμίσετε τις μονάδες των μεταβλητών εξόδου (Output 

Variables). 
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 Πατήστε OK για να αποθηκεύσετε τις αλλαγές για τη study case. 

 

 
Εικόνα 2.8 Το παράθυρο διαλόγου της study case ύστερα από τις αλλαγές των ρυθμίσεων 

 

Το όνομα της study case στη λίστα στα αριστερά θα πρέπει να έχει αλλάξει σε “Case 1”. Στη 

λίστα δίνεται η ενεργή study case. Από εκεί μπορεί να επιλεγεί κάποια άλλη study case. 

 

 

2.1.3 Τα tutorials του PowerFactory 
 

Στο σημείο αυτό, να σημειωθεί ότι το PowerFactory περιλαμβάνει μία σειρά από ασκήσεις 

γνωριμίας και εξοικείωσης με το πρόγραμμα, οι οποίες συνοδεύονται από κατάλληλο οδηγό 

[1] και μπορούν να προσπελαστούν ως εξής: 

 Ανοίξτε το μενού Help στην μπάρα του κύριου μενού 

 Επιλέξτε το Start Tutorial… 

 

Ανοίγει ένα παράθυρο που ονομάζεται Tutorial Manager και δίνει τη δυνατότητα επιλογής 

μεταξύ των επτά ασκήσεων, όπως στην Εικόνα 2.9: 

 Επιλέξτε την άσκηση που επιθυμείτε μέσω του Start → Exercise. 

 Πατήστε Execute. 
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Εικόνα 2.9 Το παράθυρο του Tutorial Manager 

 

 

2.1.4 Τερματισμός και επανεκκίνηση του PowerFactory 
 

Οι χρήστες θα πρέπει να προσέξουν ότι το PowerFactory δε διαθέτει επιλογή αποθήκευσης 

(Save) για τα projects. Όλες οι αλλαγές, οι οποίες πραγματοποιούνται στη βάση δεδομένων 

του συστήματος, αποθηκεύονται άμεσα και αυτόματα στη βάση δεδομένων του φακέλου του 

προγράμματος, στο δίσκο του υπολογιστή. Αυτό σημαίνει ότι μπορείτε να τερματίσετε τη 

λειτουργία του προγράμματος ανά πάσα στιγμή, χωρίς να χρειάζεται να αποθηκεύσετε την 

πρόοδό σας σε οποιοδήποτε project πρώτα. Μόλις εκκινήσετε το λογισμικό, δε θα 

ενεργοποιηθεί το τελευταίο ενεργό project. Ωστόσο, τα τελευταία ενεργά projects μπορούν 

να φορτωθούν μέσω του File στην μπάρα του κύριου μενού, απλά επιλέγοντας το επιθυμητό 

project. Περισσότερες λεπτομέρειες για την αποθήκευση των projects δίνονται στην ενότητα 

2.3 του κεφαλαίου, όπου αναλύεται η λειτουργία του Data Manager. 

 

 

2.2 Δημιουργία βασικών στοιχείων συστημάτων 
ηλεκτρικής ενέργειας 

 
Το PowerFactory επιτρέπει τη δημιουργία νέων συστημάτων ηλεκτρικής ενέργειας μέσω της 

χειροκίνητης επιλογής και σύνδεσης των επιμέρους ηλεκτρολογικών στοιχείων. Ο πιο 

βολικός τρόπος για κάτι τέτοιο είναι η αλληλεπίδραση με το παράθυρο του μονογραμμικού 

διαγράμματος, στο οποίο τοποθετούνται στοιχεία που επιλέγονται από την εργαλειοθήκη στα 

δεξιά. Το πρόγραμμα είναι κατάλληλα σχεδιασμένο, ώστε να δίνει τη δυνατότητα πλήρους 

αλληλεπίδρασης του χρήστη με τα διάφορα στοιχεία ενός συστήματος, προκειμένου να 

ρυθμιστούν οι εκάστοτε παράμετροι μέσα από αντίστοιχα παράθυρα διαλόγου. Στη συνέχεια, 

παρουσιάζονται τα βασικότερα στοιχεία για τη δημιουργία συστημάτων ηλεκτρικής 

ενέργειας, με στόχο την εξοικείωση του χρήστη με αυτά. Για το σκοπό αυτό, γίνεται χρήση 

του project της προηγούμενης ενότητας, εντός του οποίου θα δημιουργηθεί ένα απλό 

σύστημα ηλεκτρικής ενέργειας, ώστε να παρουσιαστούν οι δυνατότητες του προγράμματος 

αναφορικά με τη ροή φορτίου και το βραχυκύκλωμα. 
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2.2.1 Εισαγωγή των στοιχείων του συστήματος 
 

2.2.1.1 Δημιουργία υποσταθμών με ζυγούς 
 

Αρχικά, τοποθετούνται οι ζυγοί του συστήματος. Το PowerFactory διαθέτει διαφορετικές 

διατάξεις ζυγών, όπως είναι ο απλός ζυγός (single busbar system), ο απλός ζυγός με 

διακόπτη (single busbar system with tie breaker), ο διπλός ζυγός (double busbar system), ο 

διπλός ζυγός με διακόπτη (double busbar system with tie breaker) και άλλες διατάξεις. 

Επίσης, το πρόγραμμα δίνει τη δυνατότητα επιλογής μεταξύ λεπτομερών ζυγών, όπως οι 

προηγούμενοι, όπου ο χρήστης συνδέει το εκάστοτε στοιχείο σε συγκεκριμένο ακροδέκτη 

του ζυγού, καθώς και ζυγών χωρίς τη δυνατότητα αυτή (busbar), όπου το εκάστοτε στοιχείο 

συνδέεται αυτόματα. 

 

Στο συγκεκριμένο παράδειγμα χρησιμοποιείται η κατηγορία του απλού ζυγού (single busbar 

system): 

 Αν η εργαλειοθήκη σχεδιασμού δεν είναι ορατή στη δεξιά πλευρά του προγράμματος, 

πατήστε το εικονίδιο  στην μπάρα του παραθύρου των γραφικών, ώστε να 

ενεργοποιηθεί η λίστα με τα εργαλεία. 

 

Το εικονίδιο  (Freeze Mode) αλλάζει τη μέθοδο επεξεργασίας του συστήματος. Όταν 

είναι ενεργοποιημένο, η εργαλειοθήκη και το μονογραμμικό διάγραμμα «παγώνουν», με 

αποτέλεσμα να μην μπορούν να πραγματοποιηθούν αλλαγές. Ωστόσο, μπορούν να γίνουν 

αλλαγές στα ήδη υπάρχοντα στοιχεία του συστήματος (αλλαγές παραμέτρων), χωρίς βέβαια 

να μπορούν να μετακινηθούν, να μεταβληθούν οι συνδέσεις ή να δημιουργηθούν νέα 

στοιχεία. Μόλις απενεργοποιηθεί η επιλογή, ενεργοποιείται ξανά η εργαλειοθήκη. 

 

 Εντοπίστε και επιλέξτε το εικονίδιο Single Busbar System ( ), προσέχοντας ότι το 

εικονίδιο είναι πανομοιότυπο με αυτά των Busbar και Busbar (Short). 

 Τοποθετήστε το ζυγό στο παράθυρο του μονογραμμικού διαγράμματος. Θα 

εμφανιστεί ένας ζυγός με προεπιλεγμένο όνομα “SingleBusbar/BB", όπου 

“SingleBusbar” είναι το είδος του ζυγού και BB η ονομασία του. 

 Αν επιλέξετε κάποιο άλλο λάθος, μπορείτε να αναιρέσετε την επιλογή σας πατώντας 

το κουμπί . Ακόμα, κατά τη διαδικασία εισαγωγής ενός συγκεκριμένου στοιχείου 

στο μονογραμμικό διάγραμμα (ενός απλού ζυγού στην προκειμένη περίπτωση), το 

σύμβολο του στοιχείου ακολουθεί το βέλος του ποντικιού, ενώ, πατώντας είτε το 

πλήκτρο Esc είτε δεξί κλικ, μπορείτε να επανέλθετε στην αρχική κατάσταση. 

 

Ο ζυγός μπορεί να μετακινηθεί και να λάβει διαφορετικό μέγεθος, ανάλογα με τις ανάγκες 

του συστήματος: 

 Επιλέξτε το ζυγό, ο οποίος λαμβάνει ένα κόκκινο χρώμα με δύο μικρά τετράγωνα στα 

άκρα του. 

 Μετακινήστε το στοιχείο, κρατώντας πατημένο το αριστερό πλήκτρο του ποντικιού 

επάνω στην κύρια γραμμή του στοιχείου και σύροντάς το στην επιθυμητή θέση. 

Αφήστε το πλήκτρο του ποντικιού για να ορίσετε τη νέα θέση. 

 Αλλάξτε το μέγεθος του στοιχείου, κάνοντας κλικ σε κάποιο από τα δύο άκρα 

σχήματος τετραγώνου και σύροντας προς τα αριστερά ή τα δεξιά, σύμφωνα με την 

παρακάτω απεικόνιση. 
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Σημειώνεται ότι ο δείκτης του ποντικιού μπορεί να εμφανίσει ένα βοηθητικό πλαίσιο, 

εφόσον τοποθετηθεί επάνω στο όνομα του ζυγού ή οποιουδήποτε άλλου στοιχείου του 

μονογραμμικού διαγράμματος, ώστε να είναι ευκολότερη η ανάγνωση του κειμένου χωρίς να 

χρειάζεται zoom. 

 

 
Εικόνα 2.10 Αλλαγή μεγέθους του ζυγού 

 

Στη συνέχεια, δημιουργήστε άλλους δύο απλούς ζυγούς, ακολουθώντας την ίδια διαδικασία: 

 Επιλέξτε το στοιχείο  από την εργαλειοθήκη και τοποθετήστε ένα δεύτερο και 

ένα τρίτο ζυγό, με σειρά ο ένας κάτω από τον άλλο και ικανά διαστήματα στο 

ενδιάμεσο. 

 Μετακινήστε και αλλάξτε τα μεγέθη των ζυγών κατάλληλα, ώστε η τελική διάταξη 

να είναι παρόμοια με την ακόλουθη. 

 

 
Εικόνα 2.11 Τοποθέτηση τριών ζυγών 

 

Οι επιλογές μεγέθυνσης και επαναφοράς στο αρχικό μέγεθος (Zoom In και Zoom Back) 

μπορούν να αξιοποιηθούν για διευκόλυνση κατά την τοποθέτηση των ζυγών: 

 Επιλέξτε το Zoom In ( ). 

 Σχεδιάστε ένα τετράγωνο γύρω από τους τρεις ζυγούς, πατώντας το αριστερό 

πλήκτρο του ποντικιού και σύροντας το ποντίκι μέχρι την απέναντι γωνία με το 

πλήκτρο πατημένο. Η επιλεγμένη περιοχή θα μεγεθυνθεί μόλις αφήστε το πλήκτρο. 

 

Η μεγεθυμένη περιοχή μπορεί να μετακινηθεί με χρήση του Hand Tool: 

 Πατήστε το εικονίδιο  ώστε ο δείκτης του ποντικιού να λάβει τη μορφή ενός 

χεριού. 
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 Πατήστε κλικ εντός του παραθύρου γραφικών και κρατήστε το πλήκτρο πατημένο. 

 Μετακινήστε το ποντίκι στην επιθυμητή κατεύθυνση για να μετακινήσετε την εικόνα. 

 Αφήστε το πλήκτρο του πλήκτρο του ποντικιού. 

 Πατήστε ξανά το εικονίδιο Hand Tool ή το πλήκτρο Esc για να επιστρέψετε στην 

αρχική κατάσταση. 

 

Παρατηρήστε ότι το Hand Tool είναι διαθέσιμο μόνο εφόσον έχετε μεγεθύνει κάποια 

περιοχή. Μπορείτε να επαναφέρετε το παράθυρο γραφικών στην αρχική κατάσταση, 

επιλέγοντας Zoom Back ( ). Επίσης, πατώντας το εικονίδιο Zoom All ( ), εμφανίζεται 

ολόκληρη η περιοχή του διαγράμματος. 

 

2.2.1.2 Δημιουργία στοιχείων διακλάδωσης 
 

Ακολούθως, οι τρεις ζυγοί συνδέονται μέσω δύο μετασχηματιστών: 

 Επιλέξτε το μετασχηματιστή 2-Winding Transformer ( ) από την εργαλειοθήκη. 

 Προκειμένου να σχεδιάσετε τον πρώτο μετασχηματιστή, κάντε κλικ στον πρώτο ζυγό. 

 Παρατηρήστε ότι ανοίγει αυτόματα το λεπτομερές γράφημα με τις υποδοχές του 

ζυγού. Συνδέστε το μετασχηματιστή κάνοντας κλικ σε ένα διακόπτη, όπως φαίνεται 

στην Εικόνα 2.12. Το αποτέλεσμα μετά τη σύνδεση θα πρέπει να είναι όπως στην 

Εικόνα 2.13. 

 Ο μετασχηματιστής είναι τώρα συνδεμένος στον πρώτο ζυγό στην υποδοχή που 

επιλέξατε. 

 Επιλέξτε το μεσαίο ζυγό για να δημιουργήσετε και τη δεύτερη σύνδεση του 

μετασχηματιστή. 

 Ανοίγει το λεπτομερές γράφημα του δεύτερου ζυγού. Συνδέστε, όπως και πριν, το 

μετασχηματιστή σε οποιοδήποτε διακόπτη. 

 

 
Εικόνα 2.12 Σύνδεση του μετασχηματιστή με τον απλό ζυγό (λεπτομερές γράφημα) 
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Εικόνα 2.13 Μετασχηματιστής συνδεμένος στον απλό ζυγό 

 

Πρέπει να σημειωθεί η διαφορά μεταξύ των απλών τερματικών χωρίς επιλογές σύνδεσης, 

όπως είναι οι ζυγοί τύπου Busbar, και των πιο σύνθετων τερματικών με υποσταθμό 

(substation), όπως είναι οι ζυγοί τύπου Single Busbar System που χρησιμοποιήθηκαν. Στη 

δεύτερη περίπτωση, οποιαδήποτε σύνδεση ανοίγει αυτόματα το λεπτομερές γράφημα του 

υποσταθμού και ο χρήστης καλείται να πραγματοποιήσει τη σύνδεση με συγκεκριμένο 

ακροδέκτη σχήματος τετραγώνου. Πατώντας δεξί κλικ στο στοιχείο (π.χ. στο ζυγό), στο 

παράθυρο του μονογραμμικού διαγράμματος, και επιλέγοντας Show Detailed Graphic of 

Substation, ανοίγει το λεπτομερές γράφημα για περαιτέρω επεξεργασία. Αντίθετα, στην πιο 

απλή περίπτωση, η σύνδεση πραγματοποιείται αυτόματα. 

 

 Χρησιμοποιήστε την παραπάνω μέθοδο, προκειμένου να συνδέσετε ένα δεύτερο 

μετασχηματιστή μεταξύ του δεύτερου και του τρίτου ζυγού. 

 

Το μονογραμμικό διάγραμμα θα πρέπει να λάβει τη μορφή της Εικόνας 2.14. 

 

 
Εικόνα 2.14 Σύστημα τριών ζυγών με δύο μετασχηματιστές 
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Ο μετασχηματιστής μπορεί να μετακινηθεί με τρόπο παρόμοιο με αυτόν που παρουσιάστηκε 

για τους ζυγούς: 

 Επιλέξτε το μετασχηματιστή. 

 Μετακινήστε το στοιχείο, κρατώντας πατημένο το αριστερό πλήκτρο του ποντικιού 

και σύροντάς το στην επιθυμητή θέση. Αφήστε το πλήκτρο του ποντικιού για να 

ορίσετε τη νέα θέση. 

 

Τέλος, εκτός από ευθεία γραμμή σύνδεσης, υπάρχει η δυνατότητα δημιουργίας άλλης 

μορφής σύνδεσης του μετασχηματιστή: 

 Επιλέξτε τον πρώτο ζυγό για τη δημιουργία της πρώτης σύνδεσης. 

 Πατώντας μία φορά το αριστερό πλήκτρο του ποντικιού στην επιφάνεια σχεδίασης, 

καθορίζετε τις γωνίες της γραμμής σύνδεσης. 

 Πατώντας δύο φορές το αριστερό πλήκτρο του ποντικιού, τοποθετείτε το σύμβολο 

του μετασχηματιστή. 

 Συνεχίζετε την πορεία της γραμμής μετά το σύμβολο του μετασχηματιστή, πατώντας 

και πάλι μία φορά το αριστερό πλήκτρο του ποντικιού. 

 Επιλέξτε το δεύτερο ζυγό για να ολοκληρώσετε τη σύνδεση. 

 

2.2.1.3 Δημιουργία στοιχείων μονής σύνδεσης 
 

Τα στοιχεία μονής σύνδεσης (single-port elements) συνιστούν στοιχεία που συνδέονται σε 

ένα τερματικό μόνο. Χαρακτηριστικά παραδείγματα είναι οι γεννήτριες, οι κινητήρες, τα 

φορτία και τα εξωτερικά δίκτυα. Στο σημείο αυτό, περιγράφεται η διαδικασία εισαγωγής στο 

σύστημα δύο κινητήρων και μίας γεννήτριας. 

 

Για την εισαγωγή δύο ασύγχρονων κινητήρων στο σύστημα: 

 Επιλέξτε το εικονίδιο Asynchronous Machine ( ). 

 Συνδέστε τον πρώτο κινητήρα στον κατώτερο ζυγό. 

 Ανοίγει αυτόματα το λεπτομερές γράφημα του ζυγού. Πραγματοποιήστε τη σύνδεση 

σε μία κενή υποδοχή. 

 Συνδέστε ένα δεύτερο κινητήρα στο μεσαίο ζυγό. 

 

Εκτός από ευθείες γραμμές σύνδεσης, μπορούν να σχεδιαστούν συνδέσεις διαφορετικής 

μορφής ως εξής: 

 Πατήστε αριστερό κλικ στην επιφάνεια σχεδίασης για να τοποθετήσετε το σύμβολο 

του κινητήρα. 

 Δημιουργήστε την επιθυμητή κατεύθυνση της γραμμής, χρησιμοποιώντας το 

αριστερό κλικ. 

 Ολοκληρώστε τη σύνδεση με το τερματικό. 

 

Επιπλέον, πρέπει να συνδεθεί μία γεννήτρια, η οποία θα παρέχει την απαραίτητη ηλεκτρική 

ισχύ στο σύστημα: 

 Επιλέξτε το εικονίδιο Synchronous Machine ( ). 

 Συνδέστε τη γεννήτρια στον πρώτο ζυγό. 

 Στο λεπτομερές γράφημα, πραγματοποιήστε τη σύνδεση σε ένα κενό τερματικό. 

 

Αν η γεννήτρια συνδεθεί, στο μονογραμμικό διάγραμμα, στην ίδια θέση με το 

μετασχηματιστή, τότε το σύμβολό της τοποθετείται αυτόματα πάνω από το ζυγό. 



29 
 

Διαφορετικά, τοποθετείται κάτω από το ζυγό στο πλάι του μετασχηματιστή. Στη δεύτερη 

περίπτωση, η γεννήτρια μπορεί να αντιστραφεί γύρω από το ζυγό, ώστε να τοποθετηθεί στην 

επάνω πλευρά: 

 Πατήστε δεξί κλικ στη γεννήτρια, όπως φαίνεται στην Εικόνα 2.15. 

 Κάντε κλικ στην επιλογή Flip At Busbar. Το σύμβολο περιστρέφεται κατά 180 μοίρες 

γύρω από το ζυγό. 

 

Με την τοποθέτηση της γεννήτριας, ολοκληρώνεται η διαδικασία δημιουργίας των στοιχείων 

του συστήματος ηλεκτρικής ενέργειας και της σχετικής τοπολογίας. Το σύστημα θα πρέπει 

να έχει τη μορφή της Εικόνας 2.16. Το μονογραμμικό διάγραμμα μπορεί να διορθωθεί, αν 

χρειάζεται, μέσω των εντολών μετακίνησης, αλλαγής μεγέθους και περιστροφής γύρω από τη 

σύνδεση. 

 

 

 
Εικόνα 2.15 Περιστροφή της γεννήτριας γύρω από το ζυγό 
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Εικόνα 2.16 Τελική μορφή του συστήματος ηλεκτρικής ενέργειας 

 

 

2.2.2 Επεξεργασία των στοιχείων του συστήματος 
 

To PowerFactory προσφέρει διάφορες μεθόδους για την επεξεργασία των παραμέτρων των 

στοιχείων ενός συστήματος ηλεκτρικής ενέργειας, από απλά παράθυρα διαλόγου μέχρι 

εύχρηστα περιβάλλοντα, τα οποία μοιάζουν με υπολογιστικά φύλλα, για την ταυτόχρονη 

επεξεργασία περισσότερων του ενός στοιχείων. Η πιο εύκολη και άμεση μέθοδος, βέβαια, 

είναι μέσω διπλού κλικ στο επιθυμητό στοιχείο του μονογραμμικού διαγράμματος, 

προκειμένου να εμφανιστεί το αντίστοιχο παράθυρο. 

 

Τα περισσότερα στοιχεία ενός συστήματος καθορίζονται μέσω συγκεκριμένου τύπου (Type). 

Για παράδειγμα, ένα σύνολο μετασχηματιστών σε ένα δίκτυο μπορεί να χαρακτηρίζεται από 

ένα συγκεκριμένο τύπο, με αποτέλεσμα όλοι οι μετασχηματιστές να μοιράζονται κοινές 

ηλεκτρικές παραμέτρους. Οι παράμετροι αυτοί μπορούν να προσδιοριστούν μέσω της 

επιλογής Type στο παράθυρο οποιουδήποτε μετασχηματιστή του συνόλου. Κάθε 

μετασχηματιστής αναφέρεται, με αυτόν τον τρόπο, στην ίδια κατηγορία. Στην κατεύθυνση 

αυτή, υπάρχουν έτοιμα τυποποιημένα στοιχεία στη βιβλιοθήκη του προγράμματος, ενώ 

παράλληλα ο χρήστης μπορεί να δημιουργήσει δικούς του τυχαίους τύπους για τα στοιχεία 

ενός συστήματος. 
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2.2.2.1 Επεξεργασία των ζυγών 
 

Η επεξεργασία του ανώτερου ζυγού γίνεται ως εξής: 

 Επιλέξτε με διπλό κλικ το ζυγό, ώστε να ανοίξει το παράθυρο διαλόγου που 

απεικονίζεται στην Εικόνα 2.17. 

Το παράθυρο περιλαμβάνει: 

 Καρτέλες για την εισαγωγή συγκεκριμένων υπολογιστικών παραμέτρων (Basic Data, 

Load Flow, κ.λπ.). 

 Το όνομα του τερματικού. 

 Τον τύπο του (Type), μαζί με ένα κουμπί για την επιλογή τύπου και ένα για την 

επεξεργασία του. 

 Τη ζώνη (Zone) και την περιοχή (Area) που ανήκει το τερματικό, τα οποία δε θα μας 

απασχολήσουν εδώ. 

 Τον υποσταθμό (Substation) στον οποίο ανήκει το τερματικό, με σχετική επιλογή για 

άνοιγμα του παραθύρου του υποσταθμού. 

 Τον τύπο του συστήματος (System Type) με επιλογές AC (εναλλασσόμενου 

ρεύματος), DC (συνεχούς ρεύματος) ή AC/BI για συστήματα AC δύο φάσεων (π.χ. 

συστήματα σιδηροδρόμων). 

 Την τεχνολογία των φάσεων (Phase Technology) για τον καθορισμό του αριθμού των 

φάσεων. Για παράδειγμα, μπορεί να επιλεγεί η χρήση ουδέτερου ή όχι. 

 Την ονομαστική τάση του ζυγού. 

 

 
Εικόνα 2.17 Το παράθυρο διαλόγου του ζυγού 

 

Επεξεργαστείτε τον ανώτερο ζυγό σύμφωνα με τα ακόλουθα βήματα: 

 Ονομάστε το ζυγό “Busbar 1”. 
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 Για να δείτε τους διαθέσιμους τύπους, κάντε κλικ στην επιλογή  και επιλέξτε 

Select Global Type. Ανοίγει η βιβλιοθήκη στο δέντρο δεδομένων (database tree). 

Πλοηγηθείτε προς την κατηγορία Bars στο φάκελο Types, όπως δείχνει η Εικόνα 

2.18, χρησιμοποιώντας το σύμβολο “+” ή το διπλό κλικ αν χρειάζεται. 

 Στο συγκεκριμένο παράδειγμα, θα δημιουργήσουμε ένα διαφορετικό τύπο ζυγού. 

 Πατήστε Cancel για να ενεργοποιηθεί ξανά το παράθυρο του ζυγού. 

 Κάντε κλικ στην επιλογή  και επιλέξτε New Project Type. Ανοίγει το παράθυρο 

δημιουργίας νέου τύπου. 

 Ονομάστε τον τύπο “BB 33 kV”. 

 Στο χώρο της ονομαστικής τάσης (Nominal Voltage) εισάγετε τιμή 33 kV (Εικόνα 

2.19). 

 Πατήστε OK για να επιστρέψετε στο κεντρικό παράθυρο του ζυγού. 

 Στο χώρο της ονομαστικής τάσης (Nominal Voltage), αλλάξτε την πολική τάση 

(Line-Line) σε 33 kV. Παρατηρήστε ότι η φασική τάση (Line-Ground) είναι 19.05256 

kV, αφού 05256.193/33  . 

 Πατήστε το κουμπί  στο χώρο του Substation για να επεξεργαστείτε τον 

υποσταθμό. 

 Εμφανίζεται το παράθυρο διαλόγου του Substation (Εικόνα 2.20). Αλλάξτε το όνομα 

σε “Station 1”. 

 Εισάγετε “S1” ως σύντομο όνομα (Short Name). 

 Πατήστε OK για να κλείσετε το παράθυρο του υποσταθμού. 

 Επιβεβαιώστε με OK τις αλλαγές στο ζυγό για να κλείσετε το αρχικό παράθυρο. Στο 

παράθυρο που θα σας ρωτήσει αν επιθυμείτε να διατηρήσετε τις αλλαγές στην 

ονομαστική τάση και στην τεχνολογία των φάσεων, πατήστε Yes. 

 

 
Εικόνα 2.18 Επιλογή τύπου για το ζυγό 
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Εικόνα 2.19 Δημιουργία νέου τύπου ζυγού 

 

 
Εικόνα 2.20 Ρύθμιση της ονομαστικής τάσης του ζυγού και επεξεργασία της ονομασίας του 

υποσταθμού 
 

Ο μεσαίος ζυγός προσδιορίζεται με αντίστοιχα βήματα: 

 Ανοίξτε το παράθυρο διαλόγου του ζυγού. 

 Name=”Busbar 2” 

 Δημιουργήστε νέο τύπο με ονομασία “BB 11 kV” και ονομαστική τάση 11 kV. 

 Ρυθμίστε την ονομαστική τάση στα 11 kV. 

 Substation: Name=”Station 2”, Short Name=”S2” 

 Κλείστε το παράθυρο του ζυγού επιβεβαιώνοντας τις αλλαγές με OK. 
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Ο κατώτερος ζυγός έχει τα ακόλουθα χαρακτηριστικά: 

 Name=”Busbar 3” 

 Δημιουργήστε νέο τύπο με ονομασία “BB 3.3 kV” και ονομαστική τάση 3.3 kV. 

 Ονομαστική τάση στα 3.3 kV. 

 Substation: Name=”Station 3”, Short Name=”S3” 

 Επιβεβαιώστε με OK. 

 

2.2.2.2 Περιήγηση μεταξύ των στοιχείων του δικτύου 
 

Το PowerFactory προσφέρει τη δυνατότητα περιήγησης μεταξύ των στοιχείων του 

συστήματος, με τη σειρά που αυτά εμφανίζονται στην τοπολογία του δικτύου. Το παράθυρο 

κάθε στοιχείου διαθέτει την επιλογή Jump to…, με την οποία ο χρήστης μπορεί να περάσει 

στο παράθυρο του επόμενου συνδεμένου στοιχείου, αν υπάρχει μόνο ένα, ή να επιλέξει ένα 

μεταξύ άλλων από μία λίστα. 

Προκειμένου να γίνει χρήση της δυνατότητας αυτής στο υπό σχεδίαση δίκτυο: 

 Ανοίξτε το παράθυρο της γεννήτριας με διπλό κλικ. 

 Πατήστε Jump to… ώστε να εμφανιστεί το παράθυρο του πρώτου ζυγού ”Busbar 1”. 

 Πατήστε ξανά Jump to… και παρατηρήστε τη λίστα με τα συνδεμένα στοιχεία. 

Επιλέξτε το μετασχηματιστή. Ανοίγει τώρα το αντίστοιχο παράθυρο. 

 Σε κάθε περίπτωση, πατώντας το κουμπί Cancel επιστρέφετε στο μονογραμμικό 

διάγραμμα χωρίς να πραγματοποιήσετε αλλαγές σε κάποιο στοιχείο. 

 

2.2.2.3 Επεξεργασία στοιχείων διπλής σύνδεσης 
 

Για να επεξεργαστείτε τα χαρακτηριστικά των μετασχηματιστών, που είναι στοιχεία διπλής 

σύνδεσης (two-port elements), ξεκινήστε από τον επάνω μετασχηματιστή ως εξής: 

 Ανοίξτε το παράθυρο διαλόγου με διπλό κλικ. 

 Ονομάστε το μετασχηματιστή “Transformer 1”. 

 Ορίστε νέο τύπο μετασχηματιστή, επιλέγοντας Type → New Project Type. Ανοίγει το 

παράθυρο δημιουργίας νέου τύπου (Εικόνα 2.21). 

 Ονομάστε τον τύπο “33/11 kV”. 

 Rated Power=20 MVA 

 Nominal Frequency=60 Hz 

 Rated Voltage: HV-Side=33 kV, LV-Side=11 kV 

 Θεωρήστε συντελεστή τάσης βραχυκυκλώματος, ο οποίος αυξάνεται όσο αυξάνεται η 

τάση λειτουργίας μίας πλευράς, uk=10%, καθώς και μηδενικές απώλειες χαλκού. 

 Πατήστε OK. 

 Ανοίξτε την καρτέλα Load Flow στο παράθυρο του μετασχηματιστή. 

 Ελέγξτε ότι η επιλογή Automatic Tap Changing είναι απενεργοποιημένη και ότι η 

επιλογή Tap Position είναι ρυθμισμένη στο μηδέν. 

 Πατήστε OK. 

 

Θα εμφανιστεί ένα μήνυμα σφάλματος αν οι πλευρές υψηλής και χαμηλής τάσης του 

μετασχηματιστή δεν είναι συνδεμένες ορθά. Σε αυτήν την περίπτωση: 

 Στο παράθυρο του μετασχηματιστή και στην καρτέλα Basic Data, πατήστε το κουμπί 

Flip Connections. 

 Επιλέξτε OK. 
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Πρέπει να σημειωθεί ότι το παράθυρο του μετασχηματιστεί δείχνει τα συνδεμένα τερματικά, 

τα πεδία των οποίων έχουν συμπληρωθεί αυτόματα κατά τη σύνδεση του μετασχηματιστή 

ανάμεσα στους δύο ζυγούς. Τα ονόματα των δύο ζυγών φαίνονται με κόκκινο χρώμα. 

 

Επεξεργαστείτε και το δεύτερο μετασχηματιστή: 

 Ανοίξτε το παράθυρο διαλόγου του μετασχηματιστή. 

 Name=”Transformer 2” 

 Type → New Project Type: Name=”11/3.3 kV”, Rated Power=5 MVA, Nominal 

Frequency=60 Hz, HV-Side=11 kV, LV-Side=3.3 kV, uk=5%, Copper Losses=0 kW 

 Πατήστε OK. 

 Ανοίξτε την καρτέλα Load Flow και ελέγξτε ότι η επιλογή Automatic Tap Changing 

είναι απενεργοποιημένη και ότι η επιλογή Tap Position είναι ρυθμισμένη στο μηδέν. 

 Επιλέξτε OK. 

 

 
Εικόνα 2.21 Το παράθυρο του μετασχηματιστή και το παράθυρο δημιουργίας νέου τύπου 

 

2.2.2.4 Επεξεργασία στοιχείων μονής σύνδεσης 
 

Διαμορφώστε κατάλληλα τη γεννήτρια του δικτύου μέσω των παρακάτω βημάτων: 

 Ανοίξτε το παράθυρο διαλόγου της γεννήτριας. 

 Δώστε όνομα “Generator”. 

 Ορίστε νέο τύπο γεννήτριας, επιλέγοντας Type → New Project Type. Ανοίγει το 

παράθυρο δημιουργίας νέου τύπου. 

 Name=”G 10 MVA” 

 Η ονομαστική φαινόμενη ισχύς (Nominal Apparent Power) ανέρχεται στα 10 MVA 

και η ονομαστική ισχύς (Nominal Voltage) στα 33 kV. 

 Ο συντελεστής ισχύος (Power Factor) είναι 0.8 και η σύνδεση YN (αστέρας με 

ουδέτερο). 

 Πατήστε OK. 

 Ανοίξτε την καρτέλα Load Flow στο παράθυρο της γεννήτριας. 
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 Ορίστε τη γεννήτρια ως γεννήτρια αναφοράς, μέσω της επιλογής Reference Machine. 

 Στην κατηγορία Mode of Local Voltage Controller επιλέξτε Voltage. 

 Στο χώρο επιλογών Dispatch, ορίστε τα χαρακτηριστικά της γεννήτριας με Input 

Mode S, cos(phi) (με βάση τη φαινόμενη ισχύ και το συντελεστή ισχύος), όπως 

δείχνει η Εικόνα 2.22: Apparent Power=10 MVA, Power Factor=0.8, Voltage=1 p.u., 

Angle=0 deg. 

 Επιβεβαιώστε τις αλλαγές πατώντας OK. 

 

 
Εικόνα 2.22 Ρύθμιση παραμέτρων γεννήτριας 

 

Στη συνέχεια, επεξεργαστείτε τον κινητήρα που είναι συνδεμένος στο ζυγό των 11 kV: 

 Ανοίξτε το παράθυρο του κινητήρα. 

 Name=”Motor 1” 

 Προσδιορίστε τον τύπο του κινητήρα μέσω Type → New Project Type. Ανοίγει το 

παράθυρο δημιουργίας νέου τύπου. 

 Name=”M 5 MVA” 

 Rated Voltage=11 kV 

 Input Mode=Electrical Parameter 

 Στην επιλογή Power Rating ορίστε τη φαινόμενη ισχύ ίση με: Rated Apparent 

Power=5000 kVA. 

 Nominal Frequency=60 Hz 

 Η σύνδεση είναι D (τρίγωνο). 

 Πατήστε OK. 

 Ανοίξτε την καρτέλα Load Flow στο παράθυρο του κινητήρα. 

 Ορίστε την ενεργή ισχύ (Active Power) στα 4 MW. 
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 Επιλέξτε OK. 

 

Με την ίδια μέθοδο, προσδιορίστε τα χαρακτηριστικά του δεύτερου κινητήρα: 

 Ανοίξτε το παράθυρο του κινητήρα. 

 Name=”Motor 2” 

 Type → New Project Type: Name=”M 2 MVA”, Rated Voltage=3.3 kV, Rated 

Apparent Power=2000 kVA, Nominal Frequency=60 Hz 

 Πατήστε OK. 

 Load Flow: Active Power=1 MW 

 

Στο τέλος όλων των προηγούμενων επεξεργασιών, το σύστημα θα πρέπει να έχει τη μορφή 

που δίνεται στην Εικόνα 2.23. 

 

 
Εικόνα 2.23 Το υπό σχεδίαση δίκτυο ύστερα από την επεξεργασία των στοιχείων του 

 

 

 

 

 

 



38 
 

2.2.3 Υπολογισμός ροής φορτίου (load flow calculation) 
 

Μετά την ολοκλήρωση της επεξεργασίας των στοιχείων του δικτύου, μπορεί να 

πραγματοποιηθεί ένας υπολογισμός ροής φορτίου, μέσω του οποίου θα ελεγχθούν η 

ορθότητα της προηγούμενης σχεδίασης και τα μεγέθη που προκύπτουν κατά τη λειτουργία. 

Για την εμφάνιση του σχετικού παραθύρου, ακολουθήστε τη διαδρομή Calculation → Load 

Flow → Load Flow… από το κύριο μενού. Θα ανοίξει, έτσι, το παράθυρο διαλόγου για τον 

υπολογισμό, όπως δείχνει η Εικόνα 2.24. Εναλλακτικά, το παράθυρο του υπολογισμού της 

ροής φορτίου μπορεί να ανοίξει μέσω του σχετικού εικονιδίου στην μπάρα των κύριων 

εικονιδίων, με ονομασία Calculate Load Flow ( ). 

 

Ο υπολογισμός της ροής φορτίου ενός συστήματος διαθέτει μία σειρά παραμέτρων για τον 

καθορισμό του. Για το σκοπό της ροής φορτίου του συγκεκριμένου παραδείγματος, 

ακολουθήστε τα εξής βήματα: 

 Ορίστε ως μέθοδο υπολογισμού (Calculation Method) την AC Load Flow, balanced, 

positive sequence. 

 Επιλέξτε ως Temperature Dependency: Line/Cable Resistances τους 20 
o
C (…at 20 

o
C). 

 Απενεργοποιήστε όλες τις υπόλοιπες επιλογές στην καρτέλα Basic Options. 

 Στην καρτέλα Active Power Control, χρησιμοποιήστε την επιλογή as Dispatched ως 

Active Power Control και σιγουρευτείτε ότι είναι ενεργοποιημένη η επιλογή Consider 

Active Power Limits. 

 

Παρατηρήστε ότι το παράθυρο της ροής φορτίου διαθέτει επιλογές σχετικές με τη μέθοδο 

υπολογισμού και τις επαναλήψεις, στις καρτέλες Advanced Options και Iteration Control 

αντίστοιχα. 

 

 Πατήστε το κουμπί Execute για να ξεκινήσει ο υπολογισμός της ροής φορτίου. 
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Εικόνα 2.24 Το παράθυρο του υπολογισμού της ροής φορτίου 

 

Αν ο σχεδιασμός του δικτύου είναι ορθός, θα πρέπει να εμφανιστεί το μήνυμα της Εικόνας 

2.25 στο παράθυρο εξόδου (output window), το οποίο δηλώνει την επιτυχή εκτέλεση του 

υπολογισμού. Το μήνυμα αναφέρει ότι η γεννήτρια αποτελεί το στοιχείο αναφοράς για τα 

μεγέθη, καθώς ορίστηκε ως τέτοιο και είναι το μόνο στοιχείο του παραδείγματος που μπορεί 

να αποτελέσει στοιχείο αναφοράς. Επίσης, αναφέρεται ο αριθμός των επαναλήψεων που 

χρειάστηκαν για τη σύγκλιση του αλγορίθμου Newton-Raphson. 

 

 
Εικόνα 2.25 Το μήνυμα του παραθύρου εξόδου για τον υπολογισμό της ροής φορτίου 

 

Το παράθυρο χρησιμεύει για τον εντοπισμό και τη διόρθωση σφαλμάτων στο δίκτυο, ώστε 

να μπορούν να εκτελεστούν οι διάφοροι υπολογισμοί. Για παράδειγμα, αν δεν έχει οριστεί ο 

τύπος του μετασχηματιστή, θα εμφανιστεί κατάλληλο μήνυμα με σύνδεσμο που οδηγεί στο 

προβληματικό στοιχείο (στο μετασχηματιστή στην προκειμένη περίπτωση). Μέσω διπλού 

κλικ στη γραμμή με το όνομα του στοιχείου, ο χρήστης μεταφέρεται αυτόματα στο παράθυρο 

του στοιχείου αυτού. Μέσω της συγκεκριμένης διαδικασίας αλληλεπίδρασης, που προσφέρει 
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το παράθυρο εξόδου του PowerFactory, ο χρήστης έχει τη δυνατότητα εύκολης διόρθωσης 

πιθανών σφαλμάτων κατά το σχεδιασμό του συστήματος. 

 

Τα αποτελέσματα της ροής φορτίου στο δίκτυο δίνονται σε πλαίσια αποτελεσμάτων για κάθε 

στοιχείο, όπως δείχνει η Εικόνα 2.26. Απεικονίζονται η ενεργός ισχύς P, η άεργος ισχύς Q 

και το αναπτυσσόμενο ρεύμα I. Αν τοποθετηθεί ο δείκτης του ποντικιού επάνω σε κάποιο 

πλαίσιο, εμφανίζεται ένα βοηθητικό πλαίσιο με τις ίδιες τιμές μεγεθυμένες, γεγονός που 

καθιστά ευκολότερη την ανάγνωση των τιμών. Το χαρακτηριστικό αυτό του προγράμματος 

είναι ιδιαίτερα χρήσιμο όταν απεικονίζεται ένα μεγάλο μέρος του δικτύου ή ολόκληρο το 

δίκτυο στο παράθυρο γραφικών, καθώς τα στοιχεία και τα πλαίσια αποτελεσμάτων μπορεί να 

είναι μικρά και δυσανάγνωστα.  

 

 
Εικόνα 2.26 Αποτελέσματα του υπολογισμού της ροής φορτίου σε τμήμα του δικτύου 

 

Επιπλέον, ο υπολογισμός της ροής φορτίου παρέχει πληροφορίες σχετικά με τη φόρτιση των 

στοιχείων του δικτύου και τα αποδεκτά όρια. Τα ποσοστά φόρτισης δίνονται αν ο δείκτης 

του ποντικιού τοποθετηθεί επάνω στο όνομα του επιθυμητού στοιχείου. Στο υπό μελέτη 

παράδειγμα, η γεννήτρια παρουσιάζει φόρτιση 55.0%, ο πρώτος μετασχηματιστής 27.5%, ο 

πρώτος κινητήρας 86.0%, ο δεύτερος μετασχηματιστής 23.1% και ο δεύτερος κινητήρας 

56.8%. Ακόμα, μετά τον υπολογισμό χρωματίζονται κατάλληλα τα στοιχεία του δικτύου, 

ώστε να φαίνεται το επίπεδο φόρτισης (π.χ. κόκκινο για υπερφόρτιση ενός στοιχείου). Η 

επιλογή Diagram Colouring ( ) στην μπάρα του παραθύρου των γραφικών δίνει το 

υπόμνημα των χρωμάτων. 

 

Πιο συγκεκριμένα: 

 Ανοίξτε το παράθυρο μέσω της επιλογής Diagram Colouring. 

 Στην καρτέλα Load Flow, επιλέξτε Colour Settings. Ανοίγει το σχετικό παράθυρο της 

Εικόνας 2.27. 
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Στο παράθυρο αυτό μπορείτε να εξετάσετε την αντιστοιχία χρωμάτων και επιπέδων τάσεων-

φορτίσεων, καθώς και να πραγματοποιήσετε αλλαγές στα χρησιμοποιούμενα χρώματα. 

 

 
Εικόνα 2.27 Το παράθυρο αντιστοιχίας χρωμάτων και επιπέδων φόρτισης των στοιχείων του δικτύου 

 

Ακόμα, μέσω της επιλογής Colour Legend Block ( ) στην μπάρα του παραθύρου των 

γραφικών, ενεργοποιείται ή απενεργοποιείται το υπόμνημα για τα χρησιμοποιούμενα 

χρώματα, το οποίο φαίνεται στην Εικόνα 2.28. 

 

 
Εικόνα 2.28 Το υπόμνημα για την αντιστοιχία χρωμάτων και τάσεων-φορτίσεων 

 

Τέλος, στην Εικόνα 2.29 δίνεται η γενική εικόνα του δικτύου, ύστερα από την εκτέλεση του 

υπολογισμού της ροής φορτίου. 
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Εικόνα 2.29 Το υπό μελέτη δίκτυο μετά τον υπολογισμό της ροής φορτίου 

 

 

2.2.4 Επεξεργασία των αποτελεσμάτων του υπολογισμού 
 

Τα μεγέθη που δίνονται στα πλαίσια αποτελεσμάτων δεν είναι σταθερά, καθώς μπορούν να 

επιλεγούν άλλα. Το PowerFactory προσφέρει εύχρηστα εργαλεία για τον προσδιορισμό των 

εμφανιζόμενων αποτελεσμάτων, καθώς και για την τροποποίηση των πλαισίων 

αποτελεσμάτων. Εξάλλου, τα πλαίσια αποτελεσμάτων είναι, ουσιαστικά, μικρές 

υπολογιστικές αναφορές, τις οποίες ο χρήστης μπορεί να διαμορφώσει κατάλληλα. 

 

Όπως αναφέρθηκε ήδη, τα πλαίσια αποτελεσμάτων, μετά τον υπολογισμό της ροής φορτίου, 

αναφέρουν τις τιμές για τα μεγέθη P, Q και I. Μπορεί, όμως, να είναι απαραίτητο να 

προστεθεί η τιμή της φόρτισης. Η αλλαγή αυτή θα πραγματοποιηθεί, ενδεικτικά, στο πλαίσιο 

αποτελεσμάτων του επάνω μετασχηματιστή: 

 Πατήστε την επιλογή Freeze Mode ( ) για να απενεργοποιηθεί η δυνατότητα 

αλλαγών στο μονογραμμικό διάγραμμα. 

 Πατήστε δεξί κλικ σε ένα από τα δύο πλαίσια αποτελεσμάτων του μετασχηματιστή. 

Ανοίγει ένα μικρό μενού. 
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Υπάρχουν δύο επιλογές, οι Format for Edge Elements και Format for 2-Winding 

Transformer, οι οποίες ανοίγουν ένα δεύτερο μενού. Από εκεί μπορεί να επιλεγεί 

διαφορετική μορφή για το πλαίσιο αποτελεσμάτων. Ένα σύμβολο τικ δείχνει ποια μορφή 

χρησιμοποιείται κάθε φορά. Στην παρούσα φάση, χρησιμοποιείται η μορφή Format for Edge 

Elements → Branch Flow. 

 

Επίσης, η επιλογή Edit Format for Edge Elements αφορά τις δυνατότητες μεταβολής της 

χρησιμοποιούμενης μορφής αποτελεσμάτων: 

 Κάντε κλικ στην επιλογή Edit Format for Edge Elements ώστε να ανοίξει το σχετικό 

παράθυρο. 

 Πατήστε το κουμπί Input Mode και επιλέξτε User Selection. 

 Επιβεβαιώστε με OK. 

 

Το αρχικό παράθυρο περιλαμβάνει τις τρεις επιλεγμένες μεταβλητές για τα αποτελέσματα. 

Προκειμένου να αποκτήσετε πρόσβαση στο πλαίσιο με όλες τις μεταβλητές, ακολουθήστε τα 

εξής βήματα: 

 Πατήστε διπλό κλικ π.χ. στην τρίτη γραμμή, η οποία αφορά το ρεύμα (στη λίστα 

δίνεται με την ονομασία “m:I:_LOCALBUS”). Στο παράθυρο που εμφανίζεται, η 

μεταβλητή αυτή είναι ενεργοποιημένη και όλες οι άλλες απενεργοποιημένες. 

 Ενεργοποιήστε τη μεταβλητή cosphi:_LOCALBUS ώστε να προσθέσετε το 

συντελεστή ισχύος στις εμφανιζόμενες μεταβλητές, όπως δείχνει η Εικόνα 2.30. 

 Όλες οι μεταβλητές με τικ προστίθενται στη λίστα αποτελεσμάτων. 

 Πατήστε το κουμπί OK και στα δύο παράθυρα. 

 Παρατηρήστε την αλλαγή στο πλαίσιο αποτελεσμάτων του μετασχηματιστή το οποίο 

περιλαμβάνει, πλέον, και το συντελεστή ισχύος. Η ίδια αλλαγή αφορά και βοηθητικό 

πλαίσιο αποτελεσμάτων, που εμφανίζεται αν τοποθετηθεί ο δείκτης του ποντικιού 

επάνω στο αρχικό πλαίσιο. 

 Παρατηρήστε ότι όλα τα πλαίσια αποτελεσμάτων έχουν αλλάξει. 

 Επιλέξτε το Edit Format for Edge Elements ξανά. Δοκιμάστε να ρυθμίσετε τα 

εμφανιζόμενα δεκαδικά ψηφία των μεταβλητών σε 3 ή 4, καθώς και να ελέγξετε τη 

χρησιμότητα των υπόλοιπων ρυθμίσεων. 

 

Αν το πλαίσιο αποτελεσμάτων, στο μονογραμμικό διάγραμμα, είναι υπερβολικά μικρό για να 

συμπεριλάβει όλες τις επιλεγμένες πληροφορίες: 

 Πατήστε το Freeze Mode ώστε να ενεργοποιηθεί η δυνατότητα αλλαγών. 

 Πατήστε δεξί κλικ στο πλαίσιο και επιλέξτε Adapt Width. 

 

Συνήθως δεν είναι απαραίτητη η προσθήκη μονάδων ή περιγραφών στα πλαίσια 

αποτελεσμάτων, καθότι οι πληροφορίες αυτές δίνονται αυτόματα. Ακόμα, υπάρχει το 

υπόμνημα του μονογραμμικού διαγράμματος, στην κάτω αριστερή γωνία του παραθύρου 

γραφικών, το οποίο ανανεώνεται αυτόματα σύμφωνα με τις αλλαγές στις μεταβλητές. Το 

υπόμνημα αυτό εμφανίζεται ή αποκρύπτεται μέσω της επιλογής Show Legend Block ( ) 

στην μπάρα του παραθύρου των γραφικών. 
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Εικόνα 2.30 Επεξεργασία των πλαισίων αποτελεσμάτων με τη χρήση προκαθορισμένων μεταβλητών 

 

 

2.2.5 Υπολογισμός βραχυκυκλώματος (short-circuit calculation) 
 

Ο υπολογισμός βραχυκυκλώματος μπορεί να ξεκινήσει ακολουθώντας τη διαδρομή 

Calculation → Short-Circuit → Short-Circuit… από το κύριο μενού, πατώντας το κουμπί 

Calculate Short-Circuit ( ) στην μπάρα των κύριων εικονιδίων ή κατευθείαν από το 

μονογραμμικό διάγραμμα: 

 Πατήστε το Freeze Mode. 

 Πατήστε δεξί κλικ στο ζυγό των 11 kV και επιλέξτε Calculate → Short-Circuit, όπως 

δείχνει η Εικόνα 2.31. 
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Εικόνα 2.31 Έναρξη του υπολογισμού βραχυκυκλώματος από το μονογραμμικό διάγραμμα 

 

Με τους παραπάνω τρόπους ανοίγει το παράθυρο διαλόγου για το βραχυκύκλωμα: 

 Ορίστε ως μέθοδο την IEC 61363, η οποία αφορά συστήματα ηλεκτρικής ενέργειας 

στη θάλασσα. 

 Παρατηρήστε ότι για τη συγκεκριμένη μέθοδο ο τύπος σφάλματος είναι 3-Phase 

Short-Circuit και δεν αλλάζει. 

 Σιγουρευτείτε ότι είναι επιλεγμένη η Standard IEC 61363 Method στο χώρο του 

Calculate Using. 

 Καθορίστε ως θέση του βραχυκυκλώματος (Fault Location) όλους τους ζυγούς (All 

Busbars). Υπάρχει, βέβαια, και η επιλογή User Selection, όπου ο χρήστης καθορίζει 

μία συγκεκριμένη θέση. Αν το παράθυρο του βραχυκυκλώματος έχει ανοίξει μέσω 

ενός ζυγού στο μονογραμμικό διάγραμμα, τότε αυτόματα η θέση του σφάλματος είναι 

αυτή του συγκεκριμένου ζυγού. Επίσης, υπάρχει και η επιλογή Busbars and Junction 

Nodes, αλλά στο υπό μελέτη παράδειγμα χρησιμοποιείται η επιλογή για όλους τους 

ζυγούς. 

 Στην καρτέλα Advanced Options, ορίστε ότι θα πραγματοποιηθεί πρώτα μία ροή 

φορτίου (use load flow initialization). 

 Το παράθυρο διαλόγου θα πρέπει να έχει τώρα τη μορφή της Εικόνας 2.32. 

 Πατήστε Execute. 
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Εικόνα 2.32 Το παράθυρο του υπολογισμού του βραχυκυκλώματος 

 

Εκτελείται ο υπολογισμός βραχυκυκλώματος με το πρόγραμμα να θεωρεί ότι το σφάλμα 

συμβαίνει εκεί που ορίστηκε. Στην προκειμένη περίπτωση, έχουμε βραχυκυκλώματα στους 

τρεις ζυγούς του δικτύου. Τα αποτελέσματα περιλαμβάνουν τα ρεύματα βραχυκύκλωσης και 

τις ισχύεις σε όλο το δίκτυο, εκτός από τα επίπεδα φόρτισης των στοιχείων, τα οποία 

αμελούνται. Τα μεγέθη του ρεύματος και της ισχύος δίνονται για το εκάστοτε τερματικό 

θεωρώντας ότι προκύπτουν από βραχυκύκλωμα στο συγκεκριμένο τερματικό. Το παράθυρο 

εξόδου θα πρέπει να εμφανίσει, εκτός από το μήνυμα για τη ροή φορτίου, το μήνυμα της 

Εικόνας 2.33. 
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Εικόνα 2.33 Το μήνυμα του παραθύρου εξόδου για τον υπολογισμό του βραχυκυκλώματος 

 

Για τον υπολογισμό ενός πολλαπλού σφάλματος, το οποίο συμβαίνει σε περισσότερα του 

ενός στοιχεία ταυτόχρονα, ακολουθήστε τα εξής βήματα: 

 Πραγματοποιήστε έναν υπολογισμό ροής φορτίου με τα χαρακτηριστικά που 

εκτέθηκαν στην παράγραφο 2.2.3 (balanced load flow). 

 Επιλέξτε ταυτόχρονα δύο τερματικά (π.χ. τον πρώτο και το δεύτερο ζυγό) 

χρησιμοποιώντας το πλήκτρο CTRL. 

 Πατήστε δεξί κλικ στην επιλογή και ακολουθήστε τη διαδρομή Calculate → Multiple 

Faults. 

 Ανοίγει ένα παράθυρο με μία λίστα των θέσεων των σφαλμάτων. Η λίστα 

περιλαμβάνει τα επιλεγμένα τερματικά και πρόσθετα τερματικά, εφόσον έχουν 

επιλεγεί σε προηγούμενη φάση. Μπορείτε να επεξεργαστείτε τη λίστα, διαγράφοντας 

καταχωρήσεις ή δημιουργώντας νέες μέσω της επιλογής New Object ( ). 

 Πατήστε Close. 

 Ανοίγει αυτόματα το παράθυρο βραχυκυκλώματος. Θα πρέπει να είναι επιλεγμένη η 

μέθοδος complete και να είναι ενεργοποιημένο το Multiple Faults. 

 Πατήστε Execute. 

 

Πραγματοποιείται ο υπολογισμός με το πρόγραμμα να θεωρεί ότι συμβαίνουν τα δύο 

ορισμένα βραχυκυκλώματα ταυτόχρονα. 
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2.3 Ο Data Manager 
 

Στην παρούσα ενότητα, θα παρουσιαστούν οι βασικές λειτουργίες και δυνατότητες του Data 

Manager, το οποίο αποτελεί κύριο εργαλείο του PowerFactory. Για το σκοπό αυτό, 

χρησιμοποιείται το υπόβαθρο της άσκησης 3 των tutorials, το δίκτυο της οποίας είναι 

πανομοιότυπο με αυτό που δημιουργήθηκε στην ενότητα 2.2. Ακολουθήστε τα εξής βήματα 

για την εκκίνηση της άσκησης: 

 Ακολουθήστε τη διαδρομή Help → Start Tutorial… από την μπάρα του κύριου 

μενού. 

 Επιλέξτε το Start και κατόπιν την άσκηση που επιθυμείτε, εν προκειμένω επιλέξτε 

Exercise 3. 

 Πατήστε το Execute. 

Το μονογραμμικό διάγραμμα θα πρέπει να επανεμφανιστεί με διαφορετικό μοτίβο. Η βάση 

δεδομένων στην οποία αποθηκεύονται όλες οι αλλαγές δεν χρησιμοποιήθηκε άμεσα στα 

προηγούμενα tutorials. Προκειμένου να γίνει χρήση της βάσης αυτής, είναι απαραίτητη η 

πρόσβαση στο περιβάλλον του Data Manager. Πιο συγκεκριμένα: 

 Πατήστε το κουμπί Open Data Manager ( ) που βρίσκεται αριστερά στην μπάρα 

των κύριων εικονιδίων. Το παράθυρο του Data Manager θα εμφανιστεί στην οθόνη, 

όπως φαίνεται στην Εικόνα 2.34. 

 

 
Εικόνα 2.34 Το παράθυρο διαλόγου του Data Manager 

 

Ο Data Manager έχει δύο παράθυρα: 

 Το δέντρο της βάσης δεδομένων στα αριστερά, που αναπαριστά σε μορφή δέντρου 

ολόκληρη τη βάση. 

 Το παράθυρο περιήγησης στα δεξιά που δείχνει το περιεχόμενο του επιλεγμένου 

φακέλου από το δέντρο. 
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2.3.1. Χρησιμοποιώντας τον Data Manager 
 

Ανοίγοντας τον Data Manager, ο χρήστης έχει τη δυνατότητα να δει το περιεχόμενο του 

φακέλου του (Database/User). Εκτός από τα προηγούμενα projects, πλέον ο Tutorial 

Manager έχει δημιουργήσει και ενεργοποιήσει ένα νέο project με τίτλο “Tutorial Exercise 3”. 

Ένα ενεργό project υποδηλώνεται με έντονα (bold) γράμματα μέσα στον Data Manager. 

Εφόσον ο χρήστης επιθυμεί να μεταβεί σε κάποιο άλλο project, θα πρέπει να το 

ενεργοποιήσει πατώντας δεξί κλικ στον αντίστοιχο φάκελο και επιλέγοντας το Activate από 

το μενού που θα ανοίξει. 

 

Ο Data Manager μπορεί να χρησιμοποιηθεί για την επεξεργασία των στοιχείων ενός 

συστήματος που έχει ήδη μοντελοποιήσει ο χρήστης. Δηλαδή: 

 Επιλέξτε από το δέντρο στο αριστερό παράθυρο του Data Manager τη διαδρομή 

Tutorial exercise 3 → Network Model → Network Data → Part 1. 

 Από το δεξί παράθυρο του Data Manager επιλέξτε με διπλό κλικ το εικονίδιο ενός 

μετασχηματιστή . Έτσι, θα ανοίξει το ίδιο παράθυρο επεξεργασίας του 

μετασχηματιστή όπως αυτό που ανοίγει και από το μονογραμμικό διάγραμμα. 

 Κλείστε το παράθυρο πατώντας το Cancel. 

 

Γενικότερα ο Data Manager είναι ένα ιδιαίτερα χρήσιμο εργαλείο για το χρήστη και μπορεί 

να χρησιμοποιηθεί για διάφορες εργασίες: 

 Δημιουργία αντικειμένων κάθε είδους, όπως projects, calculation cases, τύπους 

στοιχείων στη βιβλιοθήκη, εντολές υπολογισμών κ.ά. 

 Αντιγραφή και επικόλληση μερών από ένα φάκελο σε έναν άλλο μέσα στη βάση 

δεδομένων. 

 Επισκόπηση των αποτελεσμάτων σε μορφή πίνακα. 

 Επεξεργασία αντικειμένων και στοιχείων σε μορφή πίνακα. 

 Εισαγωγή και εξαγωγή (import, export) μερών της βάσης δεδομένων. 

 

 

2.3.2. Δημιουργία μίας γραμμή διακλάδωσης 
 

Το σύστημα θα διευρυνθεί προσθέτοντας ένα καλώδιο διανομής με φορτία (καταναλωτές) 

στο μεσαίο ζυγό. Ξεκινήστε σχεδιάζοντας τον επιπλέον ζυγό στα δεξιά του ζυγού των 11 kV: 

 Αν η επιλογή για το πάγωμα του μονογραμμικού διαγράμματος είναι 

ενεργοποιημένη, απενεργοποιήστε τη. 

 Επιλέξτε το εικονίδιο  από την εργαλειοθήκη σχεδίασης και τοποθετήστε το ζυγό 

στα δεξιά του σταθμού “D1_11a”. 

 Επεξεργαστείτε το νέο ζυγό πατώντας διπλό κλικ πάνω του από το μονογραμμικό 

διάγραμμα, προκειμένου να ανοίξει το αντίστοιχο παράθυρο διαλόγου: 

Name=“D2_Swab”, Substation Name=“Station 4”, Short Name=“S4”, Type → Select 

Project Type → Bar 11 kV, Nominal Voltage=11 kV. 

 

Στην πλήρη έκδοση του PowerFactory τα παραπάνω βήματα μπορούν να απλοποιηθούν. Ο 

νέος σταθμός είναι παρόμοιος με τον ήδη υπάρχοντα D1_11a. Έτσι, τα στοιχεία του μπορούν 

εύκολα να αντιγραφούν από τον υπάρχοντα σταθμό στο νέο. 
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Η μέθοδος αυτή, δηλαδή η αντιγραφή των δεδομένων από ένα στοιχείο του συστήματος σε 

ένα άλλο, επιταχύνει το σχεδιασμό του συστήματος και μειώνει και τυχόν λάθη. Για 

παράδειγμα, όταν υπάρχει ένα μεγάλο δίκτυο ηλεκτρικής ενέργειας και αποτελείται από 

ηλεκτρικά όμοια στοιχεία (ζυγούς κ.λπ.), ο χρήστης μπορεί να ορίσει τα δεδομένα ενός μόνο 

στοιχείου και, στη συνέχεια, ανοίγοντας το Data Manager, όπως περιγράφηκε παραπάνω, να 

τα αντιγράψει στα υπόλοιπα όμοια στοιχεία του δικτύου με μία μόνο ενέργεια. 

 

Η αντιγραφή και επικόλληση των δεδομένων είναι δυνατή για όλα τα αντικείμενα, 

συμπεριλαμβανομένων των μετασχηματιστών, των γραμμών, των φορτίων, των γεννητριών 

κ.λπ. Εντούτοις, στη δοκιμαστική έκδοση του προγράμματος (demo version) δεν είναι 

δυνατή η παραπάνω λειτουργία. 

 

Για το σχεδιασμό του καλωδίου από το ζυγό D1_11a στο νέο D2_Swab: 

 Επιλέξτε το εικονίδιο της γραμμής Line  από την εργαλειοθήκη. 

 Τοποθετήστε τη με βάση το μοτίβο που βρίσκεται στο φόντο του μονογραμμικού 

διαγράμματος. 

- Επιλέξτε με αριστερό κλικ το ζυγό D1_11a. 

- Το λεπτομερές γραφικό σχέδιο του υποσταθμού ανοίγει αυτόματα. Συνδέστε 

τη γραμμή σε έναν από τους ελεύθερους διακόπτες. 

- Με αριστερό κλικ σχεδιάστε τις δύο γωνίες της γραμμής, όπως υποδεικνύει το 

μοτίβο. 

- Επιλέξτε με αριστερό κλικ τον άλλο ζυγό (D2_Swab). 

- Συνδέετε το άλλο άκρο της γραμμής σε κάποιο ελεύθερο διακόπτη. 

 Με διπλό αριστερό κλικ επιλέξτε τη γραμμή για να την επεξεργαστείτε ως εξής: 

- Name=“L1_Swab”  

- Επιλέξτε τον τύπο της γραμμής πατώντας το αντίστοιχο βέλος  

- Select Project Type → Line Type (TypLne) 

- Types Cables (υποφάκελος της βιβλιοθήκης) 

- Επιλέξτε Cable 11kV800A. 

- Length of Line=3 km 

- Πατήστε ΟΚ. 

 Πατήστε στη συνέχεια στο εικονίδιο Busbar (Short) από την εργαλειοθήκη.  

 Τοποθετήστε το ζυγό στο σημείο που δείχνει το μοτίβο, κάτω από τον D2_Swab. 

 Εισάγετε τα εξής στοιχεία για αυτό το ζυγό: 

- Name=“D1_Reut” 

- Type → Select Project Type → Bar 11 kV 

- Nominal Voltage=11 kV  

 Επιλέξτε κατόπιν τη γραμμή (Line) από την εργαλειοθήκη σχεδίασης. 

 Τοποθετήστε τη γραμμή μεταξύ των ζυγών D2_Swab και D1_Reut με τον τρόπο που 

υποδείχθηκε και προηγουμένως. 

 Πατήστε διπλό κλικ για να ανοίξει το παράθυρο διαλόγου της γραμμής  

- Name=“L_Swb_Rt” 

- Type → Select Project Type → Line Type → Types Cables → Cable 11kV400A 

- Length of Line=5 km 

 Συνδέστε τώρα ένα φορτίο (General Load) από την εργαλειοθήκη . 

 

Σε αυτό το σημείο λοιπόν το δίκτυο θα πρέπει να είναι όπως αυτό της Εικόνας 2.35. 
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Εικόνα 2.35 Η μορφή του νέου δικτύου μετά τις προσθήκες 

 

Στη συνέχεια, τοποθετούνται τα φορτία στην καινούρια γραμμή: 

 Επιλέξτε το φορτίο (Load) από την εργαλειοθήκη. 

 Κάντε κλικ πάνω στη γραμμή, στη θέση που συνδέεται το ανώτερο φορτίο σύμφωνα 

με το μοτίβο. Το παράθυρο διαλόγου (Branch-Off Element) θα πρέπει να εμφανιστεί. 

Αν δεν εμφανιστεί και τοποθετηθεί το φορτίο απλά στο διάγραμμα, σημαίνει ότι δεν 

επιλέχθηκε η γραμμή σωστά. Πατήστε το Esc και δοκιμάστε ξανά την παραπάνω 

διαδικασία, κάνοντας zoom in εφόσον κρίνεται απαραίτητο.  

 

Συνδέοντας το φορτίο πάνω στη γραμμή, αυτόματα εισάγεται και ένας μικρός ζυγός/σταθμός 

και η γραμμή (καλώδιο) χωρίζεται σε 2 γραμμές. Το συνολικό μήκος των 2 ξεχωριστών 

γραμμών είναι ίσο με το μήκος της αρχικής γραμμής (πριν συνδεθούν τα φορτία). Ο χρήστης 

έχει τη δυνατότητα να καθορίσει τη θέση που θα χωριστεί η γραμμή.  

 Ορίζετε τη νέα θέση στα 4 km. Το παράθυρο διαλόγου Branch-Off Element δείχνει το 

έγκυρο διάστημα (0–5 km εδώ). 

 Η επιλογή Switch Options (Insert Switches on Right Side/Left Side) πρέπει να είναι 

απενεργοποιημένη. 

 Πατήστε ΟΚ. 
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Οι αποστάσεις που τοποθετούνται τα φορτία στο γράφημα δεν έχουν σχέση τις φυσικές τους 

θέσεις. Ασφαλώς, η σειρά με την οποία τοποθετούνται ταυτίζεται με την πραγματική σειρά. 

 

 Εισάγετε το τελευταίο φορτίο (το πιο χαμηλό στο διάγραμμα) με τον ίδιο τρόπο που 

περιγράφεται παραπάνω. Ορίστε τη θέση στα 0.8 km, (που σημαίνει ότι τοποθετείται 

δηλαδή στα 4.8 km, αφού πλέον το πρόγραμμα μετράει την απόσταση από το νέο 

ζυγό που συνδέθηκε νωρίτερα), επίσης χωρίς την επιλογή διακοπτών. 

 Συνδέστε και το τρίτο φορτίο ανάμεσα στα άλλα δύο. 

 Ορίστε την απόσταση στα 4.4 km (πληκτρολογήστε δηλαδή 0.4 km). 

 Ενεργοποιήστε την επιλογή left switch. 

 Αλλάξτε την κατεύθυνση που συνδέθηκε το φορτίο ως εξής: 

- Πατήστε δεξί κλικ σε ένα κενό σημείο του διαγράμματος ή πατήστε Esc για να 

αποδεσμεύσετε την επιλογή του φορτίου από το δείκτη του ποντικιού. 

- Επιλέξτε με αριστερό κλικ το φορτίο που συνδέσατε τελευταίο και κρατήστε το 

πατημένο. 

- Μετακινήστε το φορτίο στην άλλη πλευρά της γραμμής, όπως υποδεικνύει το 

μοτίβο. 

- Αφήστε το αριστερό πλήκτρο του ποντικιού για να ολοκληρώσετε τη μετακίνηση 

στη νέα θέση. 

Το τρίτο φορτίο πλέον έχει στραφεί κατά 180
ο
. Επίσης, ο χρηστής μπορεί να το πετύχει αυτό 

πιο εύκολα, κάνοντας με δεξί κλικ στο φορτίο (ή οποιοδήποτε άλλο στοιχείο) και 

επιλέγοντας από το μενού που εμφανίζεται Flip at Busbar. 

 

Μετά από αυτή τη διαδικασία, η γραμμή που είχε ονομαστεί στην αρχή L_Swb_Rt, έχει 

χωριστεί σε τέσσερις νέες γραμμές, οπότε εμφανίζονται τα ονόματα L_Swb_Rt, 

L_Swb_Rt(1), L_Swb_Rt(2), L_Swb_Rt(3). Τα νέα αυτά στοιχεία θα επεξεργαστούν στη 

συνέχεια.  

 

Το background (μοτίβο) πλέον δεν είναι απαραίτητο: 

 Επιλέξτε το εικονίδιο  στην μπάρα εργαλείων του μονογραμμικού διαγράμματος. 

Ανοίγει έτσι το παράθυρο επεξεργασίας Graphic Layers. 

 Το Background layer βρίσκεται στο πεδίο των ορατών layers (Visible pane). Επιλέξτε 

το και πατήστε το  για να το μετακινήσετε στο αόρατο πεδίο (Invisible 

pane). Με διπλό κλικ στο Background layer πετυχαίνετε το ίδιο. 

 Κλείστε το παράθυρο.  

 

Το μοτίβο που βρισκόταν στο φόντο πλέον είναι δεν είναι ορατό.  

 Πατήστε το Freeze Mode. 

 

 

2.3.3. Επεξεργασία των καινούριων στοιχείων 
 

Ο τύπος και το μήκος της «διακλαδισμένης» γραμμής (branched-off line)  έχουν οριστεί 

παραπάνω. Έτσι θα αλλάξουν μόνο τα ονόματα των καινούριων γραμμών που 

δημιουργήθηκαν: 

 Επιλέξτε με διπλό κλικ την ανώτερη γραμμή: 

- Name=“L_Swb_Tub” 

 Ονομάστε τις υπόλοιπες γραμμές από επάνω προς τα κάτω: 
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- Name=“L_Tub_Dus” 

- Name=“L_Dus_Gom” 

- Name=“L_Gom_Reut” 

 

Σε αυτό το σημείο θα πρέπει να οριστούν οι παράμετροι των νέων τερματικών που 

δημιουργήθηκαν πάνω στις γραμμές, λόγω των φορτίων που συνδέθηκαν. Επειδή τα 

terminals είναι ίδια και είναι χρονοβόρο να τροποποιηθούν ένα-ένα ξεχωριστά, θα γίνει 

χρήση του Data Manager που παρέχει, όπως αναφέρθηκε και στην αρχή του κεφαλαίου, 

multi-edit δυνατότητες: 

 Ανοίξτε το παράθυρο του Data Manager 

 Στο δέντρο της βάσης δεδομένων στα αριστερά επιλέξτε το φάκελο “Part 1”, όπως 

φαίνεται στην εικόνα που ακολουθεί. 

 

 
Εικόνα 2.36 Το παράθυρο του Data Manager με τις νέες γραμμές και τα τερματικά 

 

Στο παράθυρο του Data Manager που άνοιξε, φαίνονται μεταξύ άλλων το όνομα και ο τύπος 

των στοιχείων. Για τα καινούρια terminals (Terminal, Terminal(1)…) δεν έχει οριστεί ακόμα 

ο τύπος. Έτσι: 

 Επιλέξτε με διπλό κλικ το εικονίδιο ενός terminal ( ) από την πρώτη στήλη για 

να ανοίξει το αντίστοιχο παράθυρο διαλόγου.  

 Ορίστε τον τύπο του ως εξής: Type → Select Project Type → Bar 11kV. 

 Κλείστε το παράθυρο διαλόγου πατώντας OK. 

 Με τον ίδιο τρόπο ορίστε τον τύπο (ίδιος) και στα άλλα δύο τερματικά. 

 

Σειρά έχουν τώρα τα ονόματα: 

 Επιλέξτε με διπλό κλικ το εικονίδιο του στοιχείου Τerminal. 

 Αλλάξτε το όνομα σε “D1_Tub”. 

 Συνεχίστε με τη μετονομασία του Terminal(1) σε “D1_Gom” και του Terminal(2) σε 

“D1_Dus”. 
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 Κλείστε το παράθυρο του Data Manager. 

 

Οι καινούριες γραμμές θα πρέπει να ομαδοποιηθούν με τα τερματικά σε ένα αντικείμενο 

(Branch object). 

 Ανοίξτε τον Data Manager εκ νέου. 

 Επιλέξτε το φάκελο Part 1 και πατήστε δεξί κλικ. 

 Από το μενού που εμφανίζεται επιλέξτε New → Branch (Εικόνα 2.37). 

 Ένα νέος κλάδος (branch) δημιουργείται. 

 Ονομάστε το νέο αυτό κλάδο “L_Swb_Reut”. 

 Επιλέξτε τα τερματικά D1_Tub, D1_Gom, D1_Dus. 

 Κάντε δεξί κλικ και αποκοπή. 

 Επιλέξτε το νέο κλάδο L_Swb_Reut από το δέντρο στα αριστερά. 

 Κάντε δεξί κλικ και επικόλληση. 

 Επαναλάβετε ακριβώς την ίδια διαδικασία για τις γραμμές L_Swb_Tub, L_Tub_Dus, 

L_Dus_Gom, L_Gom_Reut. 

 

Η Εικόνα 2.38 παρουσιάζει το νέο κλάδο με τα στοιχεία που μεταφέρθηκαν με την 

προηγούμενη διαδικασία. 

 

 
Εικόνα 2.37 Δημιουργία ενός νέου κλάδου στον Data Manager 
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Εικόνα 2.38 Ο νέος κλάδος με τα στοιχεία που μεταφέρθηκαν 

 

Τέλος, για τον κλάδο αυτό: 

 Κάντε δεξί κλικ επάνω στον κλάδο από το δέντρο. 

 Επιλέξτε Edit από το εμφανιζόμενο μενού ώστε να ανοίξει το παράθυρο διαλόγου 

(ElmBranch). 

 Πατήστε το πλήκτρο Update για να συμπληρωθούν αυτόματα οι συνδέσεις κ.ά. του 

κλάδου.  

 Κλείστε το παράθυρο με το OK. 

 

 
Εικόνα 2.39 Ο ενημερωμένος κλάδος 

  

Ακολούθως, πρέπει να ρυθμιστούν οι τύποι των τεσσάρων νέων φορτίων: 

 Επιλέξτε όλα τα φορτία (επιλέγοντας ένα και μετά κρατώντας πατημένο το Ctrl για 

να επιλέξετε και τα άλλα). 

 Πατήστε δεξί κλικ πάνω σε κάποιο από τα επιλεγμένα φορτία και επιλέξτε Edit Data. 
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 Κάντε διπλό κλικ σε ένα από αυτά και, στο παράθυρο διαλόγου που ανοίγει, 

ακολουθήστε τη διαδρομή Type → Select Project Type → General Load Type 

(TypLod) →  Types Loads → General Load και κλείστε το παράθυρο με το ΟΚ. 

 Κλείστε και το παράθυρο διαλόγου του φορτίου με ΟΚ. 

 Επαναλάβετε και για τα υπόλοιπα φορτία. 

 

Μπορεί να γίνει, πλέον, η ρύθμιση για την απαίτηση ισχύος για τα φορτία αυτά: 

 Για το ανώτερο φορτίο: 

- Στην καρτέλα Basic Data αλλάξτε το όνομα σε “Tubin”. 

- Στην καρτέλα Load Flow: 

 Balanced/Unbalanced=Balanced 

 Active Power=4.0 MW 

 Power Factor=0.9 

 Voltage=1.0 p.u. 

 

Αν η επιλογή Active Power ή/και η επιλογή του Power Factor δεν είναι διαθέσιμες, τότε στο 

Input Mode επιλέξτε το P, cos(phi). Όλα τα φορτία θεωρούνται επαγωγικά. 

 

 Για το μεσαίο φορτίο ακολουθείται η ίδια διαδικασία: 

- Στην καρτέλα Basic Data αλλάξτε το όνομα σε “Duslin”. 

- Στην καρτέλα Load Flow: 

 Balanced/Unbalanced=Balanced 

 Active Power=1.0 MW 

 Power Factor=0.9 

 Voltage=1.0 p.u. 

 Για το τρίτο κατά σειρά φορτίο επίσης: 

- Στην καρτέλα Basic Data μεταβάλλετε το όνομα σε “Goma”. 

- Στην καρτέλα Load Flow: 

 Balanced/Unbalanced=Balanced 

 Active Power=1.0 MW 

 Power Factor=0.9 

 Voltage=1.0 p.u. 

 Για το φορτίο που βρίσκεται στο μικρό ζυγό στο κάτω μέρος του διαγράμματος:  

- Στην καρτέλα Basic Data ορίστε όνομα “Reutlin”. 

- Στην καρτέλα Load Flow: 

 Balanced/Unbalanced=Balanced 

 Active Power=3.0 MW 

 Power Factor=0.9 

 Voltage=1.0 p.u. 

 

Στο σημείο αυτό ο σχεδιασμός του συστήματος ολοκληρώνεται και σειρά έχουν οι 

υπολογισμοί. 
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2.3.4. Εκτέλεση υπολογισμών 
 

Σε πρώτη φάση, εκτελείται ένας υπολογισμός ροής φορτίου με τις εξής παραμέτρους: 

 Calculation Method: AC Load Flow, Balanced, positive sequence 

 Όλες οι άλλες επιλογές είναι απενεργοποιημένες. 

 

Είναι σημαντικό εδώ να καθοριστεί, με βάση τα αποτελέσματα, ποια στοιχεία του δικτύου 

παρουσιάζουν υπερφόρτιση. Υπάρχει η δυνατότητα να «χρωματιστούν» τα στοιχεία αυτά 

πάνω στο διάγραμμα: 

 Επιλέξτε το Diagram Colouring ( ) από τη γραμμή εργαλείων του μονογραμμικού 

δικτύου. 

 Στην καρτέλα Load Flow επιλέξτε το “3. Others” και τα Results, Voltages/Loading 

από τα μενού.  

 Επιλέξτε Colour Settings και στην καρτέλα Voltages/Loading αλλάξτε το Max. 

Loading of Edge Element σε 90%, 95% και 100%, όπως φαίνεται στην Εικόνα 2.40. 

 Κλείστε το παράθυρο πατώντας ΟΚ μετά τις ρυθμίσεις αυτές. 

 

 
Εικόνα 2.40 Παρουσίαση των χρωμάτων του μονογραμμικού δικτύου 

 

Πλέον, είναι σαφές πως η γραμμή L_Swb_Tub είναι υπερφορτισμένη. Υπερτάσεις στο 

δίκτυο δε φαίνεται να υπάρχουν (οι σταθμοί έχουν μπλε χρώμα). Αν δε φαίνονται τα 
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χρώματα στο δίκτυο, εκτελέστε εκ νέου έναν υπολογισμό ροής φορτίου. Για να βελτιωθεί η 

κατάσταση (υπερφόρτιση του καλωδίου), θα πραγματοποιηθούν οι εξής αλλαγές: 

 Κάντε διπλό κλικ στη γραμμή L_Swb_Tub. 

 Επιλέξτε ένα, άλλο τύπο καλωδίου: 

- Type → Select project type → Cable 11kV800A 

- Πατήστε OK. 

Εκτελέστε τον υπολογισμό ροής φορτίου εξ αρχής, οπότε φαίνεται ότι η γραμμή δεν 

υπερφορτίζεται πλέον. Σε αυτό το σημείο: 

 Επιλέξτε μία από τις γραμμές (L_Swb_Tub, L_Dus_Gom κ.λπ.) και μετά πατήστε 

δεξί κλικ → Switch off. Απομονώνεται έτσι το σύστημα των φορτίων (γίνονται αχνά 

στο διάγραμμα). 

 Εκτελέστε πάλι έναν υπολογισμό και παρατηρήστε τις διαφορές. 

 

Με την επιλογή Switch off της γραμμής, ο υπολογισμός βραχυκυκλώματος στον τελευταίο 

ζυγό δεν έχει νόημα: 

 Κάντε δεξί κλικ στο ζυγό D1_Reut. 

 Calculate → Short Circuit 

 Method=According to IEC, Fault=3-phase Short Circuit. 

 

Αυτό θα οδηγήσει σε σφάλμα, όπως φαίνεται και από το μήνυμα στο παράθυρο εξόδου 

 

 Ενεργοποιήστε τη γραμμή (Switch on). 

 Εκτελέστε με τον ίδιο τρόπο το βραχυκύκλωμα. Θα πρέπει τώρα να εκτελείται ο 

υπολογισμός κανονικά χωρίς μήνυμα λάθους. 

 

Σε αυτό το σημείο ολοκληρώνεται η παρουσίαση των βασικών χαρακτηριστικών του Data 

Manager του προγράμματος. 

 

 

 

 



ΚΕΦΑΛΑΙΟ 3 
 

Μελέτη βραχυκυκλωμάτων με βάση το διεθνές 
πρότυπο IEC 61363-1 

 
Το παρακάτω κεφάλαιο συνοψίζει αρχικά τα βασικά σημεία της θεωρίας βραχυκυκλωμάτων, 

αναφορικά με τον ορισμό του φαινομένου του βραχυκυκλώματος, τους σχετικούς 

κανονισμούς, τις μεθόδους προστασίας και τη συμπεριφορά του δικτύου κατά την εκδήλωση 

ενός τέτοιου σφάλματος. Στη συνέχεια, εκθέτει αναλυτικά την πλειονότητα των διατάξεων 

του διεθνούς προτύπου IEC 61363-1 για τη μελέτη βραχυκυκλωμάτων σε εγκαταστάσεις ΕΡ 

πλοίων. Το εν λόγω πρότυπο συνιστά, μεταξύ άλλων, μία μεθοδολογία προσέγγισης του 

βραχυκυκλώματος, η οποία περιλαμβάνεται στο PowerFactory και χρησιμοποιείται στην 

παρούσα εργασία. 

 

 

3.1 Ορισμός και συνέπειες βραχυκυκλώματος 
 

Βραχυκύκλωμα ονομάζεται η αγώγιμη σύνδεση μεταξύ δύο σημείων διαφορετικού 

δυναμικού, μέσω πολύ μικρής ωμικής αντίστασης. Αυτό έχει σαν αποτέλεσμα την 

κυκλοφορία πολύ μεγάλου ρεύματος, καθώς από το νόμο του Ohm ισχύει: 

 

 
R

V
I  για 0R  (3.1) 

 

 

Καθίσταται σαφές ότι όσο μεγαλύτερη είναι η ονομαστική τάση λειτουργίας V, τόσο 

μεγαλύτερο είναι και το ρεύμα βραχυκυκλώματος Ι, δηλαδή τα βραχυκυκλώματα γίνονται 

πιο σημαντικά με την αύξηση της τάσης λειτουργίας. 

 

Τα βραχυκυκλώματα, σαν μεταβατικά φαινόμενα, είναι ηλεκτρικής φύσης και δυναμικής 

μορφής. Σε σχέση με τις υπερτάσεις, οι οποίες είναι επίσης ηλεκτρικά μεταβατικά φαινόμενα 

αλλά διηλεκτρικής μορφής, τα βραχυκυκλώματα είναι βραδύτερα στην εξέλιξή τους, διότι 

καθορίζονται βασικά από τη μαγνητική αντίδραση και αλληλεπίδραση των τυλιγμάτων των 

γεννητριών. 

 

Στις άμεσες συνέπειες των υπερεντάσεων λόγω βραχυκύκλωσης περιλαμβάνονται η 

υπερθέρμανση του εξοπλισμού (λόγω του φαινομένου Joule), η τήξη αγώγιμων μερών, η 

τήξη μονωτικών υλικών, η μερική ή ολική απώλεια (καταστροφή) μονώσεων, οι πυρκαγιές 

και η ολική καταστροφή εξοπλισμού, η ανάπτυξη μεγάλων (ελκτικών ή/και απωστικών, 

ανάλογα με τη φορά των ρευμάτων στους ρευματοφόρους αγωγούς) δυνάμεων Laplace, οι 

στρεβλώσεις και κάμψεις αγώγιμων μερών και οι μηχανικές ταλαντώσεις. [2] 
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Τα βραχυκυκλώματα συνοδεύονται από στιγμιαίο μηδενισμό ή βύθιση της τάσης, σε 

διαφορετικό βέβαια βαθμό για κάθε ζυγό. Όσο πιο κοντά είναι η θέση του 

βραχυκυκλώματος, τόσο πιο έντονη είναι η διακύμανση της τάσης. Λόγω της απότομης 

αυτής μείωσης της τάσης, η εξερχόμενη ηλεκτρική ισχύς των γεννητριών μειώνεται απότομα, 

ενώ αντίθετα η μηχανική ισχύς των στροβίλων στιγμιαία παραμένει σταθερή. Η κατάσταση 

αυτή μπορεί να οδηγήσει σε προσωρινό περίσσευμα κινητήριας ισχύος που δημιουργεί ένα 

ζεύγος επιτάχυνσης και μπορεί να οδηγήσει σε αστάθεια του συστήματος. Ενίοτε μπορεί να 

εμφανιστούν και υπερτάσεις (όπως συμβαίνει στα αγείωτα συστήματα των πλωτών 

κατασκευών), κάτι που οδηγεί σε καταπονήσεις των μονώσεων. Οι υπερτάσεις αυτές 

οδηγούν σε καταπόνηση των μονώσεων. Επίσης, αξίζει να αναφέρουμε ότι υπερτάσεις 

αναπτύσσονται και κατά τη διακοπή και εκκαθάριση του σφάλματος, ακόμα και αν 

εκκαθαρίζονται μόνο οι φάσεις με σφάλμα. [3] 

 

Τα βραχυκυκλώματα μπορεί να είναι τριφασικά (συμμετρικά), που είναι η πλέον απίθανη 

αλλά και δυσμενέστερη κατάσταση, καθώς αναπτύσσονται μεγάλες εντάσεις ρευμάτων, ή 

ασύμμετρα (μονοφασικά, διφασικά, διφασικά προς γη), τα οποία μπορούν να αναλυθούν με 

τη μέθοδο των συμμετρικών συνιστωσών. 

 

 

3.2 Κανονισμοί μελετών βραχυκυκλωμάτων 
 

Η Διεθνή Επιτροπή Ηλεκτροτεχνίας (International Electrotechnical Committee – IEC) έχει 

εκδώσει μία σειρά από κανονισμούς για βραχυκυκλώματα, με βασικούς τους παρακάτω: 

 IEC 60909-0 για βραχυκυκλώματα σε εγκαταστάσεις ΕΡ ξηράς [4] 

 IEC 61363-1 για βραχυκυκλώματα σε εγκαταστάσεις ΕΡ πλοίων [5] 

 IEC 61660-1 για βραχυκυκλώματα σε εγκαταστάσεις ΣΡ ξηράς [6] 

 

Όσον αφορά σε κανονισμούς Νηογνωμόνων, ο Γερμανικός Νηογνώμονας (Germanischer 

Lloyds – GL) είναι αυτός που διαθέτει τις λεπτομερέστερες οδηγίες για τη μελέτη 

βραχυκυκλωμάτων με αναφορές και ενίοτε συμπληρωματικές διευκρινίσεις στους 

κανονισμούς της IEC. 

 

Στις εγκαταστάσεις ξηράς, η μελέτη βραχυκυκλωμάτων γίνεται για τάσεις υψηλότερες του 1 

kV. Αντίθετα, σε πλωτές κατασκευές, οι κανονισμοί του IEC 61363-1 απαιτούν να γίνεται 

μελέτη βραχυκυκλωμάτων για κάθε δίκτυο (ακόμα και για τάσεις μικρότερες του 1 kV). 

Σημειώνεται ότι οι κανονισμοί του IEC 60909-0 δίνουν μόνο τη μεθοδολογία υπολογισμού, 

χωρίς να υποδεικνύονται οι ιδιαίτερες συνθήκες που πρέπει να ληφθούν υπόψη κατά τη 

μελέτη. Από την άλλη, ο IEC 61363-1 ορίζει σαφώς ότι για τα πλοία πρέπει να 

πραγματοποιείται μελέτη για τριφασικό βραχυκύκλωμα (για τη δυσμενέστερη περίπτωση), 

ενώ όλοι οι υπολογισμοί πρέπει να γίνονται για χρονική στιγμή ίση με την πρώτη ημιπερίοδο 

(T/2) της ονομαστικής ηλεκτρικής συχνότητας του δικτύου (οπότε ουσιαστικά δεν έχει 

πραγματοποιηθεί καθόλου απόσβεση). Από την άποψη αυτή, οι διατάξεις του IEC 61363-1 

είναι πιο αυστηρές. [2] Στην παρούσα εργασία, θα μας απασχολήσει το πρότυπο IEC 61363-

1, καθότι αφορά τη μελέτη βραχυκυκλωμάτων σε εγκαταστάσεις ΕΡ πλοίων. 
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3.3 Μέθοδοι προστασίας έναντι βραχυκυκλωμάτων 
 

Η αρχή λειτουργίας των στοιχείων προστασίας από βραχυκύκλωμα είναι η διακοπή ενός 

κυκλώματος στην περίπτωση ανίχνευσης υψηλών εντάσεων ρευμάτων. Η διαδικασία αυτή 

υλοποιείται αυτόματα και μάλιστα σε ένα καθορισμένο χρόνο. Τέτοια μέσα προστασίας είναι 

οι (θυσιαζόμενες) ασφάλειες και οι αυτόματοι διακόπτες ισχύος. Στις ασφάλειες τήξης 

συνήθως τήκεται (θυσιάζεται) ένα μεταλλικό στοιχείο κατά τη διαρροή υψηλής έντασης 

ρεύματος. Οι αυτόματοι διακόπτες, εκτός από την προστασία από βραχυκύκλωμα, 

χρησιμοποιούνται και για τις ζεύξεις και αποζεύξεις των γραμμών, των μετασχηματιστών, 

των γεννητριών κ.λπ. 

 

Χαρακτηριστικές παράμετροι των στοιχείων προστασίας είναι οι εξής: 

 Το μέγεθος του διακοπτόμενου ρεύματος βραχυκύκλωσης 

 Ο χρόνος διακοπής, από τη στιγμή της αναγνώρισης ύπαρξης σφάλματος και εντολής 

διακοπής έως την πλήρη διακοπή κάθε μορφής ροής ρεύματος 

 

Στο σημείο αυτό πρέπει να αναφερθούμε στη διαφορά μεταξύ υπερφόρτισης και 

υπερέντασης (βραχυκυκλώματος). Η υπερφόρτιση αναφέρεται σε υπέρβαση του 

ονομαστικού ρεύματος λειτουργίας μόνο περίπου κατά 20%, ενώ η υπερένταση 

(βραχυκύκλωμα) αναφέρεται σε πολλαπλάσια τιμή (τουλάχιστον 200%). Έτσι, η προστασία 

από υπερφόρτιση ικανοποιείται από στοιχεία με χαρακτηριστική αντίστροφου χρόνου, ενώ 

στην περίπτωση της υπερέντασης ο χρόνος αντίδρασης του στοιχείου προστασίας μπορεί να 

είναι «ακαριαίος» (Εικόνα 3.1). 

 

 
Εικόνα 3.1 Χαρακτηριστικές στοιχείων προστασίας από υπερφόρτιση και υπερένταση [2] 

 

Ασφαλώς, η ονομαστική ένταση ρεύματος διακοπής των στοιχείων προστασίας πρέπει να 

είναι μεγαλύτερη από το αναμενόμενο ρεύμα βραχυκυκλώματος, αλλιώς η διακοπή δε θα 

επιτευχθεί και, εκτός της εγκατάστασης, θα καταστραφεί και το διακοπτικό στοιχείο. 

 

Ο χρόνος διακοπής, πέρα από τη σκόπιμη καθυστέρηση που ρυθμίζεται από τους 

ηλεκτρονόμους (βοηθητικά ρελέ που δίνουν την εντολή διακοπής), περιλαμβάνει και 

χρόνους καθυστέρησης λόγω των φυσικών φαινομένων διακοπής. Ουσιαστικά, κατά τη φάση 

διακοπής, στην εκκίνηση του φαινομένου απομάκρυνσης των αγώγιμων επαφών του 

διακόπτη αναπτύσσεται ηλεκτρικό τόξο στον ενδιάμεσο χώρο. Ο χώρος αυτός πληρώνεται 
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από κάποιο διακοπτικό-μονωτικό μέσο, όπως είναι ο αέρας, κάποιο μονωτικό έλαιο κ.λπ. Ο 

φυσικός μηχανισμός για την αποκατάσταση της μόνωσης στο εσωτερικό του διακόπτη, 

δηλαδή για τη σβέση του τόξου με εξάλειψη όλων των αγώγιμων φορέων και την 

αποκατάσταση της διηλεκτρικής αντοχής μεταξύ των επαφών του διακόπτη, απαιτεί κάποιο 

χρόνο. [2] 

 

Τέλος, πρέπει να σημειωθεί ότι ένα διακοπτικό στοιχείο χαρακτηρίζεται όχι μόνο από την 

ικανότητα διακοπής ρεύματος βραχυκυκλώματος (short circuit breaking capacity), αλλά και 

από την ικανότητα ζεύξης των επαφών του σε συνθήκες βραχυκυκλώματος (short circuit 

making capacity). Γενικά, οι δύο αυτές χαρακτηριστικές τιμές διαφέρουν. 

 

 

3.4 Το ηλεκτρικό δίκτυο κατά την εκδήλωση του 
βραχυκυκλώματος 

 
Τα ισοδύναμα κυκλώματα των ηλεκτρικών στοιχείων ενός μελετώμενου ηλεκτρικού δικτύου 

είναι συγκεκριμένα και ισχύουν μόνο για μελέτες βραχυκυκλωμάτων. Όσον αφορά στο 

βραχυκύκλωμα, τα ηλεκτρικά στοιχεία ενός δικτύου διακρίνονται σε ενεργητικά και 

παθητικά, ανάλογα με το αν συμμετέχουν στην τροφοδότηση του ρεύματος βραχυκύκλωσης 

ή απλώς συμμετέχουν ως σύνθετες αντιστάσεις. Τα ενεργητικά στοιχεία, που είναι όλες οι 

στρεφόμενες ηλεκτρικές μηχανές, ανεξάρτητα από το αν λειτουργούν ως γεννήτριες ή 

κινητήρες, αποτελούνται από ωμικές αντιστάσεις (R-στοιχεία) και πηνία (L-στοιχεία) μαζί με 

πηγές τάσης (στα πρότυπα των ισοδύναμων κυκλωμάτων Thevenin-Norton). Οι σύγχρονες 

γεννήτριες του συστήματος αποτελούν τις κύριες πηγές τροφοδότησης των ρευμάτων 

βραχυκύκλωσης, ενώ οι ασύγχρονοι κινητήρες συνεισφέρουν κυρίως κατά την έναρξη. 

Μικρή αλλά όχι αμελητέα επίδραση στη συμπεριφορά όλων των μηχανών έχει και η 

κατάσταση φόρτισής τους πριν το βραχυκύκλωμα. Αντίθετα, τα παθητικά στοιχεία, στα 

οποία συγκαταλέγονται τα καλώδια, οι μετασχηματιστές, τα επαγωγικά πηνία και οι 

μετατροπείς ηλεκτρονικών ισχύος, αποτελούνται μόνο από ωμικές αντιστάσεις (R-στοιχεία) 

και πηνία (L-στοιχεία). [2] 

 

Μία σύγχρονη γεννήτρια «αντιλαμβάνεται» το βραχυκύκλωμα ως εξής: η απότομη αύξηση 

του ρεύματος του στάτη, κατά την επιβολή του βραχυκυκλώματος, επάγει στο τύλιγμα του 

δρομέα ρεύματα μεταβατικά, με τα οποία το τύλιγμα του δρομέα αντιδρά στη μεταβολή της 

πεπλεγμένης ροής. Η αντίδραση αυτή γίνεται σύμφωνα με την αρχή διατήρησης της 

πεπλεγμένης ροής, η οποία προκύπτει από το νόμο του Faraday και τον κανόνα του Lenz και 

αναφέρει ότι η πεπλεγμένη ροή σε ένα κλειστό κύκλωμα δεν μπορεί να αλλάξει στιγμιαία. 

Στην περίπτωση του βραχυκυκλώματος, όπου το ρεύμα αυξάνεται, το τύλιγμα αντιδρά 

εμφανίζοντας μειωμένη επαγωγή αντιστρόφως ανάλογη προς το ρεύμα, με αποτέλεσμα τη 

μειωμένη μεταβατική επαγωγική αντίδραση Xd΄<Xd. Εάν η γεννήτρια έχει και τυλίγματα 

απόσβεσης, πράγμα που αποτελεί κανόνα, τότε επάγονται μεταβατικά ρεύματα και στα 

τυλίγματα αυτά κατά τις πρώτες στιγμές του βραχυκυκλώματος, επιπλέον των ρευμάτων του 

δρομέα. Τα ρεύματα αυτά είναι μικρότερα από αυτά του δρομέα και μικρότερης διάρκειας, 

δηλαδή 2-3 περιόδων. Αποτέλεσμα αυτής της αντίδρασης των τυλιγμάτων είναι η 

υπομεταβατική επαγωγική αντίδραση Xd΄΄ της σύγχρονης μηχανής, με την οποία αυτή 

εμφανίζεται κατά τις πρώτες στιγμές της επιβολής του βραχυκυκλώματος. Ισχύει ότι 

Xd΄΄<Xd΄<Xd. Τόσο η μεταβατική όσο και η υπομεταβατική αντίδραση της μηχανής 

αυξάνουν με την πάροδο του χρόνου, καθώς αποκαθίσταται η ηλεκτρομαγνητική ισορροπία 
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μεταξύ των τυλιγμάτων στάτη, δρομέα και απόσβεσης, μέχρι να φτάσουν την τιμή της 

μόνιμης επαγωγικής αντίδρασης Xd. [3] 

 

Όσον αφορά τις επαγωγικές αντιδράσεις εγκάρσιου άξονα σε μια γεννήτρια έκτυπων πόλων, 

αν και οι ταχύστροφες μηχανές (π.χ. ατμο ή αεριο-στροβιλοκίνητες γεννήτριες) έχουν 

κυλινδρικό δρομέα, η μεταβατική αντίδραση είναι ίση με τη μόνιμη, δεδομένου ότι δεν 

υπάρχει τύλιγμα διέγερσης στον εγκάρσιο άξονα (Xq΄=Xq). Αν υπάρχουν τυλίγματα 

απόσβεσης κατά τον εγκάρσιο άξονα, δημιουργείται μια υπομεταβατική αντίδραση Xq΄΄ 

μικρότερη από τη Xq. Η Xq΄΄ είναι λίγο μεγαλύτερη από τη Xd΄΄. [3] 

 

Άρα, στην υπομεταβατική κατάσταση η σύγχρονη μηχανή εμφανίζει τις ελάχιστες δυνατές 

επαγωγικές αντιδράσεις (υπομεταβατική αντίδραση ευθέος και εγκάρσιου άξονα Xd΄΄, Xq΄΄, 

αντίστοιχα, στις οποίες συμμετέχουν οι αντιδράσεις τυλίγματος τυμπάνου, τυλίγματος 

διέγερσης και, κυρίως, τυλίγματος απόσβεσης). Η χρονική διάρκεια καθορίζεται από τις 

χρονικές σταθερές Τd΄΄ και Τq΄΄ και ισούται με 2-5 κύκλους βασικής περιόδου (40-100 ms 

για 50 Hz). 

 

Στη μεταβατική κατάσταση η σύγχρονη μηχανή εμφανίζει τις μεγαλύτερες επαγωγικές 

αντιδράσεις (μεταβατική αντίδραση ευθέος και εγκάρσιου άξονα Xd΄, Xq΄, αντίστοιχα, στις 

οποίες συμμετέχουν οι αντιδράσεις τυλίγματος τυμπάνου και τυλίγματος διέγερσης). Η 

χρονική διάρκεια καθορίζεται από τις χρονικές σταθερές Τd΄ και Τq΄ και ισούται με 10-15 

κύκλους βασικής περιόδου (200-300 ms για 50 Hz). 

 

Στη μόνιμη κατάσταση βραχυκύκλωσης η σύγχρονη μηχανή εμφανίζει τις σύγχρονες 

επαγωγικές αντιδράσεις μόνιμης κατάστασης (αντίδραση ευθέος και εγκάρσιου άξονα Xd΄, 

Xq΄, αντίστοιχα, στις οποίες συμμετέχουν οι αντιδράσεις τυλίγματος τυμπάνου και 

τυλίγματος διέγερσης). Η χρονική διάρκεια καθορίζεται από τις χρονικές σταθερές Τd και Τq 

και διαρκεί όσο υφίσταται το βραχυκύκλωμα. 

 

Η συνεισφορά των ασύγχρονων μηχανών είναι παρόμοια ως προς τα χαρακτηριστικά με 

αυτήν των σύγχρονων μηχανών, αλλά μικρότερης δυναμικότητας. Αυτό συμβαίνει διότι οι 

ασύγχρονες μηχανές δεν έχουν τύλιγμα διέγερσης, οπότε, κατά αντιστοιχία με τις σύγχρονες 

μηχανές, η συνεισφορά τους στο ρεύμα βραχυκύκλωσης είναι αξιόλογη κατά την 

υπομεταβατική περίοδο, ενώ δεν υφίσταται και μόνιμη κατάσταση, καθώς το ρεύμα 

βραχυκύκλωσης μηδενίζεται. [2] 

 

Γενικά, μπορεί να ειπωθεί ότι μόλις μία στρεφόμενη ηλεκτρική μηχανή «αντιληφθεί» το 

βραχυκύκλωμα (τις υψηλές απαιτήσεις σε ρεύμα με μειωμένη τάση), αντιδρά προσπαθώντας 

να το τροφοδοτήσει, εμφανιζόμενη στο δίκτυο ως πηγή τάσης με χαμηλές μάλιστα 

επαγωγικές αντιδράσεις. Οι ωμικές αντιστάσεις αποσβένουν το ρεύμα βραχυκύκλωσης και 

συνεισφέρουν μόνο στη διαμόρφωση των σταθερών χρόνου απόσβεσης των φαινομένων 

(σταθερές L/R). Επιπλέον, για την ικανοποίηση και των αρχικών συνθηκών του 

προβλήματος (συσχετισμός του τι συνέβαινε πριν με το τι συμβαίνει μετά το 

βραχυκύκλωμα), οι ημιτονοειδείς κυματομορφές ρεύματος εμφανίζονται με ασυμμετρία, δεν 

έχουν δηλαδή μέση τιμή μηδενική, περιλαμβάνοντας αποσβεννύμενες συνιστώσες ΣΡ που 

αποτυπώνουν ακριβώς τις αρχικές συνθήκες. Πρόκειται, επί της ουσίας, για τη συμμετοχή 

των αρχικών συνθηκών στη λεγόμενη μεταβατική λύση με εκθετικά αποσβεννύμενο 

μηχανισμό, σε οποιαδήποτε λύση διαφορικής εξίσωσης. Τέλος, το ρεύμα βραχυκύκλωσης, 

που ρέει στο σημείο του σφάλματος, προκύπτει από την υπέρθεση (σε κατά προσέγγιση 
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γραμμικά κυκλώματα από τη διανυσματική άθροιση) των επιμέρους ρευμάτων των 

ενεργητικών στοιχείων, σύμφωνα με τα θεωρήματα Thevenin-Norton. [2] 

 

 

3.5 Το διεθνές πρότυπο IEC 61363-1 
 

Στην παρούσα ενότητα παρουσιάζεται το διεθνές πρότυπο IEC 61363-1 [5], το οποίο, όπως 

αναφέρθηκε στην ενότητα 3.2, ορίζει ότι για τα πλοία πρέπει να γίνεται μελέτη για τριφασικό 

βραχυκύκλωμα, δηλαδή για τη δυσμενέστερη περίπτωση. Επίσης, το πρότυπο ορίζει ότι όλοι 

οι υπολογισμοί πρέπει να γίνονται για χρονική στιγμή ίση με την πρώτη ημιπερίοδο (Τ/2) της 

ονομαστικής ηλεκτρικής συχνότητας του δικτύου, προτού δηλαδή υπάρξει κάποια απόσβεση. 

Στη συνέχεια, γίνεται αναφορά στις παραγράφους του προτύπου που θα χρησιμοποιηθούν για 

τους σκοπούς της εργασίας. Το κείμενο ακολουθεί τις διατάξεις του προτύπου [5]. Έχουν 

παραληφθεί οι ενότητες και παράγραφοι 2, 5.1.3, 5.1.4, 5.2.4, 7, 8.6, 9.3 του προτύπου, λόγω 

της μη εφαρμογής τους στην παρούσα εργασία. 

 

 

3.5.1 Σκοπός και αντικείμενο 
 

Αυτό το διεθνές πρότυπο περιγράφει διαδικασίες για τον υπολογισμό ρευμάτων 

βραχυκύκλωσης που μπορεί να υπάρξουν σε μια ναυτική ή υπεράκτια ηλεκτρολογική 

εγκατάσταση ΕΡ. 

 

Οι μέθοδοι υπολογισμού εφαρμόζονται σε μη διασυνδεμένα τριφασικά δίκτυα 

εναλλασσομένου ρεύματος που: 

a) λειτουργούν στα 50 Ηz ή 60 Ηz 

b) έχουν οποιοδήποτε σύστημα τάσεως που καθορίζεται στο πρότυπο ΙEC 60092-201 

(πίνακας 2)  

c) έχουν ένα ή περισσότερα διαφορετικά επίπεδα τάσεων 

d) συμπεριλαμβάνουν γεννήτριες, κινητήρες (σύγχρονους και ασύγχρονους), 

μετασχηματιστές, επαγωγικά πηνία, καλώδια και μετατροπείς 

e) έχουν τον ουδέτερο κόμβο συνδεμένο με τη γάστρα του πλοίου μέσω μιας σύνθετης 

αντίστασης (σχεδιασμένη ώστε να περιορίζει το ρεύμα βραχυκύκλωσης που ρέει στη 

γάστρα του πλοίου) 
f) έχουν τον ουδέτερο κόμβο μονωμένο από τη γάστρα του πλοίου. 

 

Οι μέθοδοι υπολογισμού αφορούν μια κατάσταση τριφασικού συμμετρικού 

βραχυκυκλώματος, δηλαδή αγωγούς τριών φάσεων βραχυκυκλωμένους μεταξύ τους ή 

βραχυκυκλωμένους με τη γάστρα του πλοίου και για τους οποίους το βραχυκύκλωμα 

συμβαίνει ταυτόχρονα και στις τρεις φάσεις. Ο υπολογισμός ρευμάτων βραχυκύκλωσης που 

προκύπτει από ασύμμετρες καταστάσεις βραχυκυκλώματος μπορεί να οδηγήσει σε 

υψηλότερες απεριοδικές συνιστώσες (ΣΡ) του ρεύματος βραχυκύκλωσης και δεν εξετάζεται 

σε αυτό το πρότυπο. 

 

Οι υπολογιστικές σχέσεις και οι μέθοδοι, που περιγράφονται, δίνουν επαρκώς ακριβή 

αποτελέσματα για τον υπολογισμό του ρεύματος βραχυκύκλωσης κατά τη διάρκεια των 

πρώτων 100ms μιας κατάστασης σφάλματος. Μπορούν να χρησιμοποιηθούν για τον 

υπολογισμό του ρεύματος βραχυκύκλωσης για περιόδους μεγαλύτερες των 100ms όταν οι 

υπολογισμοί γίνονται σε ένα σύστημα ζυγών στους οποίους οι γεννήτριες συνδέονται 
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απευθείας. Για χρονικές περιόδους πέρα των 100ms οι ελεγκτικές επιδράσεις των ρυθμιστών 

τάσης του συστήματος μπορεί να είναι κυρίαρχες. Υπολογισμοί, οι οποίοι να περιλαμβάνουν 

τις επιδράσεις των ρυθμιστών τάσης, δεν εξετάζονται σε αυτό το πρότυπο. 

 

Αντικείμενο αυτού το προτύπου είναι να παρουσιάσει σχέσεις για τον υπολογισμό του 

ρεύματος βραχυκύκλωσης των ενεργητικών στοιχείων ενός ηλεκτρικού δικτύου και να δείξει 

πόσο αυτές οι σχέσεις μπορούν να απλοποιηθούν κατά τον υπολογισμό του ρεύματος 

βραχυκύκλωσης σε διάφορες θέσεις του ηλεκτρικού δικτύου. Οι υπολογισμοί δίνουν 

εκτιμήσεις του αναμενόμενου ρεύματος βραχυκύκλωσης όταν τα ενεργητικά στοιχεία του 

δικτύου παρουσιάζουν τη μέγιστη συνεισφορά. 

 

Οι υπολογιστικές σχέσεις στηρίζονται σε βασικές αρχές ηλεκτρολογίας σχετικές με τα 

στοιχεία του δικτύου. Οι απλοποιημένες μέθοδοι υπολογισμού ακόμη διατηρούν ένα 

αποδεκτό επίπεδο ακρίβειας στα αποτελέσματα, όμως οι κατάλληλες παραδοχές και οι 

επιδράσεις τους στα αποτελέσματα των υπολογισμών έχουν τονισθεί. 

 

 

3.5.2 Ορισμοί, σύμβολα, δείκτες και εκθέτες 
 

3.5.2.1 Ορισμοί 
 

Παρακάτω δίνονται οι ορισμοί βασικών μεγεθών, τα οποία χρησιμοποιούνται κατά τη μελέτη 

βραχυκυκλωμάτων. 

 

Βραχυκύκλωμα: Τυχαία ή σκόπιμη σύνδεση, μέσω μιας σχετικά πολύ μικρής αντίστασης ή 

σύνθετης αντίστασης, δύο ή παραπάνω σημείων ενός κυκλώματος, τα οποία είναι σε 

διαφορετικές τάσεις. 

 

Ρεύμα βραχυκύκλωσης: Υπερένταση που προκύπτει από ένα βραχυκύκλωμα λόγω ενός 

σφάλματος ή μιας λάθους σύνδεσης σε ένα ηλεκτρικό κύκλωμα. 

 

Αναμενόμενο ρεύμα (σε σχέση με μια διακοπτική διάταξη): το ρεύμα βραχυκύκλωσης που 

θα ρέει σε ένα κύκλωμα εάν κάθε πόλος της συσκευής αντικαθίστατο με έναν αγωγό 

αμελητέας σύνθετης αντίστασης. 

 

Συμμετρικό ρεύμα βραχυκύκλωσης: Η r.m.s. (ενεργός) τιμή της συμμετρικής συνιστώσας ΕΡ 

ενός αναμενόμενου (διαθέσιμου) ρεύματος βραχυκύκλωσης, όπου η απεριοδική συνιστώσα 

του ρεύματος, αν υπάρχει, αμελείται (IEC 60909, 3.4). 

 

Αρχικό συμμετρικό ρεύμα βραχυκύκλωσης Ik΄΄: Η r.m.s. (ενεργός) τιμή της συμμετρικής 

συνιστώσας ΕΡ ενός αναμενόμενου (διαθέσιμου) ρεύματος βραχυκύκλωσης που παράγεται 

τη στιγμή επιβολής του βραχυκυκλώματος εάν η σύνθετη αντίσταση παραμένει σε μηδενική 

τιμή (IEC 60909, 3.5, βλ. και Σχήμα 3.3). 

 

Υπομεταβατικό ρεύμα βραχυκύκλωσης Ιkd΄΄ ευθέος άξονα: Η r.m.s. (ενεργός) τιμή του 

ρεύματος βραχυκύκλωσης που διαρρέει ένα κύκλωμα με στρεφόμενες μηχανές, οι οποίες 

έχουν μία σύνθετη αντίσταση (επαγωγική αντίδραση) ίση με την υπομεταβατική αντίσταση 

(επαγωγική αντίδραση) του κυκλώματος. 
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Μεταβατικό ρεύμα βραχυκύκλωσης Ιkd΄ ευθέος άξονα: Η r.m.s. (ενεργός) τιμή του ρεύματος 

βραχυκύκλωσης που διαρρέει ένα κύκλωμα με στρεφόμενες μηχανές, οι οποίες έχουν μία 

σύνθετη αντίσταση (επαγωγική αντίδραση) ίση με τη μεταβατική αντίσταση (επαγωγική 

αντίδραση) του κυκλώματος. 

 

Ρεύμα βραχυκύκλωσης μόνιμης κατάστασης Ιkd ευθέος άξονα: Η r.m.s. (ενεργός) τιμή του 

ρεύματος βραχυκύκλωσης που διαρρέει ένα κύκλωμα με στρεφόμενες μηχανές, και απομένει 

μετά την απόσβεση των μεταβατικών φαινομένων. 

 

Απεριοδική συνιστώσα ΣΡ του ρεύματος βραχυκύκλωσης idc: Η συνιστώσα του ρεύματος σε 

ένα κύκλωμα αμέσως αφότου έχει ξαφνικά βραχυκυκλωθεί, με όλες τις συνιστώσες της 

θεμελιώδους και υψηλότερης συχνότητας να αποκλείονται. Είναι η μέση τιμή μεταξύ της 

άνω και κάτω περιβάλλουσας του ρεύματος βραχυκύκλωσης που αποσβένει από μια αρχική 

τιμή Α στο μηδέν, σύμφωνα με το Σχήμα 3.3. 

 

Κρουστικό ρεύμα βραχυκύκλωσης ip: Η μέγιστη πιθανή στιγμιαία τιμή του αναμενόμενου 

(διαθέσιμου) ρεύματος βραχυκύκλωσης (βλ. Σχήμα 3.3 και IEC 60909, 3.8). Για τριφασικά 

βραχυκυκλώματα υποθέτουμε ότι το βραχυκύκλωμα συμβαίνει ταυτόχρονα στους αγωγούς 

όλων των φάσεων. 

 

Υπομεταβατική χρονική σταθερά βραχυκύκλωσης ευθέος άξονα Τd΄΄: Ο χρόνος που 

απαιτείται ώστε η ταχέος μεταβαλλόμενη συνιστώσα, που εμφανίζεται στους πρώτους λίγους 

κύκλους στο ρεύμα βραχυκύκλωσης ευθέος άξονα, μετά από μια απότομη μεταβολή στις 

συνθήκες λειτουργίας, να μειωθεί στο 1/e, δηλαδή 0.368, της αρχικής της τιμής, με τη 

μηχανή (ή ισοδύναμη μηχανή) στην ονομαστική της ταχύτητα. 

 

Υπομεταβατική χρονική σταθερά ανοιχτού κυκλώματος ευθέος άξονα Τdο΄΄: Ο χρόνος που 

απαιτείται ώστε η ταχέος μεταβαλλόμενη συνιστώσα, που εμφανίζεται στους πρώτους λίγους 

κύκλους, της τάσης ανοιχτού κυκλώματος που οφείλεται στη ροή του ευθέος άξονα, μετά 

από μια απότομη μεταβολή στις συνθήκες λειτουργίας, να μειωθεί στο 1/e, δηλαδή 0.368, της 

αρχικής της τιμής, με τη μηχανή στην ονομαστική της ταχύτητα. 

 

Μεταβατική χρονική σταθερά βραχυκύκλωσης ευθέος άξονα Τd΄: Ο χρόνος που απαιτείται 

ώστε η βραδέος μεταβαλλόμενη συνιστώσα του ρεύματος βραχυκύκλωσης ευθέος άξονα, 

μετά από μια απότομη μεταβολή στις συνθήκες λειτουργίας, να μειωθεί στο 1/e, δηλαδή 

0.368, της αρχικής της τιμής, με τη μηχανή στην ονομαστική της ταχύτητα. 

 

Μεταβατική χρονική σταθερά ανοιχτού κυκλώματος ευθέος άξονα Τdο΄: Ο χρόνος που 

απαιτείται ώστε η βραδέος μεταβαλλόμενη συνιστώσα της τάσης ανοιχτού κυκλώματος, που 

οφείλεται στη ροή του ευθέος άξονα, μετά από μια απότομη μεταβολή στις συνθήκες 

λειτουργίας, να μειωθεί στο 1/e, δηλαδή 0.368 της αρχικής της τιμής με τη μηχανή στην 

ονομαστική της ταχύτητα. 

 

Χρονική σταθερά ΣΡ Τdc: Ο χρόνος που απαιτείται ώστε η συνιστώσα ΣΡ που εμφανίζεται 

στο ρεύμα βραχυκύκλωσης, μετά από μια απότομη μεταβολή στις συνθήκες λειτουργίας, να 

μειωθεί στο 1/e, δηλαδή 0.368, της αρχικής του τιμής, με τη μηχανή στην ονομαστική της 

ταχύτητα (βλ. IEC 60034-4, 20). 

 

Υπομεταβατική αντίδραση ευθέος άξονα Χd΄΄ (κορεσμένη τιμή): Το πηλίκο της αρχικής 

τιμής της βασικής συνιστώσας ΕΡ της τάσης του στάτη, ακριβώς πριν την έναρξη μιας 
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ξαφνικής αλλαγής, η οποία συνιστώσα οφείλεται στη συνολική ροή ευθέος άξονα του στάτη 

προς την τιμή της συνιστώσας ΕΡ του ρεύματος ευθέος άξονα του στάτη, τη στιγμή της 

ξαφνικής αλλαγής, με τη μηχανή στην ονομαστική της ταχύτητα. 

 

Μεταβατική αντίδραση ευθέος άξονα Χd΄ (κορεσμένη τιμή): Το πηλίκο της αρχικής τιμής της 

βασικής συνιστώσας ΕΡ της τάσης του στάτη, ακριβώς πριν την έναρξη μιας ξαφνικής 

αλλαγής, η οποία συνιστώσα οφείλεται στη συνολική ροή ευθέος άξονα του στάτη προς την 

τιμή της συνιστώσας ΕΡ του ρεύματος ευθέος άξονα του στάτη, τη στιγμή της ξαφνικής 

αλλαγής, με τη μηχανή στην ονομαστική της ταχύτητα και τις συνιστώσες ταχείας 

απόσβεσης κατά τους πρώτους κύκλους να αποκλείονται. 

 

Αντίδραση ευθέος άξονα Χd: Το πηλίκο της τιμής μόνιμης κατάστασης της βασικής 

συνιστώσας ΕΡ της τάσης του στάτη, η οποία συνιστώσα οφείλεται στη συνολική ροή ευθέος 

άξονα του στάτη, προς την τιμή του ρεύματος ευθέος άξονα του στάτη μετά την απόσβεση 

των μεταβατικών φαινομένων. 

 

Αντίσταση στάτη γεννήτριας Ra: Η αντίσταση του στάτη μιας σύγχρονης μηχανής, 

μετρημένη σε ΣΡ. 

 

Σύνθετη αντίσταση βραχυκύκλωσης Ζ: Το πηλίκο της ημιτονοειδούς τάσης ανά φάση σε ένα 

συμμετρικό ΕΡ. δίκτυο προς την ίδιας συχνότητας συνιστώσα ρεύματος βραχυκύκλωσης του 

δικτύου. 

 

Πηγή τάσης: Ενεργητικό στοιχείο που μπορεί να αναπαρασταθεί από μια ιδανική πηγή 

τάσης, ανεξάρτητη από όλα τα ρεύματα και τις τάσεις του κυκλώματος, σε σειρά με ένα 

παθητικό στοιχείο κυκλώματος. 

 

Ονομαστική τάση δικτύου Un: Τάση (πολική) από την οποία χαρακτηρίζεται ένα δίκτυο και 

στην οποία αναφέρονται συγκεκριμένα χαρακτηριστικά λειτουργίας (βλ. IEC 60038). 

 

Υπομεταβατική τάση στρεφόμενης μηχανής Ε΄΄: Η r.m.s. (ενεργός) τιμή της συμμετρικής 

εσωτερικής τάσης μιας μηχανής, η οποία είναι ενεργή πίσω από την υπομεταβατική σύνθετη 

αντίσταση Ζ΄΄ τη στιγμή του βραχυκυκλώματος. 

 

Μεταβατική τάση στρεφόμενης μηχανής Ε΄: Η r.m.s. (ενεργός) τιμή της συμμετρικής 

εσωτερικής τάσης μιας μηχανής, η οποία είναι ενεργή πίσω από τη μεταβατική σύνθετη 

αντίσταση Ζ΄ τη στιγμή του βραχυκυκλώματος. 

 

Ονομαστική τιμή (n): Κατάλληλη προσεγγιστική τιμή κάποιας ποσότητας, η οποία 

χρησιμοποιείται για τον χαρακτηρισμό ή τον προσδιορισμό ενός στοιχείου, συσκευής ή 

εξοπλισμού. 

 

Τιμή λειτουργίας (r): Τιμή κάποιας ποσότητας, η οποία προσδιορίζεται γενικά από τον 

κατασκευαστή, για μια συγκεκριμένη κατάσταση λειτουργίας ενός στοιχείου, συσκευής ή 

εξοπλισμού. 

 

Ισοδύναμη (-ος) γεννήτρια (κινητήρας): Φανταστική (ανύπαρκτη) μηχανή (κινητήρας) που 

έχει τα χαρακτηριστικά που θα δώσουν το ίδιο ρεύμα βραχυκύκλωσης σε οποιοδήποτε 

σημείο σε μια ηλεκτρολογική εγκατάσταση, με αυτό που θα έδινε ο συνδυασμός των 
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γεννητριών (κινητήρων) με διαφορετικά χαρακτηριστικά λειτουργίας, τα οποία είναι 

συνδεμένα στο δίκτυο. 

 

3.5.2.2 Σύμβολα 
 

Όλες οι εξισώσεις έχουν γραφτεί χωρίς να προσδιορίζονται οι μονάδες μέτρησης. Τα 

σύμβολα αντιπροσωπεύουν ποσότητες που έχουν και αριθμητικές τιμές και διαστάσεις που 

είναι ανεξάρτητες από τις μονάδες, δεδομένου ότι ένα σωστό σύστημα μονάδων επιλέγεται, 

δηλαδή “système international d’unités (SI)”. Στην περίπτωση της σύνθετης αντίστασης, 

αντίδρασης, αντίστασης και πτώσης τάσης, τα κεφαλαία γράμματα υποδηλώνουν απόλυτες 

τιμές και τα πεζά γράμματα υποδηλώνουν σχετικές τιμές (ανά μονάδα ή επί τοις εκατό (%)). 

Για χρονικά εξαρτημένες τιμές (ρεύμα, τάση), τα κεφαλαία γράμματα υποδηλώνουν r.m.s. 

(ενεργές) τιμές και τα πεζά γράμματα υποδηλώνουν στιγμιαίες τιμές. 

 

φ: Γωνία φάσης 

Εq΄΄, Eq΄: Υπομεταβατική και μεταβατική τάση εγκάρσιου q-άξονα γεννήτριας (r.m.s.) 

EM΄΄: Υπομεταβατική τάση κινητήρα (r.m.s.) 

F: Συχνότητα 

fr: Συχνότητα λειτουργίας του δικτύου 

IM΄΄: Υπομεταβατικό ρεύμα βραχυκύκλωσης ασύγχρονου κινητήρα (r.m.s.) 

Ikd΄΄, Ikd΄: Υπομεταβατικό και μεταβατικό αρχικό ρεύμα βραχυκύκλωσης σύγχρονης μηχανής 

(r.m.s.) 

I: Ρεύμα (r.m.s.) 

Iac: Συνιστώσα ΕΡ του ρεύματος βραχυκύκλωσης σύγχρονης μηχανής (r.m.s.) 

IacM: Συμμετρικό ρεύμα βραχυκύκλωσης ασύγχρονου κινητήρα (r.m.s.) 

idc: Συνιστώσα ΣΡ του ρεύματος βραχυκύκλωσης σύγχρονης μηχανής 

idcM: Συνιστώσα ΣΡ του ρεύματος βραχυκύκλωσης ασύγχρονου κινητήρα 

ik: Άνω περιβάλλουσα του ρεύματος βραχυκύκλωσης 

Ikd: Ρεύμα βραχυκύκλωσης μόνιμης κατάστασης σύγχρονης μηχανής (r.m.s.) 

iM: Άνω περιβάλλουσα του ρεύματος βραχυκύκλωσης ασύγχρονου κινητήρα 

ip, ipM: Κρουστική τιμή ρεύματος βραχυκύκλωσης σύγχρονης μηχανής και ασύγχρονου 

κινητήρα 

Ir: Ρεύμα λειτουργίας (r.m.s.) 

LC: Αυτεπαγωγή καλωδίων 

PCu: Απώλειες χαλκού του μετασχηματιστή στη συχνότητα λειτουργίας 

R: Αντίσταση 

Ra: Αντίσταση στάτη σύγχρονης μηχανής 

RC: Αντίσταση καλωδίου 

Rdc: Αντίσταση ΣΡ 

RM: Αντίσταση ασύγχρονου κινητήρα 

RR: Αντίσταση δρομέα (ρότορα) ασύγχρονου κινητήρα 

RS: Αντίσταση στάτη ασύγχρονου κινητήρα 

RT: Αντίσταση μετασχηματιστή 

SrT: Ισχύς λειτουργίας μετασχηματιστή 

t: Χρονική διάρκεια από την έναρξη του βραχυκυκλώματος 

tr: Λόγος μετασχηματισμού 

Td΄΄, Td΄: Υπομεταβατική και μεταβατική χρονική σταθερά σύγχρονης μηχανής 

Tdο΄΄, Tdο΄: Υπομεταβατική και μεταβατική χρονική σταθερά ανοιχτού κυκλώματος 

σύγχρονης μηχανής 
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Τe΄΄, Τe΄: Υπομεταβατική και μεταβατική χρονική σταθερά σύγχρονης μηχανής 

συμπεριλαμβάνοντας τα παθητικά στοιχεία 

ΤΜ΄΄: Υπομεταβατική χρονική σταθερά ασύγχρονου κινητήρα 

ΤΜe΄΄: Υπομεταβατική χρονική σταθερά ισοδύναμου κινητήρα συμπεριλαμβάνοντας τα 

καλώδια σύνδεσης 

Τdc: Χρονική σταθερά ΣΡ σύγχρονης μηχανής 

Τdce: Χρονική σταθερά ΣΡ σύγχρονης μηχανής συμπεριλαμβάνοντας τα παθητικά στοιχεία 

ΤdcM: Χρονική σταθερά ΣΡ ασύγχρονου κινητήρα 

ΤdcMe: Χρονική σταθερά ΣΡ ασύγχρονου κινητήρα συμπεριλαμβάνοντας τα καλώδια 

σύνδεσης 

Uo: Τάση (πολική) πριν το σφάλμα  

Un: Ονομαστική τάση (πολική) 

Ur: Τάση λειτουργίας (πολική) 

urk: Τάση βραχυκύκλωσης μετασχηματιστή 

UrM: Τάση λειτουργίας κινητήρα 

urR: Ωμική πτώση τάσης μετασχηματιστή 

ωr: 2πfr 

X: Επαγωγική αντίδραση 

Χd΄΄, Χd΄: Υπομεταβατική και μεταβατική αντίδραση ευθέος άξονα σύγχρονης μηχανής 

ΧΜ΄΄: Υπομεταβατική αντίδραση ασύγχρονου κινητήρα 

ΧMe΄΄: Υπομεταβατική αντίδραση ασύγχρονου κινητήρα συμπεριλαμβάνοντας τα καλώδια 

σύνδεσης 

Χd: Αντίδραση σύγχρονης μηχανής ευθέος άξονα 

ΧR, XS: Επαγωγική αντίδραση στάτη και δρομέα ασύγχρονου κινητήρα 

XT: Επαγωγική αντίδραση μετασχηματιστή 

Z: Σύνθετη αντίσταση 

Zd΄΄, Zd΄: Υπομεταβατική και μεταβατική σύνθετη αντίδραση σύγχρονης μηχανής 

Ze΄΄, Ze΄: Υπομεταβατική και μεταβατική σύνθετη αντίδραση σύγχρονης μηχανής 

συμπεριλαμβάνοντας και τα παθητικά στοιχεία 

ZM΄΄: Υπομεταβατική σύνθετη αντίσταση ασύγχρονου κινητήρα 

ZT: Σύνθετη αντίσταση μετασχηματιστή 

 

3.5.2.3 Δείκτες και εκθέτες 
 

Ακολούθως, δίνονται οι χρησιμοποιούμενοι δείκτες και εκθέτες. 

 

0: Συνθήκες λειτουργίας πριν το σφάλμα 

ac: Εναλλασσόμενο ρεύμα 

C: Καλώδιο 

d: Ευθύς άξονας 

dc: Συνεχές ρεύμα 

e: Τιμή που συμπεριλαμβάνει παθητικά στοιχεία (εξωτερικά) 

UIE ,, : Φασιθέτες των Ε, Ι, U 

G: Σύγχρονη γεννήτρια 

HV: Πλευρά υψηλής τάσης του μετασχηματιστή 

i: Αριθμός γεννητριών 

j: Αριθμός κινητήρων 

k: Βραχυκύκλωμα 

L: Αυτεπαγωγή 

LV: Πλευρά χαμηλής τάσης μετασχηματιστή 



70 
 

M: Ασύγχρονος κινητήρας ή ομάδα κινητήρων 

n: Ονομαστική τιμή 

q: Εγκάρσιος άξονας 

R: Δρομέας ασύγχρονου κινητήρα 

r: Τιμή λειτουργίας 

S: Στάτης ασύγχρονου κινητήρα 

T: Μετασχηματιστής 

Z : Μιγαδική σύνθετη αντίσταση 

 

΄΄: Υπομεταβατική τιμή 

΄: Μεταβατική τιμή 

 

 

3.5.3 Εισαγωγικές πληροφορίες 
 

3.5.3.1 Γενικά 
 

Σύμφωνα με την ενότητα 4.1 του διεθνούς προτύπου IEC 61363-1, ο προγραμματισμός, ο 

σχεδιασμός και η λειτουργία μιας ναυτικής ή υπεράκτιας ηλεκτρολογικής εγκατάστασης 

μπορεί να απαιτεί αρκετές μελέτες για την εκτίμηση της απόδοσης, της αξιοπιστίας, της 

ασφάλειας και της λειτουργίας του δικτύου υπό κανονικές συνθήκες αλλά και υπό συνθήκες 

βραχυκυκλώματος. Τέτοιες μελέτες μπορεί να αφορούν τη ροή φορτίου, την ευστάθεια, την 

εκκίνηση των κινητήρων, τις μεταβατικές καταστάσεις, τη γείωση ή τις αρμονικές. Ο 

μηχανικός που σχεδιάζει το δίκτυο αποφασίζει ποιες μελέτες απαιτούνται για κάθε 

συγκεκριμένη εγκατάσταση. Οι μελέτες βραχυκυκλωμάτων είναι αυτές που απαιτούνται 

περισσότερο στα ναυτικά ή υπεράκτια δίκτυα, ανεξαρτήτως μεγέθους και πολυπλοκότητας. 

 

Σε ένα πραγματικό δίκτυο, οι επιδράσεις ελέγχου των αυτόματων ρυθμιστών και της μη 

γραμμικότητας των παράλληλα συνδεμένων μηχανών θα επηρεάσουν τα προκύπτοντα 

ρεύματα. Το να υπολογισθούν με ακρίβεια τα ρεύματα που προκύπτουν από αυτές τις 

επιδράσεις είναι πέρα από το σκοπό αυτού του προτύπου, και θα έπρεπε να γίνει με τη χρήση 

τεχνικών προσομοίωσης σε υπολογιστές. 

 

Το ηλεκτρικό δίκτυο μιας ναυτικής και υπεράκτιας κατασκευής θα έπρεπε να σχεδιαστεί έτσι 

ώστε να εξασφαλίζει ότι λαμβάνονται όλες οι πιθανές προφυλάξεις για την αποφυγή 

ανάπτυξης ρευμάτων βραχυκύκλωσης. Ο κύριος στόχος υπολογισμού του ρεύματος 

βραχυκύκλωσης είναι να εξασφαλίσει ότι το δίκτυο και τα στοιχεία του είναι ικανά να 

αντέξουν τις επιδράσεις των καταστάσεων βραχυκυκλώματος και, ως εκ τούτου, να 

περιορίσουν οποιαδήποτε προκύπτουσα ζημιά στο ελάχιστο. Η προστασία του δικτύου από 

ρεύμα βραχυκύκλωσης παρέχεται συνήθως από ασφάλειες και διακόπτες. Η κύρια πρόθεση 

αυτών των υπολογισμών είναι να παρέχουν επαρκείς πληροφορίες ώστε να καταστήσουν 

ικανή την επιλογή αυτών των συσκευών με την πεποίθηση ότι είναι ικανές να προσφέρουν 

την αναγκαία προστασία. Επιπλέον, οι υπολογισμοί μπορούν να χρησιμοποιηθούν για να 

βοηθήσουν στην επιλογή συσκευών ικανών για τον περιορισμό του ρεύματος 

βραχυκύκλωσης εντός των ορίων των δυνατοτήτων των προστατευτικών συσκευών. 

 

Κατά τον υπολογισμό ρευμάτων βραχυκύκλωσης, είναι σημαντικό να κατανοήσουμε τη 

διαφορά μεταξύ ενός ρεύματος βραχυκύκλωσης που παράγεται από ένα μεμονωμένο κομμάτι 

ενός εξοπλισμού, και του ρεύματος βραχυκύκλωσης που προκύπτει όταν αρκετά κομμάτια 

ενός εξοπλισμού είναι συνδεμένα στο δίκτυο. Όταν πρόκειται για μια μεμονωμένη μηχανή, 
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μόνο οι ηλεκτρικοί παράμετροι της μηχανής επηρεάζουν το αναπτυσσόμενο ρεύμα 

βραχυκύκλωσης. Σε ένα δίκτυο όμως, αυτό το ρεύμα περιορίζεται από την σύνθετη 

αντίσταση των μη-ενεργητικών στοιχείων, για παράδειγμα, καλώδια, μετασχηματιστές, κλπ, 

που διαμορφώνουν το δίκτυο, αλλάζοντας ταυτόχρονα τις μεταβατικές και μονίμου 

καταστάσεως τιμές του προκύπτοντος ρεύματος βραχυκύκλωσης. 

 

Η πλειονότητα των ναυτικών και υπεράκτιων ηλεκτρικών δικτύων λειτουργούν με τον 

ουδέτερο κόμβο μονωμένο από τη γάστρα ή συνδεμένο μέσω μιας σύνθετης αντίστασης. Σε 

τέτοια δίκτυα, η υψηλότερη τιμή του ρεύματος βραχυκύκλωσης είναι για τριφασικό 

βραχυκύκλωμα. Εάν ο ουδέτερος είναι απευθείας συνδεμένος στη γάστρα, τότε το ρεύμα που 

παράγεται από βραχυκύκλωμα μεταξύ γραμμής-γραμμής-γάστρας πλοίου ή γραμμής-

γάστρας πλοίου μπορεί να είναι υψηλότερο. 

 

3.5.3.2 Ακρίβεια υπολογισμών 
 

Η ενότητα 4.2 του IEC 61363-1 μας πληροφορεί ότι η ενότητα 5 του προτύπου (παράγραφος 

3.5.4 της εργασίας) περιγράφει τις εξισώσεις υπολογισμού ρεύματος βραχυκύκλωσης 

διάφορων ενεργητικών στοιχείων του δικτύου. 

 

Κατά την ανάλυση των αποτελεσμάτων των υπολογισμών, προσοχή πρέπει να δοθεί στην 

εγγενή ακρίβεια που περιλαμβάνεται στον προσδιορισμό των χαρακτηριστικών παραμέτρων 

των ενεργητικών στοιχείων, τα οποία καθορίζουν το μέγεθος του ρεύματος βραχυκύκλωσης. 

Οι αποδεκτές ανοχές για την υπομεταβατική και μεταβατική σύνθετη αντίσταση μπορούν να 

αλλάξουν το υπολογισμένο ρεύμα βραχυκύκλωσης σε μεγαλύτερο βαθμό από τις αποδεκτές 

ανοχές των χρονικών σταθερών. Οι εξισώσεις των ενεργητικών στοιχείων που 

αναπτύσσονται σε αυτό το πρότυπο θεωρούνται ότι περιγράφουν τις συνθήκες τριφασικού 

βραχυκυκλώματος με επαρκή ακρίβεια για πραγματικές εφαρμογές. 

 

Όταν πρόκειται για τους υπολογισμούς του δικτύου, η ακρίβεια του τελικού αποτελέσματος 

εξαρτάται όχι μόνο από την εγγενή ακρίβεια των χαρακτηριστικών παραμέτρων των 

στοιχείων, αλλά και από τη μέθοδο υπολογισμού, τον υπολογιστικό τύπο και τη σημασία 

ενός συγκεκριμένου στοιχείου στο δίκτυο σε σχέση με την ικανότητά του να παράγει ή να 

αποσβένει το ρεύμα βραχυκύκλωσης. Παραδοχές μπορούν να γίνουν προκειμένου να 

απλοποιηθούν οι διαδικασίες υπολογισμού (βλ. ενότητα 6 του προτύπου, παράγραφο 3.5.5 

της εργασίας), αλλά οι απλοποιήσεις θα έχουν ως αποτέλεσμα την απώλεια ακρίβειας. Καλές 

απλοποιήσεις θα παράγουν συντηρητικά αποτελέσματα που οδηγούν σε υψηλότερες τιμές 

του ρεύματος βραχυκύκλωσης από αυτό που θα έρεε πραγματικά στο φυσικό σύστημα. 

 

3.5.3.3 Βασικές παραδοχές 
 

Σύμφωνα με την ενότητα 4.3 του διεθνούς προτύπου IEC 61363-1, ένας ολοκληρωμένος 

υπολογισμός ρεύματος βραχυκύκλωσης θα έπρεπε να δίνει την τιμή του ρεύματος σε κάθε 

σημείο στο χρόνο, από την έναρξη μέχρι τη λήξη. Ο υπολογισμός θα έπρεπε να δίνει 

προσοχή στις συνθήκες φόρτισης πριν το βραχυκύκλωμα, τα εγγενή χαρακτηριστικά των 

ενεργητικών στοιχείων, τις αποσβεστικές επιδράσεις των παθητικών στοιχείων, και τις 

στιγμιαίες τάσεις στα διαφορετικά σημεία του δικτύου στην αρχή του βραχυκυκλώματος. 

 

Τέτοιος υπολογισμός θεωρείται περιττός για τους περισσότερους πρακτικούς μηχανικούς 

σκοπούς και αντίστοιχα εκτός του πεδίου αυτού του προτύπου. 
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Οι σχέσεις που περιγράφονται στο παρόν, υπολογίζουν την άνω περιβάλλουσα των μέγιστων 

τιμών του χρονικά εξαρτημένου ρεύματος βραχυκύκλωσης (βλ. Εικόνα 3.3). Η 

περιβάλλουσα υπολογίζεται χρησιμοποιώντας συγκεκριμένες χαρακτηριστικές παραμέτρους 

της μηχανής, οι οποίες μπορούν να αποκτηθούν από τους κατασκευαστές του εξοπλισμού, 

που χρησιμοποιούν αναγνωρισμένες μεθόδους δοκιμής, και εφαρμόζοντας τις παρακάτω 

παραδοχές: 

a) Όλες οι χωρητικότητες του δικτύου έχουν αμεληθεί 

b) Στην έναρξη του βραχυκυκλώματος, η στιγμιαία τάση σε μια φάση στο σημείο 

σφάλματος είναι μηδενική 

c) Κατά τη διάρκεια του βραχυκυκλώματος, δεν υπάρχει αλλαγή στη διαδρομή του 

ρεύματος βραχυκύκλωσης 

d) Η σύνθετη αντίσταση του τόξου κατά το βραχυκύκλωμα έχει αμεληθεί 

e) Οι μετασχηματιστές έχουν τεθεί σε ονομαστική λήψη τάσης 

f) Το βραχυκύκλωμα συμβαίνει ταυτόχρονα και στις τρεις φάσεις 

g) Για γεννήτριες συνδεμένες παράλληλα, όλες οι γεννήτριες μοιράζονται το ενεργό και 

άεργο φορτίο αναλογικά κατά την έναρξη και κατά τη διάρκεια του 

βραχυκυκλώματος 

h) Κατά τη διάρκεια κάθε διακριτού χρονικού διαστήματος, όλα τα στοιχεία του 

κυκλώματος αντιδρούν γραμμικά. 

 

Με τις παραπάνω παραδοχές, τα αποτελέσματα των υπολογισμών θεωρούνται ικανοποιητικά 

ώστε να πετύχουν τους σκοπούς αυτού του προτύπου. 

 

Η περιβάλλουσα του ρεύματος βραχυκύκλωσης περιγράφεται συνήθως κατά τη διάρκεια των 

πρώτων λίγων χιλιοστών του δευτερολέπτου (ms) από την έναρξη του σφάλματος 

(υπομεταβατική περίοδος), μετά στα επόμενα ms (μεταβατική περίοδος) και, τέλος, κατά τα 

επόμενα δευτερόλεπτα (s) (περίοδος μόνιμης κατάστασης) του σφάλματος. Το ρεύμα 

βραχυκύκλωσης που παράγεται από μια σύγχρονη γεννήτρια επηρεάζεται πολύ από τα 

χαρακτηριστικά του ρυθμιστή τάσης της. Για να υπολογίσει κανείς την ακριβή επίδραση του 

ρυθμιστή απαιτούνται ακριβείς πληροφορίες για το σχεδιασμό του ρυθμιστή, και οι τελικές 

εξισώσεις δεν μπορούν να εκτιμηθούν εύκολα. Η τιμή μόνιμης κατάστασης του ρεύματος 

βραχυκύκλωσης που προκύπτει λαμβάνοντας υπόψη το ρυθμιστή μπορεί, ωστόσο, να 

αποκτηθεί από τον κατασκευαστή της γεννήτριας. 

 

Για τη συμμετρική τριφασική κατάσταση σφάλματος, μόνο οι συνιστώσες θετικής 

ακολουθίας των στοιχείων του δικτύου πρέπει να ληφθούν υπόψη. 

 

3.5.3.4 Μέθοδοι υπολογισμού 
 

Κατά την ενότητα 4.4 του διεθνούς προτύπου IEC 61363-1, οι σχέσεις που αναπτύσσονται 

στην ενότητα 5 (παράγραφος 3.5.4 της εργασίας) θεωρούνται ως οι πιο κατάλληλες για τον 

υπολογισμό των ρευμάτων βραχυκύκλωσης. Όταν δεν είναι διαθέσιμες όλες οι πληροφορίες, 

οι σχέσεις αυτές δεν μπορούν να χρησιμοποιηθούν, εκτός και αν απλοποιηθούν. 

Οποιαδήποτε απλοποίηση γενικά συμπεραίνει μια προσέγγιση ή αμέλεια συγκεκριμένων 

παραμέτρων και συνεπώς αυτό προκαλεί ανακρίβειες στα αποτελέσματα των υπολογισμών. 

Η ενότητα 6 (παράγραφος 3.5.5 της εργασίας) περιγράφει διάφορες απλοποιήσεις και δίνει 

μια ένδειξη για τις προκύπτουσες ανακρίβειες. Η ενότητα 8 (παράγραφος 3.5.6 της εργασίας) 

περιγράφει την εφαρμογή αυτών των τύπων στους υπολογισμούς του δικτύου. 
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Δύο βασικές υπολογιστικές προσεγγίσεις μπορούν να ληφθούν, χρονικά εξαρτημένη και 

χρονικά ανεξάρτητη. Σε κάποιες περιπτώσεις, η χρονικά εξαρτημένη φύση του ρεύματος 

βραχυκύκλωσης μπορεί να αμεληθεί. Ωστόσο, όταν απαιτείται μια ακριβής ανάλυση, για 

παράδειγμα για τον διατίμηση των αυτόματων διακοπτών τύπου μη- περιορισμένου ρεύματος 

(όπως στα δίκτυα χαμηλής τάσης) ή όταν η συνιστώσα ΣΡ είναι σημαντική (όπως στα δίκτυα 

μέσης τάσης), απαιτείται ένας χρονικά εξαρτημένος υπολογισμός. 

 

Και για τις δύο μεθόδους υπολογισμού, το δίκτυο χωρίζεται σε ενεργητικά και παθητικά 

στοιχεία. Τα ενεργητικά στοιχεία είναι πηγή ρεύματος βραχυκύκλωσης, ενώ τα παθητικά 

στοιχεία μεταδίδουν ή μετασχηματίζουν το ρεύμα βραχυκύκλωσης ώστε να διανεμηθεί από 

την πηγή στο σημείο του σφάλματος. Κάθε στοιχείο αναπαρίσταται με ένα μαθηματικό 

μοντέλο διαμορφωμένο από τις χαρακτηριστικές παραμέτρους του. 

 

Παράλληλα συνδεμένα στοιχεία όπως κινητήρες και γεννήτριες, με όμοια χαρακτηριστικά 

λειτουργίας, μπορούν να θεωρηθούν ως μια ενιαία μηχανή. Για να ολοκληρωθεί ένας 

χρονικά εξαρτημένος υπολογισμός για ένα δίκτυο που περιλαμβάνει ανόμοια ενεργητικά 

στοιχεία, η μέθοδος της ισοδύναμης γεννήτριας θα πρέπει να χρησιμοποιηθεί. 

 

Για κινητήρες, είναι αναγκαίο να γίνει διαχωρισμός μεταξύ «μικρών» και «μεγάλων» 

κινητήρων. Μια ομάδα από μικρούς κινητήρες συνδεμένους σε ένα κοινό σημείο διανομής 

μπορεί να θεωρηθεί σαν ένας ισοδύναμος κινητήρας στο σημείο διανομής. Οι μεγάλοι 

κινητήρες θα πρέπει να θεωρούνται σαν ξεχωριστές πηγές ρεύματος βραχυκύκλωσης. 

 

 

3.5.4 Στοιχεία του δικτύου και μοντέλα 
 

3.5.4.1 Ενεργητικά στοιχεία 
 

3.5.4.1.1 Σύγχρονες μηχανές 
 

Η παράγραφος 5.1.1 του διεθνούς προτύπου IEC 61363-1 ορίζει ότι οι σύγχρονες μηχανές, 

που χρησιμοποιούνται σε ναυτικές και υπεράκτιες ηλεκτρολογικές εγκαταστάσεις, 

περιλαμβάνουν σύγχρονες γεννήτριες, κινητήρες και συμπυκνωτές. Η γνώση του ρεύματος 

βραχυκύκλωσης που παράγεται από αυτές τις μηχανές είναι θεμελιώδης για τον υπολογισμό 

του ρεύματος βραχυκύκλωσης σε ένα ηλεκτρικό δίκτυο. 

 

Κατά τη διάρκεια των πρώτων κύκλων του βραχυκυκλώματος όλες οι σύγχρονες μηχανές 

ανταποκρίνονται με παρόμοιο τρόπο και αντίστοιχα το ρεύμα βραχυκύκλωσης που 

παράγεται έχει τα ίδια βασικά χαρακτηριστικά. 

 

Οι σύγχρονες μηχανές είναι είτε σύνθετης είτε παράλληλης διέγερσης. Για παράλληλης 

διέγερσης μηχανές, το ρεύμα διέγερσης μπορεί να μηδενισθεί κατά τη διάρκεια 

βραχυκυκλώματος, με αποτέλεσμα την απώλεια του ρεύματος βραχυκύκλωσης. Σε μηχανές 

σύνθετης διέγερσης, το ρεύμα βραχυκύκλωσης χρησιμοποιείται για τον έλεγχο και τη 

διατήρηση του ρεύματος διέγερσης. Αντίστοιχα, για γεννήτριες παράλληλης και σύνθετης 

διέγερσης με όμοια χαρακτηριστικά, η γεννήτρια σύνθετης διέγερσης θα δώσει μεγαλύτερες 

τιμές ρεύματος βραχυκύκλωσης όταν οι υπομεταβατικές επιδράσεις έχουν αποσβέσει. 
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Για τον υπολογισμό του τελικού τριφασικού ρεύματος βραχυκύκλωσης μίας σύγχρονης 

μηχανής, οι χαρακτηριστικές παράμετροι συνδέονται σε ένα θετικής ακολουθίας κύκλωμα, 

όπως φαίνεται στην Εικόνα 3.2. 

 

 
Εικόνα 3.2 Κύκλωμα θετικής ακολουθίας σύγχρονης μηχανής 

 

Ο υπολογισμός του ρεύματος βραχυκύκλωσης για μια σύγχρονη μηχανή βασίζεται στην 

εκτίμηση της περιβάλλουσας των μέγιστων τιμών του πραγματικού χρονικά εξαρτημένου 

ρεύματος βραχυκύκλωσης της μηχανής. Η προκύπτουσα περιβάλλουσα είναι μια συνάρτηση 

των βασικών παραμέτρων της μηχανής (ισχύς, σύνθετη αντίσταση, κ.λπ.) και των ενεργών 

τάσεων ( EÉ΄΄E ,, ) πίσω από την υπομεταβατική, μεταβατική και μόνιμης κατάστασης 

σύνθετη αντίσταση της μηχανής. Οι σύνθετες αντιστάσεις εξαρτώνται από τις συνθήκες 

λειτουργίας της μηχανής αμέσως πριν την έναρξη του βραχυκυκλώματος. 

 

a) Ενεργές τάσεις 

 

Για έναν ακριβή υπολογισμό, οι ενεργές τάσεις θα πρέπει να θεωρηθούν και στον ευθύ και 

στον εγκάρσιο άξονα, κατά την υπομεταβατική και μεταβατική περίοδο ( ΄E΄΄E΄E΄΄E qqdd ,,, ), 

και να εκτιμηθούν λαμβάνοντας υπόψη τις τάσεις λόγω των ρευμάτων των συνθηκών 

φόρτισης πριν το σφάλμα, που δρουν στη σύνθετη αντίσταση ευθέος και εγκάρσιου άξονα 

κατά τις υπομεταβατικές και μεταβατικές περιόδους. 

 

b) Σύνθετη αντίσταση μηχανής 

 

Η σύνθετη αντίσταση μηχανής περιλαμβάνει και την αντίσταση και την αντίδραση που 

δρουν στον ευθύ και εγκάρσιο άξονα. Μολονότι, για λόγους υπολογισμού, η αντίδραση της 

μηχανής θεωρείται σταθερή, είναι σταθερή μόνο για τις αντίστοιχες υπομεταβατικές, 

μεταβατικές και μόνιμης κατάστασης περιόδους του ρεύματος βραχυκύκλωσης. 

 

c) Υπομεταβατική και μεταβατική χρονική σταθερά βραχυκυκλώματος 

 

Η απόσβεση της συνιστώσας ΕΡ του ρεύματος βραχυκύκλωσης χαρακτηρίζεται από τις 

υπομεταβατικές και μεταβατικές σταθερές χρόνου της μηχανής. Η υπομεταβατική σταθερά 

χρόνου Τd΄΄ σχετίζεται με την αρχική απόσβεση της συνιστώσας ΕΡ του ρεύματος 

βραχυκύκλωσης, και εξαρτάται από τις αποσβεστικές επιδράσεις του κυκλώματος του 

δρομέα (κυρίως του τυλίγματος απόσβεσης). Η μεταβατική σταθερά χρόνου Τd΄ σχετίζεται 

με την απόσβεση της συνιστώσας ΕΡ του ρεύματος βραχυκύκλωσης. Εξαρτάται κυρίως από 

τις αποσβεστικές επιδράσεις του κυκλώματος διέγερσης. Η χρονική σταθερά ΣΡ Τdc 
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σχετίζεται με την απόσβεση της απεριοδικής συνιστώσας του ρεύματος βραχυκύκλωσης και 

εξαρτάται από τα αποσβεστικά χαρακτηριστικά του κυκλώματος του στάτη. 

 

Η κατάσταση τριφασικού ρεύματος βραχυκύκλωσης προκύπτει όταν και οι τρεις φάσεις 

βραχυκυκλώνονται ταυτόχρονα. Το προκύπτον ρεύμα σε κάθε φάση είναι μια σύνθετη 

χρονικά εξαρτημένη συνάρτηση. Το ρεύμα περιέχει και συνιστώσες ΕΡ και ΣΡ, όπως τυπικά 

φαίνονται στην Εικόνα 3.3. 

 

 
Ik΄΄: Αρχικό συμμετρικό ρεύμα βραχυκύκλωσης 

ip: Κρουστικό ρεύμα βραχυκύκλωσης 

Ik: Ρεύμα βραχυκύκλωσης μόνιμης κατάστασης 

idc: Αποσβεννύμενη (απεριοδική) συνιστώσα του ρεύματος βραχυκύκλωσης 

Α: Αρχική τιμή της απεριοδικής συνιστώσας 
Εικόνα 3.3 Τυπική κυματομορφή ρεύματος βραχυκύκλωσης σύγχρονης γεννήτριας 

 

Το ρεύμα σε οποιοδήποτε σημείο στο χρόνο εξαρτάται από τις στιγμιαίες τιμές των 

χαρακτηριστικών της μηχανής, όπως έχει περιγραφεί παραπάνω. Για μία κατάσταση 

τριφασικού ρεύματος βραχυκύκλωσης, μόνο το κύκλωμα θετικής ακολουθίας (Εικόνα 3.2) 

λαμβάνεται υπόψη. 

 

Προκειμένου να εκτιμηθεί το ρεύμα βραχυκύκλωσης με ακρίβεια, πρέπει να ληφθούν υπόψη 

τα χαρακτηριστικά της μηχανής και στον ευθύ και στον εγκάρσιο άξονα. Τέτοιος 

υπολογισμός είναι εξαιρετικά σύνθετος και η πρόσθετη ακρίβεια, που προσφέρει έναντι 

άλλων υπολογιστικών μεθόδων, δε δικαιολογεί την εργασία που απαιτείται. 

 

Αν οι συνιστώσες του ρεύματος στον εγκάρσιο άξονα αμεληθούν, τα αποτελέσματα θα είναι 

μέσα στο +10% των αποτελεσμάτων που θα λαμβάναμε αν συμπεριλαμβάνονται οι 

συνιστώσες του εγκάρσιου άξονα. 

 

Οι μέγιστες τιμές του ρεύματος βραχυκύκλωσης θα προκύψουν όταν η φόρτιση της 

γεννήτριας πριν το σφάλμα είναι σε επίπεδο τιμής λειτουργίας φορτίου, τάσης, συχνότητας 

και συντελεστή ισχύος. 

 

Αν η μηχανή πριν το σφάλμα λειτουργεί σε επίπεδα κάτω από την ενεργό ισχύ λειτουργίας 

αλλά πάνω από την άεργο ισχύ λειτουργίας, το υπερτιμημένο επίπεδο διέγερσης θα 
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προκαλέσει ρεύματα βραχυκύκλωσης που ξεπερνούν τις μέγιστες τιμές των ρευμάτων 

βραχυκύκλωσης που αναφέρονται πιο πάνω. 

 

Κατά τον υπολογισμό του ρεύματος βραχυκύκλωσης, μόνο οι μέγιστες τιμές του ρεύματος 

θεωρούνται. Η Εικόνα 3.3 δείχνει ότι οι μέγιστες τιμές μεταβάλλονται σαν μια συνάρτηση 

του χρόνου κατά μήκος της άνω περιβάλλουσας της σύνθετης χρονικά εξαρτημένης 

συνάρτησης. Το ρεύμα, το οποίο ορίζεται από αυτή την άνω περιβάλλουσα, υπολογίζεται 

από την εξίσωση: 

 

 
 

(3.2) 

 

 

Για κανονικές εφαρμογές είναι σύνηθες να υπολογίζονται τρεις συναρτήσεις από αυτή την 

περιβάλλουσα, η συνιστώσα ΕΡ Iac(t), η συνιστώσα ΣΡ Idc(t) και η μέγιστη δυνατή κρουστική 

τιμή ip. 

 

a) H συνιστώσα ΕΡ Iac(t) 

 

Είναι η κυρίαρχη συνιστώσα του ρεύματος και μειώνεται χρονικά, κυρίως λόγω του ότι τα 

επαγωγικά στοιχεία των μηχανών από τις αρχικά πολύ χαμηλές τιμές αποκαθίστανται στις 

τιμές μόνιμης κατάστασης. 

 

Η συνάρτηση της συνιστώσας ΕΡ Iac(t) χαρακτηρίζεται από τα υπομεταβατικά, μεταβατικά 

και μόνιμης κατάστασης ρεύματα κατά τη διάρκεια των υπομεταβατικών και μεταβατικών 

χρονικών περιόδων. Αυτές οι χρονικές περίοδοι ορίζονται από τις υπομεταβατικές και 

μεταβατικές χρονικές σταθερές ευθέος άξονα Τd΄΄ και Τd΄. 

 

 
 

(3.3) 

 

 

Οι υπομεταβατικές και μεταβατικές αρχικές τιμές του τριφασικού ρεύματος βραχυκύκλωσης 

Ikd΄΄ και Ikd΄ μπορούν να υπολογιστούν χρησιμοποιώντας τις ενεργές τάσεις πίσω από τις 

αντίστοιχες σύνθετες αντιστάσεις, μέσω των εξισώσεων (3.4) και (3.5). 

 

 

 

(3.4) 

 

 

(3.5) 

 

 

Το ρεύμα Ikd=Ik, που είναι το ρεύμα βραχυκύκλωσης μόνιμης κατάστασης, θα πρέπει γενικά 

να λαμβάνεται από τον κατασκευαστή. Στην παρούσα εργασία υπολογίζεται από την 

παρακάτω εξίσωση: 

 

 

 

(3.6) 
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Οι ενεργές τάσεις Εq0΄΄ και Εq0΄ εξαρτώνται από το ρεύμα φόρτισης πριν το σφάλμα και 

μπορούν να υπολογιστούν χρησιμοποιώντας τις εξισώσεις (3.7) και (3.8), που προκύπτουν 

από τις διανυσματικές εξισώσεις (3.9) και (3.10). 

 

 

 

(3.7) 

 

 

(3.8) 

 
 

(3.9) 

 
 

(3.10) 

 

 

Αντίστοιχα, στην παρούσα εργασία η ενεργή τάση υπολογίζεται από τις σχέσεις (3.11) και 

(3.12): 

 

 

 

(3.11) 

 
 

(3.12) 

 

όπου: 

 

 

 

(3.13) 

 

(3.14) 

 

 

Αντίστοιχα, χρησιμοποιείται η σχέση: 

 

 
 

(3.15) 

 

 

Αν η σύγχρονη μηχανή λειτουργεί στην ονομαστική τάση του δικτύου και στο ρεύμα 

λειτουργίας της πριν το βραχυκύκλωμα, τότε U0=Un και I0=Ir. 

 

b) Η συνιστώσα ΣΡ Idc(t) 

 

Είναι υπεύθυνη για την ασυμμετρία της κυματομορφής του ρεύματος βραχυκύκλωσης ως 

προς τον άξονα των χρόνων, καθώς οφείλεται στις αρχικές συνθήκες του προβλήματος, ενώ 

αποσβέννυται μετά τους πρώτους λίγους κύκλους (~60ms). Ο ρόλος της είναι ιδιαίτερα 

σημαντικός στη στιγμιαία τιμή (κρουστικό ρεύμα βραχυκύκλωσης) κατά την έναρξη του 

βραχυκυκλώματος (υπομεταβατική κατάσταση), οπότε δεν μπορεί να αμεληθεί στις μελέτες 

διαστασιολόγησης των διακοπτικών στοιχείων. Στη μεταβατική κατάσταση προοδευτικά 

μηδενίζεται. 

 

Η συνιστώσα ΣΡ Idc(t) μπορεί να υπολογιστεί από την εξίσωση (3.16). 
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(3.16) 

 

 

c) Η κρουστική τιμή ip 

 

Η κρουστική τιμή του ρεύματος βραχυκύκλωσης εμφανίζεται μεταξύ του χρόνου t=0 και 

t=T/2 της κατάστασης βραχυκυκλώματος. Ο ακριβής χρόνος εξαρτάται από τις συνθήκες 

φόρτισης πριν το σφάλμα, τη σύνθετη αντίσταση των γεννητριών και τις χρονικές σταθερές. 

Ωστόσο, είναι αποδεκτό να υπολογιστεί η τιμή ip στο χρόνο Τ/2, δηλαδή στην πρώτη 

ημιπερίοδο του βραχυκυκλώματος, χρησιμοποιώντας την εξίσωση (3.17). 

 

 
 

(3.17) 

 

 

3.5.4.1.2 Ασύγχρονοι κινητήρες 
 

Η παράγραφος 5.1.2 του διεθνούς προτύπου IEC 61363-1 ορίζει ότι οι ασύγχρονοι κινητήρες 

μπορούν να θεωρηθούν ως δύο ευρείες κατηγορίες: μεγάλοι κινητήρες και μικροί κινητήρες. 

Η ομαδοποίηση εξαρτάται από την ισχύ των γεννητριών του συστήματος και τα πραγματικά 

χαρακτηριστικά λειτουργίας του κινητήρα. Οι κινητήρες της πρόωσης, των αντλιών φορτίου, 

των γερανών και βαρέων μηχανημάτων, είναι συνήθως «μεγάλοι» κινητήρες, ενώ οι 

κινητήρες που τροφοδοτούν τα βοηθητικά συστήματα των πλοίων (αντλίες μεταφοράς 

καυσίμων, διαχωριστήρες, κ.λπ.) είναι «μικροί» κινητήρες. 

 

Όταν γίνεται ένα βραχυκύκλωμα σε ένα σύστημα, όλοι οι κινητήρες, που είναι συνδεμένοι τη 

στιγμή του βραχυκυκλώματος, συνεισφέρουν στο ρεύμα βραχυκύκλωσης. Οι μεγάλοι 

κινητήρες πρέπει να αξιολογηθούν ξεχωριστά. Οι μικροί κινητήρες μπορούν να 

ομαδοποιηθούν και να αντιμετωπιστούν ως μια ισοδύναμη πηγή. 

 

Ένας μεγάλος κινητήρας αντιμετωπίζεται με τον ίδιο τρόπο όπως μια γεννήτρια, 

χρησιμοποιώντας τις χαρακτηριστικές του παραμέτρους για τον υπολογισμό της άνω 

περιβάλλουσας του μέγιστου ρεύματος που παράγεται κατά την κατάσταση 

βραχυκυκλώματος. 

 

Για καταστάσεις τριφασικού σφάλματος βραχυκύκλωσης, μόνο το κύκλωμα θετικής 

ακολουθίας λαμβάνεται υπόψη (Εικόνα 3.4). 

 

 
Εικόνα 3.4 Κύκλωμα θετικής ακολουθίας ασύγχρονου κινητήρα 
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Για τριφασικά βραχυκυκλώματα, οι ασύγχρονοι κινητήρες συνεισφέρουν ρεύμα 

βραχυκύκλωσης για μια μικρή χρονική περίοδο. Το ρεύμα βραχυκύκλωσης εξαρτάται από 

την εσωτερική υπομεταβατική ενεργή τάση, τη σύνθετη αντίσταση και τις χρονικές 

σταθερές, και περιλαμβάνει συνιστώσες ΕΡ και ΣΡ, οι οποίες αποσβένουν κάτω από τις 

κατάλληλες υπομεταβατικές και ΣΡ χρονικές σταθερές. 

 

Η ωμική αντίσταση και η επαγωγική αντίδραση του κινητήρα, που φαίνονται στο κύκλωμα 

θετικής ακολουθίας (βλ. Εικόνα 3.4), είναι η ωμική αντίσταση και η επαγωγική αντίδραση 

του στάτη και του δρομέα του κινητήρα, ανηγμένες στην τάση του στάτη, για παράδειγμα σε 

ολίσθηση s=1. 

 

 

 

(3.18) 

 

(3.19) 

 

 

Η υπομεταβατική χρονική σταθερά TM΄΄ σχετίζεται με την ταχεία απόσβεση της συνιστώσας 

ΕΡ. Εξαρτάται κυρίως από την αποσβεστική επίδραση του κυκλώματος του δρομέα και 

μπορεί να υπολογιστεί από την εξίσωση (3.20). 

 

 
 

(3.20) 

 

 

Η χρονική σταθερά ΣΡ σχετίζεται με την απόσβεση της απεριοδικής συνιστώσας του 

ρεύματος βραχυκύκλωσης. Εξαρτάται κυρίως από την αποσβεστική επίδραση του 

κυκλώματος του στάτη και μπορεί να υπολογιστεί από την εξίσωση (3.21). 

 

 
 

(3.21) 

 

 

Η άνω περιβάλλουσα των μέγιστων τιμών του τριφασικού ρεύματος βραχυκύκλωσης ενός 

ασύγχρονου κινητήρα φαίνεται στην Εικόνα 3.5. Μπορεί να υπολογιστεί από την εξίσωση 

(3.22). 

 

 
 

(3.22) 
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i0M: Ρεύμα χωρίς φορτίο 

IM΄΄: Αρχικό συμμετρικό ρεύμα βραχυκύκλωσης 

ipM: Κρουστικό ρεύμα βραχυκύκλωσης 

idcM: Αποσβεννύμενη (απεριοδική) συνιστώσα του ρεύματος βραχυκύκλωσης 

Α: Αρχική τιμή της απεριοδικής συνιστώσας idcM 
Εικόνα 3.5 Τυπική κυματομορφή ρεύματος βραχυκύκλωσης ασύγχρονου κινητήρα 

 

a) H συνιστώσα ΕΡ IacΜ(t) 

 

H συνιστώσα ΕΡ IacΜ(t) εξαρτάται από τις υπομεταβατικές επιδράσεις της μηχανής και 

μπορεί να υπολογιστεί από την εξίσωση (3.23). 

 

 
 

(3.23) 

 

όπου το IM΄΄ μπορεί να υπολογιστεί από την εξίσωση (3.24). 

 

 
 

(3.24) 

 

 

Η τάση ΕM΄΄ εξαρτάται από την τάση στους ακροδέκτες του κινητήρα, το ρεύμα φόρτισης 

του κινητήρα και το συντελεστή ισχύος τη στιγμή του βραχυκυκλώματος. Μπορεί να 

υπολογιστεί από την εξίσωση (3.25). 

 

 
 

(3.25) 

 

όπου 

 

 
 

(3.26) 

 

 

Η εξίσωση (3.25) εκφρασμένη στην αριθμητική της τιμή φαίνεται στην εξίσωση (3.27). 
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(3.27) 

 

 

b) H συνιστώσα ΣΡ idcM 

 

Η συνιστώσα ΣΡ μπορεί να υπολογιστεί από την εξίσωση (3.28). 

 

 
 

(3.28) 

 

όπου cosφΜ είναι ο συντελεστής ισχύος του κινητήρα. 

 

c) Η κρουστική τιμή ipM 

 

Η κρουστική τιμή μπορεί να υπολογιστεί με χρήση της εξίσωσης (3.29). 

 

 
 

(3.29) 

 

για τη χρονική στιγμή t=T/2. 

 

3.5.4.2 Παθητικά στοιχεία 
 

Σύμφωνα με την παράγραφο 5.2.1 του διεθνούς προτύπου IEC 61363-1, τα παθητικά 

στοιχεία του συστήματος είναι τα καλώδια, οι μετασχηματιστές και τα επαγωγικά πηνία. 

Τέτοια στοιχεία αποσβένουν το ρεύμα βραχυκύκλωσης και δε συνεισφέρουν σε αυτό. 

 

3.5.4.2.1 Καλώδια 
 

Η παράγραφος 5.2.2 του διεθνούς προτύπου IEC 61363-1 δίνει το κύκλωμα θετικής 

ακολουθίας που φαίνεται στην Εικόνα 3.6. 

 

 
Εικόνα 3.6 Κύκλωμα θετικής ακολουθίας καλωδίων 

 

Η σύνθετη αντίσταση των καλωδίων περιλαμβάνει την ωμική αντίσταση και την επαγωγική 

αντίδραση. Προσοχή θα πρέπει να δοθεί στη θερμοκρασία των καλωδίων κατά τη διάρκεια 

της κανονικής λειτουργίας και στην αύξηση της θερμοκρασίας λόγω του ρεύματος 

βραχυκύκλωσης. Στις περισσότερες περιπτώσεις η ωμική αντίσταση και η επαγωγική 

αντίδραση μπορούν να ληφθούν από κατασκευαστικά πρότυπα και να υπολογιστούν για 

θερμοκρασία αγωγού ίση με 20 
ο
C και τη συχνότητα λειτουργίας του συστήματος. 
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Για καλώδια που συνδέονται παράλληλα, προσοχή πρέπει να δοθεί στο 8.5.2 του IEC 60092-

202. 

 

3.5.4.2.2 Μετασχηματιστές 
 

Η παράγραφος 5.2.3 του προτύπου δίνει το κύκλωμα θετικής ακολουθίας για ένα 

μετασχηματιστή (Εικόνα 3.7). Το κύκλωμα αυτό περιλαμβάνει τις τιμές της ωμικής 

αντίστασης και της επαγωγικής αντίδρασης, οι οποίες μπορούν να ληφθούν από τον 

κατασκευαστή. 

 

 
Εικόνα 3.7 Κύκλωμα θετικής ακολουθίας μετασχηματιστή 

 

Η ωμική αντίσταση, η επαγωγική αντίδραση και η σύνθετη αντίδραση θετικής ακολουθίας 

μπορούν να υπολογιστούν από τις εξισώσεις (3.30), (3.31) και (3.32). Οι τιμές των urR και urk 

είναι σε %. 

 

 
 

 

(3.30) 

 

(3.31) 

 

(3.32) 

 

 

Αν οι ωμικές απώλειες PCu είναι γνωστές, η ωμική αντίσταση μπορεί να υπολογιστεί από την 

εξίσωση (3.33). 

 

 
 

(3.33) 
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3.5.5 Παραδοχές απλοποίησης 
 
3.5.5.1 Γενικά 
 

Σύμφωνα με την ενότητα 6.1 του διεθνούς προτύπου IEC 61363-1, οι σχέσεις, οι οποίες 

έχουν περιγραφεί στην παράγραφο 3.5.4 της εργασίας, είναι οι πιο κατάλληλες για τον 

υπολογισμό χρονικά εξαρτημένων ρευμάτων που προκύπτουν στους ακροδέκτες ενός 

εξοπλισμού. Όταν στοιχεία συνδέονται μαζί σε ένα σύστημα, είναι επιθυμητό να 

απλοποιηθούν οι σχέσεις υπολογισμού και να τυποποιηθεί η μέθοδος υπολογισμού. 

 

Οποιαδήποτε απλοποίηση αναπόφευκτα εισάγει σφάλματα. Επομένως, ο βαθμός της 

απλοποίησης που έχει επιλεγεί θα εξαρτηθεί όχι μόνο από τα διαθέσιμα δεδομένα, αλλά και 

από την επιτρεπόμενη ακρίβεια στο τελικό αποτέλεσμα. Αν είναι διαθέσιμες όλες οι 

πληροφορίες, οι σχέσεις της παραγράφου 3.5.4 πρέπει να χρησιμοποιηθούν. Αν οι 

πληροφορίες είναι περιορισμένες, μια κατάλληλη σχέση από αυτήν την παράγραφο μπορεί 

να χρησιμοποιηθεί. 

 

Η παράγραφος αυτή περιγράφει προσεγγίσεις που μπορούν να γίνουν για την απλοποίηση 

των υπολογισμών και δείχνει την προκύπτουσα απώλεια ακρίβειας σε σύγκριση με πιο 

εξελιγμένες μεθόδους. Εξακολουθεί να παραμένει ευθύνη του μηχανικού του συστήματος η 

απόφαση για το πόση απώλεια ακρίβειας είναι ανεκτή σε έναν υπολογισμό και η επιλογή 

μιας κατάλληλης σχέσης. 

 

3.5.5.2 Σύγχρονες μηχανές 
 

3.5.5.2.1 Τριφασικά ρεύματα βραχυκύκλωσης 
 

Οι σχέσεις της υποπαραγράφου 3.5.4.1.1 για την εκτίμηση του ρεύματος βραχυκύκλωσης της 

σύγχρονης μηχανής απαιτούν γνώση των παραμέτρων της μηχανής, καθώς και των 

συνθηκών φόρτισης πριν το βραχυκύκλωμα και του συντελεστή ισχύος. 

 

Για υπολογισμούς τριφασικών ρευμάτων βραχυκύκλωσης, όπου το κύριο ενδιαφέρον 

έγκειται στην επιλογή του εξοπλισμού προστασίας, αρκετές λογικές παραδοχές μπορούν να 

γίνουν, οι οποίες θα απλοποιήσουν τις διαδικασίες υπολογισμού και θα εξακολουθήσουν να 

διατηρούν μια επαρκή ακρίβεια στο αποτέλεσμα, κατά τη διάρκεια της περιόδου που 

θεωρείται. 

 

Οι παραδοχές αυτές περιλαμβάνουν: 

a) την αγνόηση της ωμικής αντίστασης του στάτη, αμελητέο σφάλμα 

b) την αγνόηση των συνθηκών φόρτισης πριν το βραχυκύκλωμα, τα αποτελέσματα θα 

είναι μεταξύ 5% και 10% 

c) την αγνόηση της μεταβατικής απόσβεσης της συνιστώσας ΕΡ, υπερβολικές 

ανακρίβειες προκύπτουν στο κρουστικό ρεύμα βραχυκύκλωσης 

d) αγνόηση της υπομεταβατικής και μεταβατικής απόσβεσης της συνιστώσας ΕΡ, 

υπερβολικές ανακρίβειες προκύπτουν στο κρουστικό ρεύμα βραχυκύκλωσης. 

 

3.5.5.2.2 Επίδραση της ωμικής αντίστασης του στάτη 
 

Αν η ωμική αντίσταση του στάτη Ra δεν είναι διαθέσιμη, μπορεί να αγνοηθεί στις σχέσεις 

(3.4)-(3.15). Για ένα ρεύμα βραχυκύκλωσης υπολογισμένο στους ακροδέκτες μιας μηχανής, 
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το αποτέλεσμα θα είναι υψηλότερο αλλά μέσα στις αποδεκτές ανοχές. Για τους 

υπολογισμούς του συστήματος το σφάλμα είναι αμελητέο. 

 

3.5.5.2.3 Επίδραση των συνθηκών φόρτισης πριν το βραχυκύκλωμα 
 

Αν η κατάσταση φόρτισης πριν το βραχυκύκλωμα Ι0 αγνοηθεί στις εξισώσεις (3.7)-(3.12), οι 

τιμές των Εq0΄΄, Eq0΄ και Eq0 μπορούν να θεωρηθούν ίσες και ίσες με 30U . Αυτό, 

ουσιαστικά, υπολογίζει το ρεύμα βραχυκύκλωσης, θεωρώντας τη γεννήτρια υπό κενό φορτίο, 

και καταλήγει στον υπολογισμό μιας χαμηλότερης τιμής του συμμετρικού ρεύματος 

βραχυκύκλωσης (γενικά λιγότερο από 10%). 

 

3.5.5.2.4 Αγνόηση της απόσβεσης της μεταβατικής συνιστώσας ΕΡ 
 

Αν αγνοηθεί η μεταβατική απόσβεση της συνιστώσας ΕΡ, προκύπτουν υπερβολικές 

ανακρίβειες στο κρουστικό ρεύμα βραχυκύκλωσης. Αυτές οι ανακρίβειες θα ακυρώσουν 

οποιαδήποτε αποτελέσματα υπολογιστούν μετά τον πρώτο μισό κύκλο της κατάστασης 

σφάλματος, οπότε η προσέγγιση αυτή δε συνιστάται όταν απαιτούνται χρονικά εξαρτημένοι 

υπολογισμοί. 

 

Χρησιμοποιώντας αυτήν την προσέγγιση, η σχέση (3.3) γίνεται: 

 

 
 

(3.34) 

 

 

3.5.5.2.5 Αγνόηση της απόσβεσης του ρεύματος βραχυκύκλωσης 
 

Οι σχέσεις στην παράγραφο 3.5.4 βασίζονται στον υπολογισμό της απόσβεσης της 

περιβάλλουσας του ρεύματος βραχυκύκλωσης ως αποτέλεσμα των υπομεταβατικών, 

μεταβατικών και σύγχρονων στοιχείων. Αν η απόσβεση αυτή αγνοηθεί, η συνιστώσα ΕΡ του 

ρεύματος βραχυκύκλωσης μπορεί να θεωρηθεί ως ο λόγος μιας σταθερής τάσης προς τη 

σταθερή υπομεταβατική επαγωγική αντίδραση και η συνιστώσα ΣΡ ωε μια αναλογική 

σταθερά. Η ωμική αντίσταση του στάτη και τα ρεύματα πριν το βραχυκύκλωμα πρέπει να 

αγνοηθούν και το κρουστικό ρεύμα να υπολογιστεί θεωρώντας τη μέγιστη ασυμμετρία. 

 

Αυτές οι παραδοχές θα πρέπει να γίνονται μόνο όταν υπολογίζονται προσεγγιστικές τιμές, 

καθώς τα αποτελέσματα θα παράγουν υπερβολικά σφάλματα για τους υπολογισμούς που 

απαιτούνται μετά τον πρώτο μισό κύκλο. 

 

Οι σχέσεις υπολογισμού γίνονται: 

 

 

 

(3.35) 

 

(3.36) 

 

(3.37) 

 

δηλαδή 
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(3.38) 

 

 

Σημειώνεται ότι U0 είναι η τάση πριν το βραχυκύκλωμα της γεννήτριας. Για να επιβεβαιωθεί 

ότι ο υπολογισμός περιλαμβάνει τη μέγιστη τιμή των ρευμάτων βραχυκύκλωσης, θα πρέπει 

να θεωρηθεί ότι, στην κατάσταση πριν το βραχυκύκλωμα, οι γεννήτριες λειτουργούν στα 

χαρακτηριστικά λειτουργίας τους. Επίσης, για να επιτευχθεί μια πιο κοντινή εκτίμηση της 

κρουστικής τιμής στον πρώτο μισό κύκλο, ο συντελεστής 2 μπορεί να αντικατασταθεί από το 

1.8. 

 

3.5.5.2.6 Χρονικές σταθερές 
 

Αν οι χρονικές σταθερές ΕΡ και ΣΡ δεν είναι διαθέσιμες, τότε μπορούν να υπολογιστούν από 

τις χρονικές σταθερές ανοιχτού κυκλώματος και τις σύνθετες αντιστάσεις της μηχανής ως 

εξής: 

 

a) Υπομεταβατική χρονική σταθερά (συνήθως της τάξης των 1-30 ms): 

 

 

 

(3.39) 

 

b) Μεταβατική χρονική σταθερά (συνήθως της τάξης των 20-1200 ms) 

 

 

 

(3.40) 

 

c) Χρονική σταθερά ΣΡ (συνήθως της τάξης των 15-300 ms) 

 

 
 

(3.41) 

 

 

3.5.5.3 Ασύγχρονοι κινητήρες 
 

3.5.5.3.1 Πρώτες προσεγγίσεις 
 

Ως πρώτη προσέγγιση, μπορεί να θεωρηθεί ότι όλοι οι ασύγχρονοι κινητήρες, που είναι 

συνδεμένοι τη στιγμή του βραχυκυκλώματος, συνεισφέρουν ΕΡ βραχυκύκλωσης ίσο με το 

ρεύμα εκκίνησής τους (συνήθως 4 έως 7 φορές το ρεύμα πλήρους φόρτισης της μηχανής). 

Μπορεί επίσης να θεωρηθεί ότι η συνεισφορά των κινητήρων είναι σταθερή κατά τη 

διάρκεια ολόκληρης της περιόδου σφάλματος βραχυκύκλωσης. 

 

Τέτοιες παραδοχές θα δώσουν μεγαλύτερες τιμές ρευμάτων βραχυκύκλωσης από αυτές που 

θα προκύψουν στην πραγματική εγκατάσταση. Το σφάλμα θα εξαρτηθεί από τον αριθμό και 

το μέγεθος των συνδεμένων κινητήρων. 
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3.5.5.3.2 Αγνόηση των καταστάσεων φόρτισης των κινητήρων πριν το 
βραχυκύκλωμα 
 

Οι εξισώσεις (3.25) και (3.27) υπολογίζουν την εσωτερική υπομεταβατική τάση του 

κινητήρα ΕΜ΄΄ και περιλαμβάνουν την επίδραση των καταστάσεων φόρτισης των κινητήρων 

πριν το βραχυκύκλωμα. Η κατάσταση φόρτισης του κινητήρα πριν το βραχυκύκλωμα μπορεί 

να αγνοηθεί με αμελητέο σφάλμα, έτσι ώστε: 

 

 
 

(3.42) 

 

 

Επιπλέον, αν τα καλώδια σύνδεσης είναι μικρά, η UrM μπορεί να προσεγγιστεί ως Un, την 

ονομαστική τάση του συστήματος: 

 

 
 

(3.43) 

 

 

Όμοια, στις εξισώσεις (3.24) και (3.28) για τις συνιστώσες ΕΡ και ΣΡ, το ρεύμα φόρτισης του 

κινητήρα πριν το βραχυκύκλωμα μπορεί να αγνοηθεί και οι εξισώσεις γίνονται: 

 

  

 

(3.44) 

 

(3.45) 

 

 

3.5.5.3.3 Γενικά στοιχεία για μεγάλους κινητήρες 
 

Για κάθε κινητήρα με ισχύ λειτουργίας πάνω από 100 kW ή 15% της ισχύος των συνδεμένων 

γεννητριών, οι σχέσεις της παραγράφου 3.5.4 θα πρέπει να χρησιμοποιηθούν. Αν τα 

δεδομένα του κινητήρα είναι ανεπαρκή, τότε οι παρακάτω προσεγγιστικές τιμές για τις 

χαρακτηριστικές παραμέτρους του κινητήρα μπορούν να χρησιμοποιηθούν. 

 

a) Σύνθετη αντίσταση κινητήρα ΖΜ΄΄ 

Για εγκαταστάσεις 50 Hz και 60 Hz 

p.u. 0.055=r+r=r

p.u. 0.021=r

p.u. 0.034=r

p.u. 0.15=΄΄x

p.u. 0.16=΄΄z

RSM

R

S

M

M

 

όπου 

ΖΜ΄΄ είναι η σύνθετη αντίσταση ακινητοποιημένου δρομέα. 

 

b) Χρονικές σταθερές 

Σε 60 Hz, ms 11.73=T ms, 18.67=΄΄Τ dcMΜ  

Σε 50 Hz, ms 14.08=T ms, 22.4=΄΄Τ dcMΜ  
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c) Αγνόηση του ρεύματος φόρτισης πριν το βραχυκύκλωμα 

Αν αγνοηθεί το ρεύμα φόρτισης πριν το βραχυκύκλωμα, τότε η χρήση των παραπάνω 

χαρακτηριστικών παραμέτρων δίνει: 

 

 

 

(3.46) 

 

(3.47) 

 

(3.48) 

 

 

d) Χρήση του ρεύματος του ακινητοποιημένου δρομέα του κινητήρα 

Αν το ρεύμα του ακινητοποιημένου δρομέα του κινητήρα ILR είναι γνωστό, τότε μπορεί να 

θεωρηθεί ότι το ρεύμα IM΄΄ είναι ίσο με ILR. 

 

e) Όταν δεν είναι διαθέσιμα όλα τα δεδομένα του κινητήρα, τα kVA εισόδου του κινητήρα 

μπορούν να υπολογιστούν ως εξής: 

Κινητήρες επαγωγής: 1kW=1.34 kVA 

Σύγχρονοι κινητήρες: 1kW=1 kVA 

Για προσεγγιστικούς υπολογισμούς, το γινόμενο του συντελεστή ισχύος του κινητήρα και 

του βαθμού απόδοσης μπορεί να θεωρηθεί ίσο με 0.8. 

 

3.5.5.3.4 Γενικά στοιχεία για μικρούς κινητήρες 
 

Οι μικροί κινητήρες, που είναι συνδεμένοι στον ίδιο ζυγό, μπορούν να θεωρηθούν σαν ένας 

ισοδύναμος κινητήρας, με ρεύμα λειτουργίας ίσο με το άθροισμα των ρευμάτων κάθε 

χωριστού κινητήρα, ο οποίος είναι συνδεμένος στο σύστημα στον κοινό ζυγό. 

 

Η συνολική ομάδα των κινητήρων, συμπεριλαμβανόμενων και των καλωδίων σύνδεσης, 

μπορούν να θεωρηθούν ως ένας ισοδύναμος κινητήρας με τις παρακάτω χαρακτηριστικές 

παραμέτρους: 

 

a) Σύνθετη αντίσταση κινητήρα ΖΜ΄΄ 

Για εγκαταστάσεις 50 Hz και 60 Hz 

p.u. 0.07=r+r=r

p.u. 0.027=r

p.u. 0.043=r

p.u. 0.188=΄΄x

p.u. 0.2=΄΄z

RSM

R

S

M

M

 

 

b) Χρονικές σταθερές 

Σε 60 Hz, ms 11.73=T ms, 18.67=΄΄Τ dcMΜ  

Σε 50 Hz, ms 14.08=T ms, 22.4=΄΄Τ dcMΜ  

 

Αγνόηση του ρεύματος φόρτισης πριν το βραχυκύκλωμα 

Αν αγνοηθεί το ρεύμα φόρτισης πριν το βραχυκύκλωμα, τότε η χρήση των παραπάνω 

χαρακτηριστικών παραμέτρων δίνει: 
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(3.49) 

 

(3.50) 

 

(3.51) 

 

 

d) Οι σχέσεις της 3.5.5.3.3 μπορούν να χρησιμοποιηθούν για να υπολογιστούν τα kVA του 

κινητήρα. 

 

3.5.5.3.5 Ασύγχρονοι κινητήρες μη συνεχούς λειτουργίας 
 

Το ρεύμα βραχυκύκλωσης των κινητήρων, οι οποίοι είναι σχεδιασμένοι για μη συνεχή 

λειτουργία και των οποίων τα χαρακτηριστικά δεν είναι πλήρως γνωστά, μπορεί να 

υπολογιστεί θεωρώντας ότι οι κινητήρες είναι σε συνεχή λειτουργία και λειτουργούν σε 

μειωμένη ισχύ. 

 

 

3.5.6 Υπολογισμοί του δικτύου 
 

3.5.6.1 Γενικά 
 

Σύμφωνα με την ενότητα 8.1 του διεθνούς προτύπου IEC 61363-1, οι υπολογισμοί του 

δικτύου απαιτούν το ρεύμα βραχυκύκλωσης να υπολογιστεί στους: 

a) ζυγούς των κύριων γεννητριών 

b) πίνακες διανομής που συνδέονται στους ζυγούς των κύριων γεννητριών 

c) πίνακες διανομής ή υποπίνακες που συνδέονται στους ζυγούς των κύριων γεννητριών 

ή σε έναν πίνακα διανομής και τροφοδοτούνται μέσω ενός μετασχηματιστή. 

 

Οι υπολογισμοί του ρεύματος βραχυκύκλωσης του συστήματος θα πρέπει να περιλαμβάνουν 

το ρεύμα βραχυκύκλωσης, το οποίο συνεισφέρουν όλοι οι κινητήρες και οι γεννήτριες που 

είναι συνδεμένοι στο σύστημα, συμπεριλαμβανόμενων εκείνων στους ζυγούς των κύριων 

γεννητριών, υποπινάκων και πινάκων διανομής. Οι σχέσεις στις παραγράφους 3.5.4 και 3.5.5 

υπολογίζουν το χρονικά εξαρτημένο ρεύμα βραχυκύκλωσης στους ακροδέκτες των στοιχείων 

του συστήματος. Για τους υπολογισμούς του συστήματος, αυτές οι σχέσεις θα πρέπει να 

τροποποιηθούν όπως περιγράφεται στις παρακάτω παραγράφους, έτσι ώστε να 

περιλαμβάνουν τις επιδράσεις των καλωδίων και των μετασχηματιστών που συνδέουν τα 

στοιχεία του συστήματος στους πίνακες διανομής και στους υποπίνακες. 

 

Είναι δύσκολο να καθιερωθεί μια τυποποιημένη μεθοδολογία ώστε να ολοκληρωθούν οι 

υπολογισμοί του συστήματος, αλλά για να εξασφαλιστεί μια σταθερή προσέγγιση, μια 

τυποποιημένη διαδικασία υπολογισμού, όπως αυτή που περιγράφεται στην υποπαράγραφο 

3.5.6.7, θα πρέπει να ακολουθηθεί. 

 

Εξαιτίας των εμπλεκόμενων περιπλοκών, η ολοκλήρωση ενός λεπτομερειακού υπολογισμού 

μπορεί να είναι χρονοβόρα, οπότε υπολογισμοί «δοκιμής» πρέπει να γίνουν, όπως φαίνεται 

στην υποπαράγραφο 3.5.6.3, ώστε να εξακριβωθεί αν τα σφάλματα που προκύπτουν από τη 

χρήση μιας απλοποιημένης ή προσεγγιστικής μεθόδου είναι ανεκτά. 
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3.5.6.2 Επιδράσεις των παθητικών στοιχείων συνδεμένων σε σειρά με τα 
ενεργητικά στοιχεία 
 

3.5.6.2.1 Γενικά 
 

Κατά τον υπολογισμό του ρεύματος βραχυκύκλωσης σε ένα σημείο μιας εγκατάστασης, που 

συνδέεται μέσω ενός παθητικού στοιχείου (καλώδια ή μετασχηματιστές) σε ένα ενεργητικό 

στοιχείο (γεννήτριες ή κινητήρες), η σύνθετη αντίσταση του παθητικού στοιχείου θα πρέπει 

να ληφθεί υπόψη. Η σύνθετη αυτή αντίσταση ελαττώνει το μέγεθος του ρεύματος 

βραχυκύκλωσης, αυξάνει τις υπομεταβατικές και μεταβατικές χρονικές σταθερές και 

ελαττώνει τη χρονική σταθερά ΣΡ. Η επίδραση στο δίκτυο είναι μια χαμηλότερη τιμή 

ρεύματος βραχυκύκλωσης, η οποία αποσβένει αρκετά πιο αργά. 

 

3.5.6.2.2 Γεννήτριες 
 

a) Αλλαγές στη σύνθετη αντίσταση 

Οι σύνθετες αντιστάσεις των παθητικών στοιχείων λαμβάνονται υπόψη αυξάνοντας τη 

σύνθετη αντίσταση των ενεργητικών στοιχείων. 

 

Στις εξισώσεις (3.4) και (3.5), οι Zd΄΄ και Zd΄ θα πρέπει να αντικατασταθούν από τις Ze΄΄ και 

Ze΄, όπου: 

 

 

 

(3.52) 

 

(3.53) 

 

 

Στις εξισώσεις (3.9) και (3.10), οι ΄΄Z d  και ΄Zd  θα πρέπει να αντικατασταθούν από τις ΄΄Z e  

και ΄Ze , όπου: 

 

 

 

(3.54) 

 

(3.55) 

 

 

b) Αλλαγές στη χρονική σταθερά 

Οι χρονικές σταθερές θα πρέπει να περιλαμβάνουν την πρόσθετη σύνθετη αντίσταση των 

παθητικών στοιχείων. 

 

Η υπομεταβατική χρονική σταθερά Te΄΄ μπορεί να υπολογιστεί ως εξής: 

 

 

 

(3.56) 

 

 

Η μεταβατική χρονική σταθερά Te΄ μπορεί να υπολογιστεί ως εξής: 
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(3.57) 

 

 

Η χρονικά σταθερά Σ.Ρ. μπορεί να υπολογιστεί ως εξής: 

 

  

 

(3.58) 

 

(3.59) 

 

 

3.5.6.2.3 Κινητήρες 
 

a) Αλλαγές στη σύνθετη αντίσταση 

Οι σύνθετες αντιστάσεις των παθητικών στοιχείων λαμβάνονται υπόψη αυξάνοντας τη 

σύνθετη αντίσταση των ενεργητικών στοιχείων. 

 

Οι εξισώσεις (3.18) και (3.19) θα πρέπει να τροποποιηθούν ως εξής: 

 

 

 

(3.60) 

 

(3.61) 

 

 

b) Αλλαγές στη χρονική σταθερά 

Οι χρονικές σταθερές θα πρέπει να περιλαμβάνουν την πρόσθετη σύνθετη αντίσταση των 

παθητικών στοιχείων. 

 

Η υπομεταβατική χρονική σταθερά TMe΄΄ μπορεί να υπολογιστεί ως εξής: 

 

 
 

(3.62) 

 

 

Η χρονικά σταθερά ΣΡ TdcMe μπορεί να υπολογιστεί ως εξής: 

 

 
 

(3.63) 

 

 

3.5.6.3 Ρεύμα βραχυκύκλωσης στους ζυγούς των γεννητριών 
 

Σύμφωνα με την ενότητα 8.3 του προτύπου, o υπολογισμός του ρεύματος βραχυκύκλωσης 

στους ζυγούς των γεννητριών θα πρέπει να περιλαμβάνει: 

a) τις παράλληλα συνδεμένες γεννήτριες 

b) τους απευθείας συνδεμένους κινητήρες 

c) τους κινητήρες ή/και γεννήτριες συνδεμένους σε πίνακες διανομής ή υποπίνακες που 

συνδέονται απευθείας στους ζυγούς των κύριων γεννητριών. 
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3.5.6.3.1 Παράλληλα συνδεμένες γεννήτριες 
 

Αν οι παράλληλα συνδεμένες γεννήτριες έχουν ίδια χαρακτηριστικά και τιμές λειτουργίας, 

μπορούν να αξιολογηθούν σαν μία γεννήτρια με χαρακτηριστικά λειτουργίας ίσα με το 

άθροισμα των χαρακτηριστικών λειτουργίας κάθε χωριστής γεννήτριας. 

 

Τα καλώδια των γεννητριών είναι γενικά κοντά και μπορούν κανονικά να αμεληθούν. 

Ωστόσο, αν αποσβένουν το ρεύμα βραχυκύκλωσης περισσότερο από 5%, θα πρέπει να 

συμπεριληφθούν χρησιμοποιώντας τις σχέσεις που έχουν περιγραφεί στην υποπαράγραφο 

3.5.6.2. Αν η διαφορά στα μήκη των καλωδίων των γεννητριών είναι μέσα στο 5%, τότε όλες 

οι γεννήτριες θα αξιολογηθούν σαν να είναι συνδεμένες με όμοια καλώδια ίδιου μήκους. 

 

Για τον προσδιορισμό των επιδράσεων των καλωδίων των γεννητριών ή των διαφορετικού 

μήκους καλωδίων, απλοί υπολογισμοί «δοκιμής» θα πρέπει να γίνονται σε μια γεννήτρια, 

χρησιμοποιώντας προσεγγιστικές σχέσεις. Οι υπολογισμοί «δοκιμής» θα πρέπει εναλλάξ να 

συμπεριλαμβάνουν και να αγνοούν τα καλώδια, καθώς και να θεωρούν μέγιστο και ελάχιστο 

μήκος καλωδίων. Αν η διαφορά των αποτελεσμάτων είναι μέσα στο 5%, τότε αυτές οι 

επιδράσεις πρέπει να αμεληθούν χωρίς ανησυχία. Για εγκαταστάσεις μέσης τάσης, η σύνθετη 

αντίσταση των καλωδίων έχει μικρή επίδραση, αλλά για δίκτυα χαμηλής τάσης, η επίδραση 

μπορεί να είναι αξιοσημείωτη. 

 

Αν οι γεννήτριες έχουν διαφορετικά χαρακτηριστικά λειτουργίας ή τα μήκη και τα μεγέθη 

των καλωδίων δεν μπορούν να αμεληθούν, τότε κάθε γεννήτρια θα πρέπει να θεωρηθεί 

ξεχωριστά, συμπεριλαμβάνοντας και την επίδραση του δικού της καλωδίου, ενώ τα ρεύματα 

βραχυκύκλωσης να εκτιμηθούν χρησιμοποιώντας τις μεθόδους της ισοδύναμης γεννήτριας 

της ενότητας 7 από το πρότυπο IEC 61363-1, το οποίο δεν κρίθηκε αναγκαίο να 

συμπεριληφθεί σε αυτό το κεφάλαιο, διότι δεν εφαρμόστηκε στην παρούσα εργασία. 

 

3.5.6.3.2 Απευθείας συνδεμένοι κινητήρες 
 

Οι κινητήρες θα πρέπει να αξιολογηθούν με βάση τα χαρακτηριστικά λειτουργίας τους σε 

σχέση με την εγκατεστημένη ισχύ της γεννήτριας του δικτύου. Οι μικροί κινητήρες θα πρέπει 

να ομαδοποιηθούν και να αντιμετωπιστούν ως ένας ισοδύναμος κινητήρας. Οι μεγάλοι 

κινητήρες θα πρέπει να αξιολογηθούν χρησιμοποιώντας της μεθόδους της παραγράφου 3.5.4. 

Αν δεν είναι διαθέσιμα όλα τα στοιχεία, οι πληροφορίες της υποπαραγράφου 3.5.5.3.3 

μπορούν να χρησιμοποιηθούν. 

 

Στην πράξη, οποιαδήποτε συνεισφορά από τους κινητήρες μπορεί να σταματήσει όταν οι 

ελεγκτές τους βγουν εκτός λειτουργίας, λόγω της πτώσης της τάσης ΕΡ στο ζυγό του 

βραχυκυκλώματος. Αυτό μπορεί να συμβεί μεταξύ των 0.5 και 3 κύκλων. 

 

Οι μέθοδοι της παραγράφου 3.5.4 περιλαμβάνουν τις επιδράσεις της μείωσης του ρεύματος 

του κινητήρα. Το ρεύμα βραχυκύκλωσης του κινητήρα θα πρέπει να εκτιμηθεί σε κάθε 

διακριτό χρονικό διάστημα και αριθμητικά να προστεθεί στο ρεύμα βραχυκύκλωσης της 

γεννήτριας στο ίδιο χρονικό σημείο. Οι συνδυασμοί γεννήτριας-κινητήρα μπορούν τότε να 

αξιολογηθούν ως μια ισοδύναμη γεννήτρια, όπως περιγράφεται στην ενότητα 7 του 

προτύπου IEC 61363-1. 
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3.5.6.3.3 Κινητήρες και/ή γεννήτριες συνδεμένοι σε άλλους ζυγούς 
 

Πριν την ολοκλήρωση ενός ακριβούς υπολογισμού της συνεισφοράς του ρεύματος 

βραχυκύκλωσης από τους κινητήρες και τις γεννήτριες, που είναι συνδεμένοι σε άλλα μέρη 

του συστήματος, προσεγγιστικοί υπολογισμοί, οι οποίοι αμελούν τη μείωση του ρεύματος 

βραχυκύκλωσης, θα πρέπει να γίνουν και η σπουδαιότητα της συνεισφοράς από αυτά τα 

στοιχεία θα πρέπει να εξακριβωθεί. 

 

Όταν ακριβείς υπολογισμοί είναι αναγκαίοι, οι γεννήτριες και οι κινητήρες, οι οποίοι είναι 

συνδεμένοι σε άλλα μέρη του συστήματος, θα πρέπει να αντιμετωπιστούν όπως περιγράφεται 

στις υποπαραγράφους 3.5.6.3.1 και 3.5.6.3.2, λαμβάνοντας υπόψη τη μείωση του ρεύματος. 

Αυτές οι συνεισφορές μπορούν έπειτα να προστεθούν στις άλλες συνεισφορές στο ζυγό 

σφάλματος και να εκτιμηθούν ως μια ισοδύναμη γεννήτρια, χρησιμοποιώντας τις μεθόδους 

της ενότητας 7 του προτύπου IEC 61363-1. 

 

3.5.6.4 Ρεύματα βραχυκύκλωσης σε δευτερεύοντες ζυγούς απευθείας 
συνδεμένους στο ζυγό της γεννήτριας 
 

Για τον υπολογισμό του ρεύματος βραχυκύκλωσης σε ένα δευτερεύοντα ζυγό, που είναι 

απευθείας συνδεμένος στο ζυγό της γεννήτριας, το υπολογισμένο ρεύμα βραχυκύκλωσης των 

στοιχείων, τα οποία συνδέονται στο δευτερεύοντα ζυγό, θα πρέπει να εκτιμηθεί 

χρησιμοποιώντας τη μέθοδο της ισοδύναμης γεννήτριας της ενότητας 7 του IEC 61363-1, 

συμπεριλαμβάνοντας τις επιδράσεις των διασυνδεμένων στοιχείων μεταξύ του υποζυγού και 

του ζυγού της γεννήτριας. 

 

Αν ο δευτερεύων ζυγός είναι συνδεμένος μέσω ενός μικρού μήκους καλωδίου, που έχει 

μεγάλο εμβαδό διατομής, το καλώδιο σύνδεσης μπορεί να αγνοηθεί και οι συνθήκες 

βραχυκυκλώματος στο δευτερεύοντα ζυγό να θεωρηθούν ίδιες με αυτές στο ζυγό της 

γεννήτριας. Για να ελέγξουμε τις επιδράσεις του καλωδίου διασύνδεσης, θα πρέπει να γίνει 

ένας προσεγγιστικός υπολογισμός, στον οποίο το σύστημα της γεννήτριας θα θεωρηθεί ως 

ένα άπειρο σύστημα γνωστής ισχύος βραχυκύκλωσης και οι επιδράσεις του καλωδίου 

διασύνδεσης θα εκτιμηθούν συγκρίνοντας τη σύνθετη αντίσταση του συστήματος με τη 

σύνθετη αντίσταση του καλωδίου σύνδεσης. 

 

Αν απαιτείται περισσότερο ακριβής υπολογισμός, το σύστημα των γεννητριών πρέπει να 

θεωρηθεί σαν μια ισοδύναμη γεννήτρια και η επαγωγική αντίδραση και οι χρονικές σταθερές 

να εκτιμηθούν όπως περιγράφεται στην ενότητα 7 του IEC 61363-1. Αυτές οι 

χαρακτηριστικές παράμετροι θα πρέπει έπειτα να τροποποιηθούν, ώστε να περιλαμβάνουν τη 

σύνθετη αντίσταση του καλωδίου σύνδεσης, όπως περιγράφεται στην υποπαράγραφο 3.5.6.2, 

και το χρονικά εξαρτημένο ρεύμα βραχυκύκλωσης να υπολογιστεί. 

 

3.5.6.5 Μετασχηματιστές 
 

Ο υπολογισμός του ρεύματος βραχυκύκλωσης στην πλευρά του πρωτεύοντος τυλίγματος 

ενός μετασχηματιστή, που συνδέεται στο ζυγό των κύριων γεννητριών, μπορεί να 

περιλαμβάνει ή όχι τις επιδράσεις των στοιχείων του δευτερεύοντος κυκλώματος. Όμοια, ο 

υπολογισμός του ρεύματος βραχυκύκλωσης στην πλευρά του δευτερεύοντος τυλίγματος ενός 

μετασχηματιστή μπορεί να περιλαμβάνει ή όχι τις επιδράσεις των στοιχείων του 

πρωτεύοντος κυκλώματος. 
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Δύο κύριες περιπτώσεις πρέπει να θεωρηθούν: 

a) Ο μετασχηματιστής είναι αρκετά μικρός, ώστε τα φορτία στο δευτερεύον σύστημα να 

μην επηρεάζουν τους υπολογισμούς του πρωτεύοντος συστήματος και το 

υπολογισμένο ρεύμα βραχυκύκλωσης στην πλευρά του δευτερεύοντος του 

μετασχηματιστή να μην επηρεάζεται από τα φορτία του πρωτεύοντος συστήματος. 

b) Ο μετασχηματιστής είναι αρκετά μεγάλος, ώστε τα φορτία στο δευτερεύον σύστημα 

να επηρεάζουν τους υπολογισμούς του πρωτεύοντος συστήματος και τα στοιχεία του 

πρωτεύοντος κυκλώματος να επηρεάζουν το υπολογισμένο ρεύμα βραχυκύκλωσης 

στο δευτερεύον σύστημα. 

 

Αν ο μετασχηματιστής είναι μικρός και η σύνθετη αντίστασή του είναι μεγάλη, τότε τα 

στοιχεία του πρωτεύοντος κυκλώματος δε θα επηρεάσουν το ρεύμα βραχυκύκλωσης στο 

δευτερεύον σύστημα και ο μετασχηματιστής θα πρέπει να θεωρηθεί σαν να είναι 

συνδεδεμένος σε έναν άπειρο ζυγό. 

 

Αν ο μετασχηματιστής είναι μεγάλος και η σύνθετη αντίστασή του είναι μικρή, τότε οι 

υπολογισμοί των ρευμάτων βραχυκύκλωσης του πρωτεύοντος συστήματος θα πρέπει να 

περιλαμβάνουν τις συνεισφορές των κινητήρων και των γεννητριών που συνδέονται στο 

δευτερεύον σύστημα. Επιπλέον, ο υπολογισμός του ρεύματος βραχυκύκλωσης στο 

δευτερεύον σύστημα θα πρέπει να περιλαμβάνει τις επιδράσεις των στοιχείων του 

πρωτεύοντος κυκλώματος. 

 

Οι έννοιες «μικρός» και «μεγάλος» είναι σχετικές και συσχετίζουν τη σύνθετη αντίσταση του 

μετασχηματιστή με τη σύνθετη αντίσταση του συστήματος, όμως δεν πρέπει να κριθούν 

μόνο οι απόλυτες τιμές τους. Σαν μια πρώτη προσέγγιση, η σύνθετη αντίσταση του 

μετασχηματιστή θα πρέπει να συγκριθεί με τη σύνθετη αντίσταση του συστήματος 

(υπολογισμένες στις ίδιες βασικές τιμές) και θα μπορούσε να γίνει μία κρίση παρατηρώντας 

την αύξηση που θα προέκυπτε, αν συμπεριλαμβάνονταν τα στοιχεία του πρωτεύοντος 

κυκλώματος. Αν η σύνθετη αντίσταση αυξηθεί αρκετά ώστε να προκαλέσει περισσότερο από 

5% αύξηση στο ρεύμα βραχυκύκλωσης της πλευράς του δευτερεύοντος τυλίγματος, τότε τα 

στοιχεία του πρωτεύοντος κυκλώματος δεν πρέπει να αμεληθούν. 

 

Εναλλακτικά, τα αποτελέσματα της πτώσης τάσης, που συμβαίνει λόγω του 

βραχυκυκλώματος, μπορούν να ληφθούν υπόψη. Η τιμή του ρεύματος βραχυκύκλωσης 

στους ακροδέκτες του δευτερεύοντος του μετασχηματιστή, που έχει υπολογιστεί θεωρώντας 

ότι ο μετασχηματιστής είναι συνδεμένος σε έναν άπειρο ζυγό, μπορεί να χρησιμοποιηθεί για 

τον προσδιορισμό της πιθανής πτώσης τάσης στο πρωτεύοντα ζυγό όταν συμβαίνει το 

βραχυκύκλωμα. Αν η υπολογισμένη πτώση τάσης είναι μικρότερη από 20%, είναι απίθανο οι 

γεννήτριες να αντιδράσουν στο βραχυκύκλωμα. Σε τέτοιες περιπτώσεις, η σύνθετη 

αντίσταση της γεννήτριας θα έχει αμελητέα επίδραση στα ρεύματα βραχυκύκλωσης των 

ακροδεκτών του δευτερεύοντος και οι υπολογισμοί στους ακροδέκτες του δευτερεύοντος 

μπορούν να ολοκληρωθούν θεωρώντας ότι ο μετασχηματιστής συνδέεται σε έναν άπειρο 

ζυγό. 

 

Πρέπει να σημειωθεί ότι οι σχέσεις που χρησιμοποιούνται για τον υπολογισμό της 

συνιστώσας ΕΡ του ρεύματος βραχυκύκλωσης μιας γεννήτριας περιλαμβάνουν τον όρο Ikd. 

Το Ikd, που ισούται με Ιk, εξαρτάται από την τάση εξαναγκασμού λόγω του ρυθμιστή τάσης 

της γεννήτριας και επηρεάζει το ρεύμα βραχυκύκλωσης μόνο όταν ο ρυθμιστής τάσης 

«εξαναγκάζει», δηλαδή όταν η τάση του ζυγού πέφτει κοντά στο μηδέν. 
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Αν οι επιδράσεις των στοιχείων του πρωτεύοντος κυκλώματος δεν μπορούν να αμεληθούν, 

τότε η σύνθετη αντίσταση λόγω του μετασχηματιστή πρέπει να προστεθεί στη σύνθετη 

αντίσταση της (ισοδύναμης) γεννήτριας και νέες χρονικές σταθερές να υπολογιστούν. Αυτές 

οι νέες παράμετροι μπορούν έπειτα να χρησιμοποιηθούν για τον προσδιορισμό των χρονικά 

εξαρτημένων ρευμάτων βραχυκύκλωσης, όπως περιγράφεται στην υποπαράγραφο 3.5.6.2 

του παρόντος. 

 

3.5.6.6 Διαδικασίες υπολογισμού 
 

3.5.6.6.1 Γενικά 
 

Σύμφωνα με την παράγραφο 8.7.1 του προτύπου, είναι δύσκολο να καθιερωθεί μια 

τυποποιημένη διαδικασία υπολογισμού για όλα τα ρεύματα βραχυκύκλωσης των 

συστημάτων. Κάθε σύστημα θα πρέπει να αντιμετωπιστεί με τις δικές του αξίες και τις 

σχετικές απλοποιήσεις, τις παραδοχές και τους αντίστοιχους επιλεγμένους υπολογισμούς. Οι 

σχέσεις που χρησιμοποιούνται για ένα σύστημα μπορεί να μην εφαρμόζονται απαραίτητα σε 

ένα άλλο. 

 

Είναι, εντούτοις, σημαντικό να καθιερωθεί μία τυποποιημένη διαδικασία που να εξασφαλίζει 

ότι όλες οι πτυχές του συστήματος έχουν ληφθεί υπόψη. Παραμένει υπευθυνότητα του 

μηχανικού σχεδίασης του συστήματος, χρησιμοποιώντας τις οδηγίες αυτού του προτύπου, ο 

προσδιορισμός της σχετικής σημασίας του υπολογισμού και η κρίση σχετικά με το ποιες 

προσεγγίσεις μπορούν να εφαρμοστούν. 

 

3.5.6.6.2 Διαδικασία μελέτης βραχυκυκλωμάτων 
 

Η διαδικασία μελέτης βραχυκυκλωμάτων πρέπει να περιλαμβάνει τα παρακάτω βήματα: 

a) προσδιορισμός του συστήματος και του προβλήματος και προετοιμασία ενός 

διαγράμματος μελέτης του συστήματος 

b) αναγνώριση των χαρακτηριστικών παραμέτρων των στοιχείων 

c) προετοιμασία ενός διαγράμματος σύνθετων αντιστάσεων σε ένα κοινό σύστημα 

βάσης 

d) γρήγορος και χρονικά ανεξάρτητος υπολογισμός, προκειμένου να προσδιοριστούν τα 

κατά προσέγγιση επίπεδα σφαλμάτων σε κάθε σημείο 

e) εκτίμηση των κατάλληλων προσεγγίσεων που μπορούν να γίνουν, ώστε να 

απλοποιηθούν οι διαδικασίες υπολογισμού μέσα στην απαιτούμενη ακρίβεια των 

υπολογισμών 

f) υπολογισμός των χρονικά εξαρτημένων ρευμάτων βραχυκύκλωσης στα κύρια σημεία 

του συστήματος 

g) άθροισμα των ρευμάτων βραχυκύκλωσης και συμπεράσματα της μελέτης. 

 

3.5.6.6.3 Προσδιορισμός του συστήματος και του προβλήματος και 
προετοιμασία ενός διαγράμματος μελέτης του συστήματος 
 

Ένα μονογραμμικό διάγραμμα ενός βασικού συστήματος πρέπει να γίνει, στο οποίο θα 

φαίνονται όλα τα κύρια στοιχεία. Ο σκοπός του υπολογισμού, η έκταση και η αποδεκτή 

ακρίβεια θα πρέπει να αναφερθούν. Οι παραδοχές που θα εφαρμοστούν θα πρέπει να 

καταγραφούν. Οι καταστάσεις λειτουργίας κάτω από τις οποίες γίνονται οι υπολογισμοί θα 

πρέπει να παρατεθούν λεπτομερώς και ο αριθμός των γεννητριών στη γραμμή και τα 

εκτιμώμενα φορτία των γεννητριών και των κινητήρων θα πρέπει να σημειωθούν. Μία 
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σύνοψη των σχέσεων που έχουν εφαρμοστεί θα πρέπει να δοθεί, αναφέροντας λεπτομερώς 

οποιαδήποτε ειδική κατάσταση που επηρεάζει τις συνεισφορές στο ρεύμα βραχυκύκλωσης 

ενός συγκεκριμένου στοιχείου. Μία σύντομη δήλωση πρέπει να γίνει περιγράφοντας το πεδίο 

εφαρμογής των αποτελεσμάτων. 

 

3.5.6.6.4 Αναγνώριση των χαρακτηριστικών παραμέτρων των στοιχείων 
 

Για κάθε στοιχείο στο μονογραμμικό διάγραμμα, όλες οι σχετικές χαρακτηριστικές 

παράμετροι θα πρέπει να καταγραφούν. Αναφορές πρέπει να γίνουν σχετικά με το ποιο 

δεδομένο είναι πραγματικό και ποιο υποθετικό. 

 

3.5.6.6.5 Διάγραμμα σύνθετων αντιστάσεων του συστήματος 
 

Το διάγραμμα των σύνθετων αντιστάσεων του συστήματος θα πρέπει να κατασκευαστεί 

αλληλοσυνδέοντας τη σύνθετη αντίσταση, όπως έχει καθοριστεί από το μονογραμμικό 

διάγραμμα του συστήματος. Αν κάθε στοιχείο αναπαρίσταται από τη σύνθετη αντίστασή του 

υπολογισμένη σε μια κοινή βάση, το διάγραμμα των σύνθετων αντιστάσεων θα δώσει μια 

άμεση ένδειξη της σχετικής σημασίας των διάφορων στοιχείων που συνεισφέρουν στο ρεύμα 

βραχυκύκλωσης σε οποιοδήποτε σημείο και, επομένως, μια ένδειξη των πιθανών 

προσεγγίσεων που μπορούν να γίνουν. 

 

Σημειώνεται ότι για γεννήτριες είναι γενικά επαρκές να χρησιμοποιηθεί η υπομεταβατική 

σύνθετη αντίσταση μόνο, καθώς ο σκοπός του διαγράμματος είναι να απεικονίσει τη 

διαμόρφωση του συστήματος. 

 

3.5.6.6.6 Προσεγγιστικός υπολογισμός 
 

Χρησιμοποιώντας τις σχέσεις από την υποπαράγραφο 3.5.5.2.5, προσεγγιστικοί και χρονικά 

ανεξάρτητοι υπολογισμοί πρέπει να γίνουν σε κάθε κύριο πίνακα διανομής. Η 

υποπαράγραφος 3.5.5.3 θα πρέπει να χρησιμοποιηθεί για την εκτίμηση του ρεύματος 

βραχυκύκλωσης των κινητήρων. 

 

Για τον υπολογισμό του κρουστικού ρεύματος βραχυκύκλωσης, πρέπει να θεωρηθεί η 

μέγιστη ασυμμετρία. Για γεννήτριες, πρέπει να χρησιμοποιηθεί η υπομεταβατική σύνθετη 

αντίσταση. Για τους μετασχηματιστές, πρέπει να θεωρηθεί ότι είναι συνδεμένοι σε έναν 

άπειρο ζυγό. Τα αποτελέσματα των υπολογισμών θα πρέπει να συνοψιστούν και να 

χρησιμοποιηθούν για να ελέγξουν τους χρονικά εξαρτημένους υπολογισμούς. 

 

Για κάποιες εφαρμογές, δε χρειάζονται επιπλέον υπολογισμοί. Για παράδειγμα, αυτό ισχύει 

στην περίπτωση που ο σκοπός του υπολογισμού είναι να ελέγξει τα χαρακτηριστικά 

λειτουργίας του διακοπτικού εξοπλισμού και τα χαρακτηριστικά λειτουργίας του 

διακοπτικού εξοπλισμού ξεπερνούν τα ρεύματα βραχυκύκλωσης υπολογισμένα από αυτή τη 

μέθοδο. 

 

3.5.6.6.7 Εκτίμηση των κατάλληλων προσεγγίσεων 
 

Οι σχέσεις στην υποπαράγραφο 3.5.4.1.1 για τον υπολογισμό του τριφασικού ρεύματος 

βραχυκύκλωσης θα πρέπει να χρησιμοποιηθούν για τον προσδιορισμό της απόσβεσης του 

χρονικά εξαρτημένου ρεύματος βραχυκύκλωσης για τις γεννήτριες του συστήματος και για 
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τον προσδιορισμό μιας βάσης από την οποία άλλες προσεγγίσεις μπορούν να κρίνονται. Για 

παράδειγμα: 

a) υπολογισμοί για να εξακριβωθεί η επίδραση των καλωδίων των γεννητριών στα 

αποτελέσματα: Ένας χρονικά εξαρτημένος υπολογισμός μπορεί να γίνει για μια 

γεννήτρια με ή χωρίς το καλώδιό της και τα αποτελέσματα να συγκριθούν. Μια κρίση 

μπορεί μετά να γίνει για τον αν θα συμπεριληφθούν ή θα αγνοηθούν τα καλώδια 

στους υπολογισμούς. 

b) υπολογισμοί για τον προσδιορισμό της πτώσης τάσης στον πρωτεύοντα ζυγό, σαν 

αποτέλεσμα ενός ρεύματος βραχυκύκλωσης στο δευτερεύον ενός διασυνδετικού 

μετασχηματιστή: Τα αποτελέσματα αυτών των υπολογισμών θα παρέχουν τα 

κριτήρια ελέγχου για να καθορισθεί αν η σύνθετη αντίσταση της γεννήτριας θα 

πρέπει να συμπεριληφθεί κατά τον υπολογισμό του ρεύματος βραχυκύκλωσης στο 

πρωτεύον σύστημα ενός μετασχηματιστή. 

 

3.5.6.6.8 Υπολογισμός του συστήματος 
 

Χρησιμοποιώντας τα αποτελέσματα των χρονικά εξαρτημένων υπολογισμών και 

εφαρμόζοντας τις επιτρεπτές απλοποιήσεις, το ρεύμα βραχυκύκλωσης σε κάθε σχετικό 

σημείο του συστήματος θα πρέπει να υπολογιστεί. 

 

Οι υπολογισμοί των ρευμάτων βραχυκύκλωσης θα πρέπει να γίνουν για τις πιο αυστηρές 

συνθήκες λειτουργίας, δηλαδή αυτές που παράγουν τις υψηλότερες τιμές του ρεύματος 

βραχυκύκλωσης. Επιπλέον, οι θεωρητικά πιο αυστηρές συνθήκες, με όλα τα ενεργητικά 

στοιχεία να παράγουν το μέγιστο ρεύμα βραχυκύκλωσης, θα πρέπει να αναγνωριστούν και οι 

υπολογισμοί θα πρέπει να γίνουν για να εξακριβωθεί αν οι διατάξεις προστασίας θα πρέπει 

να συμπεριληφθούν στο σχεδιασμό του συστήματος, ώστε να αποφευχθεί η ύπαρξη τέτοιων 

θεωρητικά αυστηρών συνθηκών. 

 

3.5.6.6.9 Σύνοψη των υπολογισμών 
 

Μία πλήρης σύνοψη θα πρέπει να γίνει για τα αποτελέσματα. Παρατηρήσεις θα πρέπει να 

γίνουν σχετικά με την καταλληλότητα των διατάξεων προστασίας του συστήματος. 

 

 

3.5.7 Ερμηνεία και εφαρμογή των αποτελεσμάτων 
 

3.5.7.1 Γενικά 
 

Σύμφωνα με την ενότητα 9.1 του διεθνούς προτύπου IEC 61363-1, ο κύριος σκοπός της 

μελέτης του ρεύματος βραχυκύκλωσης είναι: 

a) υπολογισμός των τιμών του ρεύματος βραχυκύκλωσης σε συγκεκριμένα σημεία σε 

ένα δίκτυο συστήματος 

b) η εξακρίβωση ότι τα στοιχεία του συστήματος έχουν αρκετή ικανότητα αντοχής του 

ρεύματος βραχυκύκλωσης 

c) η επιλογή με βεβαιότητα του εξοπλισμού προστασίας του κυκλώματος. 

 

Έχοντας υπολογίσει το ρεύμα βραχυκύκλωσης, προσοχή θα πρέπει να δοθεί στις 

συγκεκριμένες συνθήκες και τα πρότυπα, στα οποία έχει δοκιμαστεί ο εξοπλισμός 

προστασίας, και να ληφθούν υπόψη αυτές οι συνθήκες όταν εφαρμόζονται τα αποτελέσματα 

του υπολογισμού ρεύματος βραχυκύκλωσης. Επιπλέον, θα πρέπει να σημειωθεί ότι τα 
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ηλεκτρικά συστήματα πάνω στα πλοία και οι υπεράκτιες εγκαταστάσεις χαρακτηρίζονται 

γενικά από μεγάλη ικανότητα ισχύος γεννητριών, περιορισμένο σε ένα μικρό χώρο. 

Επομένως, το ρεύμα βραχυκύκλωσης που μπορεί να προκύψει είναι σχετικά υψηλό σε τιμή, 

έχοντας ένα χαμηλό συντελεστή ισχύος. 

 

3.5.7.2 Συστήματα έως 1kV 
 

Οι διατάξεις προστασίας που χρησιμοποιούνται σε συστήματα έως 1kV, για προστασία 

έναντι ρευμάτων βραχυκύκλωσης, γενικά περιλαμβάνουν ασφάλειες και διακόπτες. 

 

Κατά την επιλογή των διακοπτών για χρήση σε συστήματα έως 1kV, τα παρακάτω 

χαρακτηριστικά λειτουργίας και συνθήκες ελέγχου πρέπει να είναι διαθέσιμα: 

 ικανότητα ζεύξης σε βραχυκύκλωμα 

 ικανότητα διακοπής σε βραχυκύκλωμα 

 χρόνος απομάκρυνσης επαφών 

 τάση λειτουργίας 

 συντελεστής ισχύος 

 

a) Ικανότητα ζεύξης σε βραχυκύκλωμα 

 

Για όλους τους τύπους διακοπτών, η ικανότητα ζεύξης σε βραχυκύκλωμα δεν πρέπει να είναι 

μικρότερη από το υπολογισμένο κρουστικό ρεύμα βραχυκύκλωσης ip στο σημείο της 

εγκατάστασης του συστήματος. Η ικανότητα ζεύξης σε βραχυκύκλωμα του διακόπτη θα 

πρέπει να είναι εξασφαλισμένη σε μια τάση λειτουργίας όχι μικρότερη από την ονομαστική 

τάση του δικτύου σε εκείνο το σημείο της εγκατάστασης του συστήματος. 

 

b) Ικανότητα διακοπής σε βραχυκύκλωμα 

 

Η ικανότητα διακοπής σε βραχυκύκλωμα των διακοπτών δεν θα πρέπει να είναι μικρότερη 

από το υπολογισμένο αναμενόμενο ρεύμα διακοπής σε βραχυκύκλωμα. Η τιμή αυτή θα 

πρέπει να ληφθεί από τον υπολογισμό της συνιστώσας ΕΡ του ρεύματος βραχυκύκλωσης 

Ιac(t) στο σημείο της εγκατάστασης του συστήματος, τη χρονική στιγμή που οι επαφές του 

διακόπτη διαχωρίζονται. Για διακόπτες για τους οποίους ο διαχωρισμός των επαφών μπορεί 

να συμβεί σε λιγότερο από μισό κύκλο, ο κατασκευαστής του διακόπτη θα πρέπει να 

ερωτηθεί σχετικά με τα χαρακτηριστικά λειτουργίας. 

 

Η ικανότητα διακοπής σε βραχυκύκλωμα του διακόπτη θα πρέπει να είναι εξασφαλισμένη σε 

τάση όχι μικρότερη από την ονομαστική τάση του συστήματος, σε εκείνο το σημείο της 

εγκατάστασης του συστήματος, καθώς και σε συντελεστή ισχύος όχι μεγαλύτερο από τον 

υπολογισμένο συντελεστή ισχύος του αναμενόμενου ρεύματος διακοπής σε βραχυκύκλωμα. 

 

c) Συντελεστής ισχύος 

 

Οι διακόπτες δοκιμάζονται συνήθως με ένα σταθερό συντελεστή ισχύος κυκλώματος. 

Εξαιτίας της μη γραμμικής και χρονικά εξαρτημένης φύσης της σύνθετης αντίστασης των 

ενεργητικών στοιχείων κατά τη διάρκεια του βραχυκυκλώματος, ο συντελεστής ισχύος υπό 

συνθήκες βραχυκυκλώματος αλλάζει συνεχώς. Συνεπώς, οι ναυτικές και οι υπεράκτιες 

ηλεκτρολογικές εγκαταστάσεις ΕΡ δεν έχουν σταθερό συντελεστή ισχύος, οπότε ο 

συντελεστής ισχύος θα πρέπει να υπολογίζεται σε ένα συγκεκριμένο σημείο στο χρόνο. 
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Εξαιτίας των μικρών αποστάσεων μεταξύ γεννητριών και καταναλωτών στις ναυτικές και 

υπεράκτιες εγκαταστάσεις, τα καλώδια γενικά έχουν μεγάλο εμβαδό διατομής και μικρά 

μήκη, το οποίο έχει ως αποτέλεσμα ο συντελεστής ισχύος κάτω από συνθήκες 

βραχυκυκλώματος να είναι χαμηλότερος από αυτόν που χρησιμοποιείται στις δοκιμές 

βραχυκυκλώματος. 

 

Αν ο συντελεστής ισχύος κάτω από τις συνθήκες βραχυκυκλώματος είναι μικρότερος από το 

συντελεστή ισχύος των δοκιμών του διακόπτη, η ικανότητα του διακόπτη για αντοχή σε 

βραχυκύκλωμα μπορεί να είναι ανεπαρκής, ακόμα και αν η ικανότητα διακοπής σε 

βραχυκύκλωμα του διακόπτη είναι μεγαλύτερη από το αναμενόμενο ρεύμα διακοπής σε 

βραχυκύκλωμα. 

 

Σημειώνεται ότι η ικανότητα ζεύξης σε βραχυκύκλωμα του διακόπτη μπορεί να είναι 

χαμηλότερη από το υπολογισμένο κρουστικό ρεύμα ip και, επομένως, ο διακόπτης θα ήταν 

ακατάλληλος. Γενικά, οι διακόπτες, που δοκιμάζονται σε συντελεστές ισχύος μικρότερους 

από 0.2, είναι κατάλληλοι για χρήση σε κυκλώματα που έχουν συντελεστές ισχύος 

σφάλματος στο εύρος 0.05 έως 0.20. Ωστόσο, αν ο διακόπτης έχει δοκιμαστεί σε υψηλότερο 

συντελεστή ισχύος (π.χ. 0.2 έως 0.5), η ικανότητα διακοπής μπορεί να επηρεαστεί εξαιτίας 

της αλλαγής στην τάση αποκατάστασης και θα πρέπει να ερωτηθεί σχετικά ο 

κατασκευαστής. 

 

d) Σύνοψη 

 

Μετά τις δοκιμές, στους διακόπτες ανατίθενται οι παρακάτω τιμές λειτουργίας: 

 ικανότητα ζεύξης σε βραχυκύκλωμα 

 ικανότητα διακοπής σε βραχυκύκλωμα 

 τάση λειτουργίας 

 συντελεστής ισχύος 

 χρόνος διαχωρισμού επαφών 

 

Κατά την εγκατάσταση σε ένα σύστημα, η ικανότητα ζεύξης σε βραχυκύκλωμα του διακόπτη 

δεν πρέπει να είναι μικρότερη από το ip, την υπολογισμένη κρουστική τιμή του ρεύματος 

βραχυκύκλωσης. Η ικανότητα διακοπής σε βραχυκύκλωμα ενός διακόπτη δεν πρέπει να είναι 

μικρότερη από το Iac(t), υπολογισμένο τη στιγμή διαχωρισμού των επαφών του διακόπτη. Η 

τάση λειτουργίας δεν πρέπει να είναι μικρότερη από την ονομαστική τάση του κυκλώματος 

σε εκείνο το σημείο της εγκατάστασης στο σύστημα. Ο συντελεστής ισχύος δεν πρέπει να 

είναι μεγαλύτερος από το συντελεστή ισχύος του υπολογισμένου αναμενόμενου ρεύματος 

βραχυκύκλωσης. 

 

Όπου υπάρχουν μικρές διαφορές μεταξύ των συνθηκών του υπολογισμένου ρεύματος 

βραχυκύκλωσης και των προσδιορισμένων χαρακτηριστικών λειτουργίας βραχυκυκλώματος 

του διακόπτη, ο κατασκευαστής του διακόπτη θα πρέπει να ερωτηθεί πριν τη χρήση του 

διακόπτη. Αν έχει συμφωνηθεί ότι τα χαρακτηριστικά λειτουργίας βραχυκυκλώματος 

μπορούν να αλλάξουν, ο κατασκευαστής πρέπει να ερωτηθεί για απόδειξη της 

καταλληλότητας. Τέτοια απόδειξη πρέπει κατά προτίμηση να αποτελεί επιπλέον δελτίο 

δοκιμής. 

 

 



ΚΕΦΑΛΑΙΟ 4 
 

Βραχυκυκλώματα και διεθνές πρότυπο IEC 
61363-1 στο PowerFactory 

 
Σε αυτό το κεφάλαιο αναλύεται η μέθοδος μελέτης βραχυκυκλωμάτων, η οποία απορρέει 

από το διεθνές πρότυπο IEC 61363-1, υπό το πρίσμα της εφαρμογής της στο PowerFactory. 

Γίνεται, έτσι, αναφορά στους τρόπους αναπαράστασης των στοιχείων ενός ηλεκτρικού 

δικτύου στην πλατφόρμα του προγράμματος, καθώς και στον αλγόριθμο του υπολογισμού 

βραχυκυκλώματος. 

 

 

4.1 Ανάλυση βραχυκυκλωμάτων και σχεδιασμός 
ηλεκτρικών συστημάτων 

 
Τα συστήματα μεταφοράς ηλεκτρικής ενέργειας σχεδιάζονται με θεμελιώδη σκοπό την 

ασφαλή και αξιόπιστη μεταφορά των φορτίων. Ένας από τους βασικούς παράγοντες, που 

λαμβάνονται υπόψη κατά το σχεδιασμό και τη λειτουργία ηλεκτρικών συστημάτων, είναι ο 

ικανοποιητικός χειρισμός των βραχυκυκλωμάτων. Μολονότι τα συστήματα σχεδιάζονται 

ώστε να λειτουργούν κατά το δυνατό χωρίς προβλήματα βραχυκύκλωσης, τέτοιου είδους 

σφάλματα μπορούν να προκύψουν. Γενικά, μία κατάσταση βραχυκυκλώματος προκαλεί 

υψηλές και ανεξέλεγκτες τιμές ρευμάτων, τα οποία, εφόσον δεν εντοπιστούν και δεν 

περιοριστούν έγκαιρα, μπορούν να έχουν ως αποτέλεσμα τη βλάβη εξοπλισμού, τη διακοπή 

λειτουργίας σε μεγάλες περιοχές αντί για την περιοχή του σφάλματος μόνο, καθώς και τη 

δημιουργία κινδύνων για το ανθρώπινο δυναμικό. Συνεπώς, ένα ορθά σχεδιασμένο σύστημα 

θα πρέπει να απομονώνει το σφάλμα με ασφάλεια, ελάχιστες βλάβες στον εξοπλισμό και 

αποφυγή επέκτασης του προβλήματος. 

 

Τυπικές αιτίες δημιουργίας βραχυκυκλωμάτων μπορούν να είναι οι ακόλουθες: 

 Εκκενώσεις κεραυνών σε εκτεθειμένο εξοπλισμό, όπως οι γραμμές μεταφοράς 

 Πρόωρη γήρανση των μονώσεων, λόγω μόνιμης υπερφόρτωσης, ακατάλληλου 

εξαερισμού κ.λπ. 

 Επικαθίσεις ατμοσφαιρικών ή βιομηχανικών αλάτων στις μονώσεις 

 Αστοχία στοιχείων του εξοπλισμού 

 Ακατάλληλες συνθήκες λειτουργίας του ηλεκτρικού δικτύου 

 

Ο υπολογισμός βραχυκυκλώματος στην ηλεκτρονική πλατφόρμα ενός λογισμικού, όπως 

είναι το PowerFactory, μπορεί να αξιοποιηθεί στην κατεύθυνση του σωστού σχεδιασμού των 

συστημάτων μεταφοράς ηλεκτρικής ενέργειας, της πρόβλεψης σφαλμάτων βραχυκύκλωσης 

και της προετοιμασίας για την αντιμετώπιση των δυσμενέστερων δυνατών καταστάσεων. 
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Μία από τις πολλές εφαρμογές του υπολογισμού βραχυκυκλώματος συνίσταται στον έλεγχο 

των χαρακτηριστικών των στοιχείων ενός ηλεκτρικού δικτύου, κατά τη φάση του 

σχεδιασμού του. Σε αυτήν την περίπτωση, ο σχεδιαστής μηχανικός ενδιαφέρεται να 

εντοπίσει τις μέγιστες αναμενόμενες τιμές ρευμάτων, ώστε να διαστασιολογήσει τον 

εξοπλισμό και να επιλέξει τα μέσα προστασίας κατάλληλα, καθώς και τις χαμηλότερες 

αναμενόμενες τιμές ρευμάτων, ώστε να σχεδιάσει με επάρκεια το σχέδιο προστασίας του 

δικτύου. Οι υπολογισμοί βραχυκυκλωμάτων, που πραγματοποιούνται κατά τη φάση του 

σχεδιασμού, συνήθως βασίζονται σε μεθόδους, οι οποίες απαιτούν λιγότερο λεπτομερείς 

μοντελοποιήσεις των δικτύων. Πρόκειται για μεθόδους που εξετάζουν ακραίες καταστάσεις 

σφαλμάτων βραχυκύκλωσης. Χαρακτηριστική μέθοδος υπολογισμού, εντασσόμενη στο 

παραπάνω πλαίσιο, είναι αυτή που απορρέει από το διεθνές πρότυπο 61363-1 και αφορά 

βραχυκυκλώματα σε ναυτικές εγκαταστάσεις ΕΡ. 

 

Μερικά τυπικά παραδείγματα εφαρμογής της ανάλυσης σφαλμάτων βραχυκύκλωσης στο 

σχεδιασμό συστημάτων είναι τα εξής [7]: 

 Έλεγχος της ικανότητας αντιμετώπισης βραχυκυκλωμάτων μετά την προσθήκη νέων 

στοιχείων και την επέκταση του δικτύου 

 Ορθή τοποθέτηση και προσανατολισμός μέσων προστασίας, όπως είναι οι 

θυσιαζόμενες ασφάλειες και οι αυτόματοι διακόπτες ισχύος 

 Διαστασιολόγηση ενεργητικών και παθητικών στοιχείων του δικτύου 

 Εντοπισμός πιθανών σημείων άνισων φορτίων και υπερέντασης 

 Επιβεβαίωση επάρκειας μονώσεων καλωδίων και γραμμών μεταφοράς στη βάση των 

αποδεκτών θερμικών ορίων 

 

Η ανάλυση βραχυκυκλωμάτων είναι σημαντική και για την εύρυθμη λειτουργία των 

ηλεκτρικών δικτύων, με εφαρμογές όπως οι παρακάτω [7]: 

 Επιβεβαίωση μη υπέρβασης των αποδεκτών ορίων βραχυκύκλωσης μετά από αλλαγή 

των ρυθμίσεων και αναδιαμόρφωση του πλαισίου λειτουργίας του συστήματος 

 Κατάλληλη ρύθμιση των μέσων προστασίας έναντι βραχυκύκλωσης 

 Ανάλυση σφαλμάτων κατά τη λειτουργία του συστήματος και προσδιορισμός των 

αιτίων τους (π.χ. μη αναμενόμενη λειτουργία εξοπλισμού προστασίας) 

 Ανάλυση πιθανής αλληλεπίδρασης παράλληλων γραμμών κατά την εμφάνιση 

σφαλμάτων βραχυκύκλωσης 

 

Το PowerFactory διαθέτει μία πληθώρα δυνατοτήτων αναφορικά με τον υπολογισμό 

βραχυκυκλώματος, καθότι μπορεί να προσομοιώσει τόσο μεμονωμένα όσο και πολλαπλά 

σφάλματα πρακτικά απεριόριστης πολυπλοκότητας. Δεδομένου ότι η ανάλυση 

βραχυκυκλωμάτων μπορεί να αξιοποιηθεί για μία σειρά από σκοπούς, το πρόγραμμα 

υποστηρίζει διαφορετικές αναπαραστάσεις και υπολογιστικές μεθόδους για την ανάλυση των 

ρευμάτων βραχυκύκλωσης. Η παρούσα εργασία εστιάζει στη μέθοδο 61363-1, η οποία 

παρουσιάζει ιδιαίτερο ενδιαφέρον για τον τομέα των ηλεκτρικών δικτύων σε πλοία. 
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4.2 Η μέθοδος IEC 61363-1 για την ανάλυση 
βραχυκυκλωμάτων 

 
Το διεθνές πρότυπο IEC 61363-1 καθορίζει διαδικασίες για τον υπολογισμό των ρευμάτων 

βραχυκύκλωσης σε ηλεκτρικές εγκαταστάσεις τριφασικού ΕΡ σε πλοία και σε κινητές ή 

ακίνητες υπεράκτιες μονάδες. Τονίζεται ότι το πρότυπο αυτό αναφέρεται σε υπολογιστικές 

διαδικασίες που αφορούν μόνο τριφασικά (συμμετρικά) βραχυκυκλώματα. Αυτό διότι τα 

ηλεκτρικά συστήματα στις ναυτικές εφαρμογές λειτουργούν με τον ουδέτερο απομονωμένο 

από τη γάστρα ή συνδεμένο με αυτή μέσω μίας αντίστασης. Σε τέτοιου είδους συστήματα, η 

υψηλότερη τιμή ρεύματος βραχυκύκλωσης αντιστοιχεί σε τριφασικό βραχυκύκλωμα. 

Εξάλλου, εάν ο ουδέτερος κόμβος συνδεθεί απευθείας με τη γάστρα, τότε μπορεί να 

παραχθεί ένα ρεύμα βραχυκύκλωσης υψηλής έντασης. Άρα, η μέθοδος IEC 61363-1 εξετάζει 

τη δυσμενέστερη κατάσταση βραχυκύκλωσης. 

 

Σύμφωνα με το εν λόγω πρότυπο, το PowerFactory υπολογίζει μία ισοδύναμη μηχανή, η 

οποία τροφοδοτεί απευθείας την τοποθεσία του σφάλματος. μηχανή αυτή αναπαριστά όλα τα 

ενεργητικά και τα παθητικά στοιχεία του δικτύου. Η διαδικασία υπολογισμού στο πρότυπο 

IEC 61363-1 αποσκοπεί στην εύρεση της μέγιστης τιμής της άνω περιβάλλουσας του 

ρεύματος βραχυκύκλωσης (Εικόνα 4.1). Η περιβάλλουσα υπολογίζεται με τη χρήση 

συγκεκριμένων χαρακτηριστικών παραμέτρων των μηχανών, οι οποίες είναι γνωστές από 

τους κατασκευαστές του εξοπλισμού και προέρχονται από αναγνωρισμένες μεθόδους 

υπολογισμού. Όπως εκτέθηκε και στην υποπαράγραφο 3.5.3.3 του Κεφαλαίου 3, οι βασικές 

υποθέσεις είναι οι εξής [7]: 

 Όλες οι χωρητικότητες του συστήματος αμελούνται. 

 Κατά την έναρξη του βραχυκυκλώματος, η στιγμιαία τιμή της τάσης σε μία φάση στο 

σημείο του σφάλματος είναι μηδενική. 

 Κατά την εκδήλωση του βραχυκυκλώματος, δεν υπάρχει καμία μεταβολή στη 

διαδρομή του ρεύματος βραχυκύκλωσης. 

 Η αντίδραση τόξου του βραχυκυκλώματος αμελείται. 

 Οι μετασχηματιστές τίθενται στην κύρια θέση τους. 

 Το βραχυκύκλωμα εκδηλώνεται σε όλες τις φάσεις ταυτόχρονα. 

 Αναφορικά με τις γεννήτριες που είναι συνδεμένες παράλληλα, όλες μοιράζονται το 

ενεργό και το άεργο φορτίο αναλογικά, τόσο κατά την έναρξη όσο και κατά την 

εκδήλωση του βραχυκυκλώματος. 

 Όλα τα στοιχεία του βραχυκυκλώματος αντιδρούν, κατά τη διάρκεια κάθε διακριτού 

χρονικού διαστήματος, με γραμμικό τρόπο. 

 



102 
 

 
Εικόνα 4.1 Τυπική κυματομορφή ρεύματος βραχυκύκλωσης 

 

Η ανάλυση βραχυκυκλώματος στο PowerFactory, με βάση το διεθνές πρότυπο IEC 61363-1, 

υπολογίζει τα ακόλουθα μεγέθη: 

 Ik΄΄: Αρχικό συμμετρικό ρεύμα βραχυκύκλωσης 

 Άνω περιβάλλουσα του ρεύματος βραχυκύκλωσης Ik 

 idc: Αποσβεννύμενη (απεριοδική) συνιστώσα του ρεύματος βραχυκύκλωσης 

 ip: Κρουστικό ρεύμα βραχυκύκλωσης 

 Ik: Ρεύμα βραχυκύκλωσης μόνιμης κατάστασης 

 

Οι υπολογιστικές σχέσεις και μέθοδοι του προτύπου IEC 61363-1 παράγουν αποτελέσματα 

ικανοποιητικής ακρίβειας, ούτως ώστε να υπολογιστεί το ρεύμα βραχυκύκλωσης κατά τα 

πρώτα 100 ms του σφάλματος. Το πρότυπο υποθέτει ότι, κατά το μικρό αυτό χρονικό 

διάστημα, ο έλεγχος των γεννητριών δεν έχει καμία σημαντική επίδραση στις τιμές του 

ρεύματος βραχυκύκλωσης. Εντούτοις, η μέθοδος μπορεί να χρησιμοποιηθεί και για τον 

υπολογισμό του ρεύματος βραχυκύκλωσης για περιόδους μεγαλύτερες των 100 ms, όταν οι 

γεννήτριες είναι απευθείας συνδεμένες στο ζυγό όπου δημιουργείται το σφάλμα. Για 

χρονικές περιόδους μεγαλύτερες των 100 ms, οι επιδράσεις των ρυθμιστών τάσης του 

συστήματος μπορεί να είναι αισθητές. Ωστόσο, το πρότυπο δεν περιλαμβάνει υπολογισμούς 

που να λαμβάνουν υπόψη τις επιδράσεις των ρυθμιστών τάσης. [7] 
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4.3 Εφαρμογή της μεθόδου IEC 61363-1 στο PowerFactory 
 

Το PowerFactory χρησιμοποιεί μία εικονική αναπαράσταση των ενεργητικών στοιχείων ενός 

βραχυκυκλώματος και των παθητικών στοιχείων που συνδέουν και μεταφέρουν το ρεύμα 

βραχυκύκλωσης από την πηγή στο σημείο του σφάλματος. Στα ενεργητικά στοιχεία 

περιλαμβάνονται οι σύγχρονες και οι ασύγχρονες μηχανές, τα εξωτερικά δίκτυα, οι στατικές 

γεννήτριες και οι ιδανικές πηγές τάσης. Στα παθητικά στοιχεία περιλαμβάνονται οι γραμμές 

μεταφοράς, οι μετασχηματιστές, οι διακόπτες και οι σύνθετες αντιστάσεις. 

 

Η εικονική αναπαράσταση εξυπηρετεί τους εξής σκοπούς [8]: 

 Αποθηκεύει δεδομένα που σχετίζονται με τη σύγχρονη μηχανή, σύμφωνα με την 

παράγραφο 5.1.1 του προτύπου IEC 61363-1 [5] (υποπαράγραφος 3.5.4.1.1 του 

Κεφαλαίου 3 της εργασίας). 

 Αποθηκεύει δεδομένα που σχετίζονται με τον ασύγχρονο κινητήρα, σύμφωνα με την 

παράγραφο 5.1.2 του προτύπου IEC 61363-1 [5] (υποπαράγραφος 3.5.4.1.2 του 

Κεφαλαίου 3 της εργασίας). 

 Υπολογίζει τα ρεύματα βραχυκύκλωσης σύμφωνα με το πρότυπο IEC 61363-1, 

λαμβάνοντας υπόψη τις επιδράσεις των παθητικών στοιχείων, όπως αυτές δίνονται 

στην ενότητα 8.2 του προτύπου IEC 61363-1 [5] (υποπαράγραφος 3.5.6.2 του 

Κεφαλαίου 3 της εργασίας). 

 Πραγματοποιεί ενέργειες για τη σύνθεση επιμέρους μηχανών, όπως είναι η 

ισοδύναμη γεννήτρια και οι αναπαραστάσεις των κινητήρων. 

 

Στους Πίνακες 4.1 και 4.2 αναφέρονται οι μεταβλητές που χρησιμοποιούνται στην εικονική 

αναπαράσταση του προγράμματος. 

 

Παράμετροι για τη μοντελοποίηση μίας σύγχρονης μηχανής κατά IEC 61363-1 

Περιγραφή Εικονική αναπαράσταση Μονάδα μέτρησης 

Συχνότητα δικτύου f Hz 

Πολική τάση λειτουργίας U0 p.u. 

Ρεύμα λειτουργίας I0 p.u. 

Γωνία 00 IU   Φ0 - 

Ρεύμα βραχυκύκλωσης μόνιμης κατάστασης Ikd p.u. 

Αντίσταση στάτη Ra p.u. 

Υπομεταβατική αντίδραση Xd΄΄ p.u. 

Μεταβατική αντίδραση Xd΄ p.u. 

Υπομεταβατική χρονική σταθερά Τd΄΄ s 

Μεταβατική χρονική σταθερά Τd΄ s 

Χρονική σταθερά ΣΡ Τdc s 

Πίνακας 4.1 
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Παράμετροι για τη μοντελοποίηση μίας ασύγχρονης μηχανής κατά IEC 61363-1 

Περιγραφή Εικονική αναπαράσταση Μονάδα μέτρησης 

Συχνότητα δικτύου f Hz 

Πολική τάση λειτουργίας U0 p.u. 

Ρεύμα λειτουργίας I0 p.u. 

Γωνία 00 IU   Φ0 - 

Αντίσταση ρότορα RR p.u. 

Αντίσταση στάτη RS p.u. 

Αντίδραση ρότορα XR p.u. 

Αντίδραση στάτη XS p.u. 

Υπομεταβατική χρονική σταθερά ΤM΄΄ s 

Χρονική σταθερά ΣΡ ΤdcM s 

Πίνακας 4.2 
 

 

4.3.1 Αναπαράσταση ενεργητικών στοιχείων 
 

Για όλα τα ενεργητικά στοιχεία του δικτύου, οι ενεργές τάσεις Εq0΄΄ και Εq0΄ εξαρτώνται από 

το ρεύμα φόρτισης πριν το σφάλμα. Ο αλγόριθμος του προγράμματος θεωρεί την κατάσταση 

πριν το σφάλμα σύμφωνα με τις ρυθμίσεις στην καρτέλα Advanced Options του παραθύρου 

του υπολογισμού βραχυκυκλώματος. Οι ρυθμίσεις αυτές, όπως φαίνεται στην Εικόνα 4.2, 

περιλαμβάνουν τρεις επιλογές: χρήση ροής φορτίου πριν το σφάλμα (use load flow 

initialization), χρήση ονομαστικού ρεύματος/συντελεστή ισχύος (use rated current/power 

factor), αγνόηση κατάστασης πριν το σφάλμα (neglect preload condition). 

 

 
Εικόνα 4.2 Καρτέλα Advanced Options παραθύρου υπολογισμού βραχυκυκλώματος 

 

Στη βάση των προηγούμενων επιλογών για τις συνθήκες πριν το βραχυκύκλωμα, η πολική 

τάση και το ρεύμα λειτουργίας για όλα τα ενεργητικά στοιχεία ρυθμίζονται σύμφωνα με τον 

Πίνακα 4.3. [8] 
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Μεταβλητές πριν το σφάλμα για τα ενεργητικά στοιχεία 

Εικονική αναπαράσταση Μεταβλητή 

Χρήση ροής φορτίου πριν το σφάλμα 

U0 u (μιγαδική τιμή) 

I0 cur (μιγαδική τιμή) 

Χρήση ονομαστικού ρεύματος/συντελεστή ισχύος 

U0 01  

I0 ονομαστικό I ονομαστικός cosφ 

Αγνόηση κατάστασης πριν το σφάλμα 

U0 01  

I0 00  

Πίνακας 4.3 
 

4.3.1.1 Σύγχρονες μηχανές 
 

Όσον αφορά τις σύγχρονες μηχανές, που έχουν όνομα μεταβλητής ElmSym, οι απαιτούμενες 

παράμετροι εισόδου για τον υπολογισμό με βάση τη μέθοδο IEC 61363-1 φαίνονται στην 

Εικόνα 4.3. Επίσης, η σύνδεση αυτών των παραμέτρων με την εικονική αναπαράσταση του 

προγράμματος εκτίθεται στον Πίνακα 4.4. [8] 

 

 
Εικόνα 4.3 Παράμετροι εισόδου σύγχρονων μηχανών για τη μέθοδο IEC 61363-1 
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Σύνδεση παραμέτρων και εικονικής αναπαράστασης για σύγχρονες μηχανές 

Εικονική αναπαράσταση Μεταβλητή 

f r:cpGrid:frnom 

Ikd t:Ik 

Ra t:rstr 

Xd΄΄ t:xdss 

Xd΄ t:xds 

Τd΄΄ t:tdss 

Τd΄ t:tds 

Τdc t:tdc 

Πίνακας 4.4 
 

4.3.1.2 Ασύγχρονες μηχανές 
 

Αναφορικά με τις ασύγχρονες μηχανές, που έχουν όνομα μεταβλητής ElmAsm, οι 

απαιτούμενες παράμετροι εισόδου για τον υπολογισμό με βάση τη μέθοδο IEC 61363-1 

δίνονται στην Εικόνα 4.4. Ακόμα, η σύνδεση αυτών των παραμέτρων με την εικονική 

αναπαράσταση του προγράμματος εκτίθεται στον Πίνακα 4.5. [8] 

 

 
α 
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β 

Εικόνα 4.4 Παράμετροι εισόδου ασύγχρονων μηχανών για τη μέθοδο IEC 61363-1 
 

Σύνδεση παραμέτρων και εικονικής αναπαράστασης για ασύγχρονες μηχανές 

Εικονική αναπαράσταση Μεταβλητή 

f r:cpGrid:frnom 

XS t:xstr 

RS t:rstr ή t:rstrshc 

XR XR=XM΄΄−XS 

RR RR=RM΄΄−RS 

Πίνακας 4.5 
 

Πρέπει να σημειωθούν τα εξής: 

 Η μεταβλητή XM΄΄ (Εικόνα 4.4α) εισάγεται από το χρήστη (xdssshc) ή υπολογίζεται 

από τις μεταβλητές Locked Rotor Impedance (t:aiaznshc) και R/X Locked Rotor 

(t:rtoxshc) μέσω της σχέσης: 
2rtoxshc1aiaznshc

1


΄΄X M  

 Αν είναι ενεργοποιημένη η επιλογή Consider Transient Parameter (Εικόνα 4.4β), τότε 

οι τιμές των δύο προηγούμενων μεταβλητών λαμβάνονται από την καρτέλα Load 

Flow (t:aiazn και t:rtox) μέσω της σχέσης: 
2rtox1aiazn

1


΄΄X M  

 Η μεταβλητή RM υπολογίζεται με χρήση της μεταβλητής R/X Locked Rotor (t:rtoxshc 

ή t:rtox) ως εξής: rtoxshc ΄΄XR MM  

 

 

 

 

 

 

 



108 
 

4.3.2 Αναπαράσταση παθητικών στοιχείων 
 

Οι επιδράσεις των παθητικών στοιχείων, που συνδέονται σε σειρά με ενεργητικά στοιχεία 

του δικτύου, συνίστανται σε μία μείωση του μεγέθους του ρεύματος βραχυκύκλωσης, μία 

αύξηση της υπομεταβατικής και της μεταβατικής χρονικής σταθεράς και μία μείωση της 

χρονικής σταθεράς ΣΡ. Οι μεταβολές στη σύνθετη αντίσταση και στις χρονικές σταθερές 

υπολογίζονται εντός της εικονικής αναπαράστασης των ενεργητικών στοιχείων, μέσω των 

εξισώσεων (89)-(100) της ενότητας 8.2 του προτύπου IEC 61363-1 [5] (εξισώσεις (3.52)-

(3.63), υποπαράγραφος 3.5.6.2 του Κεφαλαίου 3 της εργασίας). 

 

4.3.2.1 Μετασχηματιστές 
 

Για τους μετασχηματιστές δύο τυλιγμάτων, που έχουν όνομα μεταβλητής ElmTr2, οι 

απαιτούμενες παράμετροι εισόδου για τον υπολογισμό με βάση τη μέθοδο IEC 61363-1 

δίνονται στην Εικόνα 4.5, ενώ η σύνδεση αυτών των παραμέτρων με την εικονική 

αναπαράσταση του προγράμματος εκτίθεται στον Πίνακα 4.6. [8] 

 

 
Εικόνα 4.5 Παράμετροι εισόδου μετασχηματιστών για τη μέθοδο IEC 61363-1 

 

Σύνδεση παραμέτρων και εικονικής αναπαράστασης για μετασχηματιστές 

Περιγραφή Εικονική αναπαράσταση Μονάδα μέτρησης Μεταβλητή 

Σύνθετη αντίσταση ευθέος άξονα Z=R+jX p.u. zshv + zslv 

Πίνακας 4.6 
 

Σημειώνεται ότι η σύνθετη αντίσταση δίνεται σε μονάδες p.u. σε αναφορά με την πλευρά 

(υψηλής ή χαμηλής τάσης) όπου εκδηλώνεται το σφάλμα. 
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4.3.3 Υπολογισμός ρευμάτων βραχυκύκλωσης 
 

4.3.3.1 Σύγχρονες μηχανές κατά IEC 61363-1 
 

Οι ενεργές τάσεις, οι οποίες εξαρτώνται από το ρεύμα φόρτισης πριν το σφάλμα, 

υπολογίζονται με χρήση των εξισώσεων (7)-(8) της υποπαραγράφου 5.1.1.5 του προτύπου 

IEC 61363-1 [5] (εξισώσεις (3.9)-(3.10), υποπαράγραφος 3.5.4.1.1 του Κεφαλαίου 3 της 

εργασίας): 

 

 
 

 

 
 

 

 

 

 

 

Τα υπομεταβατικά, μεταβατικά και μόνιμης κατάστασης ρεύματα υπολογίζονται μέσω των 

εξισώσεων (3)-(4) της υποπαραγράφου 5.1.1.5 του προτύπου IEC 61363-1 [5] (εξισώσεις 

(3.4)-(3.6), υποπαράγραφος 3.5.4.1.1 του Κεφαλαίου 3 της εργασίας): 

 

 

 

 

 

 

 

 

 

 

 

 

Η συνιστώσα ΕΡ, η συνιστώσα ΣΡ και η άνω περιβάλλουσα του ρεύματος βραχυκύκλωσης 

υπολογίζονται σύμφωνα με τις εξισώσεις (2), (9) και (1), αντίστοιχα, της υποπαραγράφου 

5.1.1.5 του προτύπου IEC 61363-1 [5] (εξισώσεις (3.3), (3.16) και (3.2), αντίστοιχα, 

υποπαράγραφος 3.5.4.1.1 του Κεφαλαίου 3 της εργασίας): 

 

 
 

 

 
 

 

 
 

 

 

 

4.3.3.2 Ασύγχρονες μηχανές κατά IEC 61363-1 
 

Η ενεργή τάση, η οποία εξαρτάται από το ρεύμα φόρτισης πριν το σφάλμα, προκύπτει από 

την εξίσωση (18) της υποπαραγράφου 5.1.2.6 του προτύπου IEC 61363-1 [5] (εξίσωση 

(3.25) υποπαράγραφος 3.5.4.1.2 του Κεφαλαίου 3 της εργασίας): 
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Το υπομεταβατικό ρεύμα δίνεται από την εξίσωση (17) της υποπαραγράφου 5.1.2.6 του 

προτύπου IEC 61363-1 [5] (εξίσωση (3.24) υποπαράγραφος 3.5.4.1.2 του Κεφαλαίου 3 της 

εργασίας): 

 

 
 

 

 

 

Η συνιστώσα ΕΡ, η συνιστώσα ΣΡ και η άνω περιβάλλουσα του ρεύματος βραχυκύκλωσης 

υπολογίζονται σύμφωνα με τις εξισώσεις (16), (20) και (15), αντίστοιχα, της υποπαραγράφου 

5.1.2.6 του προτύπου IEC 61363-1 [5] (εξισώσεις (3.23), (3.28) και (3.22), αντίστοιχα, 

υποπαράγραφος 3.5.4.1.2 του Κεφαλαίου 3 της εργασίας): 

 

 
 

 

 
 

 

 
 

 

 

 

4.3.3.3 Αλγόριθμος υπολογισμού βραχυκυκλώματος κατά IEC 61363-1 
 

Η παρακάτω διαδικασία ακολουθείται μετά από την εκτέλεση της εντολής για τον 

υπολογισμό βραχυκυκλώματος (Short-Circuit Calculation) στο PowerFactory [8]: 

 

Έναρξη βρόχου: για κάθε τερματικό “k”, το οποίο προσδιορίζεται στο πεδίο Fault Location 

του παραθύρου του υπολογισμού βραχυκυκλώματος, πραγματοποιούνται τα εξής βήματα: 

 

1. Ελέγχεται αν το σύστημα είναι ακτινικό. Παράλληλες γραμμές επιτρέπονται και 

αποτελούν αντικείμενο ειδικού χειρισμού. Αν ο έλεγχος του συστήματος είναι 

αρνητικός, η υπολογιστική διαδικασία διακόπτεται και τυπώνεται ένα σχετικό 

μήνυμα στο παράθυρο εξόδου. 

 

2. Πραγματοποιείται ένας βρόχος για όλα τα τερματικά (π.χ. ζυγοί), ώστε να 

δημιουργηθούν εικονικές αναπαραστάσεις των ενεργητικών στοιχείων. Εφόσον 

υπάρχουν περισσότερα του ενός ενεργητικά στοιχεία συνδεμένα στο ίδιο τερματικό, 

τότε δημιουργείται μία αναπαράσταση μίας ισοδύναμης μηχανής, όπως αναλύεται 

στην ενότητα 7 του προτύπου IEC 61363-1 [5] και φαίνεται στην Εικόνα 4.6. 
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Εικόνα 4.6 Αναπαράσταση ισοδύναμης μηχανής 

 

3. Τα ρεύματα βραχυκύκλωσης για τις εικονικές αναπαραστάσεις υπολογίζονται 

σύμφωνα με τις σχέσεις (1)-(21) των παραγράφων 5.1.1 και 5.1.2 του προτύπου IEC 

61363-1 [5] (εξισώσεις (3.2)-(3.29), υποπαράγραφος 3.5.4.1 του Κεφαλαίου 3 της 

εργασίας). Οι βασικότερες από τις σχέσεις αυτές εκτίθενται και στις υποπαραγράφους 

4.3.3.1 και 4.3.3.2 του παρόντος κεφαλαίου. 

 

4. Αρχίζοντας από τη μεγαλύτερη και πηγαίνοντας προς τη μικρότερη απόσταση, σε 

σχέση με το βραχυκυκλωμένο τερματικό “k”, τα παθητικά στοιχεία θεωρούνται στο 

πλαίσιο της αναπαράστασης της ισοδύναμης μηχανής με τον τρόπο που περιγράφεται 

στην ενότητα 8.2 του προτύπου IEC 61363-1 [5] (υποπαράγραφος 3.5.6.2 του 

Κεφαλαίου 3 της εργασίας). Στο τέλος της διαδικασίας αυτής, μόνο μία ισοδύναμη 

μηχανή, η οποία θα αντιπροσωπεύει όλες τις επιμέρους συνεισφορές στο 

βραχυκύκλωμα, θα προστεθεί στο τερματικό “k”, όπως φαίνεται στην Εικόνα 4.7. 
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Εικόνα 4.7 Αναπαράσταση ισοδύναμης μηχανής σε ένα τερματικό 

 

5. Υπολογίζονται οι γραφικές παραστάσεις των μεταβλητών του Πίνακα 4.7, θεωρώντας 

το χρονικό διάστημα ms 1000  t . 

 

Μεταβλητές γραφικών παραστάσεων 

Μεταβλητή Περιγραφή Υπολογισμός 

i_t 

Στιγμιαία τιμή του 

ρεύματος 

βραχυκύκλωσης σε kA 

     titftIti dcac 









2
2sin2


  

ik_t 

Άνω περιβάλλουσα του 

ρεύματος 

βραχυκύκλωσης σε kA 
     titIti dcack  2  

ikl_t 

Κάτω περιβάλλουσα του 

ρεύματος 

βραχυκύκλωσης σε kA 
     titIti dcackl  2  

idc_t 

Συνιστώσα ΣΡ του 

ρεύματος 

βραχυκύκλωσης σε kA 
 

Iac_t 

Συνιστώσα ΕΡ του 

ρεύματος 

βραχυκύκλωσης σε kA  

Πίνακας 4.7 
 

6. Υπολογίζονται οι μεταβλητές που απεικονίζονται στο μονογραμμικό διάγραμμα, 

σύμφωνα με τον Πίνακα 4.8. 
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Μεταβλητές μονογραμμικού διαγράμματος 

Μεταβλητή Περιγραφή Υπολογισμός 

Ikss 
Αρχικό ρεύμα 

βραχυκύκλωσης σε kA 

       









 


2
,

2
max

tDCtLowertDCtUpper
I kss  

t: χρόνος βραχυκύκλωσης 

Skss 
Αρχική φαινόμενη ισχύς 

βραχυκύκλωσης σε kVA ksskss IVS  3  

ip 
Κρουστικό ρεύμα 

βραχυκύκλωσης σε kA 

 

s 01.0Hz 50f  γγι
2

1




peakpeak

peakkp

t
f

t

tii

 

Πίνακας 4.8 
 

7. Αν είναι ενεργοποιημένη η επιλογή Create Plots στο παράθυρο διαλόγου του 

υπολογισμού βραχυκυκλώματος, δημιουργείται αυτόματα στο παράθυρο γραφικών 

μία καρτέλα γραφικών παραστάσεων (Virtual Instrument Panel), η οποία περιέχει ένα 

ή περισσότερα διαγράμματα με τη χρονική εξέλιξη του ρεύματος βραχυκύκλωσης, με 

βάση τις εξής μεταβλητές: i_t, ik_t, idc_t. 

 

Τέλος βρόχου 

 

 

 



ΚΕΦΑΛΑΙΟ 5 
 

Μελέτη βραχυκυκλώματος σε σύστημα 
ηλεκτρικής ενέργειας 

 
Στο κεφάλαιο αυτό θα πραγματοποιηθεί μία μελέτη βραχυκυκλώματος σε ένα υποθετικό 

ηλεκτρικό δίκτυο πλοίου με χρήση του PowerFactory, ενώ θα συγκριθούν τα αποτελέσματα 

της προσομοίωσης του προγράμματος με τα αντίστοιχα θεωρητικά αποτελέσματα. Πιο 

συγκεκριμένα, το δίκτυο πλοίου θα σχεδιαστεί στην πλατφόρμα του προγράμματος στη βάση 

θεωρητικών υπολογισμών βραχυκυκλώματος για το συγκεκριμένο δίκτυο κατά το διεθνές 

πρότυπο IEC 61363-1, που έχουν πραγματοποιηθεί στο πλαίσιο του προπτυχιακού 

μαθήματος «Ενεργειακά Συστήματα Πλοίου» του 8ου εξαμήνου της Σχολής Ναυπηγών 

Μηχανολόγων Μηχανικών ΕΜΠ. Το δίκτυο και οι θεωρητικοί υπολογισμοί περιλαμβάνονται 

σε υποδειγματική ηλεκτρολογική μελέτη [9], ενώ η σύγκριση μεταξύ των θεωρητικών 

αποτελεσμάτων και των αποτελεσμάτων του προγράμματος στοχεύει στην καλύτερη 

κατανόηση της θεωρίας βραχυκυκλωμάτων και των αντίστοιχων δυνατοτήτων του 

προγράμματος. Σημειώνεται ότι το ηλεκτρικό δίκτυο θα αποτελέσει τη βάση για μελλοντική 

ένταξη και χρήση του λογισμικού πακέτου PowerFactory στο συγκεκριμένο μάθημα. 

 

 

5.1 Σχεδιασμός του συστήματος ηλεκτρικής ενέργειας και 
υπολογισμός βραχυκυκλώματος 

 
Προκειμένου να γίνει ο υπολογισμός βραχυκυκλώματος, θα σχεδιαστεί το μονογραμμικό 

διάγραμμα του δικτύου στο PowerFactory και θα οριστούν όλες οι απαραίτητες παράμετροι 

των επιμέρους στοιχείων (γεννητριών, μετασχηματιστών, κινητήρων). Θα εξεταστούν δύο 

ξεχωριστές περιπτώσεις: 

1. Στην πρώτη περίπτωση, οι παράμετροι των καλωδίων και του μετασχηματιστή θα 

ενσωματωθούν στις παραμέτρους των γεννητριών και των κινητήρων. Έτσι, θα 

υπάρχει μόνο ο κύριος ζυγός, στον οποίο θα συνδέονται όλοι οι κινητήρες. 

2. Στη δεύτερη περίπτωση, θα ενταχθούν αυτόνομα τα καλώδια (με τη μορφή στοιχείων 

RLC) και ο μετασχηματιστής στο δίκτυο. 

 

Η κατάσταση του δικτύου που θα μελετηθεί αφορά την κανονική πορεία του πλοίου (εν 

πλω). Θεωρείται ότι ο χρήστης που θα επιχειρήσει το σχεδιασμό του δικτύου, έχει 

εξοικειωθεί με τις βασικές λειτουργίες του PowerFactory, μέσω του Κεφαλαίου 2 της 

παρούσας εργασίας. 

 

Το χαρακτηριστικά του μελετώμενου ηλεκτρικού δικτύου δίνονται στον Πίνακα 5.1. 
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Βασικά χαρακτηριστικά ηλεκτρικού δικτύου 

Τάση (V) 440 

Συχνότητα (Hz) 60 

Τύπος 3-phase 

Πίνακας 5.1 
 

Το δίκτυο διαθέτει τρεις (3) όμοιες σύγχρονες γεννήτριες τύπου Caterpillar SR4B 690, με 

ονομαστική ισχύ 725 kW η καθεμία. Τα χαρακτηριστικά της γεννήτριας δίνονται στον 

Πίνακα 5.2. 

 

Χαρακτηριστικά γεννητριών 

Τάση V 440 

Ισχύς kW 725 

Φαινόμενη ισχύς kVA 906 

Συχνότητα Hz 60 

Συντελεστής ισχύος cosφ  0.8 

Υπομεταβατική αντίδραση ευθέως άξονα Xd΄΄ % 18.512 

Μεταβατική αντίδραση ευθέως άξονα Xd΄ % 24.934 

Αντίδραση ευθέως άξονα Xd % 309.157 

Υπομεταβατική χρονική σταθερά ανοικτού κυκλώματος Τd0΄΄ s 0.1215 

Υπομεταβατική χρονική σταθερά Τd΄΄ s 0.00177 

Mεταβατική χρονική σταθερά ανοικτού κυκλώματος Τd0΄ s 2.73 

Mεταβατική χρονική σταθερά Τd΄ s 0.26288 

Αντίσταση στάτη Ra % 0.0165 

Πίνακας 5.2 
 

Σύμφωνα με τις διατάξεις του IEC 61363-1 [5], οι μικρής ισχύος κινητήρες μπορούν να 

ομαδοποιηθούν σε έναν ή περισσότερους ισοδύναμους κινητήρες. Η υποδειγματική μελέτη 

ορίζει έξι (6) ισοδύναμους ασύγχρονους κινητήρες με τα χαρακτηριστικά των ακόλουθων 

πινάκων. 

  

Ισοδύναμος κινητήρας Μ1 

Τάση V 440 

Ισχύς kW 338.46 

Φαινόμενη ισχύς kVA 423.075 

Συχνότητα Hz 60 

Συντελεστής ισχύος cosφ  0.8 

Αντίσταση στάτορα rS % 3.4 

Αντίσταση ρότορα rR % 2.1 

Επαγωγική αντίδραση στάτη XS % 7.5 

Επαγωγική αντίδραση ρότορα XR % 7.5 

Πίνακας 5.3 
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Ισοδύναμος κινητήρας Μ2 

Τάση V 440 

Ισχύς kW 36.61 

Φαινόμενη ισχύς kVA 45.76 

Συχνότητα Hz 60 

Συντελεστής ισχύος cosφ  0.8 

Αντίσταση στάτορα rS % 4.3 

Αντίσταση ρότορα rR % 2.7 

Επαγωγική αντίδραση στάτη XS % 9.4 

Επαγωγική αντίδραση ρότορα XR % 9.4 

Πίνακας 5.4 
 

Ισοδύναμος κινητήρας Μ3 

Τάση V 440 

Ισχύς kW 5.43 

Φαινόμενη ισχύς kVA 6.787 

Συχνότητα Hz 60 

Συντελεστής ισχύος cosφ  0.8 

Αντίσταση στάτορα rS % 4.3 

Αντίσταση ρότορα rR % 2.7 

Επαγωγική αντίδραση στάτη XS % 9.4 

Επαγωγική αντίδραση ρότορα XR % 9.4 

Πίνακας 5.5 
 

Ισοδύναμος κινητήρας Μ4 

Τάση V 440 

Ισχύς kW 99.58 

Φαινόμενη ισχύς kVA 124.47 

Συχνότητα Hz 60 

Συντελεστής ισχύος cosφ  0.8 

Αντίσταση στάτορα rS % 4.3 

Αντίσταση ρότορα rR % 2.7 

Επαγωγική αντίδραση στάτη XS % 9.4 

Επαγωγική αντίδραση ρότορα XR % 9.4 

Πίνακας 5.6 
 

Ισοδύναμος κινητήρας Μ5 

Τάση V 220 

Ισχύς kW 5.53 

Φαινόμενη ισχύς kVA 6.91 

Συχνότητα Hz 60 

Συντελεστής ισχύος cosφ  0.8 

Αντίσταση στάτορα rS % 4.3 

Αντίσταση ρότορα rR % 2.7 

Επαγωγική αντίδραση στάτη XS % 9.4 

Επαγωγική αντίδραση ρότορα XR % 9.4 

Πίνακας 5.7 
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Ισοδύναμος κινητήρας Μ6 

Τάση V 220 

Ισχύς kW 46.84 

Φαινόμενη ισχύς kVA 58.55 

Συχνότητα Hz 60 

Συντελεστής ισχύος cosφ  0.8 

Αντίσταση στάτορα rS % 4.3 

Αντίσταση ρότορα rR % 2.7 

Επαγωγική αντίδραση στάτη XS % 9.4 

Επαγωγική αντίδραση ρότορα XR % 9.4 

Πίνακας 5.8 
 

Για το μετασχηματιστή υποβιβασμού ισχύουν τα μεγέθη του Πίνακα 5.9. 

 

Μετασχηματιστής υποβιβασμού 

Τάση λειτουργίας πρωτεύοντος V 440 

Τάση λειτουργίας δευτερεύοντος V 220 

Συχνότητα Hz 60 

Συντελεστής απωλειών χαλκού urR % 1 

Συντελεστής τάσης βραχυκυκλώματος urk % 7 

Πίνακας 5.9 
 

Τα χαρακτηριστικά των καλωδίων δίνονται στον Πίνακα 5.10 που ακολουθεί. Το μήκος των 

καλωδίων είναι από τον κύριο ζυγό έως το εκάστοτε στοιχείο (γεννήτρια, κινητήρα). 

 

Καλώδια δικτύου 

Καλώδια Τύπος 
Μήκος L 

(m) 

Αντίσταση Rc 

(Ω/m) 

Επαγωγική αντίδραση  Χc 

(Ω/m) 

Γεννήτριας 3x(1*240) 2 0.000224 0.000129 

Κινητήρα 

Μ1 
3x(1*240) 1 0.000224 0.000129 

Κινητήρα 

Μ2 
1*240 19.5 0.0000747 0.000043 

Κινητήρα 

Μ3 
3*70 37.5 0.000280 0.000090 

Κινητήρα 

Μ4 
3*35 27.5 0.000560 0.000098 

Πίνακας 5.10 
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5.1.1 Προσομοίωση του δικτύου με τις παραμέτρους των καλωδίων 
και του μετασχηματιστή ενσωματωμένες στις ηλεκτρικές μηχανές 

 
Αρχικά, ο χρήστης δημιουργεί στο περιβάλλον του PowerFactory ένα νέο project με τον 

τρόπο που έχει περιγραφεί στο Κεφάλαιο 2. Στο νέο grid που ανοίγει, τοποθετείται ο κύριος 

ζυγός (Single Busbar System) και συνδέεται, σε πρώτη φάση, σε αυτόν μία σύγχρονη 

γεννήτρια. 

 

5.1.1.1 Ορισμός κύριου ζυγού 
 

Ο χρήστης ορίζει τον τύπο του ζυγού ως εξής: 

 Διπλό κλικ στο ζυγό προκειμένου να ανοίξει το παράθυρο διαλόγου. 

 Type → New Project Type 

 Ορίστε ένα όνομα, π.χ. Bus_high, Nominal Voltage: 0.44 kV 

 Αφού κλείσει το παράθυρο του Type, στην καρτέλα Basic Data ο χρήσης ορίζει ένα 

όνομα, π.χ. Main_Bus, και εκ νέου θέτει το Nominal Voltage → Line-Line στα 0.44 

kV. 

 

Ο χρήστης θα πρέπει να ορίσει ένα νέο τύπο ζυγού, διότι στη βιβλιοθήκη του PowerFactory 

δεν υπάρχει έτοιμο busbar type των 440V. Για το λόγο αυτό, δε θα πρέπει να συγχέονται τα 

δύο διαφορετικά ονόματα που δίνει ο χρήστης στο ζυγό, όπως περιγράφηκε παραπάνω. 

 

5.1.1.2 Ορισμός γεννήτριας και υπολογισμός των παραμέτρων της 
 

Ο χρήστης θα πρέπει να ορίσει ένα νέο τύπο γεννήτριας. Το δίκτυο αποτελείται από τρεις (3) 

γεννήτριες με τα χαρακτηριστικά που δόθηκαν στην αρχή του κεφαλαίου. Για τη μελέτη 

βραχυκυκλώματος θα θεωρηθεί ότι υπάρχει μία γεννήτρια στο δίκτυο με ισχύ 

kVA 2718=9063 , με τις υπόλοιπες παραμέτρους (επαγωγικές αντιδράσεις, χρονικές 

σταθερές κ.λπ.) να παραμένουν ίδιες. Η επιλογή αυτή προκύπτει από την υποπαράγραφο 

3.5.6.3.1 του Κεφαλαίου 3 για το πρότυπο IEC 61363-1, σύμφωνα με την οποία αν οι 

παράλληλα συνδεμένες γεννήτριες έχουν ίδια χαρακτηριστικά και τιμές λειτουργίας, 

μπορούν να αξιολογηθούν σαν μία γεννήτρια με χαρακτηριστικά λειτουργίας ίσα με το 

άθροισμα των χαρακτηριστικών λειτουργίας κάθε χωριστής γεννήτριας.  Έτσι, ο χρήστης 

επιλέγει από το παράθυρο διαλόγου Type → New Project Type και ακολουθεί την παρακάτω 

διαδικασία στο παράθυρο που ανοίγει. 

 

Καρτέλα Basic Data 

 

 Name: 2718kVA/440V-Cable 

 Nominal Apparent Power: 2.718 MVA 

 Nominal Voltage: 0.44 kV 

 Power Factor: 0.8 

 Connection: YN 

 

Καρτέλα Load Flow 

 

Σύμφωνα με τα χαρακτηριστικά της γεννήτριας, η επαγωγική αντίδραση ευθέως άξονα είναι 

ίση με  Xd=309.157% ή Xd=3.09157 p.u. στο ανά μονάδα σύστημα (per unit system). Σε 

αυτήν την τιμή θα πρέπει να ενσωματωθεί και η επαγωγική αντίδραση του καλωδίου Xc. 
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Η βασική αντίσταση της γεννήτριας είναι: 

 

 
G

2

base
S

V
 =Z  (5.1) 

 

 

Επίσης, ισχύουν τα εξής: 

 

     basedd Zp.u.Χ=ΩΧ   (5.2) 

    Ω/mXL=ΩX cc   (5.3) 

 cddG X+X=X  (5.4) 

 

 

Έτσι, προκύπτουν τα αποτελέσματα του Πίνακα 5.11. 

 

Αντίδραση μόνιμης κατάστασης γεννήτριας 

Zbase (Ω) 0.071229 

Χd (Ω) 0.220209 

Χc (Ω) 0.000258 

XdG (Ω) 0.220467 

XdG (p.u.) 3.095192 

Πίνακας 5.11 
 

Η τιμή XdG (p.u.), δηλαδή, είναι η διορθωμένη τιμή Xd της γεννήτριας, έχοντας ενσωματώσει 

και το καλώδιο. Επιπλέον, θεωρείται ότι η γεννήτρια έχει ρότορα κυλινδρικής μορφής, οπότε 

η επαγωγική αντίδραση του εγκάρσιου άξονα Xq είναι κατά προσέγγιση ίση με την 

αντίδραση ευθέως άξονα: XdG=XqG. Μία ακόμα παράμετρος, που θα πρέπει να οριστεί στην 

καρτέλα του Load Flow, είναι η αντίδραση αρνητικής ακολουθίας Χ2 (Negative Sequence 

Reactance). Για τις ανάγκες της μελέτης βραχυκυκλωμάτων Χ2=ΧdG. 

 

Με βάση τα παραπάνω, ο χρήστης δίνει τις εξής τιμές στο παράθυρο διαλόγου: 

 Xd=XdG=3.09519 p.u. 

 Xq=XqG=3.09519 p.u. 

 X2=3.09519 p.u. 

 

Όλες οι υπόλοιπες τιμές παραμένουν ως έχουν (default επιλογές του προγράμματος). Στην 

εικόνα που ακολουθεί, φαίνονται οι παράμετροι που ορίζονται από το χρήστη. 
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Εικόνα 5.1 Ορισμός παραμέτρων γεννήτριας στην καρτέλα Load Flow 

 

Σημειώνεται ότι η αντίδραση αρνητικής ακολουθίας Χ2 ορίζεται ως το πηλίκο της βασικής 

συνιστώσας αντίδρασης της τάσης αρνητικής ακολουθίας του τυλίγματος του στάτη, εξαιτίας 

του ημιτονοειδούς ρεύματος αρνητικής ακολουθίας του τυλίγματος του στάτη σε ονομαστική 

συχνότητα, προς την τιμή αυτού του ρεύματος, με τη μηχανή να κινείται στο σύγχρονο 

αριθμό στροφών. 

 

Καρτέλα IEC 61363 

 

Σε αυτό το σημείο, θα υπολογιστούν η υπομεταβατική και η μεταβατική αντίδραση Xd΄΄ και 

Xd΄, αντίστοιχα, λαμβάνοντας υπόψη το καλώδιο. Ακόμα, θα πρέπει να υπολογιστούν οι  

νέες χρονικές σταθερές Td΄΄, Td΄, των οποίων η τιμή μεταβάλλεται λόγω των καλωδίων, 

καθώς και η αντίσταση του στάτη Rstr. Για τις αντιδράσεις ευθέως άξονα Xd΄΄ και Xd΄ 

ισχύουν αντίστοιχες σχέσεις με αυτές της καρτέλας Load Flow, σχετικά με τον τρόπο 

υπολογισμού και ενσωμάτωσης των καλωδίων: 

 

     basedd Zp.u.Χ=ΩΧ ΄΄΄΄  (5.5) 

     basedd Zp.u.Χ=ΩΧ ΄΄  (5.6) 

 cddG X+΄΄X=΄΄X  (5.7) 

 cddG X+΄X=΄X  (5.8) 

 

 

Επιπλέον, έχουμε: 

 

     baseaa Zp.u.R=ΩR   (5.9) 

    Ω/mRL=ΩR cc   (5.10) 

 castr R+R=R  (5.11) 
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  
 
 AI

AI
p.u.I

base

kd

kd   (5.12) 

 
V

S
I base

base



3

 (5.13) 

 

 

Ο τρόπος υπολογισμού του ρεύματος βραχυκύκλωσης μόνιμης κατάστασης Ikd και των 

χρονικών σταθερών Td΄΄, Td΄, σύμφωνα με το πρότυπο IEC 61363-1 [5], έχει παρουσιαστεί 

στο Κεφάλαιο 3.  Τα αποτελέσματα όλων των παραπάνω υπολογισμών δίνονται στον 

επόμενο πίνακα. Τα στοιχεία με έντονους χαρακτήρες είναι αυτά που τελικά εισάγονται στο 

PowerFactory (Εικόνα 5.2). 

 

Στοιχεία βραχυκυκλώματος για τη γεννήτρια 

Zbase (Ω) 0.071229 

Xd΄΄ (Ω) 0.013186 

Xd΄ (Ω) 0.017760 

Χc (Ω) 0.000258 

XdG΄΄ (Ω) 0.013444 

XdG΄ (Ω) 0.018018 

XdG΄΄ (p.u.) 0.188742 

XdG΄ (p.u.) 0.252962 

Rc (Ω) 0.000448 

Ra (Ω) 0.000012 

Rstr (Ω) 0.000460 

Rstr (p.u.) 0.006455 

Td΄΄ (s) 0.001779 

Td΄ (s) 0.123194 

Ibase (Α) 3566.450 

Ιkd (p.u.) 0.509466 

Πίνακας 5.12 
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Εικόνα 5.2 Ορισμός παραμέτρων γεννήτριας στην καρτέλα IEC 61363 

 

Αφού οριστούν όλες οι παράμετροι που περιγράφονται παραπάνω, ο χρήστης κλείνει το 

παράθυρο διαλόγου του τύπου της γεννήτριας (παράθυρο .TypSym) και στο γενικό 

παράθυρο της γεννήτριας (.ElmSym) θέτει: 

 Καρτέλα Basic Data 

- Name: Gen 

- Grounding/Neutral Conductor → N-Connection: None. Αυτή η επιλογή γίνεται, 

αφού κατά κανόνα τα δίκτυα των πλοίων δεν έχουν ουδέτερο κόμβο. 

 Καρτέλα Load Flow 

- Επιλέγεται η γεννήτρια ως Reference Machine (Slack). 

- Input Mode: P, cos(phi) 

- Active Power: 2.1744 MW 

- Power Factor: 0.8 inductive 

 

Όλες οι υπόλοιπες παράμετροι παραμένουν ως έχουν (Εικόνα 5.3). 
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Εικόνα 5.3 Ρυθμίσεις γεννήτριας στην καρτέλα Load Flow 

 

5.1.1.3 Ορισμός ισοδύναμων κινητήρων και υπολογισμός των παραμέτρων τους 
 

Όπως αναφέρθηκε και παραπάνω, όλοι οι ισοδύναμοι κινητήρες θα συνδεθούν στο ζυγό των 

440 V. Τα χαρακτηριστικά μεγέθη των κινητήρων Μ5 και Μ6, που έχουν ονομαστική τάση 

220 V, θα αναχθούν στα 440 V ενσωματώνοντας και τις παραμέτρους του μετασχηματιστή 

υποβιβασμού της τάσης. Σημειώνεται ότι ο αριθμός των πόλων των κινητήρων δεν είναι 

γνωστός, οπότε το αντίστοιχο πεδίο δε μεταβάλλεται (1 ζεύγος πόλων). Εξάλλου, η τιμή 

αυτή δεν επηρεάζει τα υπολογιζόμενα μεγέθη του βραχυκυκλώματος.  

 

Ο χρήστης αρχικά συνδέει στον κύριο ζυγό έναν ασύγχρονο κινητήρα. Δεδομένου ότι στη 

βιβλιοθήκη του PowerFactory δεν υπάρχουν κινητήρες με τα ονομαστικά μεγέθη των 

κινητήρων του δικτύου που μελετάται, θα οριστούν νέοι τύποι κινητήρων. 

 

5.1.1.3.1 Ορισμός ισοδύναμου κινητήρα Μ1 
 

Ανοίγοντας το παράθυρο διαλόγου του ασύγχρονου κινητήρα, επιλέγεται Type → New 

Project Type. Στο παράθυρο (.TypAsmo) που ανοίγει αυτόματα, ακολουθείται η παρακάτω 

διαδικασία (Εικόνα 5.4). 

 

 

Καρτέλα Basic Data 

 

 Name: AM1-Cable 

 Rated Voltage: 0.44 kV 
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 Input Mode: Electrical Parameter 

 Power Rating → Rated Mechanical Power: 338.46 kW 

 Nominal Frequency: 60 Hz 

 

 
Εικόνα 5.4 Ορισμός νέου τύπου ασύγχρονου κινητήρα 

 

Καρτέλα Load Flow 

 

Στην καρτέλα αυτή πρέπει να οριστούν οι αντιστάσεις και επαγωγικές αντιδράσεις τόσο του 

στάτη όσο και του ρότορα. Τα μεγέθη αυτά είναι γνωστά, ωστόσο όπως και με τη γεννήτρια, 

έτσι και με τους κινητήρες, θα ενσωματωθούν σε αυτά και τα αντίστοιχα μεγέθη των 

καλωδίων. Για τον κινητήρα Μ1 ισχύουν τα εξής: 

 

 
M

2

base
S

V
 =Z  (5.14) 

 

 

 

Για το στάτη ισχύει: 

 

     baseZ p.u.RΩR smsm  (5.15) 

     baseZ p.u.XΩX smsm  (5.16) 

 

 

Για το καλώδιο είναι: 
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    Ω/mRΩR cc  L  (5.17) 

    Ω/mXΩX cc  L  (5.18) 

 

 

Το καλώδιο ενσωματώνεται στα μεγέθη του κινητήρα: 

 

 csms RRR   (5.19) 

  
 

base

s
s

Z

R
upR


..  (5.20) 

 csms XXX   (5.21) 

  
 

base

s
s

Z

X
upX


..  (5.22) 

 

 

Τα αποτελέσματα δίνονται σε συγκεντρωτική μορφή στον Πίνακα 5.13. 

 

Στοιχεία ροής φορτίου για τον κινητήρα Μ1 

Zbase (Ω) 0.457602 

Rsm (Ω) 0.015558 

Xsm (Ω) 0.034320 

Rc (Ω) 0.000224 

Xc (Ω) 0.000129 

Rs (Ω) 0.015782 

Rs (p.u.) 0.034490 

Xs (Ω) 0.034449 

Xs (p.u.) 0.075282 

Πίνακας 5.13 
 

Επίσης, από τα χαρακτηριστικά του κινητήρα έχουμε ότι RrA=0.021 p.u. και XrA=0.075 για 

το ρότορα. Τα Rs, Xs, RrA, XrA είναι οι παράμετροι που εισάγονται στο PowerFactory 

(Εικόνα 5.5). Το μέγεθος Xm (magnetic reactance) είναι η αντίδραση του κλάδου μαγνήτισης 

του κινητήρα. Η τιμή του μετά από δοκιμές ορίστηκε στο 1.82, έτσι ώστε ο συντελεστής 

ισχύος του κινητήρα, που υπολογίζεται αυτόματα από το πρόγραμμα στην καρτέλα Basic 

Data, να προσεγγίζει ικανοποιητικά τον ονομαστικό συντελεστή ισχύος 0.8. 
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Εικόνα 5.5 Ορισμός μεγεθών ασύγχρονου κινητήρα Μ1 στην καρτέλα Load Flow 

 

Καρτέλα IEC 61363 

 

Στην καρτέλα αυτή ο χρήστης ενεργοποιεί την επιλογή Consider Transient Parameter, οπότε 

το πρόγραμμα αυτόματα υπολογίζει όλες τις απαραίτητες παραμέτρους του κινητήρα για τον 

υπολογισμό βραχυκυκλώματος, λαμβάνοντας υπόψη τα δεδομένα που όρισε ο χρήστης στην 

καρτέλα του Load Flow. Συγκρίνοντας τα μεγέθη αυτά με τα αντίστοιχα που έχουν 

υπολογιστεί στην υποδειγματική μελέτη [9], παρατηρείται μία μικρή απόκλιση, η οποία 

οφείλεται στον κλάδο μαγνήτισης. Ο κλάδος αυτός αγνοείται στους θεωρητικούς 

υπολογισμούς. Πράγματι, αν ο χρήστης θέσει ως Χm μια αρκετά μεγάλη τιμή (π.χ. 100000) 

ώστε να αγνοηθεί πρακτικά, παρατηρείται ότι η απόκλιση των αποτελεσμάτων των 

παραμέτρων περιορίζεται μετά τα πέντε πρώτα δεκαδικά ψηφία. 

 

Αφού ολοκληρωθούν τα παραπάνω, στο αρχικό παράθυρο .ElmAsm ορίζεται ένα όνομα για 

τον κινητήρα, όπως Motor1, ενώ στην καρτέλα του Load Flow έχουμε τα εξής (Εικόνα 5.6): 

 Bus Type: AS 

 Active Power: 0.33846 MW 
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Εικόνα 5.6 Ρύθμιση παραμέτρων ισχύος κινητήρα Μ1 

 

5.1.1.3.2 Ορισμός ισοδύναμων κινητήρων Μ2, Μ3, Μ4 
 

Για τους κινητήρες Μ2, Μ3, Μ4 ακολουθείται ακριβώς η ίδια διαδικασία. Όλα τα 

απαραίτητα μεγέθη για τους υπολογισμούς υπάρχουν στους πίνακες με τα χαρακτηριστικά 

των κινητήρων στην αρχή του παρόντος κεφαλαίου. Ο χρήστης τοποθετεί διαδοχικά τους 

κινητήρες Μ2, Μ3, Μ4 στο ζυγό των 440V και ρυθμίζει τις παραμέτρους με τη διαδικασία 

που περιγράφηκε για τον κινητήρα Μ1. Στον πίνακα που ακολουθεί, δίνονται οι παράμετροι 

που πρέπει να οριστούν για κάθε κινητήρα. 

 

Στοιχεία ροής φορτίου για τους κινητήρες Μ2, Μ3, Μ4 

Παράμετροι Μ2 Μ3 Μ4 

Rs (p.u.) 0.043344 0.043368 0.052901 

Xs (p.u.) 0.094198 0.094118 0.095733 

RrA (p.u.) 0.027 0.027 0.027 

XrA (p.u.) 0.094 0.094 0.094 

Xm (p.u.) 1.882 1.881 1.85 

Active Power (MW) 0.03661 0.00543 0.09958 

Πίνακας 5.14 
 

5.1.1.3.3 Ορισμός ισοδύναμων κινητήρων Μ5, Μ6 
 

Οι κινητήρες αυτοί έχουν ονομαστική τάση 220V. Τα χαρακτηριστικά τους θα αναχθούν στα 

440V, λαμβάνοντας υπόψη και τις παραμέτρους του μετασχηματιστή. 

 

Αρχικά, γίνεται αναγωγή των παραμέτρων Rs, Xs, XrA και RrA των κινητήρων στην πλευρά 

των 440V, πολλαπλασιάζοντας τις ονομαστικές τιμές αυτών (σε p.u.) με το λόγο 220/440. 

Στη συνέχεια, ενσωματώνονται  οι απώλειες χαλκού και  ο συντελεστής τάσης 
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βραχυκυκλώματος του μετασχηματιστή στις νέες αυτές τιμές των παραμέτρων των 

κινητήρων: 

 

 rRu s,440cors, RR  (5.23) 

 rku s,440cors, XX  (5.24) 

 

Ο Πίνακας 5.15 περιλαμβάνει τις παραμέτρους για τους κινητήρες Μ5, Μ6, ενώ στην Εικόνα 

5.7 έχουμε το παράθυρο του κινητήρα Μ5 (όμοιο με το παράθυρο του κινητήρα Μ6) με τις 

ορθές τιμές συμπληρωμένες. Απαιτείται προσοχή στο ότι η τάση των κινητήρων είναι στα 

440 V, λόγω της αναγωγής τους στον κύριο ζυγό των 440 V, μέσω του μετασχηματιστή. 

 

Στοιχεία ροής φορτίου για τους κινητήρες Μ5, Μ6 

Παράμετροι Μ5 Μ6 

Rs,440 (p.u.) 0.0215 0.0215 

Xs,440 (p.u.) 0.0470 0.0470 

RrA,440 (p.u.) 0.0135 0.0135 

XrA,440 (p.u.) 0.0470 0.0470 

Rs,corr (p.u.) 0.0315 0.0315 

Xs,corr (p.u.) 0.1170 0.1170 

Xm (p.u.) 1.834 1.834 

Active Power (MW) 0.00553 0.04684 

Πίνακας 5.15 
 

 
Εικόνα 5.7 Ορισμός παραμέτρων κινητήρων Μ5 και Μ6 
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Σε αυτό το σημείο και αφού έχουν οριστεί όλες οι παράμετροι του ζυγού, της γεννήτριας και 

των κινητήρων, το σύστημα είναι έτοιμο για τον υπολογισμό βραχυκυκλώματος. Το 

ηλεκτρικό δίκτυο θα πρέπει να είναι όπως φαίνεται στην Εικόνα 5.8. 

 

 
Εικόνα 5.8 Ηλεκτρικό δίκτυο (περίπτωση με ενσωματωμένα καλώδια και μετασχηματιστή) 

 

5.1.1.4 Υπολογισμός βραχυκυκλώματος 
 

Από την μπάρα των κύριων εικονιδίων επιλέγεται το εικονίδιο . Στο παράθυρο που 

ανοίγει γίνονται οι εξής ρυθμίσεις: 

 Basic Options 

- Method: IEC 61363 

- Calculate Using: Standard IEC 61363 Method 

- Break Time: 0.1 s 

- Fault Location: User Selection → Select → Επιλογή Main_Bus 

- Show Output: επιλογή για εμφάνιση αποτελεσμάτων στο παράθυρο εξόδου 

- Create Plots: επιλογή, Show: only short-circuit current at faulted terminal, ώστε 

να αποτυπωθούν τα αποτελέσματα του βραχυκυκλώματος στο ζυγό με τη μορφή 

διαγράμματος. 

 Advanced Options 

- Preload Condition: use load flow initialization, ώστε να πραγματοποιηθεί ένας 

υπολογισμός ροής φορτίου πριν από το βραχυκύκλωμα 

 

Σημειώνεται ότι ο υπολογισμός βραχυκυκλώματος σε ένα ζυγό μπορεί να επιλεγεί και με δεξί 

κλικ στο ζυγό στο μονογραμμικό διάγραμμα, μέσω της διαδρομής Calculate → Short-Circuit. 

 

Κατόπιν, με το Execute πραγματοποιείται ο υπολογισμός σε κάθε στοιχείο του δικτύου. Στο 

παράθυρο αποτελεσμάτων κάθε στοιχείου εμφανίζονται τα εξής μεγέθη: 

 Skss: αρχική φαινόμενη ισχύς βραχυκύκλωσης 

 Ikss: αρχικό ρεύμα βραχυκύκλωσης (ίσο με το υπομεταβατικό ρεύμα 

βραχυκυκλώματος) 

 Ip: κρουστικό ρεύμα βραχυκύκλωσης 

 

Ο χρήστης έχει τη δυνατότητα να εμφανίσει και άλλα μεγέθη. Αυτό είναι εφικτό επιλέγοντας 

το παράθυρο αποτελεσμάτων και ακολουθώντας τα εξής βήματα: 

 Δεξί κλικ και επιλογή Edit Format for Edge Elements. 

 Στο παράθυρο που ανοίγει, διπλό κλικ σε κάποια μεταβλητή της στήλης Variable 

 Επιλογή επιθυμητών μεγεθών με το , ώστε να εμφανίζονται τα ακόλουθα μεγέθη 

(Εικόνα 5.9): 
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- Ikdss (Subtransient Short-Circuit Current) 

- Ikds (Transient Short-Circuit Current) 

- Ikd (Steady-State Short-Circuit Current) 

- ip (Peak Short-Circuit Current) 

- Tdss (Subtransient Time Constant) 

- Tds (Transient Time Constant) 

- Tdc (D.C. Time Constant) 

 

Τα προηγούμενα μεγέθη αφορούν τη γεννήτρια και τους κινητήρες. Με αντίστοιχη 

διαδικασία, μέσω της επιλογής Edit Format for Short Circuit Nodes, επιλέγεται για το ζυγό 

το μέγεθος ip (Peak Short-Circuit Current). 

 

 
Εικόνα 5.9 Επιλογή εμφανιζόμενων μεγεθών για τον υπολογισμό βραχυκυκλώματος 

 

Στον Πίνακα 5.16 που ακολουθεί, παρουσιάζονται τα αποτελέσματα της μελέτης 

βραχυκυκλώματος. Όσον αφορά τη γεννήτρια, τα αποτελέσματα περιλαμβάνουν το 

υπομεταβατικό και μεταβατικό ρεύμα βραχυκύκλωσης, το ρεύμα μόνιμης κατάστασης, το 

κρουστικό ρεύμα, την υπομεταβατική χρονική σταθερά, τη μεταβατική χρονική σταθερά και 

τη χρονική σταθερά ΣΡ. Για τους ασύγχρονους κινητήρες, καθώς δεν έχουν τύλιγμα 

διέγερσης, η συνεισφορά τους είναι αξιόλογη μόνο κατά την υπομεταβατική τους περίοδο, 

ενώ δεν υφίσταται μόνιμη κατάσταση (μηδενίζεται το ρεύμα βραχυκύκλωσης). Στον κύριο 

ζυγό ενδιαφέρον παρουσιάζει η τιμή του κρουστικού ρεύματος. 
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Αποτελέσματα υπολογισμού βραχυκυκλώματος 

Variables Generator 
Motor 

1 

Motor 

2 

Motor 

3 

Motor 

4 

Motor 

5 

Motor 

6 

Main Busbar 

(440 V) 

Ikd΄΄ (kA) 19.470 3.298 0.281 0.042 0.750 0.050 0.420 - 

Ikd΄ (kA) 14.677 0.000 0.000 0.000 0.000 0.000 0.000 - 

Ikd (kA) 1.817 0.000 0.000 0.000 0.000 0.000 0.000 - 

Ip (kA) 43.662 5.562 0.478 0.071 1.195 0.097 0.824 52.559 

Td΄΄ (s) 0.0018 0.0202 0.0199 0.0199 0.0201 0.0337 0.0337 - 

Td΄ (s) 0.1232 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 - 

Tdc (s) 0.0776 0.0113 0.0113 0.0113 0.0093 0.0137 0.0137 - 

Πίνακας 5.16 
 

Επιπρόσθετα, δίνεται το διάγραμμα της κυματομορφής του ρεύματος βραχυκύκλωσης στον 

κύριο ζυγό, το οποίο περιλαμβάνει τη στιγμιαία τιμή, τη συνιστώσα ΣΡ και την άνω 

περιβάλλουσα του ρεύματος βραχυκύκλωσης σε συνάρτηση με το χρόνο (Εικόνα 5.10). 

 

 
Εικόνα 5.10 Κυματομορφή ρεύματος βραχυκύκλωσης στον κύριο ζυγό 
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5.1.2 Προσομοίωση του δικτύου με τα καλώδια και το 
μετασχηματιστή ως αυτόνομα στοιχεία 

 
Η δεύτερη εκδοχή του δικτύου, με τα καλώδια και το μετασχηματιστή ως αυτόνομα στοιχεία, 

θα σχεδιαστεί σε ένα νέο grid. Η διαδικασία σχεδιασμού είναι παρόμοια με αυτήν που 

περιγράφηκε για την πρώτη περίπτωση, οπότε το κείμενο της παραγράφου θα είναι πιο 

σύντομο, ώστε να εστιάζει στην ερμηνεία των διαφορών που προκύπτουν λόγω της ύπαρξης 

των καλωδίων και του μετασχηματιστή. Η συγκεκριμένη εκδοχή του δικτύου δεν απαιτεί 

υπολογισμούς για την ενσωμάτωση των καλωδίων και του μετασχηματιστή στις 

παραμέτρους των ηλεκτρικών μηχανών, οπότε γίνεται χρήση των ονομαστικών τους 

παραμέτρων. Στο νέο grid, δημιουργούνται αρχικά δύο κύριοι ζυγοί (Single Busbar System). 

 

 

5.1.2.1 Ορισμός κύριων ζυγών στα 440 και στα 220 V 
 

Για το ζυγό των 440 V, γίνεται χρήση του υπάρχοντος τύπου με όνομα Bus_high και 

Nominal Voltage 0.44 kV. Ο τύπος μπορεί να εντοπιστεί μέσω της διαδρομής Type → Select 

Project Type. Χρησιμοποιείται ένα χαρακτηριστικό όνομα, π.χ. Main_Bus 440 V, ενώ τίθεται 

το Nominal Voltage → Line-Line στα 0.44 kV. 

 

Για το ζυγό των 220 V, ο χρήστης δημιουργεί νέο τύπο με τη γνωστή διαδικασία, θέτοντας 

ως όνομα του τύπου Bus_low και Nominal Voltage 0.22 kV. Επίσης, δίνεται όνομα 

Main_Bus 220 V στο ζυγό, ενώ τίθεται το Nominal Voltage → Line-Line στα 0.22 kV. 

 

5.1.2.2 Ορισμός γεννήτριας 
 

Θεωρείται και πάλι μία ισοδύναμη γεννήτρια, η οποία αντικαθιστά τις τρεις γεννήτριες του 

δικτύου. Προκειμένου να μοντελοποιήσουμε το καλώδιο, θα χρησιμοποιήσουμε το στοιχείο 

Series RLC-Filter ( ), το οποίο είναι ένα στοιχείο RLC. Εφόσον δοθούν οι κατάλληλες 

τιμές στο στοιχείο, αυτό μπορεί να μοντελοποιήσει ένα καλώδιο συγκεκριμένου μήκους. Η 

μέθοδος αυτή απαιτεί τη χρήση ενός απλού βοηθητικού ζυγού (Busbar), επί του οποίου θα 

συνδεθούν η γεννήτρια και το στοιχείο RLC. 

 

Αρχικά, τοποθετείται ο βοηθητικός ζυγός, στον οποίο αποδίδεται ο τύπος του κύριου ζυγού 

των 440 V και όνομα Bus_Gen. Στην επάνω πλευρά του ζυγού συνδέεται μία γεννήτρια, ενώ 

στην κάτω πλευρά ένα στοιχείο RLC, το οποίο οδηγείται μέχρι τον κύριο ζυγό των 440 V. Τα 

χαρακτηριστικά των στοιχείων RLC θα καθοριστούν στην παράγραφο 5.1.2.4. 

 

Απαιτείται νέος τύπος για τη γεννήτρια, χωρίς το καλώδιο και με τα ακόλουθα 

χαρακτηριστικά. 

 

Καρτέλα Basic Data 

 

 Name: 2718kVA/440V 

 Nominal Apparent Power: 2.718 MVA 

 Nominal Voltage: 0.44 kV 

 Power Factor: 0.8 

 Connection: YN 
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Καρτέλα Load Flow 

 

Χρησιμοποιούμε την ονομαστική τιμή για την επαγωγική αντίδραση του ευθέως άξονα Xd, η 

οποία ισούται και εδώ με την επαγωγική αντίδραση του εγκάρσιου άξονα Xq, καθώς και με 

την αντίδραση αρνητικής ακολουθίας Χ2. Οι τιμές για την καρτέλα είναι οι ακόλουθες: 

 Xd=3.09157 p.u. 

 Xq=3.09157 p.u. 

 X2=3.09157 p.u. 

 

Καρτέλα IEC 61363 

 

Εδώ χρησιμοποιούνται οι ονομαστικές τιμές της γεννήτριας και η σχέση (5.12) για το ρεύμα 

βραχυκύκλωσης μόνιμης κατάστασης Ikd, όπως φαίνεται στον Πίνακα 5.17. 

 

Στοιχεία βραχυκυκλώματος για τη γεννήτρια 

Td΄΄ (s) 0.00177 

Td΄ (s) 0.26288 

Xd΄΄ (p.u.) 0.18512 

Xd΄ (p.u.) 0.24934 

rstr (p.u.) 0.000165 

Ikd (p.u.) 0.50957 

Πίνακας 5.17 
 

Τα υπόλοιπα χαρακτηριστικά στο αρχικό παράθυρο διαλόγου παραμένουν όμοια με αυτά της 

προηγούμενης περίπτωσης. 

 

5.1.2.3 Ορισμός ισοδύναμων κινητήρων 
 

Οι κινητήρες Μ1, Μ2, Μ3, Μ4 θα συνδεθούν στον κύριο ζυγό των 440 V, ενώ οι κινητήρες 

Μ5, Μ6 στον κύριο ζυγό των 220 V. Θα οριστεί νέος τύπος για κάθε κινητήρα, ο οποίος θα 

περιλαμβάνει τις ονομαστικές παραμέτρους του εκάστοτε κινητήρα, λόγω της μη 

ενσωμάτωσης των καλωδίων και του μετασχηματιστή, με αντίστοιχο όνομα, όπως π.χ. AM1 

για τον κινητήρα Μ1. 

 

Για τους κινητήρες Μ1, Μ2, Μ3, Μ4 και τη σύνδεση των στοιχείων RLC, ακολουθείται η 

ίδια διαδικασία όπως και στη γεννήτρια. Ο βοηθητικός ζυγός του κάθε κινητήρα έχει τον 

τύπο του κύριου ζυγού των 440 V. Χρησιμοποιούμε ονόματα αντίστοιχα του εκάστοτε 

κινητήρα, π.χ. Bus_Motor1 για τον κινητήρα Μ1. 

 

Στον Πίνακα 5.18 δίνονται όλα τα στοιχεία της καρτέλας Load Flow στον ορισμό του τύπου 

για κάθε κινητήρα, καθώς και η ενεργός ισχύς στο αρχικό παράθυρο διαλόγου για λόγους 

πληρότητας. Τα υπόλοιπα στοιχεία, όπως είναι η ενεργός ισχύς και η συχνότητα στο 

παράθυρο του τύπου του κινητήρα, παραμένουν όμοια. 
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Στοιχεία ροής φορτίου για τους κινητήρες 

Παράμετροι Μ1 Μ2 Μ3 Μ4 Μ5 Μ6 

Rs (p.u.) 0.034 0.043 0.043 0.043 0.043 0.043 

Xs (p.u.) 0.075 0.094 0.094 0.094 0.094 0.094 

RrA (p.u.) 0.021 0.027 0.027 0.027 0.027 0.027 

XrA (p.u.) 0.075 0.094 0.094 0.094 0.094 0.094 

Xm (p.u.) 1.821 1.882 1.882 1.882 1.882 1.882 

Active Power (MW) 0.33846 0.03661 0.00543 0.09958 0.00553 0.04684 

Πίνακας 5.18 
 

5.1.2.4 Ορισμός καλωδίων και υπολογισμός των παραμέτρων τους 
 

Ακολούθως, ρυθμίζουμε τα χαρακτηριστικά των στοιχείων RLC για τη γεννήτρια και τους 

κινητήρες Μ1, Μ2, Μ3, Μ4. 

 

Καρτέλα Basic Data 

 

Το ρεύμα των στοιχείων (Rated Current) δίνεται από τη σχέση (5.13) για το βασικό ρεύμα 

Ibase και είναι κοινό για όλα, καθώς εκφράζει το μέγιστο ονομαστικό ρεύμα. Εφόσον το 

ρεύμα, για σταθερή τάση, είναι ανάλογο της φαινόμενης ισχύος, το μέγιστο ονομαστικό 

ρεύμα οφείλεται στη γεννήτρια, η οποία έχει τη μεγαλύτερη φαινόμενη ισχύ.  

Χρησιμοποιούμε ονόματα που να προσιδιάζουν στη συνδεμένη ηλεκτρική μηχανή, π.χ. 

Series RLC-Gen για τη γεννήτρια και Series RLC-Motor1 για τον κινητήρα Μ1. Σε όλα τα 

στοιχεία θέτουμε τα εξής: 

 Rated Voltage: 0.44 kV 

 Rated Current: 3.56645 kA 

 

Καρτέλα Load Flow 

 

Οι τύποι για την επαγωγική αντίδραση και την ωμική αντίσταση είναι οι ακόλουθοι, όπου 

θεωρούμε μηδενική χωρητική αντίδραση (δε δίνεται σχετική τιμή): 

 

  
    3c

c 10
fπ2

Ω/mXmL
=mHL 




 (5.25) 

    Ω/mRL=ΩR cc   (5.26) 

 

Με την εφαρμογή των τύπων αυτών, λαμβάνουμε τις τιμές του Πίνακα 5.19 για τα στοιχεία 

RLC. 

 

Μεγέθη στοιχείων RLC 

Παράμετροι Gen Μ1 Μ2 Μ3 Μ4 

Lc (mH) 0.000684 0.000342 0.002224 0.008952 0.007149 

Rc (Ω) 0.000448 0.000224 0.001457 0.0105 0.0154 

Πίνακας 5.19 
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5.1.2.5 Ορισμός μετασχηματιστή και υπολογισμός των παραμέτρων του 
 

Αρχικά, τοποθετείται ένας μετασχηματιστής για τη σύνδεση των δύο κύριων ζυγών των 440 

και των 220 V. Στο παράθυρο διαλόγου του μετασχηματιστή, τίθεται ένα ενδεικτικό όνομα, 

π.χ. Transformer. Στη συνέχεια, δημιουργείται νέος τύπος μέσω του Type → New Project 

Type, όπου τίθενται τα εξής (Εικόνα 5.11): 

 Name: 440/220 V 

 Technology: Three Phase Transformer 

 Rated Power: 0.1 MVA 

 Nominal Frequency: 60 Hz 

 Rated Voltage: HV-Side: 0.44 kV, LV-Side: 0.22 kV 

 

Σημειώνεται ότι η φαινόμενη ισχύς των 0.1 MVA προκύπτει μέσω μίας προσαύξησης, για 

λόγους επάρκειας, του αθροίσματος των φαινόμενων ισχύων των κινητήρων Μ5, Μ6, τους 

οποίους τροφοδοτεί ο μετασχηματιστής μέσω του κύριου ζυγού των 220 V. 

 

Στο πλαίσιο της αντίστασης θετικής ακολουθίας (Positive Sequence Impedance), ο χρήστης 

επιλέγει ως μεγέθη εισαγωγής τα Reactance in p.u. and Resistance in p.u., πατώντας το βέλος 

και επιλέγοντας τα μεγέθη στο παράθυρο που εμφανίζεται. Οι σχέσεις για τα μεγέθη αυτά 

δίνονται από το διεθνές πρότυπο IEC 61363-1 και είναι οι ακόλουθες (σχέσεις (3.30)-(3.32) 

του Κεφαλαίου 3): 

 

 
 

 

(5.27) 

 

(5.28) 

 

(5.29) 

 

 

Εφόσον τα μεγέθη RT και XT (r1 και x1 στο πρόγραμμα) πρέπει να εισαχθούν σε p.u., έχουμε: 
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Στη βάση αυτή, θέτουμε τα εξής (Εικόνα 5.11): 

 Reactance x1: 0.069282 p.u. 

 Resistance r1: 0.01 p.u. 
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Εικόνα 5.11 Ορισμός παραμέτρων στον τύπο του μετασχηματιστή 

 

Οι υπόλοιπες καρτέλες του τύπου του μετασχηματιστή και του αρχικού παραθύρου 

παραμένουν ως έχουν, αφού ελεγχθεί ότι, στην καρτέλα Load Flow του αρχικού παραθύρου, 

η επιλογή Automatic Tap Changing, η οποία αφορά την ύπαρξη συστήματος μεταβολής του 

λόγου μετασχηματισμού, είναι απενεργοποιημένη και η επιλογή Tap Position είναι 

ρυθμισμένη στο μηδέν. 

 

Σε αυτό το σημείο και αφού έχουν οριστεί όλες οι παράμετροι των ζυγών, της γεννήτριας, 

των κινητήρων, των στοιχείων RLC και του μετασχηματιστή, μπορεί να πραγματοποιηθεί ο 

υπολογισμός βραχυκυκλώματος. Το ηλεκτρικό δίκτυο, στη δεύτερη εκδοχή του, θα πρέπει να 

είναι όπως φαίνεται στην Εικόνα 5.12. 
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Εικόνα 5.12 Ηλεκτρικό δίκτυο (περίπτωση με αυτόνομα καλώδια και μετασχηματιστή) 

 

5.1.2.6 Υπολογισμός βραχυκυκλώματος 
 

Για τον υπολογισμό βραχυκυκλώματος, ο χρήστης έχει τη δυνατότητα να απενεργοποιήσει 

το grid της πρώτης εκδοχής του δικτύου, πατώντας δεξί κλικ στο grid αυτό και επιλέγοντας 

Deactivate, εφόσον επιθυμεί να πραγματοποιήσει τον υπολογισμό μόνο για τη δεύτερη 

εκδοχή. Από την μπάρα των κύριων εικονιδίων επιλέγεται το εικονίδιο . Στο παράθυρο 

διαλόγου χρησιμοποιούνται οι ρυθμίσεις που εκτέθηκαν στην παράγραφο 5.1.1.4, με τη μόνη 

διαφορά ότι επιλέγεται ως Fault Location το All Busbars, ώστε να υπάρξουν αποτελέσματα 

και για τους κινητήρες Μ5 και Μ6. Τα εμφανιζόμενα μεγέθη παραμένουν όπως ρυθμίστηκαν 

στον προηγούμενο υπολογισμό. 

 

Στον Πίνακα 5.20 παρουσιάζονται τα αποτελέσματα της μελέτης βραχυκυκλώματος για το 

ηλεκτρικό δίκτυο, με τα καλώδια και το μετασχηματιστή ως αυτόνομα στοιχεία. Απαιτείται 

προσοχή στο ότι οι τιμές των ρευμάτων για τους κινητήρες Μ5 και Μ6, τις οποίες δίνει το 

πρόγραμμα, έχουν αναχθεί στην πλευρά των 440 V μέσω του λόγου 220/440, διότι αφορούν 

την τάση των 220 V. Επίσης, σημειώνεται ότι παρατίθενται τα αποτελέσματα των στοιχείων 

που εξετάστηκαν και στην παράγραφο 5.1.1.4, τα οποία αποτελούν αντικείμενο μελέτης και 

σύγκρισης με τα αποτελέσματα των θεωρητικών υπολογισμών. 
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Αποτελέσματα υπολογισμού βραχυκυκλώματος 

Variables Generator 
Motor 

1 

Motor 

2 

Motor 

3 

Motor 

4 

Motor 

5 

Motor 

6 

Main Busbar 

(440 V) 

Ikd΄΄ (kA) 19.436 3.288 0.281 0.042 0.736 0.041 0.346 - 

Ikd΄ (kA) 14.652 0.000 0.000 0.000 0.000 0.000 0.000 - 

Ikd (kA) 1.814 0.000 0.000 0.000 0.000 0.000 0.000 - 

Ip (kA) 44.214 5.545 0.476 0.071 1.166 0.070 0.589 52.706 

Td΄΄ (s) 0.0018 0.0202 0.0199 0.0199 0.0201 0.0199 0.0199 - 

Td΄ (s) 0.2664 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 - 

Tdc (s) 0.0776 0.0113 0.0113 0.0112 0.0092 0.0113 0.0113 - 

Πίνακας 5.20 
 

Ακόμα, δίνεται το διάγραμμα της κυματομορφής του ρεύματος βραχυκύκλωσης στον κύριο 

ζυγό των 440 V (Εικόνα 5.13). Παρατηρούμε ότι η χρονική εξέλιξη των καμπυλών είναι 

παρόμοια με αυτήν που απεικονίζεται στην Εικόνα 5.10. 

 

 
Εικόνα 5.13 Κυματομορφή ρεύματος βραχυκύκλωσης στον κύριο ζυγό των 440 V 
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5.2 Θεωρητικοί υπολογισμοί βραχυκυκλώματος 
 

Στην παρούσα ενότητα πραγματοποιούνται οι θεωρητικοί υπολογισμοί για την κατάσταση 

λειτουργίας πριν το βραχυκύκλωμα και τα χαρακτηριστικά βραχυκύκλωσης όλων των 

μηχανών του μελετώμενου ηλεκτρικού δικτύου. Οι υπολογισμοί βασίζονται στη θεωρία 

βραχυκυκλωμάτων και στις σχέσεις του διεθνούς προτύπου IEC 61363-1 [5], ενώ 

ακολουθούν τη μεθοδολογία της υποδειγματικής ηλεκτρολογικής μελέτης [9]. 

 

 

5.2.1 Κατάσταση λειτουργίας πριν την εκδήλωση βραχυκυκλώματος 
 

Σε αυτό το σημείο υπολογίζονται τα ρεύματα λειτουργίας των στρεφόμενων μηχανών πριν 

από το σφάλμα (βραχυκύκλωμα). Για τους ισοδύναμους κινητήρες θεωρείται ότι 

απορροφούν την ονομαστική ισχύ τους, στον ονομαστικό συντελεστή ισχύος. Το ρεύμα 

λειτουργίας κάθε κινητήρα δίνεται από τη σχέση (5.30). Το ρεύμα της γεννήτριας θα είναι, 

επομένως, το άθροισμα των ρευμάτων των κινητήρων (νόμος ρευμάτων Kirchhoff). Στον 

Πίνακα 5.21 δίνονται τα αποτελέσματα. 

 

 
V

S
I




3
 (5.30) 

 

όπου 

S: Φαινόμενη ισχύς κινητήρα 

V: Τάση αναφοράς κινητήρα 

 

Όσον αφορά τους κινητήρες Μ5 και Μ6, που βρίσκονται στην πλευρά των 220 V, το 

υπολογιζόμενο ρεύμα μετασχηματίζεται στην πλευρά των 440 V πολλαπλασιαζόμενο με το 

λόγο τάσεων 220/440. 

 

Ρεύματα λειτουργίας στρεφόμενων μηχανών πριν το σφάλμα 

Στρεφόμενη μηχανή Ρεύμα λειτουργίας (Α) 

Μ1 555.158 

Μ2 60.046 

Μ3 8.906 

Μ4 163.329 

Μ5 9.067 

Μ6 76.829 

Γεννήτρια 873.336 

Πίνακας 5.21 
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5.2.2 Χαρακτηριστικά βραχυκύκλωσης 
 

Στη συνέχεια, υπολογίζονται σε απόλυτες τιμές τα χαρακτηριστικά βραχυκύκλωσης όλων 

των στρεφόμενων μηχανών του δικτύου. 

 

 

5.2.2.1 Γεννήτρια 
 

Τα απαραίτητα μεγέθη για τη μελέτη βραχυκυκλωμάτων, σύμφωνα και με την παράγραφο 

3.5.2 του Κεφαλαίου 3, είναι τα ακόλουθα: 

Zbase: Βασική αντίσταση 

Ra: Αντίσταση τυλίγματος 

Xd΄΄: Υπομεταβατική αντίδραση 

Xd΄: Μεταβατική αντίδραση 

Xd: Αντίδραση μόνιμης κατάστασης 

Τe΄΄, Τe΄: Υπομεταβατική και μεταβατική χρονική σταθερά 

Τdc: Χρονική σταθερά ΣΡ 

Εq΄΄, Eq΄: Υπομεταβατική και μεταβατική επαγόμενη τάση 

Eq: Επαγόμενη τάση μόνιμης κατάστασης 

Ikd΄΄: Υπομεταβατικό ρεύμα βραχυκύκλωσης 

Ikd΄: Μεταβατικό ρεύμα βραχυκύκλωση 

Ikd: Ρεύμα βραχυκύκλωσης μόνιμης κατάστασης 

IAC(t): Συνιστώσα ΕΡ ρεύματος βραχυκύκλωσης 

IDC(t): Συνιστώσα ΣΡ ρεύματος βραχυκύκλωσης 

Ik(t): Συνολικό ρεύμα βραχυκύκλωσης 

Ip(t): Κρουστική τιμή ρεύματος βραχυκύκλωσης 

 

Η διόρθωση λόγω του καλωδίου πραγματοποιείται ως εξής: 

Σύνθετη αντίσταση καλωδίου: 

   Ω 0.000258 j + 0.00045=20.000129 j + 0.000224=X+R cc   

 

Τα μεγέθη της γεννήτριας που θα πρέπει να διορθωθούν λόγω καλωδίου είναι τα εξής: 

Αντίσταση τυλίγματος: ca R+R  

Υπομεταβατική αντίδραση: cd X+΄΄X  

Μεταβατική αντίδραση: cd X+΄X  

Αντίδραση μόνιμης κατάστασης: cd X+X  

 

Όλα τα μεγέθη που περιγράφονται παραπάνω υπολογίζονται από τις σχέσεις (5.31)-(5.49), 

σύμφωνα πάντα με το πρότυπο IEC 61363-1. 

 

       
  

 
 (5.31) 

                      (5.32) 

   
        

               (5.33) 

   
       

              (5.34) 

                      (5.35) 
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    (5.46) 

                         (5.47) 

             (5.48) 

                 (5.49) 

 

 

Στον Πίνακα 5.22 δίνονται τα αποτελέσματα που προέκυψαν για τα μεγέθη της γεννήτριας 

με βάση τα ανωτέρω, όπου Τ/2 = 0.00833 s. 
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Χαρακτηριστικά μεγέθη γεννήτριας 

Zbase Ω 0.071229 

Ra Ω 0.000012 

Xd΄΄ Ω 0.013186 

Xd΄ Ω 0.017760 

Xd Ω 0.220209 

Ra + Rc Ω 0.000460 

Xd΄΄+Xc Ω 0.013444 

Xd΄+Xc Ω 0.018018 

Χd + Χc Ω 0.220467 

Te΄΄ s 0.001779 

Te΄ s 0.123194 

Tdc s 0.077605 

Eq΄΄ V 261.568 

Eq΄ V 264.093 

Eq V 400.586 

Ikd΄΄ A 19444.883 

Ikd΄ A 14652.254 

Ikd A 1816.985 

IAC(0) A 19444.883 

IAC(T/2) A 13857.061 

IDC(t) A 26757.910·e
-t/0.077605 

Ip(0) A 54256.863 

Ip(T/2) A 43630.157 

Πίνακας 5.22 
 

5.2.2.2 Ισοδύναμοι κινητήρες Μ1, Μ2, Μ3, Μ4 
 

Για τους ισοδύναμους κινητήρες τα χαρακτηριστικά μεγέθη είναι τα εξής: 

Zbase: Βασική αντίσταση 

RΜ: Αντίσταση τυλίγματος 

IrM: Ρεύμα λειτουργίας 

ΧΜ΄΄: Υπομεταβατική αντίδραση 

ΤΜ΄΄: Υπομεταβατική χρονική σταθερά 

ΤdcM: Χρονική σταθερά ΣΡ 

EM΄΄: Υπομεταβατική επαγόμενη τάση 

IACM(t): Συνιστώσα ΕΡ ρεύματος βραχυκύκλωσης 

IDCM(t): Συνιστώσα ΣΡ ρεύματος βραχυκύκλωσης 

IpM(t): Κρουστική τιμή ρεύματος βραχυκύκλωσης 

 

Η διόρθωση λόγω του καλωδίου πραγματοποιείται ως εξής: 

Σύνθετη αντίσταση καλωδίου: 

Μ1:    Ω 0.000258 j + 0.00045=10.000129 j + 0.000224=X+R cc   

Μ2:    Ω 0.000839 j + 0.001457=19.50.000043 j + 0.0000747=X+R cc   

Μ3:    Ω 0.003375 j + 0.0105=37.50.00009 j + 0.00028=X+R cc   
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Μ4:    Ω 0.002695 j + 0.0154=5.720.000098 j +0.00056=X+R cc   

 

Τα μεγέθη των κινητήρων που θα πρέπει να διορθωθούν λόγω καλωδίου είναι τα εξής: 

Αντίσταση τυλίγματος: cM R+R  

Υπομεταβατική αντίδραση: cM X+΄΄X  

Υπομεταβατική χρονική σταθερά: ΤΜ΄΄ 

Χρονική σταθερά ΣΡ: ΤDCM 

 

Ακολουθούν οι σχέσεις (5.50)-(5.59) με τις οποίες υπολογίζονται τα ανωτέρω μεγέθη. 

 

       
  

 
 (5.50) 

                        (5.51) 
   

                       (5.52) 
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(5.55) 

   
   

  
  

  
   

  
  

        
     

      
 
 (5.56) 

           
    

 
 

  
  
       (5.57) 

                
               

 
 

           (5.58) 

                            (5.59) 

 

Το ρεύμα λειτουργίας IrM κάθε κινητήρα έχει υπολογιστεί προηγουμένως (Πίνακας 5.21) και 

η τάση είναι VrM=440V. Στον Πίνακα 5.23 δίνονται τα αποτελέσματα των υπολογισμών για 

κάθε ισοδύναμο κινητήρα με βάση τα παραπάνω. 
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Χαρακτηριστικά μεγέθη κινητήρων Μ1, Μ2, Μ3, Μ4 

  Μ1 Μ2 Μ3 Μ4 

Zbase Ω 0.457602 4.230769 28.525122 1.555395 

RM Ω 0.025168 0.296154 1.996759 0.108878 

RM + Rc Ω 0.025392 0.297610 2.007259 0.124278 

XM΄΄ Ω 0.068640 0.795385 5.362723 0.292414 

ΧM΄΄+ Χc Ω 0.068769 0.796223 5.366098 0.295109 

TM΄΄ s 0.018992 0.018499 0.018491 0.018650 

TDCM s 0.011564 0.011523 0.011512 0.009518 

EM΄΄ V 220.964 212.847 212.851 210.542 

IM΄΄ A 3014.210 250.400 37.152 657.514 

IACM(0) A 3014.210 250.400 37.152 657.514 

IACM(T/2) A 1943.640 159.585 23.673 420.577 

IDCM(t) A 4733.758·e
-t/0.011564

 405.066·e
-t/0.011523

 60.097·e
-t/0.011512

 1068.444·e
-t/0.009518

 

IpM(0) A 8996.453 759.182 112.637 1998.299 

IpM(T/2) A 5051.507 422.234 62.618 1039.974 

Πίνακας 5.23 
 

5.2.2.3 Ισοδύναμοι κινητήρες Μ5, Μ6 
 

Για τους συγκεκριμένους κινητήρες που βρίσκονται στην πλευρά των 220 V γίνεται 

διόρθωση σε ορισμένα μεγέθη, λόγω της παρουσίας μετασχηματιστή υποβιβασμού της 

τάσης. 

 

Η διόρθωση της σύνθετης αντίστασης λόγω του μετασχηματιστή πραγματοποιείται ως εξής: 

baserkbaserRTT Zu+Zu=X+R   

 

Τα υπόλοιπα μεγέθη υπολογίζονται χρησιμοποιώντας τις σχέσεις για τους προηγούμενους 

κινητήρες (σχέσεις (5.50)-(5.59)). Στον Πίνακα 5.24 δίνονται τα αντίστοιχα αποτελέσματα. 
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Χαρακτηριστικά μεγέθη κινητήρων Μ5, Μ6 

  Μ5 Μ6 

Zbase Ω 7.004342 0.826644 

RM Ω 0.490304 0.057865 

RM + Rc Ω 0.560347 0.066132 

XM΄΄ Ω 1.316816 0.155409 

ΧM΄΄+ Χc Ω 1.807120 0.213274 

TM΄΄ s 0.025360 0.025360 

TDCM s 0.012919 0.012919 

EM΄΄ V 101.248 101.248 

IM΄΄ A 53.514 453.433 

IACM(0) A 53.514 453.433 

IACM(T/2) A 38.526 326.439 

IDCM(t) A 91.067·e
-t/0.012919

 771.627·e
-t/0.012919

 

IpM(0) A 166.746 1412.873 

IpM(T/2) A 102.262 866.491 

Πίνακας 5.24 
 

Τα ρεύματα στον Πίνακα 5.24 αφορούν την τάση των 220 V. Στην πλευρά των 440 V τα 

ανωτέρω μετασχηματίζονται πολλαπλασιάζοντας με το λόγο 220/440. Έτσι, προκύπτουν τα 

αποτελέσματα του Πίνακα 5.25 για κάθε ένα κινητήρα. 

 

Ρεύματα βραχυκύκλωσης κινητήρων Μ5, Μ6 ανηγμένα στην πλευρά των 440 V 

  Μ5 Μ6 

IM΄΄ A 26.757 226.717 

IACM(0) Α 26.757 226.717 

IACM(T/2) Α 19.263 163.220 

IDCM(t) Α 45.533·e
-t/0.012919

 385.814·e
-t/0.012919

 

IpM(0) Α 83.373 706.436 

IpM(T/2) Α 51.131 433.245 

Πίνακας 5.25 
 

5.2.2.4 Ζυγός τροφοδοσίας 
 

Επομένως, καταλήγουμε στο κρουστικό ρεύμα βραχυκύκλωσης για t=T/2 στο ζυγό 

τροφοδοσίας, δηλαδή στον κύριο ζυγό των 440 V, με υπέρθεση των επτά κρουστικών 

ρευμάτων που προκύπτουν από την ισοδύναμη γεννήτρια και τους έξι κινητήρες: 

  A 506912/ TI p  
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5.3 Σύγκριση αποτελεσμάτων PowerFactory και 
θεωρητικών υπολογισμών 

 
Στους Πίνακες 5.26α και 5.26β παρουσιάζονται τα αποτελέσματα του υπολογισμού στην 

πρώτη περίπτωση, με τις παραμέτρους των καλωδίων και του μετασχηματιστή 

ενσωματωμένες, του δικτύου στη δεύτερη περίπτωση, με τα καλώδια και το μετασχηματιστή 

ως αυτόνομα στοιχεία, και των θεωρητικών υπολογισμών. Τα εξεταζόμενα στοιχεία του 

δικτύου είναι η ισοδύναμη γεννήτρια, οι έξι ισοδύναμοι κινητήρες και ο κύριος ζυγός των 

440 V. 

 

Παρατηρούμε ότι οι τιμές των δύο προσομοιώσεων για τη γεννήτρια και τους κινητήρες Μ1-

Μ4 προσεγγίζουν ιδιαίτερα ικανοποιητικά τα θεωρητικά προβλεπόμενα αποτελέσματα. Οι 

μικρές αποκλίσεις, που παρατηρούνται σε ορισμένες περιπτώσεις, οφείλονται κυρίαρχα στην 

αγνόηση του κλάδου μαγνήτισης των κινητήρων στην υποδειγματική μελέτη, καθώς και στο 

ότι πραγματοποιείται υπολογισμός ροής φορτίου πριν το βραχυκύκλωμα (Preload Condition: 

use load flow initialization). Πιο συγκεκριμένα, αναφορικά με τον κλάδο μαγνήτισης, αυτός 

δεν μπορεί να αγνοηθεί κατά τη δημιουργία του τύπου των κινητήρων, επειδή μέσω της 

κατάλληλης επιλογής της τιμής της αντίδρασης Xm ρυθμίζεται ο συντελεστής ισχύος. 

Εξάλλου, ο συντελεστής ισχύος στο παράθυρο του τύπου του κινητήρα μπορεί να επιλεγεί 

απευθείας μέσω της μεθόδου εισαγωγής Slip-Torque-Current Characteristic, η οποία όμως 

απαιτεί τη γνώση στοιχείων όπως ο βαθμός απόδοσης στο σημείο λειτουργίας, η ονομαστική 

ταχύτητα περιστροφής και η ροπή στο σημείο απώλειας στήριξης (stalling point), που είναι 

άγνωστα. Επίσης, ο υπολογισμός ροής φορτίου πριν το βραχυκύκλωμα δίνει τα ακριβέστερα 

αποτελέσματα, αλλά χρησιμοποιεί τιμές ρευμάτων που διαφέρουν από τις τιμές των 

ονομαστικών ρευμάτων λειτουργίας των θεωρητικών πράξεων, καθότι το πρόγραμμα 

υπολογίζει τις πραγματικές αναμενόμενες τιμές ρευμάτων. Η εκτέλεση ενός υπολογισμού 

ροής φορτίου αποδεικνύει ότι οι τιμές των ρευμάτων του PowerFactory διαφέρουν από τις 

ονομαστικές. 

 

Τα μεγέθη των δύο προσομοιώσεων για τους κινητήρες Μ5 και Μ6 παρουσιάζουν σχετικά 

πιο σημαντικές αποκλίσεις από τις θεωρητικές τιμές. Αυτό διότι, στην περίπτωση αυτή, 

ανακύπτει το ζήτημα της ύπαρξης του μετασχηματιστή, ο οποίος καθιστά το ζήτημα των 

συνθηκών πριν το βραχυκύκλωμα πιο σύνθετο. Ο κλάδος μαγνήτισης του μετασχηματιστή 

αγνοείται στην υποδειγματική μελέτη. Είναι, μάλιστα, χαρακτηριστικό το ότι οι άλλες δύο 

επιλογές υπολογισμού πριν το σφάλμα (use rated current/power factor και neglect preload 

condition) δίνουν εξίσου υψηλές αποκλίσεις. Επιπλέον, ο τρόπος ενσωμάτωσης του 

μετασχηματιστή στους κινητήρες Μ5 και Μ6 στους θεωρητικούς υπολογισμούς επηρεάζει σε 

αμελητέο βαθμό τα μεγέθη των κινητήρων. Πιο συγκεκριμένα, το γεγονός ότι η διόρθωση 

της σύνθετης αντίστασης λόγω του μετασχηματιστή πραγματοποιήθηκε ξεχωριστά σε κάθε 

κινητήρα, με χρήση της φαινόμενης ισχύος του καθενός, ισοδυναμεί με την ύπαρξη δύο 

παράλληλων σύνθετων αντιστάσεων. Έτσι, ο παραλληλισμός των δύο σύνθετων 

αντιστάσεων δίνει διαφορετικές τιμές για την αντίσταση r1=RT και την αντίδραση x1=XT στο 

παράθυρο του τύπου του μετασχηματιστή (σχέσεις (5.27)-(5.29)). Ωστόσο, για λόγους 

ευκολίας αυτό δε λαμβάνεται υπόψη, δεδομένου ότι η προσομοίωση με τις νέες τιμές 

μεταβάλλει ελάχιστα τα μεγέθη του βραχυκυκλώματος. Ασφαλώς, οι αποκλίσεις δε θα 

δημιουργούσαν κινδύνους ασφάλειας, αφού οι τιμές των ρευμάτων του προγράμματος είναι 

υψηλότερες από τις αντίστοιχες θεωρητικές τιμές. 

 



147 
 

Τέλος, η τιμή του κρουστικού ρεύματος βραχυκύκλωσης στον κύριο ζυγό προσεγγίζει σε 

ικανοποιητικό βαθμό τη θεωρητική αναμενόμενη τιμή. Λαμβάνοντας υπόψη ότι το 

κρουστικό ρεύμα στο ζυγό συνιστά το άθροισμα των επιμέρους κρουστικών ρευμάτων, 

συμπεραίνουμε ότι οι δύο προσομοιώσεις ανταποκρίνονται στις θεωρητικές προβλέψεις του 

διεθνούς προτύπου IEC 61363-1. Μάλιστα, η τιμή του PowerFactory για το κρουστικό 

ρεύμα στις δύο προσομοιώσεις υπερβαίνει ελαφρώς τη θεωρητική τιμή, γεγονός που 

αποδεικνύει και πάλι την ασφάλεια που παρέχει το πρόγραμμα στο σχεδιασμό των 

ηλεκτρικών δικτύων, αναφορικά με τη μελέτη βραχυκυκλωμάτων. 
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Σύγκριση αποτελεσμάτων υπολογισμού βραχυκυκλώματος (α) 

Μεγέθη Generator Motor 1 Motor 2 Motor 3 

 Δίκτυο 1 Δίκτυο 2 Θεωρητ. Δίκτυο 1 Δίκτυο 2 Θεωρητ. Δίκτυο 1 Δίκτυο 2 Θεωρητ. Δίκτυο 1 Δίκτυο 2 Θεωρητ. 

Ikd΄΄ (kA) 19.470 19.436 19.445 3.298 3.288 3.014 0.281 0.281 0.250 0.042 0.042 0.037 

Ikd΄ (kA) 14.677 14.652 14.652 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 

Ikd (kA) 1.817 1.814 1.817 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 

Ip (kA) 43.662 44.214 43.630 5.562 5.545 5.052 0.478 0.476 0.422 0.071 0.071 0.063 

Td΄΄ (s) 0.0018 0.0018 0.0018 0.0202 0.0202 0.0190 0.0199 0.0199 0.0185 0.0199 0.0199 0.0185 

Td΄ (s) 0.1232 0.2664 0.1232 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 

Tdc (s) 0.0776 0.0776 0.0776 0.0113 0.0113 0.0116 0.0113 0.0113 0.0115 0.0113 0.0112 0.0115 

Πίνακας 5.26α 
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Σύγκριση αποτελεσμάτων υπολογισμού βραχυκυκλώματος (β) 

Μεγέθη Motor 4 Motor 5 Motor 6 Main Busbar (440 V) 

 Δίκτυο 1 Δίκτυο 2 Θεωρητ. Δίκτυο 1 Δίκτυο 2 Θεωρητ. Δίκτυο 1 Δίκτυο 2 Θεωρητ. Δίκτυο 1 Δίκτυο 2 Θεωρητ. 

Ikd΄΄ (kA) 0.750 0.736 0.658 0.050 0.041 0.027 0.420 0.346 0.227 - - - 

Ikd΄ (kA) 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 - - - 

Ikd (kA) 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 - - - 

Ip (kA) 1.195 1.166 1.040 0.097 0.070 0.051 0.824 0.589 0.433 52.559 52.706 50.691 

Td΄΄ (s) 0.0201 0.0201 0.0187 0.0337 0.0199 0.0254 0.0337 0.0199 0.0254 - - - 

Td΄ (s) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 - - - 

Tdc (s) 0.0093 0.0092 0.0095 0.0137 0.0113 0.0129 0.0137 0.0113 0.0129 - - - 

Πίνακας 5.26β 
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ΚΕΦΑΛΑΙΟ 6 
 

Προσομοίωση βραχυκυκλώματος σε ηλεκτρικό 
δίκτυο πλοίου μεταφοράς φορτίου χύδην 

 
Το κεφάλαιο αυτό πραγματεύεται την προσομοίωση του ηλεκτρικού δικτύου ενός 

πραγματικού πλοίου μεταφοράς φορτίου χύδην, καθώς και τη μελέτη βραχυκυκλώματος στο 

δίκτυο αυτό. Το πλοίο διαθέτει μεταφορική ικανότητα 80800 DWT. Το ηλεκτρικό δίκτυο θα 

σχεδιαστεί στην πλατφόρμα του PowerFactory, ώστε να πραγματοποιηθεί ο υπολογισμός 

βραχυκυκλώματος που προσφέρει το πρόγραμμα. Στη συνέχεια, τα αποτελέσματα θα 

συγκριθούν με τις θεωρητικές τιμές που δίνονται σε σχετικό φυλλάδιο του πλοίου. Το 

συγκεκριμένο φυλλάδιο βασίζεται στις σχέσεις του διεθνούς προτύπου IEC 61363-1 [5] για 

τη μελέτη βραχυκυκλωμάτων. Με τη διαδικασία αυτή, θα εξεταστεί η χρησιμότητα του 

PowerFactory αναφορικά με την επαλήθευση των θεωρητικών υπολογισμών για τα 

βραχυκυκλώματα και την ασφαλή εκτίμηση για πραγματικά συστήματα ηλεκτρικής 

ενέργειας πλοίων. 

 

 

6.1 Παρουσίαση του ηλεκτρικού δικτύου 
 

Αρχικά, παρουσιάζεται το υπό μελέτη ηλεκτρικό δίκτυο του πλοίου, όπως αυτό δίνεται στα 

έγγραφα που το συνοδεύουν. Εκτίθενται το πλήρες μονογραμμικό διάγραμμα της ηλεκτρικής 

εγκατάστασης και τα δεδομένα στοιχεία των τριών γεννητριών, των κινητήρων και του 

βασικού μετασχηματιστή. 

 

 

6.1.1 Μονογραμμικό διάγραμμα ηλεκτρικού δικτύου 
 

Στο Σχήμα 6.1 φαίνεται το μονογραμμικό διάγραμμα του συστήματος ηλεκτρικής ενέργειας 

του bulk carrier. Με βάση αυτό θα πραγματοποιηθεί ο υπολογισμός βραχυκυκλώματος. 

 



151 
 

 
Εικόνα 6.1 Μονογραμμικό διάγραμμα μελετώμενου ηλεκτρικού δικτύου 
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6.1.2 Χαρακτηριστικά γεννητριών 
 

Στον Πίνακα 6.1 δίνονται τα γενικά δεδομένα για τις τρεις γεννήτριες του συστήματος, ενώ 

στον Πίνακα 6.2 τα βασικά χαρακτηριστικά τους. 

 

Γενικά δεδομένα γεννητριών 

 
Πίνακας 6.1 

 

Χαρακτηριστικά γεννητριών 

 
Πίνακας 6.2 

 

Για το σκοπό της μελέτης βραχυκυκλώματος θεωρείται μία ισοδύναμη γεννήτρια, η οποία 

αντικαθιστά τις τρεις γεννήτριες, με ενεργό ισχύ kW 1530=5103  και φαινόμενη ισχύ 

kVA 1912.5=5.3763 . Οι υπόλοιπες παράμετροι (επαγωγικές αντιδράσεις, χρονικές 

σταθερές κ.λπ.) παραμένουν ως έχουν. Η ίδια πρακτική ακολουθείται και από τους 
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συντάκτες του υπολογισμού βραχυκυκλώματος του πλοίου, σύμφωνα με τις διατάξεις του 

προτύπου IEC 61363-1. 

 

Η γεννήτρια έκτακτης ανάγκης του πλοίου δεν περιλαμβάνεται στην εν λόγω μελέτη, καθότι 

εξετάζεται η περίπτωση κανονικής πορείας. 

 

 

6.1.3 Χαρακτηριστικά κινητήρων 
 

Αναφορικά με τους κινητήρες του πλοίου, έχουμε δύο μεγάλους κινητήρες, δηλαδή μία 

αντλία έρματος και μία αντλία λιπαντικού ελαίου, καθώς και έναν ισοδύναμο κινητήρα για 

τους υπόλοιπους μικρούς κινητήρες. Ο διαχωρισμός μεταξύ μεγάλων και μικρών κινητήρων 

βασίζεται στο όριο ονομαστικής ισχύος 100 kW. Βέβαια, στην προκειμένη περίπτωση, η 

αντλία λιπαντικού ελαίου θεωρείται ως ξεχωριστός κινητήρας λόγω αρκετά υψηλής ισχύος, 

παρότι δεν ξεπερνά το σύνηθες όριο. Στον Πίνακα 6.3 δίνεται η τάση των κινητήρων, ενώ 

στους Πίνακες 6.4 και 6.5 εκτίθενται τα βασικά χαρακτηριστικά τους. 

 

Γενικά δεδομένα κινητήρων 

 
Πίνακας 6.3 

 

Χαρακτηριστικά ισοδύναμου κινητήρα 

 
Πίνακας 6.4 
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Χαρακτηριστικά αντλίας έρματος και αντλίας λιπαντικού ελαίου 

 
Πίνακας 6.5 

 

 

6.1.4 Χαρακτηριστικά μετασχηματιστή 
 

Στο ηλεκτρικό δίκτυο υπάρχει ένας κύριος μετασχηματιστής, ο οποίος υποβιβάζει την τάση 

ώστε να τροφοδοτούνται οι καταναλωτές του φωτισμού και διάφορων άλλων λειτουργιών 

μικρής απαίτησης ισχύος. Ο μετασχηματιστής αυτός θα προστεθεί στη μελέτη, αλλά τα 

φορτία που τροφοδοτεί δε θα συμπεριληφθούν, διότι δε συνεισφέρουν στο βραχυκύκλωμα. 

Στη βάση αυτή, θα πραγματοποιηθεί ένας κύριος υπολογισμός, κατά τον οποίο το 

βραχυκύκλωμα θα θεωρηθεί στον κύριο ζυγό, καθώς και ένας συμπληρωματικός 

υπολογισμός, κατά τον οποίο το βραχυκύκλωμα θα θεωρηθεί στο ζυγό χαμηλότερης τάσης. 

Τα χαρακτηριστικά του μετασχηματιστή δίνονται στον Πίνακα 6.6. 

 

Επιπλέον, το ηλεκτρικό δίκτυο περιλαμβάνει και ένα μετασχηματιστή έκτακτης ανάγκης, για 

την τροφοδότηση των απαραίτητων καταναλωτών του φωτισμού. Με το ίδιο σκεπτικό που 

εκτέθηκε για τη γεννήτρια έκτακτης ανάγκης, ο μετασχηματιστής αυτός δεν εξετάζεται. 
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Χαρακτηριστικά μετασχηματιστή 

 
Πίνακας 6.6 
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6.2 Σχεδιασμός του συστήματος ηλεκτρικής ενέργειας και 
υπολογισμός βραχυκυκλώματος 

 
Στο πρώτο σκέλος της ενότητας παρουσιάζεται η διαδικασία σχεδιασμού του συστήματος 

ηλεκτρικής ενέργειας του μελετώμενου bulk carrier, ενώ στο δεύτερο σκέλος 

πραγματοποιείται ο υπολογισμός βραχυκυκλώματος. 

 

 

6.2.1 Σχεδιασμός του συστήματος ηλεκτρικής ενέργειας 
 

Ο σχεδιασμός του συστήματος ηλεκτρικής ενέργειας του πλοίου στο περιβάλλον του 

PowerFactory εκκινεί από τη δημιουργία ενός νέου project, σύμφωνα με τη γνωστή 

διαδικασία. Στη συνέχεια, τοποθετούνται τα στοιχεία του δικτύου, ενώ τους αποδίδονται οι 

κατάλληλες παράμετροι. 

 

6.2.1.1 Ορισμός κύριου ζυγού 
 

Τοποθετείται ο κύριος ζυγός (Single Busbar System) στο χώρο του παραθύρου του 

μονογραμμικού διαγράμματος και ορίζεται ο τύπος του ως εξής: 

 Διπλό κλικ στο ζυγό προκειμένου να ανοίξει το παράθυρο διαλόγου. 

 Type → New Project Type 

 Name: BB 440 V 

 Nominal Voltage: 0.44 kV 

 Αφού κλείσει το παράθυρο του Type, στην καρτέλα Basic Data ο χρήσης ορίζει ένα 

όνομα, π.χ. Main Busbar, και εκ νέου θέτει το Nominal Voltage → Line-Line στα 

0.44 kV. 

 

Ο κύριος ζυγός είναι έτοιμος για να συνδεθούν σε αυτόν τα στοιχεία του δικτύου. 

 

6.2.1.2 Ορισμός γεννήτριας και υπολογισμός των παραμέτρων της 
 

Όπως σημειώθηκε στην παράγραφο 6.1.2, θεωρείται μία ισοδύναμη γεννήτρια, η οποία 

αντικαθιστά τις τρεις γεννήτριες, με τριπλάσια ισχύ και ίδιες παραμέτρους με τις 

ονομαστικές των επιμέρους γεννητριών. Έτσι, ο χρήστης επιλέγει από το παράθυρο διαλόγου 

Type → New Project Type και ακολουθεί την παρακάτω διαδικασία στο παράθυρο που 

ανοίγει. 

 

Καρτέλα Basic Data 

 

 Name: Gen 1530 kW 

 Nominal Apparent Power: 1.9125 MVA 

 Nominal Voltage: 0.45 kV 

 Power Factor: 0.8 

 Connection: YN 
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Καρτέλα Load Flow 

 

Η επαγωγική αντίδραση ευθέως άξονα Xd της γεννήτριας δε δίνεται στον Πίνακα 6.2, αλλά 

σύμφωνα με τα διαθέσιμα στοιχεία για τις γεννήτριες του πλοίου, ισούται με Xd=1.4 p.u., 

όπου πρέπει  να ενσωματωθεί και η επαγωγική αντίδραση του καλωδίου Xc: 

 

 cddG XXX   (6.1) 

 

Έτσι, προκύπτουν τα αποτελέσματα του Πίνακα 6.7. 

 

Αντίδραση μόνιμης κατάστασης γεννήτριας 

Χd (p.u.) 1.40000 

Χc (p.u.) 0.00105 

XdG (p.u.) 1.40105 

Πίνακας 6.7 
 

Η τιμή XdG (p.u.) είναι η διορθωμένη τιμή Xd της γεννήτριας, έχοντας ενσωματώσει και το 

καλώδιο. Επιπλέον, θεωρείται ότι η γεννήτρια έχει ρότορα κυλινδρικής μορφής, οπότε η 

επαγωγική αντίδραση του εγκάρσιου άξονα Xq είναι κατά προσέγγιση ίση με την αντίδραση 

ευθέως άξονα: XdG=XqG. Μία ακόμα παράμετρος, που θα πρέπει να οριστεί στην καρτέλα 

του Load Flow, είναι η αντίδραση αρνητικής ακολουθίας Χ2 (Negative Sequence Reactance). 

Για τις ανάγκες της μελέτης βραχυκυκλωμάτων Χ2=ΧdG. 

 

Με βάση τα παραπάνω, έχουμε τις εξής τιμές στο παράθυρο διαλόγου: 

 Xd=XdG=1.40105 p.u. 

 Xq=XqG=1.40105 p.u. 

 X2=1.40105 p.u. 

 

Σε όλα τα υπόλοιπα μεγέθη διατηρούνται οι προεπιλεγμένες τιμές του προγράμματος. Στην 

Εικόνα 6.2 φαίνονται οι παράμετροι που ορίζονται από το χρήστη. 
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Εικόνα 6.2 Ορισμός παραμέτρων γεννήτριας στην καρτέλα Load Flow 

 

Καρτέλα IEC 61363 

 

Η υπομεταβατική και η μεταβατική αντίδραση Xd΄΄ και Xd΄, αντίστοιχα, πρέπει να 

συμπεριλάβουν την αντίδραση των καλωδίων. Επιπλέον, τα καλώδια πρέπει να ληφθούν 

υπόψη και κατά τον προσδιορισμό των χρονικών σταθερών Td΄΄, Td΄, Tdc, καθώς και της 

αντίστασης του στάτη Rstr. Γίνεται χρήση των παρακάτω σχέσεων, ενώ τα αποτελέσματα των 

σχετικών υπολογισμών δίνονται ως δεδομένα στον Πίνακα 6.2: 

 

 cddG X+΄΄X=΄΄X  (6.2) 

 cddG X+΄X=΄X  (6.3) 

 

 

(6.4) 

 
 

(6.5) 

 castr R+R=R  (6.6) 

 

 

Σημειώνεται ότι ο δείκτης e υποδηλώνει την ενσωμάτωση των παθητικών στοιχείων. Επίσης, 

η μεταβατική χρονική σταθερά Td΄ δίνεται σε στοιχεία για τις γεννήτριες του πλοίου, εκτός 

του Πίνακα 6.2. Θεωρείται προσεγγιστικά ότι περιλαμβάνει τα καλώδια, παρότι βέβαια δεν 

προσδιορίζεται με σαφήνεια κάτι τέτοιο. Δεδομένου, όμως, ότι οι μεταβολές των τιμών είναι 

ελάχιστες, θεωρείται ότι πρακτικά δεν επηρεάζεται ο υπολογισμός του ρεύματος 

βραχυκύκλωσης. 

Το ρεύμα βραχυκύκλωσης μόνιμης κατάστασης υπολογίζεται από τις ακόλουθες σχέσεις, 

όπου στη σύνθετη αντίσταση συμπεριλαμβάνονται και οι επιδράσεις των καλωδίων και ως 

I0=818 Α θεωρείται το ρεύμα λειτουργίας των γεννητριών: 
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(6.7) 

 

 

(6.8) 

  
 
 AI

AI
p.u.I

base

kd

kd   (6.9) 

 
V

S
I base

base



3

 (6.10) 

 

 

Τα αποτελέσματα όλων των παραπάνω υπολογισμών δίνονται στον Πίνακα 6.8. Τα στοιχεία 

με έντονους χαρακτήρες είναι αυτά που τελικά εισάγονται στο PowerFactory (Εικόνα 6.3). 

 

Στοιχεία βραχυκυκλώματος για τη γεννήτρια 

Xd΄΄ (p.u.) 0.15470 

Xd΄ (p.u.) 0.22700 

Χc (p.u.) 0.00105 

Rc (p.u.) 0.00443 

XdG΄΄ (p.u.) 0.15575 

XdG΄ (p.u.) 0.22805 

Rc (p.u.) 0.00443 

Ra (p.u.) 0.0162 

Rstr (p.u.) 0.02058 

Td΄΄ (s) 0.02000 

Te΄΄ (s) 0.02015 

Te΄ (s) 0.17700 

Tdc (s) 0.02100 

Tdce (s) 0.01661 

Eq0 (V) 347.573 

Ιkd (A) 2342.727 

Ibase (Α) 2453.739 

Ιkd (p.u.) 0.95476 

Πίνακας 6.8 
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Εικόνα 6.3 Ορισμός παραμέτρων γεννήτριας στην καρτέλα IEC 61363 

 

Αφού οριστούν όλες οι παράμετροι που εκτίθενται παραπάνω, ο χρήστης κλείνει το 

παράθυρο διαλόγου του τύπου της γεννήτριας (παράθυρο .TypSym) και στο αρχικό 

παράθυρο της γεννήτριας (.ElmSym) θέτει: 

 Καρτέλα Basic Data 

- Name: Equiv. Main Generator 

- Grounding/Neutral Conductor → N-Connection: None. Αυτή η επιλογή γίνεται, 

αφού κατά κανόνα τα δίκτυα των πλοίων δεν έχουν ουδέτερο κόμβο. 

 Καρτέλα Load Flow 

- Επιλέγεται η γεννήτρια ως Reference Machine (Slack). 

- Input Mode: S, P 

- Apparent Power: 1.9125 MW 

- Active Power: 1.53 MW 

 

Όλες οι υπόλοιπες παράμετροι παραμένουν ως έχουν (Εικόνα 6.4). 
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Εικόνα 6.4 Ρυθμίσεις γεννήτριας στην καρτέλα Load Flow 

 

6.2.1.3 Ορισμός κινητήρων και υπολογισμός των παραμέτρων τους 
 

Στη συνέχεια, συνδέονται στο δίκτυο ο ισοδύναμος κινητήρας για τους μικρούς κινητήρες, η 

αντλία έρματος και η αντλία λιπαντικού ελαίου, ενώ παράλληλα καθορίζονται οι παράμετροι 

κάθε κινητήρα με βάση τα δεδομένα στοιχεία. Πρέπει να διευκρινιστεί ότι ο συντελεστής 

ισχύος του κάθε κινητήρα δε δίνεται. Το μόνο διαθέσιμο στοιχείο είναι πως, για τον 

ισοδύναμο κινητήρα, ισχύει ότι 1 kW=1.34 kVA (Πίνακας 6.4), δηλαδή cosφ=0.746, όπως 

αναφέρεται και στην υποπαράγραφο 3.5.5.3.4 του Κεφαλαίου 3. Για τους άλλους δύο 

κινητήρες θεωρείται μία συνηθισμένη τιμή cosφ=0.8. 

 

6.2.1.3.1 Ορισμός ισοδύναμου κινητήρα 
 

Συνδέεται ένας ασύγχρονος κινητήρας στον κύριο ζυγό και στο παράθυρο διαλόγου του 

επιλέγεται Type → New Project Type. Στο παράθυρο (.TypAsmo) που ανοίγει αυτόματα, 

ακολουθείται η παρακάτω διαδικασία (Εικόνα 6.5). 

 

Καρτέλα Basic Data 

 

 Name: Motor 590.6 kW 

 Rated Voltage: 0.44 kV 

 Input Mode: Electrical Parameter 

 Power Rating → Rated Mechanical Power: 590.6 kW 

 Nominal Frequency: 60 Hz 

 No of Pole Pairs: 2 (υπόθεση που δεν επηρεάζει τους υπολογισμούς) 
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Εικόνα 6.5 Ορισμός νέου τύπου ασύγχρονου κινητήρα 

 

Καρτέλα Load Flow 

 

Στην καρτέλα αυτή πρέπει να οριστούν οι αντιστάσεις και επαγωγικές αντιδράσεις τόσο του 

στάτη όσο και του ρότορα. Τα μεγέθη αυτά είναι γνωστά από τον Πίνακα 6.4, οπότε 

παρατίθενται συγκεντρωμένα στον Πίνακα 6.9, ενώ η καρτέλα διαμορφώνεται όπως στην 

Εικόνα 6.6. Ο ισοδύναμος κινητήρας δεν περιλαμβάνει στοιχεία για καλωδιώσεις. Οι τιμές 

είναι οι τυπικές του προτύπου IEC για μικρούς κινητήρες 

 

Στοιχεία ροής φορτίου για τον ισοδύναμο κινητήρα 

Rs (p.u.) 0.043 

Xs (p.u.) 0.094 

RrA (p.u.) 0.027 

XrA (p.u.) 0.094 

Xm (p.u.) 1.5958 

Πίνακας 6.9 
 

Η τιμή του μεγέθους της μαγνητικής αντίδρασης (magnetic reactance) ορίστηκε μέσω 

δοκιμών, ώστε ο συντελεστής ισχύος του κινητήρα, που υπολογίζεται αυτόματα από το 

πρόγραμμα στην καρτέλα Basic Data, να προσεγγίζει ικανοποιητικά τον ονομαστικό 

συντελεστή ισχύος 0.746. 
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Εικόνα 6.6 Ορισμός μεγεθών ισοδύναμου κινητήρα στην καρτέλα Load Flow 

 

Καρτέλα IEC 61363 

 

Στην καρτέλα αυτή ενεργοποιείται η επιλογή Consider Transient Parameter, οπότε το 

πρόγραμμα αυτόματα υπολογίζει όλες τις απαραίτητες παραμέτρους του κινητήρα για τον 

υπολογισμό βραχυκυκλώματος, λαμβάνοντας υπόψη τα δεδομένα που όρισε ο χρήστης στην 

καρτέλα του Load Flow. Συγκρίνοντας τα μεγέθη αυτά με τα αντίστοιχα που δίνονται στον 

Πίνακα 6.4, παρατηρείται μία μικρή απόκλιση, η οποία οφείλεται στον κλάδο μαγνήτισης. Ο 

κλάδος αυτός αγνοείται στους θεωρητικούς υπολογισμούς. Πράγματι, αν ο χρήστης θέσει ως 

Χm μία αρκετά μεγάλη τιμή (π.χ. 100000) ώστε να αγνοηθεί πρακτικά, παρατηρείται ότι η 

απόκλιση των αποτελεσμάτων των παραμέτρων ελαχιστοποιείται. 

 

Αφού ολοκληρωθούν τα παραπάνω, στο αρχικό παράθυρο .ElmAsm ο κινητήρας ονομάζεται 

Small Motor, ενώ στην καρτέλα του Load Flow ορίζονται τα εξής (Εικόνα 6.7): 

 Bus Type: AS 

 Active Power: 0.5906 MW 
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Εικόνα 6.7 Ρύθμιση παραμέτρων ισχύος ισοδύναμου κινητήρα 

 

6.2.1.3.2 Ορισμός αντλίας έρματος 
 

Συνδέεται ένας νέος ασύγχρονος κινητήρας στον κύριο ζυγό και στο παράθυρο διαλόγου του 

επιλέγεται Type → New Project Type. Στο παράθυρο του τύπου που ανοίγει αυτόματα, 

ορίζονται τα παρακάτω. 

 

Καρτέλα Basic Data 

 

 Name: Motor 132 kW 

 Rated Voltage: 0.44 kV 

 Input Mode: Electrical Parameter 

 Power Rating → Rated Mechanical Power: 132 kW 

 Nominal Frequency: 60 Hz 

 No of Pole Pairs: 2 

 

Καρτέλα Load Flow 

 

Προκειμένου να συμπληρωθεί η καρτέλα αυτή, υπάρχουν τα στοιχεία για τις αντιστάσεις 

τόσο του στάτη όσο και του ρότορα, αλλά όχι τα στοιχεία για τις αντίστοιχες επαγωγικές 

αντιδράσεις (Πίνακας 6.5). Δίνεται, όμως, η συνολική επαγωγική αντίδραση του κινητήρα 

p.u. 1923.0΄΄Xm  rs XX . Λόγω έλλειψης επιπλέον στοιχείων, θεωρείται ότι οι 

επαγωγικές αντιδράσεις του στάτη και του ρότορα είναι ίσες μεταξύ τους. 

Στο σημείο αυτό, θα ενσωματωθούν στα στοιχεία της ροής φορτίου του κινητήρα τα 

αντίστοιχα μεγέθη των καλωδίων, όπως αυτά δίνονται στον Πίνακα 6.5. Για το σκοπό αυτό, 

γίνεται χρήση των ακόλουθων σχέσεων: 
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 csms RRR   (6.11) 

 csms XXX   (6.12) 

 

 

Στη βάση αυτή, ο Πίνακας 6.10 περιλαμβάνει τα στοιχεία για την καρτέλα. Η μαγνητική 

αντίδραση καθορίζεται και πάλι μέσω δοκιμών, ώστε να επιτευχθεί ο συντελεστής ισχύος 

cosφ=0.8. 

 

Στοιχεία ροής φορτίου για την αντλία έρματος 

Rs (p.u.) 0.01993 

Xs (p.u.) 0.09615 

RrA (p.u.) 0.00990 

XrA (p.u.) 0.09615 

Xm (p.u.) 1.9803 

Πίνακας 6.10 
 

Καρτέλα IEC 61363 

 

Εδώ χρησιμοποιείται και πάλι η επιλογή Consider Transient Parameter για αυτόματο 

υπολογισμό των παραμέτρων του κινητήρα. 

 

Τέλος, ο κινητήρας ονομάζεται Large Motor (Ballast Pump). 

 

6.2.1.3.3 Ορισμός αντλίας λιπαντικού ελαίου 
 

Η αντλία λιπαντικού ελαίου προσδιορίζεται με παρόμοιο τρόπο όπως και η αντλία έρματος. 

Τα απαραίτητα στοιχεία αναφέρονται στον Πίνακα 6.11. Επειδή και σε αυτήν την περίπτωση 

δε δίνονται οι τιμές για τις επαγωγικές αντιδράσεις του στάτη και του ρότορα, αυτές 

θεωρούνται ίσες μεταξύ τους. 

 

Στοιχεία ροής φορτίου για την αντλία λιπαντικού ελαίου 

Rs (p.u.) 0.04588 

Xs (p.u.) 0.07500 

RrA (p.u.) 0.02100 

XrA (p.u.) 0.07500 

Xm (p.u.) 1.7804 

Active Power (MW) 0.075 

Πίνακας 6.11 
 

Ο κινητήρας ονομάζεται Large Motor (LO Pump). 

 

6.2.1.4 Ορισμός δευτερεύοντος ζυγού και μετασχηματιστή 
 

Ακολούθως, τοποθετείται στο δίκτυο ο ζυγό χαμηλότερης τάσης, ο οποίος τροφοδοτεί τα 

φορτία φωτισμού και άλλων λειτουργιών μικρής απαίτησης ισχύος. Αυτό γίνεται 

χρησιμοποιώντας το στοιχείο του απλού ζυγού (Busbar) και θέτοντας ως όνομα νέου τύπου 

BB 220 V και Nominal Voltage 0.22 kV. Επίσης, δίνεται όνομα Secondary Busbar στο ζυγό, 

ενώ τίθεται το Nominal Voltage → Line-Line στα 0.22 kV. 
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Ύστερα, τοποθετείται ένας μετασχηματιστής για τη σύνδεση του κύριου ζυγού των 440 V 

και του δευτερεύοντος ζυγού των 220 V. Ο μετασχηματιστής ονομάζεται General Service 

Transformer και δημιουργείται νέος τύπος μέσω του Type → New Project Type, όπου 

τίθενται τα εξής, σύμφωνα με τον Πίνακα 6.6: 

 Name: 450/230 V 

 Technology: Three Phase Transformer 

 Rated Power: 0.025 MVA 

 Nominal Frequency: 60 Hz 

 Rated Voltage: HV-Side: 0.45 kV, LV-Side: 0.23 kV 

 

Επίσης, στο πλαίσιο της αντίστασης θετικής ακολουθίας (Positive Sequence Impedance), ο 

χρήστης επιλέγει ως μεγέθη εισαγωγής τα Reactance in p.u. and Resistance in p.u., πατώντας 

το βέλος και επιλέγοντας τα μεγέθη στο παράθυρο που εμφανίζεται. Οι τιμές των μεγεθών 

είναι (Πίνακας 6.6): 

 Reactance x1: 0.0168 p.u. 

 Resistance r1: 0.0196 p.u. 

 

Το παράθυρο του τύπου του μετασχηματιστή φαίνεται στην Εικόνα 6.8. 

 

Οι υπόλοιπες καρτέλες του τύπου του μετασχηματιστή και του αρχικού παραθύρου 

παραμένουν ως έχουν, αφού ελεγχθεί ότι, στην καρτέλα Load Flow του αρχικού παραθύρου, 

η επιλογή Automatic Tap Changing, η οποία αφορά την ύπαρξη συστήματος μεταβολής του 

λόγου μετασχηματισμού, είναι απενεργοποιημένη και η επιλογή Tap Position είναι 

ρυθμισμένη στο μηδέν. 

 

 
Εικόνα 6.8 Ορισμός παραμέτρων στον τύπο του μετασχηματιστή 
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Μετά την τοποθέτηση και τον προσδιορισμό των χαρακτηριστικών της γεννήτριας, των 

κινητήρων, των ζυγών και του μετασχηματιστή, το σύστημα είναι έτοιμο για τον υπολογισμό 

βραχυκυκλώματος. Το ηλεκτρικό δίκτυο θα πρέπει να είναι όπως φαίνεται στην Εικόνα 6.9. 

 

 
Εικόνα 6.9 Προσομοίωση ηλεκτρικού δικτύου πλοίου bulk carrier 

 

 

6.2.2 Υπολογισμός βραχυκυκλώματος 
 

Ο βασικός υπολογισμός βραχυκυκλώματος θα πραγματοποιηθεί για σφάλμα στον κύριο 

ζυγό, ώστε να εξεταστεί το αναπτυσσόμενο ρεύμα στην ισοδύναμη γεννήτρια, στους τρεις 

κινητήρες και στο ζυγό. Επιπλέον, θα πραγματοποιηθεί ένας συμπληρωματικός υπολογισμός 

για σφάλμα στο ζυγό χαμηλότερης τάσης, προκειμένου να εξεταστεί το αναπτυσσόμενο 

ρεύμα στην περίπτωση αυτή. 

 

6.2.2.1 Βραχυκύκλωμα στον κύριο ζυγό 
 

Από την μπάρα των κύριων εικονιδίων επιλέγεται το εικονίδιο . Στο παράθυρο που 

ανοίγει γίνονται οι εξής ρυθμίσεις: 

 Basic Options 

- Method: IEC 61363 

- Calculate Using: Standard IEC 61363 Method 

- Break Time: 0.1 s 

- Fault Location: User Selection → Select → Επιλογή Main Busbar 

- Show Output: επιλογή για εμφάνιση αποτελεσμάτων στο παράθυρο εξόδου 

- Create Plots: επιλογή, Show: only short-circuit current at faulted terminal, ώστε 

να αποτυπωθούν τα αποτελέσματα του βραχυκυκλώματος στο ζυγό με τη μορφή 

διαγράμματος. 



168 
 

 Advanced Options 

- Preload Condition: use load flow initialization, ώστε να πραγματοποιηθεί ένας 

υπολογισμός ροής φορτίου πριν από το βραχυκύκλωμα 

 

Ακολούθως, εκτελείται ο υπολογισμός πατώντας Execute. Στα παράθυρα αποτελεσμάτων 

των στοιχείων του δικτύου εμφανίζονται διάφορα μεγέθη. Όπως αναφέρεται στην 

υποπαράγραφο 5.1.1.4 του Κεφαλαίου 5, η επιλογή μεγεθών είναι εφικτή μέσω της 

διαδρομής δεξί κλικ → Edit Format for Edge Elements. Τα μεγέθη, τα οποία χρειάζονται για 

τη συγκεκριμένη μελέτη, είναι τα εξής (Εικόνα 6.10): 

 Ikdss (Subtransient Short-Circuit Current) 

 Ikds (Transient Short-Circuit Current) 

 ip (Peak Short-Circuit Current) 

 Tdss (Subtransient Time Constant) 

 Tdc (D.C. Time Constant) 

 

Σημειώνεται ότι τα μεγέθη Ikd (Steady-State Short-Circuit Current) και Tds (Transient Time 

Constant) δεν εντάσσονται στα αποτελέσματα, διότι δε δίνονται οι τιμές τους στα θεωρητικά 

αποτελέσματα των γεννητριών. Τα προηγούμενα μεγέθη αφορούν τη γεννήτρια και τους 

κινητήρες. Με αντίστοιχη διαδικασία, μέσω της επιλογής Edit Format for Short Circuit 

Nodes, επιλέγεται για το ζυγό το μέγεθος ip (Peak Short-Circuit Current). 

 

 
Εικόνα 6.10 Επιλογή εμφανιζόμενων μεγεθών για τον υπολογισμό βραχυκυκλώματος 

 

Στον Πίνακα 6.12 παρουσιάζονται τα αποτελέσματα της μελέτης βραχυκυκλώματος. Όσον 

αφορά τη γεννήτρια, τα αποτελέσματα περιλαμβάνουν το υπομεταβατικό και μεταβατικό 

ρεύμα βραχυκύκλωσης, το κρουστικό ρεύμα, την υπομεταβατική χρονική σταθερά και τη 

χρονική σταθερά ΣΡ. Για τους ασύγχρονους κινητήρες, καθώς δεν έχουν τύλιγμα διέγερσης, 
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η συνεισφορά τους είναι αξιόλογη μόνο κατά την υπομεταβατική τους περίοδο. Στον κύριο 

ζυγό ενδιαφέρον παρουσιάζει η τιμή του κρουστικού ρεύματος. 

 

Αποτελέσματα υπολογισμού βραχυκυκλώματος 

Variables Equiv. Main Generator Small Motor Ballast Pump LO Pump 
Main Busbar 

(440 V) 

Ikd΄΄ (kA) 16.371 4.851 1.032 0.717 - 

Ikd΄ (kA) 11.553 0.000 0.000 0.000 - 

Ip (kA) 33.455 8.318 2.437 1.094 45.341 

Td΄΄ (s) 0.0202 0.0202 0.0554 0.0202 - 

Tdc (s) 0.0166 0.0113 0.0250 0.0085 - 

Πίνακας 6.12 
 

Επιπλέον, δίνεται το διάγραμμα της κυματομορφής του ρεύματος βραχυκύκλωσης στον 

κύριο ζυγό, το οποίο περιλαμβάνει τη στιγμιαία τιμή, τη συνιστώσα ΣΡ και την άνω 

περιβάλλουσα του ρεύματος βραχυκύκλωσης σε συνάρτηση με το χρόνο (Εικόνα 6.11). 

 

 
Εικόνα 6.11 Κυματομορφή ρεύματος βραχυκύκλωσης στον κύριο ζυγό 
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6.2.2.2 Βραχυκύκλωμα στο δευτερεύοντα ζυγό 
 

Ο συμπληρωματικός υπολογισμός βραχυκυκλώματος για σφάλμα στο βοηθητικό ζυγό των 

220 V πραγματοποιείται με τις ίδιες ρυθμίσεις, με τη μόνη διαφορά ότι επιλέγεται ο σχετικός 

ζυγός στο παράθυρο του υπολογισμού. Στον Πίνακα 6.13 παρουσιάζονται τα αποτελέσματα 

της μελέτης βραχυκυκλώματος στην περίπτωση αυτή, με το μέγεθος του κρουστικού 

ρεύματος να αφορά το δευτερεύοντα ζυγό, ενώ στην Εικόνα 6.12 δίνεται το διάγραμμα της 

κυματομορφής του ρεύματος βραχυκύκλωσης στο δευτερεύοντα ζυγό. 

 

Αποτελέσματα υπολογισμού βραχυκυκλώματος 

Variables 
Secondary Busbar 

(220 V) 

Ip (kA) 3.300 

Πίνακας 6.13 
 

 
Εικόνα 6.12 Κυματομορφή ρεύματος βραχυκύκλωσης στο δευτερεύοντα ζυγό 
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6.3 Σύγκριση αποτελεσμάτων PowerFactory και 
θεωρητικών υπολογισμών 

 
Στους Πίνακες 6.14α και 6.14β παρουσιάζονται τα αποτελέσματα της προσομοίωσης 

βραχυκύκλωσης στο δίκτυο του πλοίου. Τα εξεταζόμενα στοιχεία είναι η ισοδύναμη 

γεννήτρια, οι τρεις κινητήρες, ο κύριος ζυγός των 440 V και ο βοηθητικός ζυγός των 220 V. 

 

Παρατηρούμε ότι οι τρεις τιμές ρευμάτων και οι δύο χρονικές σταθερές προσεγγίζουν σε 

ικανοποιητικό βαθμό τις θεωρητικές τιμές του φυλλαδίου του πλοίου. Οι μικρές αποκλίσεις 

οφείλονται, κατ’ αρχάς, στους δύο βασικούς παράγοντες που αναφέρθηκαν στην ενότητα 5.3 

του Κεφαλαίου 5, δηλαδή στην αγνόηση του κλάδου μαγνήτισης των κινητήρων στους 

θεωρητικούς υπολογισμούς, καθώς και στο ότι πραγματοποιείται υπολογισμός ροής φορτίου 

πριν το βραχυκύκλωμα με τιμές ρευμάτων που διαφέρουν από τις τιμές των ονομαστικών 

ρευμάτων λειτουργίας. 

 

Επιπρόσθετα, θα πρέπει να ληφθούν υπόψη οι υποθέσεις που πραγματοποιήθηκαν, κατά το 

σχεδιασμό της ηλεκτρικής εγκατάστασης, λόγω έλλειψης στοιχείων. Πιο συγκεκριμένα, η 

μεταβατική χρονική σταθερά Td΄ της ισοδύναμης γεννήτριας θεωρήθηκε προσεγγιστικά ότι 

περιλαμβάνει τα καλώδια, χωρίς αυτό να προσδιορίζεται με σαφήνεια. Επίσης, ο 

συντελεστής ισχύος της αντλίας έρματος και της αντλίας λιπαντικού ελαίου δεν είναι 

διαθέσιμος, οπότε έγινε η υπόθεση cosφ=0.8. Ακόμα, οι επαγωγικές αντιδράσεις του στάτη 

και του ρότορα των δύο αντλιών δεν είναι γνωστές, οπότε αυτές θεωρήθηκαν ίσες μεταξύ 

τους, έχοντας ως δεδομένη τη συνολική επαγωγική αντίδραση. Γενικά, η ισχύς λειτουργίας 

καθενός από τους τρεις κινητήρες δεν αναφέρεται, γεγονός που οδήγησε στη θεώρηση ισχύος 

λειτουργίας ίσης με την ονομαστική ισχύ σε κάθε κινητήρα. 

 

Εκτός από τις υποθέσεις λόγω έλλειψης στοιχείων, πρέπει να τονιστεί το ότι οι συντάκτες 

του φυλλαδίου θεωρητικών υπολογισμών έχουν χρησιμοποιήσει μία προσαύξηση της 

συνιστώσας ΕΡ του ρεύματος βραχυκύκλωσης της γεννήτριας κατά 10%, για λόγους 

ασφάλειας. Το γεγονός αυτό ερμηνεύει τις ελαφρώς υψηλότερες τιμές του υπομεταβατικού 

και του κρουστικού ρεύματος βραχυκύκλωσης της γεννήτριας, καθώς και του συνολικού 

κρουστικού ρεύματος στον κύριο ζυγό, οι οποίες προκύπτουν από τις πράξεις κατά το 

πρότυπο IEC 61363-1, σε σχέση με αυτές του προγράμματος. Για παράδειγμα, αν 

αφαιρέσουμε την προσαύξηση, έχουμε για τη γεννήτρια ότι: 

kA 619.15
1.1

17.181
΄΄I kd  

 

Καθίσταται σαφές ότι το PowerFactory δεν υποτιμά το αναπτυσσόμενο ρεύμα 

βραχυκύκλωσης, καθώς η τιμή της προσομοίωσης για το συνολικό κρουστικό ρεύμα στον 

κύριο ζυγό είναι υψηλότερη από την αντίστοιχη θεωρητική τιμή, μετά την αφαίρεση της 

προσαύξησης. Επομένως, το μελετώμενο λογισμικό παρέχει ασφαλείς εκτιμήσεις για τη 

μελέτη βραχυκυκλωμάτων σε πραγματικά ηλεκτρικά δίκτυα πλοίων, ακόμα και σε 

περιπτώσεις έλλειψης ορισμένων στοιχείων, όπως η παρούσα. 
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Σύγκριση αποτελεσμάτων υπολογισμού βραχυκυκλώματος (α) 

Μεγέθη Equiv. Main Generator Small Motor Ballast Pump LO Pump 

 Προσομοίωση Θεωρητ. Προσομοίωση Θεωρητ. Προσομοίωση Θεωρητ. Προσομοίωση Θεωρητ. 

Ikd΄΄ (kA) 16.371 17.181 4.851 5.192 1.032 1.079 0.717 0.727 

Ikd΄ (kA) 11.553 11.790 0.000 0.000 0.000 0.000 0.000 0.000 

Ip (kA) 33.455 35.090 8.318 8.308 2.437 2.402 1.094 1.059 

Td΄΄ (s) 0.0202 0.0202 0.0202 0.0187 0.0554 0.0518 0.0202 0.0191 

Tdc (s) 0.0166 0.0166 0.0113 0.0117 0.0250 0.0257 0.0085 0.0087 

Πίνακας 6.14α 
 

Σύγκριση αποτελεσμάτων υπολογισμού βραχυκυκλώματος (β) 

Μεγέθη 
Main Busbar 

(440 V) 

Secondary Busbar 

(220 V) 

 Προσομοίωση Θεωρητ. Προσομοίωση Θεωρητ. 

Ip (kA) 45.341 46.860 3.300 3.747 

Πίνακας 6.14β 
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ΚΕΦΑΛΑΙΟ 7 
 

Επίλογος 
 

7.1 Σύνοψη και συμπεράσματα 
 

Το DIgSILENT PowerFactory είναι ένα ισχυρό λογισμικό ανάλυσης συστημάτων ηλεκτρικής 

ενέργειας, το οποίο χρησιμοποιείται για εφαρμογές σχετικές με την παραγωγή, τη μετάδοση 

και τη διανομή ηλεκτρικής ενέργειας, καθώς και για μελέτες βιομηχανικών συστημάτων. 

Κατά την υλοποίηση της παρούσας διπλωματικής εργασίας, η οποία σκοπό έχει τη 

διερεύνηση των δυνατοτήτων που προσφέρει το εν λόγω λογισμικό στον τομέα της ναυτικής 

μηχανολογίας και συγκεκριμένα στη μελέτη βραχυκυκλωμάτων σε πλοία, έγινε προσπάθεια 

να επιτευχθούν οι παρακάτω στόχοι: 

1. Γνωριμία του αναγνώστη με τις βασικές πτυχές του PowerFactory, μέσα από την 

έκθεση αναλυτικών οδηγιών για τη λειτουργία του, προκειμένου να καταστεί εφικτή 

η ακαδημαϊκή χρήση του για εφαρμογές στον τομέα της ναυτικής μηχανολογίας 

2. Συνοπτική έκθεση της θεωρίας βραχυκυκλωμάτων και παρουσίαση του διεθνούς 

προτύπου IEC 61363-1 για τη μελέτη βραχυκυκλωμάτων 

3. Εξέταση του τρόπου εφαρμογής του διεθνούς προτύπου IEC 61363-1 στην ανάλυση 

βραχυκυκλωμάτων μέσω του PowerFactory 

4. Μελέτη βραχυκυκλώματος στο ηλεκτρικό δίκτυο μίας υποδειγματικής 

ηλεκτρολογικής μελέτης πλοίου και εξέταση των αποτελεσμάτων της προσομοίωσης 

υπό το πρίσμα των θεωρητικών σχέσεων 

5. Μελέτη βραχυκυκλώματος στο ηλεκτρικό δίκτυο ενός πραγματικού πλοίου 

μεταφοράς φορτίου χύδην και σύγκριση των αποτελεσμάτων με τις θεωρητικές τιμές, 

κατά το πρότυπο IEC 61363-1, που δίνονται σε σχετικό φυλλάδιο του πλοίου 

6. Δημιουργία μίας αντιπροσωπευτικής βάσης δεδομένων – βιβλιοθήκης με 

ολοκληρωμένα σχέδια (projects) στην πλατφόρμα του PowerFactory, τα οποία είναι 

διαθέσιμα για ακαδημαϊκή χρήση 

 

Μέσα από την προηγούμενη διαδικασία και την επίλυση των προβλημάτων που προέκυψαν, 

έγινε δυνατή η διερεύνηση των δυνατοτήτων που προσφέρει το μελετώμενο λογισμικό 

πακέτο, καθώς και ο εντοπισμός ορισμένων προβληματικών στοιχείων. 

 

Ως βασικά πλεονεκτήματα του PowerFactory θεωρούνται τα ακόλουθα: 

 Δυνατότητα χρήσης για την ανάλυση τόσο απλών ηλεκτρικών δικτύων όσο και 

σύνθετων συστημάτων ηλεκτρικής ενέργειας μεγάλης κλίμακας 

 Υποστήριξη όλων των στοιχείων και αναπαραστάσεων ηλεκτρικών δικτύων, καθώς 

και όλων των τεχνολογιών φάσεων, για δίκτυα ΕΡ ή ΣΡ 

 Πληθώρα μεταβλητών για την καλύτερη δυνατή περιγραφή των στοιχείων των 

συστημάτων ηλεκτρικής ενέργειας, με δυνατότητα επιλογών διαφορετικών μοντέλων 

αναπαράστασης 
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 Εύχρηστα διαγράμματα ηλεκτρικών δικτύων και ποιοτικές γραφικές αναπαραστάσεις 

 Ποικιλία σχετικά απλών τρόπων αλληλεπίδρασης του χρήστη με το λογισμικό 

 Λεπτομερής καθοδήγηση του χρήστη για την εις βάθος μελέτη και εξειδίκευση, μέσω 

ενός ιδιαίτερα αναλυτικού manual [7] 

 Ενσωμάτωση όλων των γνωστών υπολογισμών και διαδικασιών ανάλυσης που 

αφορούν τα συστήματα ηλεκτρικής ενέργειας, όπως είναι η ανάλυση ροών φορτίου 

(load flow analysis), η ανάλυση βραχυκυκλώματος (short circuit analysis), η 

εκκίνηση κινητήρα (motor starting), η αρμονική ανάλυση (harmonics analysis), η 

προσομοίωση μεταβατικών φαινομένων (RMS/ EMT simulation), ο υπολογισμός 

ιδιοτιμών (eigenvalue calculation), η ανάλυση καταστάσεων έκτακτης ανάγκης 

(contingency analysis) κ.λπ. 

 Χρήση μίας μοναδικής βάσης δεδομένων για την αποθήκευση όλων των δεδομένων 

για τον εξοπλισμό ενός συστήματος ηλεκτρικής ενέργειας, με στόχο την εύκολη 

εκτέλεση όλων των διαδικασιών προσομοίωσης εντός του ίδιου προγραμματιστικού 

περιβάλλοντος 

 

Ως κύρια μειονεκτήματα του PowerFactory, υπό το πρίσμα της ακαδημαϊκής χρήσης, 

εντοπίζονται τα εξής: 

 Πολυπλοκότητα και ανάγκη συστηματικής ενασχόλησης για την εξοικείωση με το 

πρόγραμμα, λόγω του προορισμού του για τη μελέτη σύνθετων συστημάτων 

ηλεκτρικής ενέργειας και βιομηχανικές εφαρμογές μεγάλης κλίμακας 

 Ανεπαρκής υποστήριξη της γνωριμίας με το πρόγραμμα για αρχάριους και φοιτητές 

με θεωρητικές γνώσεις προπτυχιακού ή/και μεταπτυχιακού επιπέδου, με μοναδική 

εξαίρεση την ύπαρξη ενός περιεκτικού και εύστοχου tutorial [1] 

 Έλλειψη ναυτικών εφαρμογών του προγράμματος 

 Δυσκολία καθορισμού των στοιχείων ενός ηλεκτρικού δικτύου, λόγω ύπαρξης μίας 

πληθώρας παραμέτρων, οι τιμές των οποίων δεν είναι πάντα γνωστές 

 Τεχνικές δυσκολίες στη δημιουργία διαγραμμάτων των μελετώμενων μεγεθών και 

ανεπαρκής επεξήγηση στο manual του προγράμματος 

 Συχνή ανεπάρκεια των μηνυμάτων σφαλμάτων για τη διόρθωση των ηλεκτρικών 

δικτύων κατά το σχεδιασμό 

 

 

7.2 Προτάσεις για ακαδημαϊκή χρήση του PowerFactory και 
περαιτέρω μελέτη 

 
Παρά τις δυσκολίες που εμφανίζει η εξοικείωση με το PowerFactory, λόγω της 

πολυπλοκότητάς του, το υπό μελέτη λογισμικό πακέτο προσφέρεται για ακαδημαϊκή χρήση, 

αποτελώντας μία ποιοτικότερη εναλλακτική σε σχέση με άλλα προγράμματα, όπως είναι το 

ETAP και το PSCAD, καθότι είναι πληρέστερο και ανανεώνεται συνεχώς. Μέσω της 

κατάλληλης υποστήριξης, το συγκεκριμένο λογισμικό θα μπορούσε να αποτελέσει τη βάση 

για την καλύτερη κατανόηση της θεωρίας βραχυκυκλωμάτων και την εμβάθυνση σε 

υπολογιστικές μεθόδους, όπως αυτή που απορρέει από το διεθνές πρότυπο IEC 61363-1. Πιο 

συγκεκριμένα, στο πλαίσιο του προπτυχιακού μαθήματος «Ενεργειακά Συστήματα Πλοίου» 

του 8ου εξαμήνου της Σχολής Ναυπηγών Μηχανολόγων Μηχανικών ΕΜΠ αλλά και 

ευρύτερα των μαθημάτων ηλεκτροτεχνίας, το PowerFactory θα μπορούσε να συνεισφέρει 

στον εμπλουτισμό της ακαδημαϊκής διαδικασίας και στην άμεση εφαρμογή των θεωρητικών 

γνώσεων στην επίλυση πραγματικών προβλημάτων. Πρόκειται για προβλήματα ναυτικής 



175 
 

μηχανολογίας, τα οποία ένας Ναυπηγός Μηχανολόγος Μηχανικός πιθανά θα κληθεί να 

αντιμετωπίσει κατά τη διάρκεια της επαγγελματικής του σταδιοδρομίας. 

 

Όπως αναφέρθηκε και στην ενότητα 7.1, η παρούσα διπλωματική εργασία επιδιώκει, μεταξύ 

άλλων, να προσφέρει το κατάλληλο υπόβαθρο για μελλοντική ακαδημαϊκή χρήση του 

PowerFactory, μέσω της ένταξής του στα αντίστοιχα μαθήματα της Σχολής. Στην 

κατεύθυνση αυτή, το Κεφάλαιο 2 περιλαμβάνει γενικές οδηγίες για την εξοικείωση των 

φοιτητών με το περιβάλλον του προγράμματος. Επίσης, το διεθνές πρότυπο IEC 61363-1 

εκτίθεται τόσο αυτοτελώς (Κεφάλαιο 3) όσο και σε σχέση με την εφαρμογή του στο 

πρόγραμμα (Κεφάλαιο 4). Ακόμα, το ηλεκτρικό δίκτυο της υποδειγματικής ηλεκτρολογικής 

μελέτης, που χρησιμοποιείται για την καλύτερη κατανόηση των βραχυκυκλωμάτων και την 

εκπόνηση της σχετικής εργασίας στο μάθημα «Ενεργειακά Συστήματα Πλοίου», συνιστά τη 

βάση για τη λεπτομερή μελέτη της ανάλυσης βραχυκυκλωμάτων στο PowerFactory, στο 

Κεφάλαιο 5. Τέλος, η προσομοίωση του πραγματικού ηλεκτρικού δικτύου και ο υπολογισμός 

βραχυκυκλώματος σε αυτό, στο Κεφάλαιο 6, αποτελούν ένα τυπικό παράδειγμα χρήσης του 

λογισμικού στη μελέτη και σχεδίαση συστημάτων ηλεκτρικής ενέργειας πλοίων, με δεδομένα 

το μονογραμμικό διάγραμμα και τα βασικά χαρακτηριστικά των στοιχείων του δικτύου. 

 

Έχει σημασία να σημειωθεί ότι το πρότυπο IEC 61363-1 χρησιμοποιήθηκε στην παρούσα 

εργασία, διότι αφορά τον υπολογισμό των ρευμάτων βραχυκύκλωσης σε ναυτικές και 

παράκτιες εγκαταστάσεις ΕΡ, όπως είναι τα πλοία. Ωστόσο, παρουσιάζει ιδιαίτερο 

ενδιαφέρον η εξέταση και άλλων προτύπων για τη μελέτη βραχυκυκλωμάτων, τα οποία 

βασίζονται σε διαφορετικές υπολογιστικές μεθόδους. Χαρακτηριστικές είναι οι δύο 

ακόλουθες περιπτώσεις: 

 IEC 60909-0 [4]: Υπολογισμός των ρευμάτων βραχυκύκλωσης σε εγκαταστάσεις ΕΡ 

στην ξηρά 

 IEC 61660-1 [6]: Υπολογισμός των ρευμάτων βραχυκύκλωσης σε βοηθητικά 

συστήματα ΣΡ εγκαταστάσεων στην ξηρά 

 

Επιπρόσθετα, το PowerFactory διαθέτει τους υπολογισμούς διαστασιολόγησης καλωδίων 

(cable sizing) και προστασίας (protection), οι οποίοι προσφέρονται για μελλοντικές μελέτες 

σε σχέση με τα βραχυκυκλώματα. Στην πρώτη περίπτωση, μπορούν να εξεταστούν οι 

παράμετροι για την κατάλληλη επιλογή καλωδίων σε σχέση με τις αναμενόμενες τιμές του 

ρεύματος βραχυκύκλωσης, καθώς στο παράθυρο του υπολογισμού υπάρχει αναφορά στον 

υπολογισμό βραχυκυκλώματος. Η δεύτερη περίπτωση αφορά τον προσδιορισμό ενός 

συστήματος προστασίας του ηλεκτρικού δικτύου με την ενσωμάτωση συγκεκριμένων 

διατάξεων προστασίας. Το manual του προγράμματος [7] περιέχει τις απαιτούμενες οδηγίες 

και πληροφορίες για την εκτέλεση των υπολογισμών αυτών. 

 

Επιπλέον, η μελέτη βραχυκυκλωμάτων και ο προσδιορισμός των αντίστοιχων ρευμάτων 

μπορούν να υλοποιηθούν σε ηλεκτρικές εγκαταστάσεις μίας σειράς πλοίων. Για παράδειγμα, 

στο πλαίσιο του «Θέματος Μελέτης και Σχεδίασης Πλοίου» της Σχολής, το ηλεκτρικό δίκτυο 

του εκάστοτε πατρικού πλοίου μπορεί, εφόσον υπάρχουν τα απαιτούμενα δεδομένα για τα 

στοιχεία του δικτύου, τις ομαδοποιήσεις των κινητήρων και τα ρεύματα βραχυκύκλωσης, να 

σχεδιάζεται στην πλατφόρμα του PowerFactory, ώστε να αποτελέσει πεδίο μελέτης της 

θεωρίας βραχυκυκλωμάτων. Στην ίδια κατεύθυνση μπορούν να αξιοποιηθούν τα διαθέσιμα 

στοιχεία για άλλα πλοία. Παράλληλα, ιδιαίτερο ενδιαφέρον για την ασφαλή λειτουργία των 

ηλεκτρικών εγκαταστάσεων των πλοίων παρουσιάζει η μελέτη των πτώσεων τάσης που 

προκαλούνται από σφάλματα βραχυκύκλωσης [10], καθώς και η κατάταξη των πτώσεων 

αυτών με στόχο την αντικειμενική αξιολόγηση της ποιότητας της ηλεκτρικής ισχύος [11]. Σε 
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κάθε περίπτωση, τα βασικά βιβλία της Σχολής για τη θεωρία βραχυκυκλωμάτων και τις 

ηλεκτροτεχνικές εφαρμογές σε πλοία και πλωτές κατασκευές ([2] και [12] αντίστοιχα) 

μπορούν να αποτελέσουν τον οδηγό για την περαιτέρω εμβάθυνση στα διάφορα αντικείμενα. 
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